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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

CAUTION  
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

CAUTION  
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

NOTICE  
indicates that an unintended result or situation can occur if the relevant information is not taken into account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 

 

 Siemens AG 
Industry Sector 
Postfach 48 48 
90026 NÜRNBERG 
GERMANY 

Order number: 3ZX1012-0RK31-1AC1 
Ⓟ 06/2012 Technical data subject to change 

Copyright © Siemens AG 2008. 
All rights reserved 
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About this manual 1
1.1 What's new? 

Two new central units with AS-i interface 
Two other 3RK3 central units with AS-i interface are available in addition to the MSS 3RK3 
Advanced: 

● 3RK3 ASIsafe basic 

● 3RK3 ASIsafe extended 

Both support the same function elements as the 3RK3 Advanced central unit. The 
differences between these three central units are listed in the table: 

 
Feature 3RK3 ASIsafe 

basic 
3RK3 ASIsafe 
extended 

3RK3 Advanced 

Safety-related, freely 
parameterizable sensor inputs 

2 4 8 

Digital standard inputs (single-
channel) 

6 4 0 

Safety-related, redundant relay 
outputs 

1 1 1 

Safety-related, redundant 
semiconductor outputs 

1 1 1 

Expansion modules 0 2 9 
Maximum number of simulated 
safety-related AS-i slaves 

8 10 12 

DP interface Yes Yes Yes 
Diagnostics module Yes Yes Yes 

Service Pack SP3 for MSS ES 
A new SP3 is available for MSS ES, see Chapter "What's new? (Page 143)". 
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1.2 Purpose of this manual 
This manual contains a detailed description of the 3RK3 Modular Safety System 
(abbreviated to MSS 3RK3) and its components. This manual provides you with the 
information you require for configuring, commissioning, operating, and diagnosing the MSS 
3RK3. A typical safety application will provide you with a clear and practice-oriented 
introduction to the system. 

1.3 Required basic knowledge 
A general knowledge of the following areas is needed in order to understand this manual: 

● Low-voltage switchgear 

● Digital circuit logic 

● Automation systems 

● Safety systems 

1.4 Topics dealt with 
This manual consists of instructive chapters for reference purposes. The table below 
contains a list of the most important topics dealt with, along with their associated target 
groups. 

 
Subject Target group 
Overview Configuration engineers, planning engineers 
Getting Started Configuration engineers, planning engineers 
Description of the hardware: 
• Mounting / installing / attaching 
• Connecting / wiring 

Configuration engineers, planners, installation engineers, 
electricians, service and maintenance personnel 

Description of the software 
(Parameterizing, configuring) 

Configuration engineers 

Operation 
(Response times, commissioning, tips 
and tricks, PROFIBUS connection, AS-i 
connection) 

Configuration engineers, commissioning engineers, 
installation engineers, service and maintenance personnel 

Diagnostics / service Configuration engineers, service and maintenance 
personnel 

Technical data Configuration engineers 
Dimension drawings Configuration engineers 
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1.5 Validity range 
This manual is valid for the MSS 3RK3 components listed below with their order numbers: 

 
Component Order No.   
3RK3 Basic (central unit) 3RK3111-xAA10 
3RK3 Advanced (central unit) 3RK3131-xAC10 
3RK3 ASIsafe basic (central unit) 3RK3121-xAC00 
3RK3 ASIsafe extended (central unit) 3RK3122-xAC00 
4/8F-DI (expansion module) 3RK3211-xAA10 
2/4F-DI 1/2F-RO (expansion module) 3RK3221-xAA10 
2/4F-DI 2F-DO (expansion module) 3RK3231-xAA10 
4F-DO (expansion module) 3RK3242-xAA10 
4/8F-RO (expansion module) 3RK3251-xAA10 
8DI (expansion module) 3RK3321-xAA10 
8DO (expansion module) 3RK3311-xAA10 
DP interface (interface module) 3RK3511-xBA10 
Diagnostics display 3RK3611-3AA00 
MSS ES (parameterization software) 3ZS1314-* 

x = 1: Version with screw-type terminals: 
x = 2: Version with spring-loaded terminals: 

SIEMENS reserves the right of including a Product Information for each new component, 
and for each component of a later version. 
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1.6 Additional documentation 
If you use products other than those described in this manual, you also require further 
documentation:   

 

 Note 
Manuals for other products used 

The manuals are available in the Internet (www.siemens.com/industrial-controls/manuals) for 
downloading free of charge. 

 

 

 
Manual Download / order number 
AS-Interface System Manual 3RK2703-3BB02-1AA1 
SIRIUS Safety Integrated Manual (SIAM)  L3-Z333 
SIMATIC NET PROFIBUS Network Manual C79000-G8900-C124-03 

 
 

 Note 
Latest information 

For the latest information on MSS 3RK3 (e.g. FAQ), see the Internet 
(http://support.automation.siemens.com/WW/view/en/4000024). 

 

 

http://www.siemens.com/industrial-controls/manuals�
http://support.automation.siemens.com/WW/view/en/4000024�
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1.7 Evaluation of safety functions 

Safety Evaluation Tool 
The Safety Evaluation Tool from Siemens for EN 62061 and EN ISO 13849-1 supports you 
in evaluating the safety functions of your machine. The TÜV-tested online tool guides you 
step by step, from specifying the structure of the safety system and selecting the 
components to determining the achieved safety integrity (SIL /PL). The final result is a report 
in conformance with the standards that you can integrate as proof of safety into the 
documentation. 

Safety Integrated 
The Safety Evaluation Tool is part of Safety Integrated, the intelligent safety solution from 
Siemens featuring a complete product line. Our certified safety technology complies with all 
relevant standards and is already contained in the Safety Evaluation Tool.  

Reference 
The free Safety Evaluation Tool can be found at: 

http://www.siemens.com/safety-evaluation-tool/ 

For more information on how to increase safety and productivity, go to: 

www.siemens.com/safety-integrated 

1.8 User responsibility for system design and function 
   

The products described here were developed to perform safety-related functions as part of 
an overall installation or machine.  

A complete, safety-related system is generally equipped with sensors, evaluation units, and 
signaling units, and uses reliable shutdown concepts.  

It is the responsibility of the manufacturer to ensure that the system or machine is functioning 
properly as a whole. 

Siemens AG, its regional offices, and associated companies (hereinafter referred to as 
"Siemens") cannot guarantee all the properties of a whole installation or machine that has 
not been designed by Siemens. 

Nor can Siemens assume liability for recommendations that appear or are implied in the 
following description. No new guarantee, warranty, or liability claims beyond the scope of the 
Siemens general terms of supply are to be derived or inferred from the following description. 

http://www.siemens.com/safety-evaluation-tool/
http://www.siemens.com/safety-integrated
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1.9 Definitions 
"MSS 3RK3" always refers to all versions of the 3RK3 Modular Safety System.  

1.10 Correction sheet 
The appendix to this manual contains a correction sheet for evaluation and feedback. Please 
use it to record your suggestions for improvements, additions and corrections, and return the 
sheet to us. This will help us to improve the next edition of the manual. 
Thank you. 
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Product-specific information 2
2.1 General safety notes 
 

 Note 
SIL 3 as per EN 61508 
PL e as per EN ISO 13849-1    

The design of the 3RK3 modular safety system allows implementation of applications up to 
SIL 3 as per EN 61508 and PL e as per EN ISO 13849-1. 

 

CAUTION  
Protection against electrostatic charge 

When handling and installing the MSS components, ensure that the components are 
protected from being electrostatically charged. Changes to the system configuration and 
wiring are only permissible while the supply voltage is switched off. 
The connection of MSS 3RK3 central units is only permissible when the power sections 
(PELV and SELV) are switched off. 

 

WARNING  
Hazardous voltage 
Will Cause Death, Serious Injury or Property Damage 
Installing devices in control cabinets 

Taking the ambient conditions into account, you must install the devices in control cabinets 
with the IP32, IP43 or IP54 degree of protection. 

 

CAUTION  
Noise immunity/grounding 

The following must be grounded in accordance with the regulations in order to ensure noise 
immunity of the MSS components: 
• MSS components 
• PELV / SELV power supply units (also note the documentation for the respective power 

supply unit in this regard). 

The PROFIBUS must be grounded in accordance with the installation guidelines for 
PROFIBUS networks (see the PROFIBUS manual). 
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NOTICE  
Operational faults and malfunctions in communication 

If the EMC Directive 2004/108/EC is not complied with when plants and devices are 
installed, communication breaks may occur.  

 

 Note 

Cover all unused system interfaces. 
 

2.2 Safety information for hazardous areas 
 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 
Installation of the MSS 3RK3 in hazardous areas 

The components of the MSS 3RK3 are not suitable for the installation in hazardous areas. 
Please contact your explosion hazard specialist. 
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2.3 Guidelines for inductive loads 
 

CAUTION  
The outputs of the MSS 3RK3 do not feature internal inductive interference protection. If 
inductive loads are operated at the solid-state or relay outputs of the MSS 3RK3, they must 
be provided with inductive interference protection.   

 

Inductive loads must be provided with protective circuits that limit the voltage rise when the 
controller output is switched off. Protective circuits protect the outputs against premature 
failure due to high inductive switched currents. They also limit the electrical faults that can 
occur when inductive loads are connected. 

 

 Note 

The effectiveness of a protective circuit depends on the respective application and must 
always be checked on a case-by-case basis. The components in a protective circuit must 
always be rated in line with the relevant application. 
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Protective circuit for outputs that switch inductive loads 
 

WARNING  
Note that the system response time is made longer by the protective circuit. 

 

 

 
The diagrams show examples of protective 
circuits for inductive loads. You will find details of 
protective circuits from SIEMENS in the catalog 
and the relevant documentation. 

Example: 
Protective circuit for an inductive load 
 

 
  

 

 
 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 

If you switch inductive loads with relay outputs of the MSS 3RK3, the external protective 
circuit must be installed parallel with the load. Connection in parallel with the relay contacts 
can prevent shutdown of the machine or process. 
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2.4 Intended use 
 

WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 
Safe state (safety concept) 

The basis of the safety concept is that a safe state exists for all process variables. In the 
case of the MSS 3RK3 modular safety system, this is the value "0". This applies to sensors 
and actuators. 

Note that the use of inverting functions either in the logic diagram or in the wiring outside 
the system may prevent the safe state from being reached. 

 

WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 
Conduct a functional test of the system 

To ensure the safety of the system, any changes to it or any replacement of defective 
components must be followed by a thorough and successfully completed function test of 
the system. 

 

WARNING  
Hazardous voltage 
Will Cause Death, Serious Injury or Property Damage 
Test interval for safe AS-i input slaves 

The calculated failure probabilities for safe transmission of AS-i input slaves is based on an 
actuation interval of one year. 

For this reason, all sensors that are recorded using safety-related AS-i input slaves must be 
actuated at least once every 12 months in order to test their function.  

If the mechanism of the safety-related AS-i input slaves is used for direct data exchange, a 
corresponding signal change must also take place here at least once every 12 months, 
same as for the safety-related AS-i input slaves. 
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WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 
Proper use of hardware products 

This equipment is only allowed to be used for the applications described in the catalog and 
in the technical description, and only in conjunction with non-Siemens equipment and 
components recommended by Siemens. 

Correct transport, storage, installation and assembly, as well as careful operation and 
maintenance, are required to ensure that the product operates safely and without faults. 

Before you run any sample programs or programs you have written yourself, make sure 
that running the plant cannot cause injury to anyone else or damage to the machine itself. 

EU note regarding machine safety: Commissioning is absolutely prohibited until it has been 
ensured that the machine in which the component described here is to be installed 
complies with the stipulations of the Directive 2006/42/EC. 

 

WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 
Proper use of software products 

The software may be used only for the applications described in the catalog or the technical 
description, and only in combination with the software products, components and devices of 
other manufacturers where recommended or permitted by Siemens. 

Before you run any sample programs or programs you have written yourself, make sure 
that running the plant cannot cause injury to anyone else or damage to the machine itself.  
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2.5 Current information about operational safety 

Important note for maintaining operational safety of your system  
 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 
Please take note of our latest information   

Systems with safety-related characteristics are subject to special operational safety 
requirements on the part of the operator. The supplier is also obliged to comply with special 
product monitoring measures. For this reason, we publish a special newsletter containing 
information on product developments and features that are (or could be) relevant to 
operation of safety-related systems. By subscribing to the appropriate newsletter, you will 
ensure that you are always up-to-date and able to make changes to your system, when 
necessary: 

SIEMENS newsletter (www.siemens.com/industrial-controls/newsletter)  

Sign on to the following newsletter under "Products & Solutions": 
• Control Components and System Engineering News 
• Safety Integrated Newsletter 

 

 

http://www.siemens.com/industrial-controls/newsletter�


Product-specific information  
2.5 Current information about operational safety 

 Modular Safety System 3RK3 

28 System Manual, 06/2012, 9262530-02 Rev 004 



 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 29 

Overview 3
 

The 3RK3 Modular Safety System is a modular safety relay. Depending on the version of the 
external wiring with sensors and actuators, applications can be implemented up to SIL3 as 
per EN 61508 or PL e as per EN ISO 13849-1.    

Application areas and use   
● The MSS 3RK3 can be implemented in any protective application with three or more 

safety functions. 

● The modular safety relay enables you to interconnect several safety applications with 
each other. In this way, you can set shutdown ranges, for example, and define other 
dependencies. 

● With suitable safety-related expansion modules, you can adapt the system flexibly to the 
required safety application. 

● With extensive fault diagnostic features and the provision of status information, faults can 
be quickly located and the commissioning and down times of the system reduced. 

● Test operation for support during commissioning. Hier signals can be forced to test the 
logic processing or system sections already installed. That means that the signals in the 
logic can be set to 1 or 0, irrespective of the real signal. 

● Fault diagnostics and status information can be transferred to higher-level bus systems 
(e.g., PROFIBUS DP) through an optional interface module. 

● The 3RK3 central units with AS-i interface also perform the functions of an AS-i safety 
monitor. These central units can read in safety-related, standard, AB, and CTT3 data on 
the AS-i bus, control safe outputs on the AS-i bus, and simulate safety-related standard 
and AB slaves. Diagnostics of the system is possible through the AS-i using the CTT2 
protocol. 

System components   
The MSS 3RK3 consists of the following system components: 

● Central unit 

● Expansion modules 

● Interface module 

● Diagnostics display 

● Parameterization software 

● Accessories 
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3.1 A typical system configuration of the MSS 3RK3 main system 
The following diagram shows a typical configuration of the MSS 3RK3 main system with the 
maximum cable lengths between individual modules. The system consists of a central unit, a 
number of expansion modules, an interface module, and a diagnostics display.    

SIRIUS 3RK3
DEVICE

BF

SF

 
① Diagnostics display  
② Interface module  
③ Central unit 
④ ... ⑫ Expansion modules:  

• 0 for MSS 3RK3 ASIsafe basic 
• Maximum of 2 for MSS 3RK3 ASIsafe extended 
• Maximum of 7 for MSS 3RK3 Basic 
• Maximum of 9 for MSS 3RK3 Advanced 

⑬ Memory module 

Figure 3-1 A typical system configuration of the MSS 3RK3 main system 
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3.2 A typical configuration of the subsystem with AS-Interface 
The following central units can be integrated on the AS-i bus: 

● MSS 3RK3 Advanced 

● MSS 3RK3 ASIsafe basic 

● MSS 3RK3 ASIsafe extended 

In doing so the 3RK3 central unit can perform various functions: 

● Monitoring of AS-i slaves 

● Simulation of AS-i slaves 

● Safety-related data exchange with other safety monitors (e.g., with further MSS 3RK3 
units with AS-i interface) 

 

 Note 
MSS 3RK3 bus load 

The MSS 3RK3 is always a bus load from an A/B slave on the AS-i bus. This bus load does 
not depend on how many slaves are simulated by the 3RK3 central unit or whether only AS-i 
slaves are monitored. 

 

Some typical applications of the MSS 3RK3 with AS-i interface are described below. These 
examples are all represented with a 3RK3 Advanced central unit.. However, they apply 
equally to all other central units with AS-i interface. However, you must note the limitations 
on the number of expansion modules. 
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Integration of the MSS 3RK3 Advanced as an AS-i monitor on an AS-i bus   
The MSS 3RK3 Advanced monitors the various safety-related and non-safety-related AS-i 
slaves as a safety monitor and exchanges up to 12 safety-related signals bidirectionally with 
an AS-i safety monitor.  

Moreover, the MSS 3RK3 Advanced can mutually independently control up to 12 safety-
related AS-i outputs (with up to 4 outputs). 

1 2 3

111096

4

7 8

5

 
 PROFIBUS 
 AS-Interface   
 ASIsafe 

① CPU / PLC (optional) 
② MSS 3RK3 Advanced (The DP interface is optional.) 
③ AS-i safety monitor 
④ AS-i master 
⑤ Data exchange with other safety monitors or MSS 3RK3 units with AS-i interface 
⑥ AS-i power section 
⑦ ... ⑪ Safety-related and non-safety-related AS-i slaves 

Figure 3-2 A typical system configuration with MSS 3RK3 Advanced as the safety monitor 
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Integration of the MSS 3RK3 Advanced into a higher-level, fail-safe control 
The MSS 3RK3 Advanced monitors the various safety-related and non-safety-related AS-i 
slaves as a safety monitor and exchanges up to 12 safety-related signals bidirectionally with 
an AS-i safety monitor.  

Moreover, the MSS 3RK3 Advanced can mutually independently control up to 12 safety-
related AS-i outputs (with up to 4 outputs). 

Up to 12 safety-related signals can be transmitted by the MSS 3RK3 Advanced to an F-PLC 
over the F-Link.  

3

2

4

6

1

5

1211107 8 9  
 AS-Interface 
 PROFIBUS with PROFIsafe 
 ASIsafe 

① F-PLC (optional) 
② DP / AS-i F-Link 
③ MSS 3RK3 Advanced (The DP interface is optional) 
④ AS-i safety monitor 
⑤ Unidirectional data exchange between MSS 3RK3 Advanced and the F-Link 
⑥ Data exchange between MSS 3RK3 Advanced and a safety monitor 
⑦ AS-i power section 
⑧ ... ⑫ Safety-related and non-safety-related AS-i slaves 

Figure 3-3 A typical system configuration with MSS 3RK3 Advanced on an F-PLC 
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3.3 System components 

Central units    
For each system configuration, you require a 3RK3 central unit that you select appropriately 
for the specific application (e.g., 3RK3 Basic). For executing the safety functions, the 3RK3 
central unit contains the parameterization data in a plug-in memory module. You can 
optionally connect the expansion modules and the interface module or the diagnostic display 
to the 3RK3 central unit. 

The following table lists the properties of the 3RK3 central units: 

 
Central unit Inputs / outputs Maximum number of 

expansion modules 
3RK3 Basic 
Central unit with safety-related inputs 
and outputs 

8 fail-safe digital inputs 
1 two-channel fail-safe relay output 
1 two-channel fail-safe digital output 

7 

3RK3 Advanced 
Central unit with safety-related inputs 
and outputs; 
AS-i connection; 
Monitor functionality; 
Simulation of AS-i slaves 

8 fail-safe digital inputs 
1 two-channel fail-safe relay output 
1 two-channel fail-safe digital output 
Connection for AS-i bus 

9 

3RK3 ASIsafe basic 
Central unit with safety-related inputs 
and outputs; 
AS-i connection; 
Monitor functionality; 
Simulation of AS-i slaves 

2 fail-safe digital inputs 
6 digital standard inputs  
1 two-channel fail-safe relay output 
1 two-channel fail-safe digital output 
Connection for AS-i bus 

0 

3RK3 ASIsafe extended 
Central unit with safety-related inputs 
and outputs; 
AS-i connection; 
Monitor functionality; 
Simulation of AS-i slaves 

4 fail-safe digital inputs 
4 digital standard inputs 
1 two-channel fail-safe relay output 
1 two-channel fail-safe digital output 
Connection for AS-i bus 

2 
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Expansion modules   
You need expansion modules to adapt the MSS 3RK3 to the required application. You 
thereby supplement the 3RK3 central unit with additional safety-related inputs and outputs. 

The following table lists the expansion modules and their properties: 

 
Expansion module Description Inputs / outputs 
4/8F-DI Safety-related input module 8 fail-safe digital inputs 
2/4F-DI 1/2F-RO Safety-related mixed expansion module 4 fail-safe digital inputs 

2 single-channel, fail-safe relay outputs 
2/4F-DI 2F-DO Safety-related mixed expansion module 4 fail-safe digital inputs 

2 two-channel, fail-safe semiconductor outputs 
4F-DO Safety-related output module 4 fail-safe two-channel semiconductor outputs 
4/8F-RO Safety-related output module 8 fail-safe, single-channel relay outputs 
8DI Standard input module 8 digital standard inputs 
8 DO Standard output module 8 digital standard outputs 

Interface modules    
You need interface modules for exchanging data between the MSS 3RK3 and higher-level 
bus systems (e.g., PROFIBUS DP).  

The DP interface has the following characteristics: 

● The DP interface constitutes the interface between the MSS 3RK3 and an automation 
system over PROFIBUS DP. 

● The interface module is connected to the 3RK3 central unit. 

● A diagnostics display or a PC or programming device can be connected to the interface 
module. 

Diagnostics display   
With the diagnostics display, you can monitor and analyze the diagnostics and status data of 
the MSS 3RK3 and acknowledge errors locally or from a central location. 

The diagnostics display has the following characteristics: 

● The diagnostics display shows fault diagnostics and diagnostics information as plaintext 
on its display. 

● The diagnostics display is intended to be installed in a control panel / control cabinet door 
and is connected to the 3RK3 central unit or, if there is one, to the interface module. 

● If required, a PC or programming device can be connected to the diagnostics display. 
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Parameterization software   
The MSS ES parameterization software is available in three license variants: 

● Basic 

● Standard 

● Premium 

The MSS ES parameterization software provides a graphical editor (logic diagram) for 
entering, displaying, and performing diagnostics on the interconnection logic. 

The MSS ES parameterization software provides the following functionalities:   

● You use the logic diagram to parameterize the safety functions for the MSS 3RK3. 

● The MSS 3RK3 is accessed for parameterization and diagnostics over a PC cable or by 
means of PROFIBUS-DP and DP interface (optional). 

● You can also upload an existing configuration from the 3RK3 central unit to the PC or 
programming device. 

● The diagnostics functionality of the software enables you to diagnose the MSS 3RK3 
online. 

● You can force outputs when commissioning the MSS 3RK3.  

Accessories   
You require the following accessories when using the modules: 

 
Component Description Diagram 
Connection cables • Ribbon cable for data connection of system 

components via the system interfaces 
• Mechanically-coded and color-coded protection 

against reverse polarity 
• 0.025 m ("adjacent") 
• Order no. 3UF7930-0AA00-0 

 

Connection cable to the 
diagnostics display 

• Ribbon cable for the data connection from the 3RK3 
central unit to the diagnostic display 

• Mechanically-coded and color-coded protection 
against reverse polarity 

• Max. 2.5 m 
• Order numbers: 

– 3UF7931-0AA00-0: 0.1 m, (flat) 
– 3UF7935-0AA00-0: 0.3 m, (flat) 
– 3UF7932-0AA00-0: 0.5 m, (flat) 
– 3UF7932-0BA00-0: 0.5 m, (round) 
– 3UF7937-0BA00-0: 1 m, (round) 
– 3UF7933-0BA00-0: 2.5 m, (round) 

Flat: 

 
Round: 
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Component Description Diagram 

• Connection cable for exchanging data between the 
PC or programming device and the 3RK3 central 
unit. 
The connection cable connects the interface of the 
PC/programming device to the system interface of 
the 3RK3 central unit. 
– COM port 

Order no. 3UF7940-0AA00-0, product version 2 
– USB port 

Order no. 3UF7941-0AA00-0 

PC cable and adapter 

• USB-to-serial adapter for connection of an RS 232 
PC cable to the USB interface of a PC, 
recommended for use in conjunction with 3RK3 

• Order no. 3UF7946-0AA00-0 

 
 

Memory module   • External memory module of the 3RK3 central unit 
for storing configuration data 

• The slot for the memory module is located on the 
underside of the 3RK3 central unit 

• Order no. 3RK3931-0AA00 
Note: One memory module each is included in the 
scope of supply of the 3RK3 central unit. 

 

System interfaces 
cover 

• Cover for free system interfaces as protection 
against contamination and for compliance with EMC 
regulations 

• Order no. 3UF7950-0AA00-0 
 

Door adapter • for bringing out the system interface, e.g., out of a 
cabinet 

• Order no. 3UF7920-0AA00-0  
Fixing lugs • Fixing lugs for installing the device on a level 

surface, 2 required per device 
• Order no. 3RP1903  
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3.4 Overview of the device functions 
The following tables provide an overview of the features and the functions of the various 
3RK3 central units. Basically, the 3RK3 central units are suitable for applications with at least 
3 safety-related functions. 

 
MSS 3RK3 Features of the 3RK3 central units 

Basic Advanced 
 

ASIsafe basic ASIsafe 
extended 

General characteristics 
Certified acc. to  
• SIL 3 as per EN 61508 
• PL e as per EN ISO 13849-1 

✓ ✓ ✓ ✓ 

Modularity / expansion capability with expansion 
modules 

✓ 
(max. 7 EM) 

✓ 
(max. 9 EM) 

- ✓ 
(max. 2 EM) 

Very simple parameterization with extensive MSS 
ES parameterization software 

✓ ✓ ✓ ✓ 

Low wiring effort and high connection depth using 
function combinations in the software 

✓ ✓ ✓ ✓ 

Safety-related, freely parameterizable sensor 
inputs 

8 8 2 4 

Digital standard inputs - - 6 4 
Safety-related redundant relay output 1 1 1 1 
Safety-related redundant solid-state output 1 1 1 1 
Support with commissioning by forcing ✓ ✓ ✓ ✓ 
Communication 
Data exchange over PROFIBUS with optional DP 
interface module 

✓ ✓ ✓ ✓ 

Integration into the automation environment 
through a GSD to each PROFIBUS-DP master 
irrespective of the programmable controller 

✓ ✓ ✓ ✓ 

Access with MSS ES 
Configuration and diagnostics through the device 
interface 

✓ ✓ ✓ ✓ 

Configuration and diagnostics over PROFIBUS ✓ ✓ ✓ ✓ 
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MSS 3RK3 Features of the 3RK3 central units 

Basic Advanced 
 

ASIsafe basic ASIsafe 
extended 

AS-i functionality 

• Simulation of non-safety-related AS-i slaves - ✓ ✓ ✓ 

• Simulation of safety-related AS-i input slaves - ✓ ✓ ✓ 

• Control of safety-related AS-i outputs - ✓ ✓ ✓ 

• Representation of safety-related AS-i outputs - ✓ ✓ ✓ 

• Monitoring of non-safety-related AS-i slaves - ✓ ✓ ✓ 

• Monitoring of safety-related AS-i input slaves - ✓ ✓ ✓ 

Diagnostics 
Diagnostics using LEDs  ✓ ✓ ✓ ✓ 
Diagnostics using MSS ES ✓ ✓ ✓ ✓ 
Diagnostics using PROFIBUS ✓ ✓ ✓ ✓ 
Diagnosis using AS-Interface (CTT2 protocol) - ✓ ✓ ✓ 
Diagnostics using the diagnostics display ✓1) ✓2) ✓2) ✓2) 

1)  Product version E01 and higher of the diagnostics display 
2) Product version E03 or FW version V1.1.x and higher of the diagnostics display 
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MSS 3RK3 Function elements in the logic diagram 

Basic Advanced ASIsafe 
basic 

ASIsafe 
extended 

Cell functions 

• Input cell ✓ ✓ ✓ ✓ 

• Output cell ✓ ✓ ✓ ✓ 

Monitoring functions 

• Monitoring Universal - ✓ ✓ ✓ 

• EMERGENCY STOP ✓ ✓ ✓ ✓ 

• ESPE (electro-sensitive protective equipment) ✓ ✓ ✓ ✓ 

• Safety shutdown mat (NC principle) ✓ ✓ ✓ ✓ 

• Safety shutdown mat (cross-circuit principle) ✓ ✓ ✓ ✓ 

• Protective door ✓ ✓ ✓ ✓ 

• Protective door with lock - ✓ ✓ ✓ 

• Enabling button ✓ ✓ ✓ ✓ 

• Two-hand operation ✓ ✓ ✓ ✓ 

• Mode selector switch ✓ ✓ ✓ ✓ 

• AS-i 2F-DI (safety-related AS-i input) - ✓ ✓ ✓ 

Muting functions 

• Muting (2-sensor-parallel) - ✓ ✓ ✓ 

• Muting (4-sensor-parallel) - ✓ ✓ ✓ 

• Muting (4-sensor-sequential) - ✓ ✓ ✓ 

Status functions 

• Device status ✓ ✓ ✓ ✓ 

• Element status - ✓ ✓ ✓ 

Control functions 

• Device command ✓ ✓ ✓ ✓ 

Logic functions 

• AND ✓ ✓ ✓ ✓ 

• OR ✓ ✓ ✓ ✓ 

• XOR ✓ ✓ ✓ ✓ 

• NAND ✓ ✓ ✓ ✓ 

• NOR ✓ ✓ ✓ ✓ 

• NEGATION (NEG) ✓ ✓ ✓ ✓ 

Flip-flop 

• FF-SR ✓ ✓ ✓ ✓ 
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MSS 3RK3 Function elements in the logic diagram 

Basic Advanced ASIsafe 
basic 

ASIsafe 
extended 

Counter functions 

• Counter (0 -> 1) ✓ ✓ ✓ ✓ 

• Counter (1 -> 0) ✓ ✓ ✓ ✓ 

• Counter (0 -> 1 / 1 -> 0) ✓ ✓ ✓ ✓ 

Timer functions 

• With ON delay ✓ ✓ ✓ ✓ 

• With ON delay (trigger) ✓ ✓ ✓ ✓ 

• Passing make contact ✓ ✓ ✓ ✓ 

• Passing make contact (trigger) ✓ ✓ ✓ ✓ 

• With OFF delay ✓ ✓ ✓ ✓ 

• With OFF delay (trigger) ✓ ✓ ✓ ✓ 

• Clocking ✓ ✓ ✓ ✓ 

Start functions 

• Monitored start ✓ ✓ ✓ ✓ 

• Manual start ✓ ✓ ✓ ✓ 

Output functions 

• Standard output ✓ ✓ ✓ ✓ 

• F output ✓ ✓ ✓ ✓ 

• AS-i 1..4F-DO - ✓ ✓ ✓ 
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Getting started with MSS 3RK3 Basic 4
4.1 Introduction 

This chapter provides a step-by-step guide to commissioning a Modular Safety System 
3RK3 (MSS 3RK3) using an example demonstrating how to protect a metalworking press.   

The essential steps for commissioning the MSS 3RK3 are as follows:   

1. Installation 

2. Wiring 

3. Configuring 

4. Function test 

4.2 Hardware and software requirements 
To commission the MSS 3RK3 in this example, you will need the following hardware and 
software components: 

 
Number Device Order No. 
1 3RK3 Basic central unit 3RK3111-1AA10 
1 Expansion module 2/4 F-DI 2 F-DO 3RK3231-1AA10 
1 24V PELV power supply unit 6ES73071EA00-0AA0  
1 Light curtain (ESPE) - 
1 Pushbutton (NO contact) 3SB3801-0DD3 
1 EMERGENCY STOP control device 3SB3801-0EG3 
1 Two-hand operator panel 3SB3863-4BB 
2 Contactors 3RT1015-1BB42 
1 0.025 m connection cable 3UF7930-0AA0-0 
1 PC cable 3UF7940-0AA00-0, product version 2 
1 MSS ES 2008 (software) 3ZS1314-5CC10-0YA5 

To configure the modules, you need a programming device or PC with MS Windows XP 
Professional SP2/SP3 or MS Windows 7 Ultimate/Professional/Enterprise 32-bit operating 
system (SP3 and higher: 64-bit). You will find additional information in the attached 
README file of the software. 
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4.3 Task and structure of the example 

Protecting a metalworking press 
● The hazardous area is protected by permanent isolating protective equipment. 

● The insertion point is additionally protected by electrosensitive protective equipment 
(ESPE). 

● The working stroke of the press is triggered with a two-hand operator panel. If the zone 
protected by the electrosensitive protective equipment is entered during operation, or if 
the EMERGENCY STOP is activated, the press drive is immediately switched off (stop 
category 0). 

● The press starts once the protective zone of the ESPE has been enabled and the two-
hand operator panel has been actuated. 

  Note 

To enable switch-on by two-hand operation, the start pushbutton must be pressed after 
unlocking the pressed EMERGENCY STOP. 

 
① Start pushbutton 
② Two-hand operator panel 
③ EMERGENCY STOP control device  
④ Light curtain (ESPE) 

Figure 4-1 Typical system configuration 
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4.4 Installation of the MSS 3RK3 Basic 

Installation   
 
Step Activity 
1 Hang the device on the mounting rail or screw it onto a level surface using the fixing lugs. 
2 Establish a connection between the 3RK3 Basic central unit (interface X2) and the 

expansion module (interface X1) by means of a connection cable (0.025 m). 

 

 
Figure 4-2 MSS 3RK3 configuration 
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4.5 Wiring of the MSS 3RK3 Basic 

Wiring     
 

NOTICE  
All components, including the light curtain, must be operated on the same power supply.   

 

 
Step Action Result 

1 Connect the 3RK3 Basic central unit to the 
power supply with: 
• + 24 V to terminal L+ 
• Ground to terminal M 
• Ground to terminal FE  

(see Chapter "Grounding (Page 141)") 

The 3RK3 Basic central unit is supplied with power. 

2 Connect the expansion module 2/4 F-DI 
2F-DO to the power supply with: 
• + 24 V to terminal L+ 
• Ground to terminal M 

The expansion module 2/4 F-DI 2F-DO is supplied with power. 

3 Connect the light curtain to the power 
supply. 
Note: 
Please refer here to the operating 
instructions for the light curtain. 

The light curtain is supplied with power. 

4 Connect the EMERGENCY STOP control 
device to the 3RK3 Basic central unit, with:
• NC 1: Terminal T1/IN3 
• NC 2: Terminal T2/IN4 
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Step Action Result 
5 Connect the light curtain to the 3RK3 

Basic central unit, with 
• Output 1 of the light curtain: Terminal 

IN1 
• Output 2 of the light curtain: Terminal 

IN2 
Note: 
Please refer here to the operating 
instructions for the light curtain. 

 
6 Connect the two-hand operator panel to 

the 3RK3 Basic central unit, with: 
• NC pushbutton 1: Terminal T2/IN6 

NO pushbutton 1: Terminal T1/IN5 
• NC pushbutton 2: Terminal T2/IN8 

NO pushbutton 2: Terminal T1/IN7 

 
7 Connect the Start pushbutton on the 

expansion module 2/4 F-DI 2F-DO, with: 
• NO contact: Terminal T1/IN1 
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Step Action Result 
8 Connect the contactors QA and QB on the 

expansion module 2/4 F-DI 2F-DO, with: 
• Contactor / coil QA: Terminal Q1 
• Contactor / coil QB: Terminal Q2 

 
9 Connect the feedback circuit of the 

contactors QA and QB on the expansion 
module 2/4 F-DI 2F-DO, with: 
• Contactor / NC QA / QB: Terminal IN3 
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4.6 Configuration of the MSS 3RK3 Basic 

Configuration   
 
Step Activity Result 

1 Switch on your PC/PG. Install the MSS ES 
software. Administrator rights are required 
here. 
For additional information, see Chapter 
"Description of the software (Page 143)" 

The MSS ES software is installed on your computer. 

2 Start the MSS ES software and choose 
"Switching device" > "New..." >"Safety relays" 
> "SIRIUS Modular Safety System 3RK3". 

The MSS ES software opens. 

3 Connect the 3RK3 Basic central unit to your 
PC / PG using the PC cable. 

The MSS 3RK3 is connected to the PC / PG. 

4 On the left of the navigation window, select 
the "Identification" directory and then the 
"Project" subdirectory. 

5 Make entries in the following lines of the work 
space: 
• Project name 
• Name of configuration engineer 
• Configuration engineer's company name 

 

6 On the left of the navigation window, select 
the "Configuration" directory and then the 
"Main system" subdirectory. 

7 Drag the 3RK3 Basic central unit from the 
catalog window to the first green-illuminated 
row in the work space for the hardware 
configuration. 

 

8 Drag the 2/4 F-DI 2F-DO expansion module 
from the catalog window to the next empty 
row (under the 3RK3 central unit added in 
Step 7) in the work space for the hardware 
configuration. 

 
9 On the left of the navigation window, select 

the "Logic" directory and then the "Diagram 1" 
subdirectory. 
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4.7 Creating the safety program 

Parameter assignment   
 
Step Activity Result 

1 • Drag the "ESPE" element from the 
"Monitoring functions" folder to the work 
space. 

 
2 • Open the "Properties - ESPE" dialog box 

by double-clicking the block. 
• Select the following in the "Parameter > 

Input" directory: 
– The "Type" parameter, and define this 

as "2-channel (NCNC)". 
– The "IN1" parameter, and connect this 

to "SLOT3_F-IN1". 
– The "IN2" parameter is automatically 

set to "SLOT3_F-IN2". 
• Close the window by clicking "OK".  

3 • Drag the "EMERGENCY STOP" element 
from the "Monitoring functions" folder into 
the work space. 

• Open the "Properties - EMERGENCY 
STOP" dialog box by double-clicking the 
block. 

• Select the following in the "Parameter > 
Input" directory: 
– The "Type" parameter, and define this 

as "2-channel (NCNC)". 
– The "IN1" parameter, and connect this 

to "SLOT3_F-IN3". 
– The "IN2" parameter is automatically 

set to "SLOT3_F-IN4". 
– Activate cross-circuit detection. 

• Select the following in the "Parameter > 
Start" directory: 
– The "Type of start" parameter, and 

define this as "Monitored". 
• Close the window by clicking "OK". 
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Step Activity Result 
4 • Drag the "Input cell" element from the "Cell 

functions" folder into the work space. This 
cell function is required for acknowledging 
the EMERGENCY STOP control device. 

• Open the "Properties - Input cell" dialog 
box by double-clicking the block. 

• Select the following in the "Parameter" 
directory: 
– The "Connection - input" parameter, 

and connect this to "SLOT4_F-IN1". 
• Close the window by clicking "OK". 

 

5 • Drag the "Two-hand operation" element 
from the "Monitoring functions" folder into 
the work space. 

• Open the "Properties - Two-hand 
operation" dialog box by double-clicking the 
block. 

• Select the following in the "Parameter > 
Input" directory: 
– The "Type" parameter, and define this 

as "4-channel (NONCNONC)". 
– The "IN1" parameter, and connect this 

to "SLOT3_F-IN5". 
– The "IN2" parameter is automatically 

set to "SLOT3_F-IN6". 
– The "IN3" parameter, and connect this 

to "SLOT3_F-IN7". 
– The "IN4" parameter is automatically 

set to "SLOT3F-IN8". 
– Activate cross-circuit detection 

• Close the window by clicking "OK". 
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Step Activity Result 
6 • Drag the "F output" element from the 

"Output functions" > "Switching output" 
folder to the work space. 

• Open the "Properties - F output" dialog box 
by double-clicking the block. 

• Select the following in the directory 
"Parameter" > "Type of output: Redundant 
F output". 

• Select the following in the "Parameter" > 
"Feedback circuit" directory: 
– The "Monitoring" parameter, and define 

this as "To OFF and ON status". 
• Select the following in the "Parameter" > 

"Output circuit" directory: 
– The "Q1" parameter, and connect this 

to "SLOT4-F-Q1". 
– The "Q2" parameter, and connect this 

to "SLOT4-F-Q2". 
• Close the window by clicking "OK". 

 
 

7 • Drag the "Input cell" element from the "Cell 
functions" folder into the work space. This 
cell function is required for monitoring the 
feedback circuit. 

• Open the "Properties - Input cell" dialog 
box by double-clicking the block. 

• Select the following in the "Parameter" 
directory: 
– The "Connection - input" parameter, 

and apply this to "SLOT4_F-IN3". 
• Close the window by clicking "OK". 
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Step Activity Result 
8 • Drag the "AND" element from the "Logic 

operations" folder into the work space. 
• Open the "Properties - AND" dialog box by 

double-clicking the block. 
• Select the following in the "Parameter" 

directory: 
– The "Number of logic inputs" 

parameter, and define this as "3". 
• Close the window by clicking "OK". 

 

9 • Connect outputs "Q" of the monitoring 
functions with inputs "IN" of the AND 
function element by drag and drop. 

• Connect the output "Q" of the AND function 
with the input "IN" of the F output. 

• Connect the output of the input cell 
"SLOT4_F-IN3" with the input 
"FEEDBACK" (feedback circuit) of the F 
output. 

• Connect the output of the input cell 
"SLOT4_F-IN1" with the input "Start" of the 
EMERGENCY STOP monitoring function. 

10 For a clearer display, choose "Edit" > "Realign 
graphic".  
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4.8 Function test of the MSS 3RK3 Basic 

Download to 3RK3 Basic central unit   
 
Step Action Result 
1 Switch on the power supply. The safety relay executes a self-test. 
2 Choose "Edit" > "Check consistency". If no message is displayed in the output window, the 

test was successful. 
3 Choose "Target system" > "Load to switching device" 

and confirm the memory dialog with "Yes". 
The "Save switching device as" dialog box opens.  

4 Save the project. The "Load to switching device" dialog box opens. 
5 Set the interface via which you have access to the 

device (e.g., COM1) and confirm with "OK". 
The configuration data is now downloaded. A 
message is displayed on completion of the download. 

6 Confirm with "OK". You are now online in configuring mode. 
7 Choose "Target system" > "Test mode" and confirm 

the message "Activate test mode" with "Yes". 
The "Change password for test mode" dialog box 
opens. 

8 Assign a new password and confirm it. The default 
password is 0000. 

The MSS 3RK3 changes from configuring mode to 
test mode. 

Testing the functions 
The MSS 3RK3 can be switched to "test mode" so that the full function test can be 
conducted. Outputs of function elements can be forced in this operating mode.   

You can create printouts of the configuration to help you in the function test by choosing 
"Target system" > "Prepare configuration test". 

 
Step Action Result 
1 Check whether the EMERGENCY STOP has been 

unlocked and the protective field of the ESPE is free. 
- 

2 Press the Start button. - 
3 Press both buttons of the two-hand operator panel 

simultaneously. 
The contactors QA and QB pick up. 

4 Press EMERGENCY STOP. If the two-hand operator panel is pressed again, 
contactors QA and QB do not pick up. 

5 Unlock the EMERGENCY STOP and press the Start 
button. 

The "EMERGENCY STOP" function element is 
acknowledged. 

6 Place a suitable object in the protection zone of the 
ESPE. 

If the two-hand operator panel is pressed again while 
the light curtain is interrupted, contactors QA and QB 
do not pick up. 
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Configuration release    
 
Step Action Result 

1 Select the menu command "Target system" > "Go 
offline". 

The offline configuration is opened. 

2 Choose "Target system" > "Approve configuration". The "Approve configuration" dialog box is opened, 
thereby confirming that the configuration test has been 
performed properly. 

3 Set the interface via which you have access to the 
device (e.g., COM1) and confirm with "OK". 

The "Approve configuration" dialog box opens. 

4 Enter the name and approving company and confirm 
with "OK". 

The "Approve configuration" dialog box opens. The 
configuration has been successfully approved. 

5 Acknowledge the message with "OK". The printout of the release information is created. 

 
 

 Note 

If the report could not be printed when the project was released, e.g., because no printer was 
available, the printout must be created at the latest by the time of acceptance by selecting 
"Options" > "Release information...".    

 

Safety mode   
 
Step Action Result 
1 Establish an online connection with the MSS 3RK3 

using the "Switching device" > "Open online" or "Target 
system" > "Load to PC" menu command. 

The Set interface dialog box appears. 

2 Set the interface and confirm with "OK". The project opens online. 
3 Activate the menu command "Target system" > "Safety 

mode". 
The message "Activate safety mode" appears.  

4 Confirm with "Yes". The MSS 3RK3 switches to safety mode without 
password protection. 
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Description of the hardware 5
5.1 Description of the individual modules 

Which device is supported by which software version?   
 
Device MSS ES 2008 MSS ES 2008 SP1 MSS ES 2008 SP2 MSS ES 2008 SP3 
Central units 
Basic ✓ ✓ ✓ ✓ 
Advanced - - ✓ ✓ 
ASIsafe basic - - - ✓ 
ASIsafe extended - - - ✓ 
Interface modules 
DP interface ✓ ✓ ✓ ✓ 
Expansion modules 
4/8 F-DI ✓ ✓ ✓ ✓ 
2/4 F-DI 2 F-DO ✓ ✓ ✓ ✓ 
2/4 F-DI 1/2 F-RO ✓ ✓ ✓ ✓ 
8 DO ✓ ✓ ✓ ✓ 
4 F-DO - ✓ ✓ ✓ 
4/8 F-RO - ✓ ✓ ✓ 
8 DI - ✓ ✓ ✓ 
HMI modules 
Diagnostics display - - ✓1) ✓2) 

1)  Up to product version E02 or FW version V1.0.x 
2) Product version E03 or FW version V1.1.x and higher 

5.1.1 General information on 3RK3 central units 
The application for 3RK3 central units are safety-related control functions. A 3RK3 central 
unit is required for each system configuration. The 3RK3 central unit contains the configuring 
data in an external memory module, and it handles all control tasks.   
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5.1.2 3RK3 Basic central unit 

 
Figure 5-1 3RK3 Basic central unit 

Properties 
The 3RK3 Basic central unit is the basic component of an MSS 3RK3 configuration for 
safety-related control functions. It can be used up to SIL 3 as per EN 61508 and PL e as per 
EN ISO 13849-1.   

● Up to 7 expansion modules can be connected to the 3RK3 Basic central unit. 

● An additional interface module (e.g., DP interface) can be used to exchange process data 
with a PLC. Diagnostic data of the MSS 3RK3 are also transmitted to the PLC. 

● The 3RK3 Basic central unit can be parameterized using MSS ES. 

● Connection of the diagnostic display is possible as an option. 

Inputs and outputs 
The 3RK3 Basic central unit has the following inputs and outputs: 

● 8 safety-related, freely parameterizable sensor inputs 

● 1 safety-related redundant relay output 

● 1 safety-related, redundant, solid-state output 

 

 Note 
Safety-related outputs 

If you use the safety-related outputs with a two-channel shutdown, a fault exclusion, such as 
a short-circuit to P or M, is required. This condition is met within a control cabinet or when 
the connection cables are installed in such a way that they are protected. 
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Structure of the 3RK3 Basic central unit 
 

Front view No. Meaning 

① Removable terminal block D  

② Removable terminal block C 

③ Connection for expansion module (X2) 

④ RESET button 

⑤ Removable terminal block A 

⑥ Connection of a memory module (X3) 

⑦ Label 

⑧ Display LEDs 

24V
DC

3RK3111-1AA10

 

⑨ Connection of PC or programming 
device, interface module, diagnostics 
display (X1) 

 

 
Figure 5-2 MSS 3RK3 Basic internal circuit diagram 
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Terminal names of the 3RK3 Basic central unit 
 
Terminal Meaning Description 
T1 Test output for inputs IN1, 

IN3, IN5, IN7 
T2 Test output for inputs IN2, 

IN4, IN6, IN8 

Test outputs with different test signals 
Connection for sensor contacts for detecting cross-
circuits 

IN1 ... IN8 Safety-related sensor inputs Connection for safety sensors 
Combinations for two-channel connection method: 
IN1-IN2, IN3-IN4, IN5-IN6, IN7-IN8 

Q1.1, Q1.2 Safety-related relay output Isolated, redundant output for connecting actuators 
Q2 Safety-related solid-state 

output 
Redundant semiconductor output for connecting 
actuators 

L+ Power supply 24 V DC 
M Ground Ground to 24 V DC 
FE Functional ground Shielding, equipotential bonding 

Interfaces of the 3RK3 Basic central unit 
 
Interface Meaning Description 
X1 System interface Connection of PC or programming device, interface 

module, diagnostics display 
X2 Interface Interface for connecting expansion modules (e.g., I/O 

modules) 
X3 External memory module Slot for external memory module with parameterization 

data 
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Operator controls of the 3RK3 Basic central unit 
 
Element Meaning Description 
RESET 
button 

• Error acknowledgment 
• Factory setting 

• Confirm the acknowledgeable errors with this 
button. 

• Refer to Chapter "Restoring factory settings 
(Page 637)" 

Displays of the 3RK3 Basic central unit 
 
Element Meaning 
DEVICE Device status 
SF Group error 
IN1 ... IN8 Status of the sensor inputs 
Q1, Q2 Status of the safety-related outputs 

Connecting inputs and outputs 
You will find more information on connecting inputs and outputs in Chapter "Connecting / 
wiring (Page 117)." 
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5.1.2.1 Startup / self-test of the MSS 3RK3 Basic 
Once the power supply has been applied, the MSS 3RK3 runs a self-test. During the self-test 
phase, all the LEDs on the MSS 3RK3 central unit light up for two seconds (lamp test). Two-
color LEDs light up yellow. The 3RK3 Basic central unit then loads the configuration from the 
external memory module and checks whether a valid configuration or parameterization is 
stored and automatically switches to safety mode (DEVICE LED lights up green).  

Configuring mode 
The 3RK3 Basic central unit enters configuring mode (the DEVICE LED lights up yellow) 
when: 

● No configuration exists, 

● The TARGET configuration differs from the ACTUAL configuration (the SF LED lights up 
red) 

● The modules could not be parameterized (the SF LED lights up red) 

● The existing configuration has not been released. 

● The memory module is missing or defective. In this case, only diagnostics of the MSS 
3RK3 is possible (DEVICE LED flashes red, SF LED lights up red). 
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5.1.3 3RK3 Advanced central unit 

 
Figure 5-3 3RK3 Advanced central unit 

Properties 
The 3RK3 Advanced central unit is a basic component of an MSS 3RK3 configuration for 
safety-related control functions with use of AS-Interface. As an AS-i monitor, the 
3RK3 Advanced central unit can monitor sensor inputs in the lower fieldbus level and also 
shut down safety circuits through its outputs. It can be used up to SIL 3 as per EN 61508 and 
PL e as per EN ISO 13849-1.    

● Up to 9 expansion modules can be connected to the 3RK3 Advanced central unit. 

● An additional interface module (e.g., DP interface) can be used to exchange process data 
with a PLC. Diagnostic data of the MSS 3RK3 are also transmitted to the PLC. 

● Connection to AS-Interface for safety-related and non-safety-related data exchange. 

● The 3RK3 Advanced central unit can be parameterized using MSS ES. 
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Inputs and outputs 
The 3RK3 Advanced central unit has the following inputs and outputs: 

● 8 safety-related, freely parameterizable sensor inputs 

● 1 safety-related redundant relay output 

● 1 safety-related, redundant, solid-state output 

 

 Note 
Safety-related outputs 

If you use the safety-related outputs with a two-channel shutdown, a fault exclusion, such as 
a short-circuit to P or M, is required. This condition is met within a control cabinet or when 
the connection cables are installed in such a way that they are protected. 

 

 

MSS 3RK3 Advanced on the AS-i bus 
The MSS 3RK3 Advanced can perform various functions on the AS-i bus: 

● Simulation of up to 4 non-safety-related AS-i slaves 

● Simulation of up to 12 safety-related AS-i input slaves 

● Control of up to 12 safety-related AS-i outputs 

● Representation of of up to 31 safety-related AS-i outputs 

● Monitoring of up to 14 non-safety-related AS-i slaves 

● Monitoring of up to 31 safety-related AS-i input slaves 

You will find additional information in Chapter "Integrating the 3RK3 modular safety system 
into the AS-i bus (Page 452)." 
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Structure of the 3RK3 Advanced central unit 
 

Front view No. Meaning 

① Removable terminal block D 

② Removable terminal block C 

③ Connection for expansion module (X2) 

④ RESET button 

⑤ Removable terminal block A 

⑥ External memory module (X3) 

⑦ Label 

⑧ Display LEDs 

24V
DC

3RK3131-1AC10

 

⑨ Connection of PC or programming 
device, interface module, diagnostics 
display (X1) 

 

 
Figure 5-4 MSS 3RK3 Advanced internal circuit diagram 
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Terminal names of the 3RK3 Advanced central unit 
 
Terminal Meaning Description 
T1 Test output for inputs IN1, 

IN3, IN5, IN7 
T2 Test output for inputs IN2, 

IN4, IN6, IN8 

Test outputs with different test signals 
Connection for sensor contacts for detecting cross-
circuits 

IN1 ... IN8 Safety-related sensor inputs Connection for safety sensors 
Combinations for two-channel connection method: 
IN1-IN2, IN3-IN4, IN5-IN6, IN7-IN8 

Q1.1, Q1.2 Safety-related relay output Isolated, redundant output for connecting actuators 
Q2 Safety-related solid-state 

output 
Redundant semiconductor output for connecting 
actuators 

AS-i+, AS-i- AS-i terminals Connection of the AS-i cable 
L+ Power supply 24 V DC 
M Ground Ground to 24 V DC 
FE Functional ground Shielding, equipotential bonding 

Interfaces of the 3RK3 Advanced central unit 
 
Interface Meaning Description 
X1 System interface Connection of PC or programming device, interface 

module, diagnostics display 
X2 Interface Interface for connecting expansion modules (e.g., I/O 

modules) 
X3 External memory module Slot for external memory module with parameterization 

data 
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Operator controls of the 3RK3 Advanced central unit 
 
Element Meaning Description 
RESET 
button 

• Error 
acknowledgment 

• Factory setting 
• Application of code 

sequences 

• Confirm the acknowledgeable errors with this button 
• Refer to Chapter "Restoring factory settings 

(Page 637)" 
• Refer to Chapter "Teaching the code sequences 

(Page 482)" 

Displays of the 3RK3 Advanced central unit 
 
Element Meaning 
DEVICE Device status 
AS-i AS-i error 
TEACH Status of the teaching of code sequences 
SF Group error 
IN1 ... IN8 Status of the sensor inputs 
Q1, Q2 Status of the safety-related outputs 

Connecting inputs and outputs 
You will find more information on connecting inputs and outputs in Chapter "Connecting 
safety-related inputs and outputs (Page 117)." 
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5.1.3.1 Startup / self-test of the MSS 3RK3 Advanced 
Initially, startup is performed very much like startup of the MSS 3RK3 Basic, as described in 
Chapter "Startup / self-test of the MSS 3RK3 Basic (Page 62)." The AS-i function is activated 
during startup, depending on the configuration. 

If no AS-i bus is detected within 30 s during startup, the MSS 3RK3 Advanced switches to 
safety mode. The missing AS-i slaves are then processed with substitute value "0" in the 
logic. (AS-i-BF-LED flashes red)  

If safety-related AS-i slaves have been detected on the AS-i bus whose code sequence has 
not been acquired by teaching or whose code sequence does not match the existing code 
sequence, these are processed with the substitute value "0" in the interconnection logic. 
(AS-i-BF-LED flashes red)  

If no AS-i is configured, the AS-i functionality and the AS-i-BF LED are not processed. 

Configuring mode 
The 3RK3 Advanced central unit enters configuring mode (the DEVICE LED lights up yellow) 
when: 

● No configuration exists, 

● The TARGET configuration differs from the ACTUAL configuration (the SF LED lights up 
red) 

  Note 
Actual AS-i structure ≠ target AS-i structure 

If the actual AS-i structure deviates from the target structure, substitute values will be 
used for the AS-i slaves affected and the MSS 3RK3 Advanced will change to safety 
mode after startup. 

● The modules could not be parameterized (the SF LED lights up red) 

● The existing configuration has not been released. 

● The memory module is missing or defective. In this case, only diagnostics of the MSS 
3RK3 is possible (DEVICE LED flashes red, SF LED lights up red). 
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Simulated slaves in configuration mode   
If simulated AS-i slaves are contained in the configuration, they will already be simulated on 
the AS-i bus in configuration mode. The process data of the simulated slaves in configuration 
mode are always zero. 

If the AS-i bus does not exist or if no data traffic is detected on the AS-i bus by the master, 
simulation of these AS-i slaves is not possible. (AS-i LED flashes red) 

If configuration mode is entered by ending safety mode or test mode, the AS-i functionality 
remains, that is, the simulated slaves remain active on the AS-i bus. Teaching of safety-
related AS-i slaves also remains active. Only when a new configuration is loaded onto the 
device will the period for transmission stop the simulation of AS-i slaves and it will not be 
started again until the new configuration has been evaluated and accepted.  
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5.1.4 3RK3 ASIsafe basic central unit 

 
Figure 5-5 3RK3 ASIsafe basic central unit 

Properties 
The 3RK3 ASIsafe central unit is a basic component of an MSS 3RK3 configuration for 
safety-related control functions with use of AS-Interface. As an AS-i monitor, the 
3RK3 ASIsafe basic central unit can monitor sensor inputs in the lower fieldbus level and 
also shut down safety circuits through its outputs. It can be used up to SIL 3 as per 
EN 61508 and PL e as per EN ISO 13849-1.    

● An additional interface module (e.g., DP interface) can be used to exchange process data 
with a PLC. Diagnostic data of the MSS 3RK3 are also transmitted to the PLC. 

● Connection to AS-Interface for safety-related and non-safety-related data exchange. 

● The 3RK3 ASIsafe basic central unit can be parameterized using MSS ES. 

 

 Note 

No expansion modules can be connected to the 3RK3 ASIsafe basic central unit. 
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Inputs and outputs 
The 3RK3 ASIsafe basic central unit has the following inputs and outputs: 

● 2 safety-related, freely parameterizable sensor inputs 

● 6 digital standard inputs 

● 1 safety-related redundant relay output 

● 1 safety-related, redundant, solid-state output 

 

 Note 
Safety-related outputs 

If you use the safety-related outputs with a two-channel shutdown, a fault exclusion, such as 
a short-circuit to P or M, is required. This condition is met within a control cabinet or when 
the connection cables are installed in such a way that they are protected. 

 

 

MSS 3RK3 ASIsafe basic on the AS-i bus 
The MSS 3RK3 ASIsafe basic can perform various functions on the AS-i bus: 

● Simulation of up to 4 non-safety-related AS-i slaves 

● Simulation of up to 8 safety-related AS-i input slaves 

● Control of up to 8 safety-related AS-i outputs 

● Representation of of up to 31 safety-related AS-i outputs 

● Monitoring of up to 14 non-safety-related AS-i slaves 

● Monitoring of up to 31 safety-related AS-i input slaves 

You will find additional information in Chapter "Integrating the 3RK3 modular safety system 
into the AS-i bus (Page 452)." 
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Structure of the 3RK3 ASIsafe basic central unit 
 

Front view No. Meaning 

① Removable terminal block D 

② Removable terminal block C 

③ RESET button 

④ Removable terminal block A 

⑤ External memory module (X3) 

⑥ Label 

⑦ Display LEDs 

24V
DC

3RK3121-1AC00

 

⑧ Connection of PC or programming 
device, interface module, diagnostics 
display (X1) 

 

 
Figure 5-6 MSS 3RK3 ASIsafe basic internal circuit diagram 
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Terminal designations of the 3RK3 ASIsafe basic central unit 
 
Terminal Meaning Description 
T1 Test output for 

input F-IN1 
T2 Test output for 

input F-IN2 

Test outputs with different test signals 
Connection for sensor contacts for detecting cross-
circuits 

F-IN1 ... F-IN2 Safety-related sensor 
inputs 

Connection for safety sensors 
Combinations for two-channel connection method: 
F-IN1 ↔ F-IN2 

IN3 ... IN8 Digital standard inputs Connection for sensors 
Q1.1, Q1.2 Safety-related relay 

output 
Isolated, redundant output for connecting actuators 

Q2 Safety-related solid-state 
output 

Redundant semiconductor output for connecting 
actuators 

AS-i+, AS-i- AS-i terminals Connection of the AS-i cable 
L+ Power supply 24 V DC 
M Ground Ground to 24 V DC 
FE Functional ground Shielding, equipotential bonding 

Interfaces of the 3RK3 ASIsafe basic central unit 
 
Interface Meaning Description 
X1 System interface Connection of PC or programming device, interface 

module, diagnostics display 
X3 External memory module Slot for external memory module with parameterization 

data 
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Operator controls of the 3RK3 ASIsafe basic central unit 
 
Element Meaning Description 
RESET 
button 

• Error 
acknowledgment 

• Factory setting 
• Application of code 

sequences 

• Confirm the acknowledgeable errors with this button 
• Refer to Chapter "Restoring factory settings 

(Page 637)" 
• Refer to Chapter "Teaching the code sequences 

(Page 482)" 

Displays of the 3RK3 ASIsafe basic central unit 
 
Element Meaning 
DEVICE Device status 
AS-i AS-i error 
TEACH Status of the teaching of code sequences 
SF Group error 
F-IN1, F-IN2 Status of the sensor inputs 
IN3 ... IN8 Status of the digital standard inputs 
Q1, Q2 Status of the safety-related outputs 

Connecting inputs and outputs 
You will find more information on connecting inputs and outputs in Chapter "Connecting 
safety-related inputs and outputs (Page 117)." 

5.1.4.1 Startup/self-test of the MSS 3RK3 ASIsafe basic 
The startup process is similar to the startup of the MSS 3RK3 Advanced, as described in 
Chapter "Startup / self-test of the MSS 3RK3 Advanced (Page 68)." 
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5.1.5 3RK3 ASIsafe extended central unit 

 
Figure 5-7 3RK3 ASIsafe extended central unit 

Properties 
The 3RK3 ASIsafe extended central unit is a basic component of an MSS 3RK3 
configuration for safety-related control functions with use of AS-Interface. As an AS-i 
monitor, the 3RK3 ASIsafe extended central unit can monitor sensor inputs in the lower 
fieldbus level and also shut down safety circuits through its outputs. It can be used up to 
SIL 3 as per EN 61508 and PL e as per EN ISO 13849-1.    

● Up to 2 expansion modules can be connected to the 3RK3 extended central unit. 

● An additional interface module (e.g., DP interface) can be used to exchange process data 
with a PLC. Diagnostic data of the MSS 3RK3 are also transmitted to the PLC. 

● Connection to AS-Interface for safety-related and non-safety-related data exchange. 

● The 3RK3 ASIsafe extended central unit can be parameterized using MSS ES. 
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Inputs and outputs 
The 3RK3 ASIsafe extended central unit has the following inputs and outputs: 

● 4 safety-related, freely parameterizable sensor inputs 

● 4 digital standard inputs 

● 1 safety-related redundant relay output 

● 1 safety-related, redundant, solid-state output 

 

 Note 
Safety-related outputs 

If you use the safety-related outputs with a two-channel shutdown, a fault exclusion, such as 
a short-circuit to P or M, is required. This condition is met within a control cabinet or when 
the connection cables are installed in such a way that they are protected. 

 

 

MSS 3RK3 ASIsafe extended on the AS-i bus 
The MSS 3RK3 ASIsafe extended can perform various functions on the AS-i bus: 

● Simulation of up to 4 non-safety-related AS-i slaves 

● Simulation of up to 10 safety-related AS-i input slaves 

● Control of up to 10 safety-related AS-i outputs 

● Representation of of up to 31 safety-related AS-i outputs 

● Monitoring of up to 14 non-safety-related AS-i slaves 

● Monitoring of up to 31 safety-related AS-i input slaves 

You will find additional information in Chapter "Integrating the 3RK3 modular safety system 
into the AS-i bus (Page 452)." 
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Structure of the 3RK3 ASIsafe extended central unit 
 

Front view No. Meaning 

① Removable terminal block D 

② Removable terminal block C 

③ Connection for expansion module (X2) 

④ RESET button 

⑤ Removable terminal block A 

⑥ External memory module (X3) 

⑦ Label 

⑧ Display LEDs 

24V
DC

3RK3122-1AC00

 

⑨ Connection of PC or programming 
device, interface module, diagnostics 
display (X1) 

 

 
Figure 5-8 MSS 3RK3ASIsafe extended internal circuit diagram 
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Terminal designations of the 3RK3 ASIsafe extended central unit 
 
Terminal Meaning Description 
T1 Test output for inputs 

F-IN1, F-IN3 
T2 Test output for inputs 

F-IN2, F-IN4 

Test outputs with different test signals 
Connection for sensor contacts for detecting cross-
circuits 

F-IN1 ... F-IN4 Safety-related sensor 
inputs 

Connection for safety sensors 
Combinations for two-channel connection method: 
F-IN1 ↔ F-IN2, F-IN3 ↔ F-IN4 

IN5 ... IN8 Digital standard inputs  Connection for sensors 
Q1.1, Q1.2 Safety-related relay 

output 
Isolated, redundant output for connecting actuators 

Q2 Safety-related solid-state 
output 

Redundant semiconductor output for connecting 
actuators 

AS-i+, AS-i- AS-i terminals Connection of the AS-i cable 
L+ Power supply 24 V DC 
M Ground Ground to 24 V DC 
FE Functional ground Shielding, equipotential bonding 

Interfaces of the 3RK3 ASIsafe extended central unit 
 
Interface Meaning Description 
X1 System interface Connection of PC or programming device, interface 

module, diagnostics display 
X2 Interface Interface for connecting expansion modules (e.g., I/O 

modules) 
X3 External memory module Slot for external memory module with parameterization 

data 
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Operator controls of the 3RK3 ASIsafe extended central unit 
 
Element Meaning Description 
RESET 
button 

• Error 
acknowledgment 

• Factory setting 
• Application of code 

sequences 

• Confirm the acknowledgeable errors with this button 
• Refer to Chapter "Restoring factory settings 

(Page 637)" 
• Refer to Chapter "Teaching the code sequences 

(Page 482)" 

Displays of the 3RK3 ASIsafe extended central unit 
 
Element Meaning 
DEVICE Device status 
AS-i AS-i error 
TEACH Status of the teaching of code sequences 
SF Group error 
F-IN1 ... F-IN4 Status of the sensor inputs 
IN5 ... IN8 Status of the digital standard inputs 
Q1, Q2 Status of the safety-related outputs 

Connecting inputs and outputs 
You will find more information on connecting inputs and outputs in Chapter "Connecting 
safety-related inputs and outputs (Page 117)." 

5.1.5.1 Startup/self-test of the MSS 3RK3 ASIsafe extended 
The startup process is similar to the startup of the MSS 3RK3 Advanced, as described in 
Chapter "Startup / self-test of the MSS 3RK3 Advanced (Page 68)." 
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5.1.6 General information on expansion modules 

 
Figure 5-9 Expansion modules of the MSS 3RK3 

Application 
The expansion modules provide additional inputs and outputs for a 3RK3 central unit. The 
precondition for the use of expansion modules is always connection to a 3RK3 central unit 
and the corresponding software version MSS ES, see Chapter "Requirements (Page 150)."   

Power-up/self-test 
Once the power supply has been applied, all the devices perform a self-test. During this 
phase, the LEDs of the 3RK3 central unit and the expansion modules light up (lamp test). 
When the system has powered up, the self-test is complete, and the device is in safety or 
test mode, the LEDs light up in accordance with the pending signals. 
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5.1.7 Expansion module 4/8F-DI 

Properties 
With the expansion module 4/8F-DI, the 3RK3 central unit can be expanded with further 
safety-related inputs. It can be used up to SIL 3 as per EN 61508 and PL e as per 
EN ISO 13849-1.   

● Additional expansion modules can be connected to the expansion module 4/8F-DI. 

● Parameterization is performed using the 3RK3 central unit with MSS ES. 

Inputs and outputs 
The expansion module 4/8F-DI has the following inputs and outputs: 

● 8 safety-related, parameterizable sensor inputs 
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Design of the expansion module 4/8F-DI: 
 

Front view No. Meaning 

① Removable terminal block D 

② Removable terminal block C 

③ Interface (X2) 

④ Label 

⑤ Removable terminal block A 

⑥ Removable terminal block B 

⑦ Display LEDs 

 

⑧ Interface (X1) 

 

 
Figure 5-10 EM 4/8F-DI internal circuit diagram 



 Description of the hardware 
 5.1 Description of the individual modules 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 83 

Terminal designations of the expansion module 4/8F-DI: 
 
Terminal Meaning Description 
T1 Test output for inputs IN1, 

IN3, IN5, IN7 
T2 Test output for inputs IN2, 

IN4, IN6, IN8 

Test outputs with different test signals 
Connection for sensor contacts for detecting cross-
circuits 

IN1 ... IN8 Safety-related sensor inputs Connection for safety sensors 
Combinations for two-channel connection method: 
IN1-IN2, IN3-IN4, IN5-IN6, IN7-IN8 

L+ Power supply 24 V DC 
M Ground Ground to 24 V DC 

Interfaces of the expansion module 4/8F-DI: 
 
Interface Meaning Description 
X1 Interface Connection of central unit/expansion module 
X2 Interface Connection of expansion module 

Displays of the expansion module 4/8F-DI 
 
Element Meaning 
SF / IN1 Group error / status of the sensor input 
IN2 ... IN8 Status of the sensor inputs 

Connecting inputs and outputs 
You will find more information on connecting inputs and outputs in Chapter "Connecting 
safety-related inputs and outputs (Page 117)." 
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5.1.8 Expansion module 2/4F-DI 1/2F-RO 

Properties 
With the 2/4F-DI 1/2F-RO expansion module, the 3RK3 central unit can be expanded with 
further safety-related inputs and outputs. In order to achieve SIL 3 as per EN 61508 or PL e 
as per EN ISO 13849-1, you must interconnect 2 relay outputs in a logic combination.   

● Additional expansion modules can be connected to the expansion module 
2/4F-DI 1/2F-RO. 

● Parameterization is performed using the 3RK3 central unit with MSS ES. 

Inputs and outputs 
The expansion module 2/4F-DI 1/2F-RO has the following inputs and outputs: 

● 4 safety-related, freely parameterizable sensor inputs 

● 2 single-channel, safety-related relay outputs. 
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Design of the expansion module 2/4F-DI 1/2F-RO 
 

Front view No. Meaning 

① Removable terminal block D 

② Removable terminal block C 

③ Interface (X2) 

④ Label 

⑤ Removable terminal block A 

⑥ Removable terminal block B 

⑦ Display LEDs 

 

⑧ Interface (X1) 

 

 
Figure 5-11 2/4F-DI 1/2F-RO internal circuit diagram 
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Terminal designations of the expansion module 2/4F-DI 1/2F-RO 
 
Terminal Meaning Description 
T1 Test output for inputs IN1, 

IN3 
T2 Test output for inputs IN2, 

IN4 

Test outputs with different test signals 
Connection for sensor contacts for detecting cross-
circuits 

IN1 ... IN4 Safety-related sensor inputs Connection for safety sensors 
Combinations for two-channel connection method: 
IN1-IN2, IN3-IN4 

Q1.1, Q1.2 Safety-related relay output 
Q2.1, Q2.2 Safety-related relay output 

Isolated output for connecting actuators 

L+ Power supply 24 V DC 
M Ground Ground to 24 V DC 

Interfaces of the expansion module 2/4F-DI 1/2F-RO 
 
Interface Meaning Description 
X1 Interface Connection of central unit/expansion module 
X2 Interface Connection of expansion module 

Displays of the expansion module 2/4F-DI 1/2F-RO 
 
Element Meaning 
SF / IN1 Group error / status of the sensor input 
IN2, IN3, IN4 Status of the sensor inputs 
Q1, Q2 Status of the relay outputs 

Connecting inputs and outputs 
You will find more information on connecting inputs and outputs in Chapter "Connecting 
safety-related inputs and outputs (Page 117)." 
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5.1.9 Expansion module 2/4F-DI 2F-DO 

Properties 
With the 2/4F-DI 2F-DO expansion module, the 3RK3 central unit can be expanded with 
further safety-related inputs and outputs. It can be used up to SIL 3 as per EN 61508 and 
PL e as per EN ISO 13849-1.   

● Additional expansion modules can be connected to the expansion module 
2/4F-DI 2F-DO. 

● Parameterization is performed using the 3RK3 central unit with MSS ES. 

Inputs and outputs 
The expansion module 2/4F-DI 2F-DO has the following inputs and outputs: 

● 4 safety-related, freely parameterizable sensor inputs 

● 2 two-channel, safety-related, solid-state outputs. 
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Design of the expansion module 2/4F-DI 2F-DO 
 

Front view No. Meaning 

① Removable terminal block D 

② Removable terminal block C 

③ Interface (X2) 

④ Label 

⑤ Removable terminal block A 

⑥ Removable terminal block B 

⑦ Display LEDs 

 

⑧ Interface (X1) 

 

 
Figure 5-12 2/4F-DI 2F-DO internal circuit diagram 
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Terminal designations of the expansion module 2/4F-DI 2F-DO 
 
Terminal Meaning Description 
T1 Test output for inputs IN1, 

IN3 
T2 Test output for inputs IN2, 

IN4 

Test outputs with different test signals 
Connection for sensor contacts for detecting cross-
circuits 

IN1 ... IN4 Safety-related sensor inputs Connection for safety sensors 
Combinations for two-channel connection method: 
IN1-IN2, IN3-IN4 

Q1, Q2 Safety-related solid-state 
outputs 

Redundant semiconductor outputs for connecting 
actuators 

L+ Power supply 24 V DC 
M Ground Ground to 24 V DC 

Interfaces of the expansion module 2/4F-DI 2F-DO 
 
Interface Meaning Description 
X1 Interface Connection of central unit/expansion module 
X2 Interface Connection of expansion module 

Displays of the expansion module 2/4F-DI 2F-DO 
 
Element Meaning 
SF / IN1 Group error / status of the sensor input 
IN2, IN3, IN4 Status of the sensor inputs 
Q1, Q2 Status of the solid-state outputs 

Connecting inputs and outputs 
You will find more information on connecting inputs and outputs in Chapter "Connecting 
safety-related inputs and outputs (Page 117)." 
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5.1.10 Expansion module 4F-DO 

Properties 
With the expansion module 4F-DO, the 3RK3 central unit can be expanded with further 
safety-related outputs. It can be used up to SIL 3 as per EN 61508 and PL e as per 
EN ISO 13849-1.   

● Additional expansion modules can be connected to the expansion module 4F-DO. 

● Parameterization is performed using the 3RK3 central unit with MSS ES. 

Inputs and outputs 
The expansion module 4F-DO has the following inputs and outputs: 

● 4 two-channel, safety-related solid-state outputs 
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Structure of the expansion module 4F-DO 
 

Front view No. Meaning 

① Removable terminal block D 

② Removable terminal block C 

③ Interface (X2) 

④ Label 

⑤ Removable terminal block A 

⑥ Removable terminal block B 

⑦ Display LEDs 

 

⑧ Interface (X1) 

 

 
Figure 5-13 4F-DO internal circuit diagram 
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Terminal designations of the expansion module 4F-DO 
 
Terminal Meaning Description 
Q1, Q2, Q3, 
Q4 

Safety-related solid-state 
outputs 

Redundant semiconductor outputs for connecting 
actuators 

L+ Power supply 24 V DC 
M, 1M, 2M Ground Ground to 24 V DC 

Interfaces of the expansion module 4F-DO 
 
Interface Meaning Description 
X1 Interface Connection of central unit/expansion module 
X2 Interface Connection of expansion module 

Displays of the expansion module 4F-DO 
 
Element Meaning 
SF/Q1 Group error / status of the solid-state output  
Q2, Q3, Q4 Status of the solid-state outputs 

Connecting inputs and outputs 
You will find more information on connecting inputs and outputs in Chapter "Connecting 
safety-related inputs and outputs (Page 117)." 
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5.1.11 Expansion module 4/8F-RO 

Properties 
With the expansion module 4/8F-RO, the 3RK3 central unit can be expanded with further 
safety-related outputs. In order to achieve SIL 3 as per EN 61508 or PL e as per 
EN ISO 13849-1, you must interconnect 2 relay outputs in a logic combination.   

● Additional expansion modules can be connected to the expansion module 4/8F-RO. 

● Parameterization is performed using the 3RK3 central unit with MSS ES. 

Inputs and outputs 
The expansion module 4/8F-RO has the following inputs and outputs: 

● 8 single-channel, safety-related relay outputs. 
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Design of the expansion module 4/8F-RO 
 

Front view No. Meaning 

① Removable terminal block D 

② Removable terminal block C 

③ Interface (X2) 

④ Removable terminal block A 

⑤ Label 

⑥ Display LEDs 

 

⑦ Interface (X1) 

 

 
Figure 5-14 4/8F-RO internal circuit diagram 



 Description of the hardware 
 5.1 Description of the individual modules 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 95 

Terminal designations of the 4/8F-RO expansion module 
 
Terminal Meaning Description 
Q1.1, Q1.2 Safety-related relay output 
Q2.1, Q2.2 Safety-related relay output 
Q3.1, Q3.2 Safety-related relay output 
Q4.1, Q4.2 Safety-related relay output 
Q5.1, Q5.2 Safety-related relay output 
Q6.1, Q6.2 Safety-related relay output 
Q7.1, Q7.2 Safety-related relay output 
Q8.1, Q8.2 Safety-related relay output 

Isolated output for connecting actuators 

L+ Power supply 24 V DC 
M Ground Ground to 24 V DC 

Interfaces of the expansion module 4/8F-RO 
 
Interface Meaning Description 
X1 Interface Connection of central unit/expansion module 
X2 Interface Connection of expansion module 

Operator controls and displays of the expansion module 4/8F-RO 
 
Element Meaning 
SF/Q1 Group error / status of the relay output 
Q2 ...Q8 Status of the relay outputs 

Connecting inputs and outputs 
You will find more information on connecting inputs and outputs in Chapter "Connecting 
safety-related inputs and outputs (Page 117)." 
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5.1.12 Expansion module 8DI 

Properties 
With the 8DI expansion module, the 3RK3 central unit can be expanded by further (non-
safety-related) inputs. The 8DI expansion module supplements a 3RK3 central unit.   

● It is suitable as an input module with non-safety-related sensor inputs, e.g. for: 

– Displaying process statuses for operational switching. 

– Detecting start buttons. 

● Additional expansion modules can be connected to the expansion module 8DI. 

● Parameterization is performed using the 3RK3 central unit with MSS ES. 

Inputs and outputs 
The expansion module 8DI has the following inputs and outputs: 

● 8 sensor inputs (non-safety-related) 
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Design of the expansion module 8-DI 
 

Front view No. Meaning 

① Removable terminal block D 

② Removable terminal block C 

③ Interface (X2) 

④ Label 

⑤ Removable terminal block A 

⑥ Removable terminal block B 

⑦ Display LEDs 

 

⑧ Interface (X1) 

 

 
Figure 5-15 8-DI internal circuit diagram 
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Terminal designations of the expansion module 8-DI 
 
Terminal Meaning Description 
IN1 ... IN8 Sensor inputs Connection for sensors 
L+ Power supply 24 V DC 
M Ground Ground to 24 V DC 

Interfaces of the expansion module 8-DI 
 
Interface Meaning Description 
X1 Interface Connection of central unit/expansion module 
X2 Interface Connection of expansion module 

Displays of the expansion module 8-DI 
 
Element Meaning 
SF / IN1 Group error / status of the sensor input 
IN2 ... IN8 State of the sensor inputs 

Connecting inputs and outputs 
You will find more information on connecting inputs and outputs in Chapter "Connecting 
safety-related inputs and outputs (Page 117)." 
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5.1.13 Expansion module 8DO 

Properties 
With the 8DO expansion module, the 3RK3 central unit can be expanded by further (non-
safety-related) outputs. It is suitable as an output module with non-safety-related outputs, 
e.g. for messages.   

● Additional expansion modules can be connected to the expansion module 8DO. 

● Parameterization is performed using the 3RK3 central unit with MSS ES. 

Inputs and outputs 
The expansion module 8DO has the following inputs and outputs: 

● 8 semiconductor outputs (non safety related) 
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Design of the expansion module 8DO 
 

Front view No. Meaning 

① Removable terminal block D 

② Removable terminal block C 

③ Interface (X2) 

④ Label 

⑤ Removable terminal block A 

⑥ Removable terminal block B 

⑦ Display LEDs 

 

⑧ Interface (X1) 

 

 
Figure 5-16 8DO internal circuit diagram 
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Terminal designations of the expansion module 8DO 
 
Terminal Meaning Description 
Q1 ...Q8 Solid-state outputs Semiconductor outputs (non safety related) 
L+ Power supply 24 V DC 
M, 1M, 2M Ground Ground to 24 V DC 

System interfaces of the expansion module 8DO 
 
Interface Meaning Description 
X1 Interface Connection of central unit/expansion module 
X2 Interface Connection of expansion module 

Displays of the expansion module 8DO 
 
Element Meaning 
SF/Q1 Group error / state of the solid-state output 
Q2 ...Q8 State of the semiconductor outputs (non-safety-related) 

Connecting inputs and outputs 
You will find more information on connecting inputs and outputs in Chapter "Connecting 
safety-related inputs and outputs (Page 117)." 
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5.1.14 DP interface module 

 
Figure 5-17 DP interface module   

Application 
Interface modules are the interface between the MSS 3RK3 and a higher-level bus system, 
e.g. PROFIBUS DP. The MSS 3RK3 uses them to make diagnostics and status information 
available to a higher-level controller. Non-safety-related input and output signals can be 
exchanged between the MSS 3RK3 and a higher-level controller (PLC).    

Device power-up of DP interface 
Once the hardware has been successfully initialized, the LED and display test is carried out. 
Then the connection between the DP interface and the 3RK3 central unit is established.  

After successful startup, the DP interface appears as a PROFIBUS slave on the bus and 
starts data exchange if the configuration is correct. 
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Properties 
The DP interface module has the following properties: 

● The DP interface connects the MSS 3RK3 to PROFIBUS DP and thus with a higher-level 
programmable controller. 

● Integration into the higher-level control is performed by means of a GSD file. 

● The properties of the DP interface are set with MSS ES. 

● The DP interface is equipped with one system interface for connecting the 3RK3 central 
unit and one system interface for connecting a PC / PG. 

● The DP interface can be used to link non-safety-related signals of a higher-level controller 
with the MSS 3RK3 logic. 

● The DP interface has a baud rate of up to 12 MBit. 

● Process and diagnostics data can be exchanged through the DP interface: 

– Cyclic: The PLC can exchange 32-bit or 64-bit process data with the MSS 3RK3 
depending on the central unit. 

– Acyclic: The PLC can query diagnostic data from the MSS 3RK3. With MSS ES, the 
diagnostic information can be displayed graphically. 

Both options can be used at the same time. 

● The DP interface supports DPV1 and DPV0 mode. 
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Design of the DP interface module 
 

Front view No. Meaning 

① Removable terminal block D 

② Removable terminal block C 

③ System interface (X2) 

④ PROFIBUS DP connection 

⑤ Removable terminal block A 

⑥ Button (SET / MODE) 

⑦ Label 

⑧ LCD display 

⑨ Display LEDs 

  

 
 

⑩ System interface (X1) 

 

 
Figure 5-18 DP-Interface internal circuit diagram 
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Terminal designations of the DP interface module 
 
Terminal Meaning Description 
L+ Power supply 24 V DC 
M Ground Ground to 24 V DC 
FE Functional ground Shielding, equipotential bonding 

Interfaces of the DP interface module 
 
Interface Meaning Description 
X1 System interface Connection of PC / PG, diagnostics display 
X2 System interface Connection of central unit 
PROFIBUS DP 9-pin sub D socket Connection to PROFIBUS DP 

Operating elements of the DP interface 
 
Element Meaning Description 
SET Pushbutton For navigating through the menu 
MODE Pushbutton For navigating through the menu 

Display elements of the DP interface module 
 
Element Meaning 
DEVICE Status 
BF Bus error 
SF Group error 

Operating the DP interface 
See Chapter "DP interface device statuses  (Page 443)." 
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5.1.15 Diagnostics display 

Application 
A diagnostics display is available for the MSS 3RK3 that displays the current messages, 
diagnostics data, and status information of the monitored system directly on the control 
cabinet, enabling elementary diagnostics without PC and MSS ES. The diagnostics display 
has a connection to the 3RK3 central unit (rear) and a connection to the PC or programming 
device (front).   

 
Figure 5-19 Diagnostics display of the MSS 3RK3 
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 Note 
MSS 3RK3 Advanced/ MSS 3RK3 ASIsafe basic/ MSS 3RK3 ASIsafe extended 

These three 3RK3 central units are supported by the diagnostics display with product version 
E03 and firmware version V1.1.x and higher. 

MSS 3RK3 Basic is supported by the diagnostics display with product version E01 and 
higher. 

 

 Note 
Access from MSS ES via PROFIBUS and diagnostics display 

If the access from MSS ES to the MSS 3RK3 is by means of PROFIBUS, the diagnostics 
display must have, at a minimum, product version 3 (E03) or firmware version1) V1.1.x, as 
well as the MSS ES 2008 SP3. 

If an access path is established by the MSS ES over an extended period or the device is 
switched to test mode, the display is disabled and outputs a corresponding message. The 
display restarts automatically once this status ends. 

 

1) The firmware version can be read at the startup of the display or at the bottom left when 
the display is disabled. In addition, it is shown by selecting menu command "Display settings 
/ Identification". (see also Chapter "Display settings (Page 633)") 
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Design of the diagnostics display 
 

Front view No. Meaning 

① System interface (X1)  

② Display 

③ Arrow keys  

④ Park position for interface 
cover 

⑤ Keys for menu navigation 

⑥ Display LED 

⑦ Functional ground 

Front view: 
 

SIRIUS 3RK3
DEVICE

BF

SF

Rear view: 

 

⑧ System interface (X2) 

 

 
Figure 5-20 Diagnostic display internal circuit diagram 
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Terminal designations of the diagnostics display 
 
Terminal Meaning Description 
FE Functional ground Shielding, equipotential bonding 

Interfaces of the diagnostics display 
 
Interface Meaning Description 
X1 System interface Connection to the PC or programming device 
X2 System interface Connection to the central unit 

Operator controls  
 
Element Meaning 
Keys Navigation in the operator control menu/error 

acknowledgement 

Displays 
 
Element Meaning 
DEVICE Device status 
BF Bus error 
SF Group error 

Operating the diagnostics display 
See Chapter "Diagnostics with diagnostics display (Page 615)."  
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5.2 Mounting / installing / attaching 

5.2.1 General note 
During installation, pay attention to the maximum cable lengths to be complied with between 
the modules: 

SIRIUS 3RK3
DEVICE

BF

SF

 
① Diagnostics display 
② Interface module 
③ Central unit 
④ ... ⑫ Expansion modules  

• 0 for MSS 3RK3 ASIsafe basic 
• Maximum of 2 for MSS 3RK3 ASIsafe extended 
• Maximum of 7 for MSS 3RK3 Basic 
• Maximum of 9 for MSS 3RK3 Advanced 

⑬ Memory module 

Figure 5-21 Maximum cable lengths of the MSS 3RK3 
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5.2.2 Mounting the central unit, expansion module, or interface module on a DIN rail 

Requirements 
● At the installation location, a horizontal 35-mm wide mounting rail per DIN EN 60715 is 

properly secured.  

● Pay attention to the information on the mounting position in Chapter "General technical 
data (Page 655)." 

DIN rail mounting procedure 
 

Step Operating instruction Figure 
1 Place the back of the device onto the upper edge 

of the standard mounting rail. 
2 Press the lower half of the device against the DIN 

rail until the device engages. 
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5.2.3 Mounting the central unit, expansion module, or interface module on a level 
surface 

Requirements 
Please note the following requirements for mounting on a level surface:   

● Pay attention to the information on the mounting position in Chapter "General technical 
data (Page 655)." 

● Two properly executed drill holes with thread or plug on the level surface 

Refer to the relevant dimension drawings in the appendix for the distances between the 
drill holes "Dimension drawings (Page 675)." 

● Two screws with a maximum thread diameter of 4.8 mm 

● Two plastic securing brackets 

Refer to the accessories list in Chapter "System components (Page 34)" for the relevant 
order number. 

Procedure for mounting on a level surface 
 

Step Operating instruction Figure 
1 Insert the securing brackets into the openings 

provided on the device until they engage. 
2 Hold the device up to the surface prepared for 

screw fastening. 
3 Insert the screws through the oblong holes in the 

securing brackets. 
4 Screw the device onto the level surface so that it 

is secure. 
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5.2.4 Installing the diagnostics display in a control cabinet door / switchboard 

Requirements 
● A mounting cut-out measuring H x W 55 x 92 mm must be available. 

● The control cabinet door/control panel must be no more than 16 mm thick. 

   
 

NOTICE  
Overall depth 

Please observe the installation depth of 41 mm for the device. 
 

NOTICE  
Degree of protection IP54 

The degree of protection IP54 on the front is only guaranteed if: 
• The device has been properly installed with the fixing elements supplied. 
• The system interface on the front has been protected with a system interface cover. 

 

Procedure for installing in a control cabinet door / control panel 
 

Step Operating instruction Figure 
1 Insert the diagnostics display in the mounting cut-

out from the front. 
2 Take appropriate measures to ensure the 

diagnostics display does not fall out of the control 
cabinet door/control panel. 

3 Snap the four fixing brackets on the rear into the 
oblong holes of the diagnostics display. 

4 Tighten the screws of the fixture bracket slightly so 
that the diagnostics display cannot fall out of the 
installation opening. 

5 Align the diagnostics display. 
6 Gently tighten the screws of the fixing brackets with 

0.15 + 0.05 Nm. 
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5.2.5 Removing the central unit, expansion module, or interface module 
 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 

Before starting work, therefore, disconnect the system and devices from the power supply. 
 

Requirements 
● All system interface connections are terminated. 

● If applicable, the PROFIBUS DP connection or AS-i bus is terminated. 

● The terminal blocks have been removed or disconnected. 

Removing the central unit, expansion module, or interface module from a DIN rail   
 

Step Operating instruction Figure 
1 Pull the device down until the lower half 

can be pulled away from the DIN rail. 
2 Pull the lower half of the device away 

from the DIN rail. 
3 Lift the device from the upper edge of 

the DIN rail. 
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Removing the central unit, expansion module, or interface module from a level surface 
 

Step Operating instruction Figure 
1 Hold the device firmly. 
2 Unscrew the cap screws. 
3 Lift the device from the level surface. 
4 Remove the securing brackets from the 

device. 
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5.2.6 Removing the diagnostics display 

Removing the diagnostics display from a control cabinet door / control panel   
 

Step Operating instruction Figure 
1 Take appropriate measures to ensure 

the diagnostics display does not fall out 
of the control cabinet door/control 
panel. 

2 Unscrew the screws of the four fixing 
brackets on the rear. 

2 Remove the fixing brackets. 
3 Pull the diagnostics display out of the 

mounting cut-out from the front. 
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5.3 Connecting / wiring 

5.3.1 Connecting safety-related inputs and outputs 

Inputs    
To achieve the required performance level or SIL, single-channel or two-channel 
interconnection of the inputs of the MSS 3RK3 is possible. The following connection 
methods are possible: 

● In the case of the single-channel connection method, only one input terminal is assigned 
for each sensor. 

● In the case of the two-channel connection method, two input terminals are assigned for 
each sensor. In mixed operation, both single-channel and two-channel sensors can be 
interconnected on one module. 

● Cross-circuit detection is possible when the test cycle outputs are used with two-channel 
sensors. 

The number of connectable sensors thus varies according to the connection method. Up to 4 
two-channel sensors or 8 single-channel sensors can be connected to the 3RK3 central unit. 

The safety-related inputs can also be used to read standard signals (non-safety-related). 



Description of the hardware  
5.3 Connecting / wiring 

 Modular Safety System 3RK3 

118 System Manual, 06/2012, 9262530-02 Rev 004 

Connection methods of the safety-related inputs with cross-circuit detection  
 

2 x single-channel sensor 1 x two-channel sensor Single-channel and two-channel sensor 
mixed 

  

 

T1 test output for IN1, 3, 5, 7 
T2 test output for IN2, 4, 6, 8 
IN1 ... IN5 sensor inputs 

Non-floating sensors  
When sensors with non-floating outputs (e.g., light curtains, laser scanners) are used, they 
must not be supplied with power through test outputs T1/T2. With this function element, 
cross-circuit detection must be deactivated in the MSS ES tool. 

Connection methods of the safety-related inputs without cross-circuit detection 
 

1 x single-channel sensor 1 x two-channel sensor 

  

IN1, IN2 sensor inputs 
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Relay outputs    
Safety-related outputs of the 3RK3 central unit are configured with two channels; those of 
the expansion modules, with one channel. To achieve PL d/e or SIL 2/3 of the expansion 
modules, two relay outputs must be interconnected in a logic combination. 

 

WARNING  
Overload 

The relay contacts may weld if an overload occurs. The system cannot then shut down. To 
prevent relay contact welding, the switched loads must be protected accordingly, see 
Chapter "Technical data (Page 655)."  

 

 Note 

When inductive loads are controlled through a relay output, the load must be equipped with 
inductive interference protection. 
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Main connection methods of the safety-related relay outputs of the 3RK3 central unit 
 
1 x single-channel actuator shutdown 1 x two-channel actuator shutdown 

 

 

QA, QB contactors 
Qx.1, Qx.2 safety-related relay outputs 

 

 

WARNING  
To achieve SIL 2/3 as per IEC 61508 or PL d/e as per EN ISO 13849-1, a fault exclusion 
such as a short-circuit to P or M is required. This can, for example, be implemented within a 
control cabinet or by installing the connection cables in such a way that they are protected. 
If that is not possible, the outputs must be implemented redundantly. For this purpose, 
separate cables must be laid to actuators/contactors. In the associated function element "F 
output," the output type "F output redundant" must be chosen. 
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Main connection methods of the safety-related relay outputs of the expansion modules 
2/4F-DI 1/2F-RO and 4/8F-RO  

 
2 x single-channel actuator shutdown 1 x two-channel actuator shutdown 

 

 

QA, QB contactors 
Qx.1, Qx.2 safety-related relay outputs 

Solid-state outputs    
Internally, safety-related solid-state outputs always have a two-channel structure. As a result, 
each of these outputs can be used for applications up to PL e or SIL 3. 
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Connection methods of the safety-related solid-state outputs 
 
2 x single-channel actuator shutdown 2 x two-channel actuator shutdown 

 

 

QA ... QD contactors 
Q1, Q2 safety-related solid-state outputs 

 

 

WARNING  
To achieve SIL 2/3 as per IEC 61508 or PL d/e as per EN ISO 13849-1, a fault exclusion 
such as a short-circuit to P or M is required. This can, for example, be implemented within a 
control cabinet or by installing the connection cables in such a way that they are protected. 
If that is not possible, the outputs must be implemented redundantly. For this purpose, 
separate cables must be laid to actuators/contactors. In the associated function element "F 
output," the output type "F output redundant" must be chosen. 

 

 Note 

When inductive loads are controlled through a solid-state output, the load must be equipped 
with inductive interference protection. 
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5.3.2 Connecting non-safety-related inputs and outputs 

Connection methods of the non-safety-related inputs 
    

 
1 x single-channel sensor 

 

IN1 sensor input 

Connection methods of the non-safety-related solid-state outputs 
    

 
Single-channel actuator shutdown 

 

QA contactors 
Q1 safety-related solid-state outputs 

 

 

 Note 

When inductive loads are controlled through a solid-state output, the load must be equipped 
with inductive interference protection. 
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5.3.3 Guidelines for wiring the MSS 3RK3 
 

WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 

To minimize any risk to humans or the environment, you must not bypass any safety 
functions or implement measures that cause such safety functions to be bypassed. The 
manufacturer is not liable for the consequences of any such manipulation or for any 
damage resulting if this warning is not observed. 

 

WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 

If a two-channel evaluation is carried out via a module comprising two single-channel 
function elements, the input signals must each be read by a linear and non-linear sensor 
input. 

If these specifications are not observed, the requirements of the highest protection class 
are not fulfilled. 

 

WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 

When safe outputs or inputs are used on a single channel, a cable cross-circuit or the 
reaction of loads can result in a dangerous malfunction. When stringent requirements 
regarding safety must be fulfilled, the risk of dangerous malfunctions must be minimized by 
implementing appropriate measures (e.g., protected cable installation). 
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Cross-circuit detection 
To ensure reliable cross-circuit detection, note the following points when wiring the individual 
modules:       

1. All components (i.e., all modules including the sensors) must be operated on the same 
power supply. 

2. Cross-circuit detection is not possible with single-channel sensors. 

3. A two-channel sensor must only be connected to a single (expansion) module. 

4. A two-channel sensor must be connected to test outputs T1/T2 to ensure cross-circuit 
detection. 
If a cross-circuit is detected, this applies to the entire module. 

5. Test output T1 must always be combined with an odd-numbered sensor input (IN1, IN3, 
IN5, IN7). 

6. Test output T2 must always be combined with an even-numbered sensor input (IN2, IN4, 
IN6, IN8). 

7. Non-floating sensors cannot be connected to test outputs T1/T2. Cross-circuit detection 
of non-floating sensors with MSS 3RK3 is therefore not possible. 

8. Cross-circuit detection is not possible with non-floating sensors. In this case, cross-circuit 
detection must be deactivated in MSS ES. See also Chapter "Properties across function 
elements (Page 271)." 

9. Cross-circuit detection between three, four, or more inputs on one sensor is not possible. 
For this reason, the cables for the two buttons must be routed separately to prevent a 
cross-circuit (in two-hand operation, for example). 

10. If a safety shutdown mat (cross-circuit principle) is connected to a module, cross-circuit 
detection must be deactivated for the remaining inputs on this module because otherwise 
the monitoring functions configured for these inputs will also signal a cross-circuit when 
somebody steps on the safety shutdown mat. 

Outputs 
1. If outputs are used as redundant outputs, the two outputs do not have to be on the same 

module. 

2. Safety-related solid-state outputs can be used for safety-related shutdown to SIL 3 as per 
EN 61508 and PL e as per EN ISO 13849-1, if the cables are installed in a protected 
manner or routed inside the control cabinet. 

Reference 
For examples of how to wire sensors, see Chapter "Wiring of the MSS 3RK3 Basic 
(Page 46)." 
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5.3.4 Connection data for terminal blocks 
The following connection data apply dependent on the removable terminal block:    

 
 Specification and value  

in the case of removable 
terminal blocks with screw-type 
terminals 

Specification and value  
in the case of removable 
terminal blocks with spring-
loaded terminals 

Screwdriver 

 

Cross-tip screwdriver 
Size: PZ 2 (⌀ 5 … 6 mm) 
Torque: 0.8 … 1.2 Nm 

Screwdriver 
Size: 0 or 1 (width to 3 mm) for 
raising the terminal springs 

Rigid cable 

 

Maximum number of cables x 
cable cross-section:  
1 x 0.5 … 4.0 mm2 

or 
2 x 0.5 … 2.5 mm2 

Maximum number of cables x 
cable cross-section: 
2 x 0.25 … 1.5 mm2 

Flexible cable with end 
sleeve/cable lug 

 

Maximum number of cables x 
cable cross-section: 
1 x 0.5 … 2.5 mm2 

or 
2 x 0.5 … 1.5 mm2 

Maximum number of cables x 
cable cross-section: 
2 x 0.25 … 1.5 mm2 

Flexible cable 

 

Not allowed Maximum number of cables x 
cable cross-section: 
2 x 0.25 … 1.5 mm2 
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5.3.5 Connecting terminal blocks 
 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 

Before starting work, therefore, disconnect the system and devices from the power supply. 
 

 Note 
Functional ground - protective ground conductor    

Terminal FE must be connected to functional ground with a low-resistance connection. 
 

Requirements   
● The insulation on the connection cables must be properly stripped to a length of 10 mm. 

● Flexible cables must be fitted with end sleeves or cable lugs for connection to screw-type 
terminal blocks. 
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Procedure for screw-type terminal blocks   
 

Step Operating instruction Figure 
1 Insert the relevant cable into square on the 

screw-type terminal until it engages. 
2 Hold the cable in the screw-type terminal. 
3 Tighten the screw of the terminal in which the 

cable is inserted. 
4 Pull on the cable to ensure it is screwed tight. 

 

Procedure for spring-loaded terminal blocks   
 

Step Operating instruction Figure 
1 To release the terminal spring, insert the 3-mm 

flat-head screwdriver into the square opening 
of the spring-loaded terminal until it engages. 
Please observe a 10° horizontal angular 
deviation of the screwdriver to the oval 
opening. 

2 Insert the cable into the oval opening as far as 
it will go. 

3 Hold the cable in the spring-loaded terminal. 
4 Remove the screwdriver. 
5 Pull on the cable to ensure it is tight. 

~10°

~10°

3 mm
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5.3.6 Connecting the system interfaces 
 

CAUTION  
Protection against electrostatic charge 

Unused system interfaces must be closed using system interface covers.   
 

CAUTION  
Off-circuit installation 

Connect the system interfaces only in a voltage-free state! 

If you connect system interfaces while the system is connected to the power supply, this 
can damage the safety components which, in turn, means that the safety function is no 
longer available. 

 

 Note 
Connection cables   
• MSS components are connected through the system interfaces using connection cables. 
• The connection cables are available as adjacent versions (0.025 m). Connection cables 

up to max. 2.5 m in length are available for connecting to the diagnostics display. 
 

 Note 
Reverse polarity protection 

Observe the color coding and mechanical coding on the connection cables. 
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SIRIUS 3RK3
DEVICE

BF

SF

 
① Diagnostics display  
② Interface module  
③ Central unit 
④ ... ⑫ Expansion modules: 

• Maximum of 7 for MSS 3RK3 Basic 
• Maximum of 9 for MSS 3RK3 Advanced 
• 0 for MSS 3RK3 ASIsafe basic 
• Maximum of 2 for MSS 3RK3 ASIsafe extended 

⑬ Memory module  

Figure 5-22 Maximum cable lengths of the MSS 3RK3 
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Procedure for connecting the system interfaces   
 

Step Operating instruction Figure 
1 Observe the color coding ② and mechanical 

coding. Insert the cable connector into the 
connector slot. Engage the locking 
mechanisms ①. 

2 Pull on the connection cable to ensure the 
locking element has engaged. 

3 Close unused interfaces with system interface 
covers. 
Observe the mechanical coding. 

 



Description of the hardware  
5.3 Connecting / wiring 

 Modular Safety System 3RK3 

132 System Manual, 06/2012, 9262530-02 Rev 004 

5.3.7 Connecting a diagnostics display 
    

 

 Note 
Cable length 

The connection cable between the diagnostics display and the central unit/interface module 
must not exceed 2.5 m.  

 

Every diagnostics display has three connections: 

Connections on the rear 
 

 
① System interface X2 
② Functional ground 

The rear is normally not accessible if the diagnostics display is installed. The connection 
cable from the central unit / interface module is connected to the system interface Χ2 ② 
there. The diagnostics display also has to be grounded at the functional ground ①.  

You will find additional information in Chapter " Grounding (Page 141)." 
 

 Note 

Only the central unit or the interface module may be connected to the system interface X2 
② on the rear of the diagnostics display. 
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Connections on the front 
 

SIRIUS 3RK3
DEVICE

BF

SF

 
③ System interface X1 

The front is normally accessible if the diagnostics display is installed. Components are only 
directly inserted in the system interface X1 ③ as required and removed after use. These can 
be: 

● PC cable for connecting a PC/PG 

● Cover (when the system interface is not used) 

 

 Note 

Only one PC / PG may be connected to the system interface X1 ③ on the front of the 
diagnostics display. 

 

CAUTION  
EMC measures 

If the system interface X1 is not used, it must be closed with the interface cover supplied to 
retain the degree of protection of the diagnostics display and to prevent damage due to 
electrostatic charge. 

 



Description of the hardware  
5.3 Connecting / wiring 

 Modular Safety System 3RK3 

134 System Manual, 06/2012, 9262530-02 Rev 004 

5.3.8 Establishing a PROFIBUS DP connection 

PI installation guidelines 
In the case of electric PROFIBUS networks, note also the PROFIBUS DP/FMS installation 
guidelines defined by the PROFIBUS user organization. These contain important information 
about installing cables and commissioning PROFIBUS networks.    

Publisher: 

PROFIBUS-Nutzerorganisation e. V. 
Haid-und-Neu-Straße 7 
76131 Karlsruhe, Germany  

Tel.: ++721 / 9658 590 
Fax: ++721 / 9658 589 
Internet (http://www.profibus.com) 
guidelines, order no. 2.111 

See also "SIMATIC NET PROFIBUS Network Manual 
(http://support.automation.siemens.com/WW/view/de/35222591/0/en)" (order number: 
C79000-G8900-C124-03) 

Requirement 
PROFIBUS DP connection cable with 9-pin sub-D connector is available. 

Connection to PROFIBUS DP 
 

Step Operating instruction Figure 
1 Connect the PROFIBUS DP connector to the 

PROFIBUS DP interface. 
2 Tighten the screws on the PROFIBUS DP 

connector. 
3 If the device is located at the end of the 

PROFIBUS DP cable, switch on the 
terminating resistor on the PROFIBUS DP 
connector. 

 

http://www.profibus.com/�
http://support.automation.siemens.com/WW/view/de/35222591/0/en�
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5.3.9 Connecting the AS-i bus 

Requirements 
The MSS 3RK3 can only be connected to the following central units on the AS-i bus: 

● 3RK3 Advanced 

● 3RK3 ASIsafe basic 

● 3RK3 ASIsafe extended 

When connecting the AS-i cables, pay attention to the general information in Chapter 
"Connecting terminal blocks (Page 127)."    

 

 Note 
Bus load of MSS 3RK3 

The MSS 3RK3 is always a bus load from an A/B slave on the AS-i bus. This bus load does 
not depend on how many slaves are simulated by the 3RK3 central unit or whether only AS-i 
slaves are monitored. 

 

 

How to connect to the AS-i bus 
 
Step Operating instruction Figure 
1 Connect AS-Interface to the AS-i terminals ① / ② on 

the 3RK3 central unit. 
The blue conductor of the AS-i cable is connected to 
the terminal "ASi-" ① and the brown conductor to the 
terminal "ASi+" ②. 

24V
DC  
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5.3.10 Disconnecting 
   

 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 

Before starting work, therefore, disconnect the system and devices from the power supply. 
 

Disconnecting PROFIBUS DP connection (if applicable) 
 

Step Operating instruction Figure 
1 Loosen the screws of the PROFIBUS DP 

connector. 
2 Remove the PROFIBUS DP connector. 

 

Disconnecting system interfaces 
 

Step Operating instruction Figure 
1 Press the locking element apart and 

simultaneously pull the connection cable out of 
the connector slot of the system interface. 
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Removing terminal blocks from the device 
 

NOTICE  
Order of removal 

Remove terminal block A before terminal block B, and C before D. 
 

 
Step Operating instruction Figure 

1 Insert a flat-head screwdriver between the clip 
of the terminal block and the front panel ①. 

2 Pull the terminal block out to the front ②. 
3 Lift the terminal block out of the mechanically 

coded guiderail of the device ③. 

 



Description of the hardware  
5.3 Connecting / wiring 

 Modular Safety System 3RK3 

138 System Manual, 06/2012, 9262530-02 Rev 004 

Disconnecting screw-type terminals 
 

Step Operating instruction Figure 
1 Unscrew the screw of the screw-type terminal. 
2 Remove the cable from the unscrewed screw 

terminal. 

 

Disconnecting spring-loaded terminals 
 

Step Operating instruction Figure 
1 Insert the flat-head screwdriver into the square 

opening of the spring-loaded terminal until it 
engages. Please observe a 10° horizontal 
angular deviation of the screwdriver to the oval 
opening. 

2 Remove the cable from the oval opening. 
3 Remove the screwdriver. 

~10°

~10°

3 mm
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5.3.11 Plugging in terminal blocks 
 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 

Before starting work, therefore, disconnect the system and devices from the power supply. 
 

Requirement 
You must have removed the terminal blocks, for the purpose of replacing a device, for 
example. 

Procedure when plugging in the terminal blocks   
 

NOTICE  
Removable terminal blocks are mechanically coded to prevent polarity reversal 

The removable terminal blocks are mechanically coded to prevent polarity reversal and are 
labeled with A, B, C or D on the inside. Only use the slots shown in the diagram below. 

 

NOTICE  
Plug-in sequence 

Connect terminal block B before terminal block A, and D before C. 
 

 
Step Operating instruction Figure 

1 Insert the removable terminal block into the 
mechanically coded guiderail of the device ①.

2 Slide the removable terminal block back until it 
audibly engages. 

3 Check that the clip of the removable terminal 
block closes flush with the front panel ②. 
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5.3.12 Connecting the memory module 
The memory module is included in the scope of delivery of the 3RK3 central unit. Program 
the memory module in the 3RK3 central unit that is connected to a configuring PC or 
programming device. 

Connecting the memory module   
 

NOTICE  
The memory module must only be connected/disconnected when the 3RK3 central unit is 
disconnected from the power supply. 

 

NOTICE  
Do not connect a memory module with released configuration to a 3RK3 central unit of 
another type. 

The released configuration on the memory module depends on the 3RK3 central unit. For 
example, the configuration released on an MSS 3RK3 Basic cannot be interpreted by an 
MSS 3RK3 Advanced, or vice versa. The same applies to all other 3RK3 central units. 
When the memory module is plugged into a 3RK3 central unit of another type, the 
configuration release is canceled.  

The configuration may have to be adapted and released again. 
 

Connect the memory module to the interface on the underside of the 3RK3 central unit ①. 
Engage the locking mechanisms ②. 

The memory module can be sealed. 

 
Figure 5-23 Connecting the memory module 
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 Note 
Correct position of the memory module 

Make sure that the memory module is positioned correctly on the 3RK3 central unit (the 
locking elements must be locked ②). 

 

5.3.13 Grounding 
 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 

Before grounding or wiring an electrical device, you must ensure that the power supply for 
the device is switched off. Ensure that all the connected devices are also switched off. 

 

Grounding measures    
All electrical devices must be grounded and wired properly not only to ensure that your 
system functions as smoothly as possible but also to provide additional noise immunity for 
your application. 

The following components must be grounded: 

● FE contacts of the module, if present 

● Shield of the PROFIBUS cable 

● Tab connector of the diagnostics display 

● The shield, if shielded sensor and actuator cables are used 

All ground cables must be as short as possible and have the largest possible cable cross-
section. 
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Description of the software 6
6.1 Introduction 

6.1.1 What's new? 

Function expansion as from 2008 + SP3   
The new Modular Safety System ES 2008 SP3 contains a few new features, which are listed 
below: 

● The software is additionally released for the following 64-bit operating systems and 
service packs: 

– Windows 7 Professional SP1 (64-bit) 

– Windows 7 Enterprise SP1 (64-bit) 

– Windows 7 Ultimate SP1 (64-bit) 

– Windows 7 Professional (64-bit) 

– Windows 7 Enterprise (64-bit) 

– Windows 7 Ultimate (64-bit) 

● Adobe Reader 

Modular Safety System ES 2008 SP3 no longer uses Adobe Reader for the "Print" and 
"Print Preview" functions. Therefore, product setup no longer includes Adobe Reader. 

● The new Modular Safety System ES 2008 SP3 supports the two new central units: 

– 3RK3 ASIsafe basic 

– 3RK3 ASIsafe extended 
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These support the same function elements as the 3RK3 Advanced central unit. The 
differences between these three central units are listed in the table: 

 

Feature 3RK3 ASIsafe 
basic 

3RK3 ASIsafe 
extended 

3RK3 Advanced 

Safety-related, freely 
parameterizable sensor inputs 

2 4 8 

Digital standard inputs (single-
channel) 

6 4 0 

Safety-related, redundant relay 
outputs 

1 1 1 

Safety-related, redundant 
semiconductor outputs  

1 1 1 

Expansion modules 0 2 9 
Maximum number of simulated 
safety-related AS-i slaves 

8 10 12 

DP interface Yes Yes Yes 
Diagnostics module Yes Yes Yes 

6.1.2 Overview 

The engineering system (ES)   
SIRIUS ES is the shared software platform for different communication-enabled switching 
devices.   

The Modular Safety System ES 2008 (MSS ES) engineering system is the software for 
configuring and parameterizing and diagnosis of the Modular Safety System 3RK3 
(MSS 3RK3).   

It provides the following functions: 

● Simple configuration of the modules of an MSS 3RK3, including the graphical 
parameterization of the function elements, e.g., monitoring functions 

● Test and startup functions, e.g., device diagnostics, monitoring of logic elements, forcing 
of logic elements 

● Tool for creating the system documentation, e.g., documentation of the circuits, device 
comments, module names 
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Communication 
MSS ES communicates with the MSS 3RK3 through the system interface of the 3RK3 
central unit or over PROFIBUS. 

1

2

3

5

 
① PC or programming device through the device interface on the MSS 3RK3 
② PC/device interface with diagnostics display on the MSS 3RK3 
③ MSS 3RK3 
④ PLC over PROFIBUS and DP-Interface 
⑤ DP interface 

Figure 6-1 Communication options of MSS ES 

 

WARNING  
To prevent unauthorized access to the MSS 3RK3 through the PROFIBUS network, you 
assign a password for device access. 
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Delivery form 
The MSS ES parameterization software is available in three different license versions with 
different functional scopes:   

● Basic license 

– CD with a license on a USB stick (order number: 3ZS1 314-4CC10-0YA5) 

– License download (order number: 3ZS1 314-4CE10-0YB5) 

● Standard license 

– CD with a license on a USB stick (order number: 3ZS1 314-5CC10-0YA5) 

– License download (order number: 3ZS1 314-5CE10-0YB5) 

– Software Update Service (order number: 3ZS1 314-5CC10-0YL5) 

– Powerpack (Basic → Standard) (order number: 3ZS1 314-5CC10-0YD5) 

● Premium license (new) 

– CD with a license on a USB stick (order number: 3ZS1 314-6CC10-0YA5) 

– License download (order number: 3ZS1 314-6CE10-0YB5) 

– Software Update Service (order number: 3ZS1 314-6CC10-0YL5) 

– Powerpack (Standard → Premium) (order number: 3ZS1 314-6CC10-0YD5) 

For the functional scope of each license version, see Chapter "License-dependant available 
menu commands (Page 147)." 

The software package contains: 

 
Software Application 
MSS ES Configuration of the MSS 3RK3 
Automation License Manager License management 
.NET Framework Required for generating the printout or print preview 
MSI Execution of the setup 
Readme (Readme.rtf) Important information you require before installation. 

 
 

 Note 

The licenses are implemented exclusively as a floating license. You will find additional 
information in Chapter "Installing the Automation License Manager (Page 153)." 
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6.1.3 License-dependant available menu commands 
 

3 different license versions of the "Modular Safety System ES 2008+SP3" software are 
available: 

● Basic license: This license contains a reduced functional scope and is suitable for 
commissioning engineers and service personnel. 

● Standard license: This license contains a full range of functions for creating 
configurations. The functional scope is that of the previous Software 
Modular Safety System ES 2008. 

● Premium license: In contrast to the standard license, this license enables MSS ES to 
communicate with MSS 3RK3 additionally via PROFIBUS. This license version also 
features macro functionality. 

Not all functions are available with all licenses. If a function is not available with your license 
version, the associated menu option is always grayed out. 

Overview: Availability of menu options   
The following table provides an overview of which commands are available with which 
license version:   

 
Menu option Basic license Standard license Premium license 

New... ✓ ✓ ✓ 
Open... ✓ ✓ ✓ 
Import... - ✓ ✓ 
Open Online... ✓ ✓ ✓ 
Save ✓ ✓ ✓ 
Save as... - ✓ ✓ 
Export... - ✓  ✓ 
Close ✓ ✓ ✓ 
Print... ✓  ✓ ✓ 
Page Setup... - ✓ ✓ 
Print Preview... - ✓ ✓ 
Most recently used files - ✓ ✓ 

Switching device 

Exit ✓ ✓ ✓ 
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Menu option Basic license Standard license Premium license 
Undo - ✓ ✓ 
Restore - ✓ ✓ 
Cut - ✓ ✓ 
Copy - ✓ ✓ 
Paste - ✓ ✓ 
Delete ✓ ✓ ✓ 
Select all - ✓ ✓ 
Go to - ✓ ✓ 
Insert comment - ✓ ✓ 
Realign graphic - ✓ ✓ 
Interrupt connection - ✓ ✓ 
Redraw partial connection - ✓ ✓ 
Add diagram - ✓ ✓ 
Remove diagram - ✓ ✓ 
Create macro - - ✓ 
Edit terminal identifier - ✓ ✓ 
Object properties ✓ ✓ ✓ 
Check consistency ✓ ✓ ✓ 
Password for project access ✓ ✓ ✓ 
Reset password for project 
access 

✓ ✓ ✓ 

Password for test mode ✓ ✓ ✓ 
Password for device access ✓ ✓ ✓ 
Compare with File - ✓ ✓ 

Edit 

Compare with switching 
device 

- ✓ ✓ 
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Menu option Basic license Standard license Premium license 
Load to switching device... ✓ ✓ ✓ 
Load to PC... ✓ ✓ ✓ 
Go Offline ✓ ✓ ✓ 
Undo the fixed assignment of 
the interface 

✓ ✓ ✓ 

PROFIBUS DP line view - - ✓ 
Learn ASIsafe code tables... ✓ ✓ ✓ 
Prepare configuration test... ✓ ✓ ✓ 
Approve configuration... ✓ ✓ ✓ 
Cancel configuration release ✓ ✓ ✓ 
Configuring mode ✓ ✓ ✓ 
Test mode - ✓ ✓ 
Safety mode ✓ ✓ ✓ 
Commands... - ✓ ✓ 
Diagnostics configuration ✓ ✓ ✓ 

Target system 

Diagnostics logic ✓ ✓ ✓ 
Toolbar - ✓ ✓ 
Status bar - ✓ ✓ 
Zoom in ✓ ✓ ✓ 
Zoom out ✓ ✓ ✓ 
Zoom dialog - ✓ ✓ 
Overall view - ✓ ✓ 
Display settings ✓ ✓ ✓ 
Grid properties  ✓ ✓ ✓ 
Move diagram ✓ ✓ ✓ 
Highlight signal flow - ✓ ✓ 
Delete highlighting - ✓ ✓ 
Navigation window ✓ ✓ ✓ 
Output window ✓ ✓ ✓ 
Catalog window ✓ ✓ ✓ 

View 

Minimize / restore online 
dialog 

- ✓ ✓ 
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Menu option Basic license Standard license Premium license 
Basic Settings... ✓ ✓ ✓ 
Modular Safety System ES 
settings 

✓ ✓ ✓ 

Cross references - ✓ ✓ 
Symbol list - ✓ ✓ 
Terminal list - ✓ ✓ 
Release information ✓ ✓ ✓ 
Export macro - - ✓ 
Import macro - - ✓ 

Options 

Set the PG/PC interface... - - ✓ 
Help topics ✓ ✓ ✓ Help 
Info ✓ ✓ ✓ 

6.1.4 Requirements 
To be able to work with MSS ES, you must meet the following requirements: 

Software requirements 
To configure the modules, you need a programming device or PC with MS Windows XP 
Professional SP2/SP3 or MS Windows 7 Ultimate/Professional/Enterprise 32-bit operating 
system (SP3 and higher: 64-bit). The readme file (Readme.rtf) contains the current software 
requirements. 

● You need administrator rights to install MSS ES. To be able to work with MSS ES under 
MS Windows XP Professional SP2/SP3 or MS Windows 7 
Ultimate/Professional/Enterprise 32-bit (SP3 and higher: 64-bit), at least the main user 
rights are required. 

● When MSS ES is installed, the administrator must grant full access rights to the MSS ES 
setup directory to all users wishing to work with MSS ES on this computer. You can find 
information on assigning access rights in the documentation of your operating system. 

Hardware requirements 
● A programming device or PC is required for using the MSS ES: 

Refer to the readme file (Readme.rtf) in which the current hardware requirements are 
listed. 

● PC cable for serial communication via local device interface, see Chapter "System 
components (Page 34)." 

● PROFIBUS interface, e.g., CP5512 in the PC or programming device for access via 
PROFIBUS (only possible for MSS ES Premium) 

● CD-ROM drive (for software installation from CD-ROM only) 
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Required knowledge 
Understanding of this documentation and software requires the following: 

● General knowledge of the operating system used. 

● Basic knowledge of parameterizing, configuring, and commissioning safety relays. 

Which device is supported by which software version?   
 
Device MSS ES 2008 MSS ES 2008 SP1 MSS ES 2008 SP2 MSS ES 2008 SP3 
Central units 
Basic ✓ ✓ ✓ ✓ 
Advanced - - ✓ ✓ 
ASIsafe basic - - - ✓ 
ASIsafe extended - - - ✓ 
Interface modules 
DP interface ✓ ✓ ✓ ✓ 
Expansion modules 
4/8 F-DI ✓ ✓ ✓ ✓ 
2/4 F-DI 2 F-DO ✓ ✓ ✓ ✓ 
2/4 F-DI 1/2 F-RO ✓ ✓ ✓ ✓ 
8 DO ✓ ✓ ✓ ✓ 
4 F-DO - ✓ ✓ ✓ 
4/8 F-RO - ✓ ✓ ✓ 
8 DI - ✓ ✓ ✓ 
HMI modules 
Diagnostics display - - ✓1) ✓2) 

1)  Up to product version E02 or FW version V1.0.x 
2) Product version E03 or FW version V1.1.x and higher 
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6.2 Installation and program start 

6.2.1 Usage authorizations via the Automation License Manager 

Automation License Manager     
To use the programming software, you need a product-specific license key (usage 
authorization), which is installed using the Automation License Manager.  

The Automation License Manager is a software product developed by Siemens AG that is 
used to manage license keys (technical representation of licenses) on a system-wide basis. 

The Automation License Manager is available: 

● On the product CDs of MSS ES 

● As a download on the Internet pages for IA&DT Customer Support at Siemens AG. 

The Automation License Manager features an online help function that you can use to call up 
context-specific information via the F1 key, or via "Help" > "Help on License Manager". This 
help function contains detailed information about how to use the Automation License 
Manager and the functions it offers. 

License keys 
The license key acts as the technical representation of a license (electronic license stamp). 

SIEMENS AG issues a license key for all license-protected software. The software can only 
be used in accordance with the license and usage conditions associated with the license key 
once the system has established that a valid license key has been installed on the computer 
when the software is launched. 

License keys can be stored as follows and transferred from one storage medium to another: 

● On license key data carriers 

● On local hard disks 

● On the hard disks of computers in the network 
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For more information about using license keys, please refer to the online help for the 
Automation License Manager.  

 

 Note 
• MSS ES cannot be used without a license key. 
• To familiarize yourself with the operator interface and the range of functions, you can 

activate one Trial License, allowing you to work with the system for 14 days. Following 
this period, you must acquire a valid license. Otherwise you cannot continue to work with 
MSS ES. 

 

6.2.2 Installing the Automation License Manager 

Installing Automation License Manager    
Automation License Manager is installed by a setup program. You will find the installation 
software for the Automation License Manager on the MSS ES product CD.  

You can install the Automation License Manager together with MSS ES or later.   
 

 Note 
• For detailed information on the setup procedure for the Automation License Manager, 

read the latest readme file (Readme.rtf). 
• The online help for the Automation License Manager contains all the information you 

need about using license keys and the functions they offer. 
 

Installing license keys at a later date 
When you start the MSS ES software without installed license keys, the system displays a 
corresponding message.  

You can install license keys later in the following ways:  

● Install license keys from a USB stick 

● Install license keys downloaded from the Internet (license keys must be ordered first) 

● Using floating license keys available on the network. 

Refer to the online help for the Automation License Manager for detailed information on 
installing license keys. To access this context-sensitive help function, press F1 or select the 
menu command "Help" > "Help on Automation License Manager".  

 

 Note 
• License keys will only be operational if they are installed on a hard disk on which write 

access is allowed. 
• Floating licenses can also be used within a network ("remote" use). 
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6.2.3 Rules for using license keys 

Additional information    
You can open the context-sensitive online help for the Automation License Manager by 
pressing F1 or by selecting the menu command "Help" > "Help on Automation License 
Manager".  

This help contains all the information you need about the functions and handling of license 
keys.  

 

CAUTION  
Read the information on handling license keys contained in the online help and readme file 
for the Automation License Manager. If you do not follow these instructions, the license 
keys may be irretrievably lost. 

 

6.2.4 Installation 

Requirement 
 

 Note 

You require administrator rights to install MSS ES.    
 

Before installing: 
 

 Note 

Read the "readme.rtf" file on the CD ROM before installing MSS ES. 
 

Installing the software 
The installation program starts automatically after you insert the CD ROM, if this function is 
activated on your computer.  

If the installation program does not start automatically, proceed as follows: 

● Open the main directory on the CD ROM. 

● Double click on the "setup.exe" file to start the setup program. The setup program guides 
you step by step through the entire process of installing MSS ES. 
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6.2.5 Starting the program 

Starting the MSS ES program on the PC 
After terminating the installation program and after restarting your computer (if prompted to 
do so during setup), you can start MSS ES as follows:   

● By double-clicking on the "Modular Safety System ES " icon on the desktop. 

● MS Windows XP Professional SP2/SP3: Clicking on the "Start" button in the Windows 
task bar under "SIRIUS engineering" > "Modular Safety System ES" 

● MS Windows 7 Ultimate/Professional/Enterprise 32-bit (SP3 and higher: 64-bit): Clicking 
on the "Start" button in the Windows task bar under "All Programs" > "Siemens 
Automation" > "SIRIUS engineering" 

Start wizard   
After the program has been started, a deactivatable Start wizard appears with which you can 
execute the following actions: 

● Create a new configuration ("New") 

● Open an existing configuration file ("Open") 

● Read out a configuration online from an MSS 3RK3 ("Open online") 
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6.3 User interface 

6.3.1 Design of the user interface 
If you start the software of the 3RK3 (MSS ES) Modular Safety System and create a new 
project using the menu command "Switching device" > "New", then the user interface opens 
in the "Configuration" - "Main system" setting. The central work space of this setting is the 
configuration table. 

 
① Title line ⑥ Navigation window 
② Menu bar ⑦ Status bar 
③ Toolbar ⑧ Output window 
④ Work space ⑨ Information window 
⑤ Catalog window   

Figure 6-2 User interface with configuration table   
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Number Description Function 

① Title line Contains general information: 
• The type of license: Basic / Standard / Premium 
• "Unnamed": Project not yet saved 
• <File name>: Project already saved 
• The connection status: [Online] / [Offline] 

② Menu bar Providing all of the functions required for program control.

③ Toolbar Contains buttons for frequently used program commands.

④ Work space Depending on the selected view in the navigation 
window, this contains tables or diagrams for editing the 
project: 
• Identification parameters 
• Configuration table 
• Logic diagram 

⑤ Catalog window Depending on the selected view in the navigation 
window, this contains the components needed for the 
configuration: 
• Configuration: Modules for hardware configuration 
• Logic diagram: Function elements for the safety logic 

⑥ Navigation window Allows the various views of the open project to be 
selected: 
• Identification: Central unit, marking, project 
• Configuration: Main system 
• Logic: Diagram 1 / diagram n 

⑦ Status bar Contains information on the program status of MSS ES 
for selected menu commands and buttons. 

⑧ Output window Contains information on the project which does not 
appear in dialog boxes, e.g. cross reference lists and 
symbol lists. 

⑨ Information window Contains information on the components selected in the 
catalog window. 
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6.3.2 Toolbar 
 
Menu option Basic license Standard license Premium license 
View Toolbar - ✓ ✓ 

Actions 
To display or hide the toolbar at the top of the application screen, choose "View" > "Toolbar".  

Properties of the toolbar   

 
Figure 6-3 Toolbar in MSS ES 

● The toolbar has icons that make the most important menu functions directly accessible. If 
you allow the mouse pointer to rest on an icon for about one second, its function is briefly 
displayed as a tool tip and in the status bar in plain text. 

● To print data, click on the printer icon. All other icons correspond to the function of the 
associated menu command. 

● You cannot change the number or assignment of the icons for the individual menu 
commands. 
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6.3.3 Status bar 
 
Menu option Basic license Standard license Premium license 
View Status bar - ✓ ✓ 

Actions   
To display or hide the status bar at the bottom of the application screen, choose "View" > 
"Status bar".  

Properties of the status bar 
The status bar contains the standard information and the additional MSS-specific 
information.  

 
Figure 6-4 Status bar in MSS ES 

 
No. Meaning 

① Displays the operating mode of the MSS 3RK3 and the status of the user program 
STOP: Circuit is not being processed 
RUN: Circuit is being processed 

② Shows the current utilization of the memory module. 

③ Displays of the current utilization of the internal MSS 3RK3 memory (depends on the type 
and number of function elements used). 

④ Shows the current utilization of the parameterized program cycle time. 

⑤ Connection status (online / offline). 

⑥ Type of online connection (e.g. COM1 (= serial interface), DP 42 (= PROFIBUS connection 
to a switching device with address 42) 
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6.4 Description of the menu commands 

6.4.1 Switching device menu 

6.4.1.1 New... 
 
Menu option Button Basic license Standard 

license 
Premium 
license 

Switching 
device 

New...  ✓ ✓ ✓ 

Actions 
To create a new project, choose "Switching device" > "New."   

A list containing the short codes for the available switching devices is displayed. You can 
select one of these switching devices for processing or you can search for a specific 
switching device for further processing. 

In the display window underneath a short description of the selected switching device is 
displayed. If you install SIRIUS engineering for other switching devices, the new switching 
devices are added to the hardware catalog.   

Searching for a switching device 
To search for a specific switching device, proceed as follows: 

1. Enter the name or order number (MLFB) of the switching device in the search dialog box 
either in full or in part. 

2. Click on the up and down search buttons to look for the switching device. 

If the switching device could not be found the following error message appears: 

"The device being searched does not exist in catalog." 

As a remedy, change the search text and click on the search buttons again. 

Selecting a switching device 
To choose the switching device, select it and then click "OK" or simply double-click the 
required device name. 

To open or close the sub-directories of the switching device tree displayed, click [+] or [-]. 
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6.4.1.2 Open... 
 
Menu option Button Basic license Standard 

license 
Premium 
license 

Switching 
device 

Open...  ✓ ✓ ✓ 

Actions 
To open parameter files that were generated with MSS ES and that have the file extension 
*.sdp (switching device parameters), choose the "Switching device" > "Open..." menu 
command. When a file is selected, the directory that was last used is always displayed from 
which you can navigate to the required file.  

6.4.1.3 Import... 
 
Menu option Button Basic license Standard 

license 
Premium 
license 

Switching 
device 

Import... - - ✓ ✓ 

Actions   
You can overwrite the currently displayed diagram with the values from a file by choosing the 
"Switching device" > "Import..." menu command. The current focus of the program does not 
change (i.e. if you make changes, for example, these will not be saved in the device from 
which the data was imported). 

Error message when parameters are overwritten 
The current parameters are overwritten with those from the file. 

If the content of the file is not compatible with the current safety relay, an error message is 
displayed (Example: You are processing the parameters of an MSS and have opened the 
parameter file for a motor starter.) 

 

 Note 
Overwriting parameters 

When you choose this menu command, the parameters in the main memory are overwritten 
without you being prompted to confirm this. 

 

Storage directory display 
When a file is selected, the directory that was last used is always displayed from which you 
can navigate to the required file. 
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6.4.1.4 Open online... 
 
Menu option Button Basic license Standard 

license 
Premium 
license 

Switching 
device 

Open online...  ✓ ✓ ✓ 

Actions   
The "Switching device" > "Open online..." menu command establishes a data connection 
betweeen the PC and a switching device through the local device interface or over 
PROFIBUS DP and loads the data from the switching device once into the PC's RAM. The 
data connection remains in place, 

Local device interface   
To load the data from a switching device into the working memory of the PC through the 
local device interface, proceed as follows: 

● Specify the COMx interface. 

● Confirm the dialog with "OK". 

● The program establishes a connection with the specified safety relay, checks whether the 
parameters that are currently displayed are compatible with this safety relay, and then 
reads all the parameters from the device. 

– If no configuration is open when the "Open online..." action is performed, a graphical 
diagram will be created in which the function elements are arranged automatically 
according to the signal flow. 

– If a configuration is open when the "Open online..." action is performed, the offline 
configuration will be compared with the online data. The graphical arrangement of the 
function elements of the offline parameters is retained as far as possible. 
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PROFIBUS DP   
 

WARNING  
To prevent unauthorized access to the MSS 3RK3 through the PROFIBUS network, you 
assign a password for device access. 

 

The preconditions for access over PROFIBUS are the use of the DP interface module, a 
PROFIBUS interface in the PC / PG and a Premium license. 

Perform the following steps: 

● Connect the DP interface to the PC / PG using a PROFIBUS cable. 

● Start MSS ES. 

● Open the "Switching device" > "Open online..." menu. 

● Select the access point. 

● Enter the DP address under "Preferred address," or select the corresponding address 
under "Available stations."  

● Click OK to confirm. 

 

 Note 

Without configuration or with the factory settings, the MSS 3RK3 logs on to the PROFIBUS 
with address 126. 
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6.4.1.5 Save 
 
Menu option Button Basic license Standard 

license 
Premium 
license 

Switching 
device 

Save  ✓ ✓ ✓ 

Actions   
With the "Switching device > Save" menu command, you save existing parameters in the 
standard format (*.sdp) on a data medium. 

If no file is open at this point (e.g. because you have selected "Switching device" > "New" to 
select a new safety relay for processing), the "Save as..." dialog box will open instead. 

6.4.1.6 Save as... 
 
Menu option Button Basic license Standard 

license 
Premium 
license 

Switching 
device 

Save as... - - ✓ ✓ 

Actions   
With the menu command "Switching device" > "Save as...", you save the current data under 
a new name. 

6.4.1.7 Export ... 
 
Menu option Button Basic license Standard 

license 
Premium 
license 

Switching 
device 

Export... - - ✓ ✓ 

Actions   
With the "Switching device" > "Export..." menu command, you can copy the currently 
displayed parameters to a parameter file. 
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6.4.1.8 Close 
 
Menu option Button Basic license Standard 

license 
Premium 
license 

Switching 
device 

Close - ✓ ✓ ✓ 

Actions   
With the menu command "Switching device" > "Close", you exit the function for processing 
the current parameters. The menu command has the following effect: 

● An opened parameter file is closed. 

● An existing online connection to a safety relay is terminated. 

● Before you exit the function, you are asked if you want to save any changes you may 
have made to parameters or if you want to load them to the safety relay. 

6.4.1.9 Information about the print options 

Required settings 
A default printer must be set up on the target system. 

Print on DIN A3   
To print on DIN A3, a DIN A3-capable printer must be installed and defined as the default 
printer. To select the DIN A3 format, choose "Switching device" > "Page setup...". 
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6.4.1.10 Page Setup... 
 
Menu option Button Basic license Standard 

license 
Premium 
license 

Switching 
device 

Page Setup... - - ✓ ✓ 

Actions   
To call up a dialog in which you can set the print options, select "Switching device" > "Page 
setup...". These settings are copied for a specific project (*.sdp file) or device. 

Setting options 
The Wizard contains the following four pages:  

● Page 1 - General settings: choosing the page format 

● Page 2 - Header: maintaining the header fields 

● Page 3 - Footer: maintaining the footer fields 

● Page 4 - Contents: selecting the data to be printed, paper orientation, margins 

Page 1 - General settings 

Settings on the 1st page   
On page 1 of the "Page setup" dialog, you can define the general settings. These functions 
include:   

● The paper format for the entire report (default: A4) 

● What happens when you close a dialog (print preview is displayed, printout is triggered) 

● Display of initial page 

 

 Note 
Further format settings 

You can define further format settings (e.g. page margins and document alignment) on page 
4 of the "Page setup" dialog. 
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Page 2 - Header 

Maintaining the header 
On page 2 of the "Page setup" dialog (header), you can maintain the header fields.     

Inserting elements in the header 
You can insert the following elements left justified, centrally, or right justified via the context 
menu (can be selected using the "+" pushbuttons): 

 
Element Note 
Date short Date in short format as defined in the control panel under "Regional 

and Language Options". 
Date Date in long format as defined in the control panel under "Regional 

and Language Options". 
System time Time as defined in the control panel under "Regional and Language 

Options". 
Time 24h Time 24 hour clock format. 
Path Path of the *.sdp file that is currently open. 
Document name Name of the current *.sdp file / DP address / COM port 
Page (curr.) Current number of pages. 
Pages (tot.) Total number of pages. 
My text When you select "My text", the system displays a field in which you 

can enter your own text. 
My image You can add a picture or logo here. 

To remove any elements, choose "-". 
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Page 3 - Footer 

Maintaining the footer    
On page 3 of the "Page setup" dialog (footer), you can maintain most of the fields in the 
(tabular) footer.   

Standard DIN EN ISO 7200   
The tabular footer is structured in accordance with DIN EN ISO 7200. 

Overview of all the fields in the footer: 

 
Footer field Meaning Maintaining 
MSS-specific part of the footer 
Diagram Number of the logic diagram Automatic 
Diagram name Configured name of the logic diagram Automatic 
Diagram sheet Page and pages, including the logic diagram Automatic 
Last change Date and time of last change saved Automatic 
Configuration CRC Cyclic Redundancy Check which saves all safety-relevant 

configuration data (4 bytes). 
Automatic 

Standard-compliant part of the footer 
Department 
responsible 

Name of the department which, at the time the document is 
released, is responsible for the technical content and updating the 
document. 

In the "Page setup" dialog 

Technical reference Company contact for technical queries regarding the content of the 
document. 

In the "Page setup" dialog 

Document type Indicates the content and format of the document (intended 
specifically for searching for documents). 

In the "Page setup" dialog 

Document status Status of the document within the lifecycle (e.g. "Being 
processed", "Released", "Withdrawn"). 

In the "Page setup" dialog 

Owner Name of the company that is the legal owner of the document (an 
abbreviated trade name or logo can also be entered).  
With Modular Safety System ES: Configuration engineer's 
company name: 

in the "Identification" > 
"Project" output window 

Created by Name of the person who created or revised the document.  
With Modular Safety System ES: Name of configuration engineer 

in the "Identification" > 
"Project" output window 

Approved by For approvals/releases with signature (e.g. releases required for 
acceptance inspections performed by certification centers). 

handwritten on the printout 

Title Unique name for the parameters or project 
With Modular Safety System ES: Project name 

in the "Identification" > 
"Project" output window 

Item number Establishes a unique reference to the document. In the "Page setup" dialog 
Modification Indicates the different versions with combinations of letters and/or 

numbers. 
In the "Page setup" dialog 

Release date Date on which the document was approved/released. handwritten on the printout 
Language Indicates the document language (in max. 4 characters). In the "Page setup" dialog 
Sheet Current page / total number of pages Automatic 
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Page 4 - Contents 

Selecting the configuration data to be printed.    
On page 4 of the "Page setup" dialog, you can select which configuration data is to be 
printed. In the selection tree, select the checkbox in front of the data you want to print out. 
You can either select individual elements or higher-level elements with all the associated 
sub-elements. You must select at least one element before you can close the dialog.  

Separate page layout for level 2 elements 
In the various tab dialog boxes on the right, you can define a separate page layout for level 2 
elements (e.g. parameters). This layout is valid for all levels below this. You can also select 
the paper orientation (portrait/landscape) and the margins. You have already set the paper 
format (e.g. A4) on page 1 of the "Page setup" dialog. This setting applies to the entire 
report. 

Applying the settings 
Once you have made all the required settings, you can exit the dialog and apply all your 
settings by choosing "Finish". 
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6.4.1.11 Print preview... 
 
Menu option Button Basic license Standard 

license 
Premium 
license 

Switching 
device 

Print Preview... - - ✓ ✓ 

Actions   
To call up a print preview that displays the document with the current settings, choose 
"Switching device" > "Print preview...". On page 1 of the "Page setup" dialog, you can specify 
that the print preview is displayed automatically when you close the dialog. 

Export from print preview 
You have the option of saving the contents of the print preview as a PDF. To do so, click on 
the diskette icon in the toolbar in the Print Preview window. 

6.4.1.12 Print... 
 
Menu option Button Basic license Standard 

license 
Premium 
license 

Switching 
device 

Print...  ✓ ✓ ✓ 

Actions   
To open the standard Windows "Print" dialog, choose the "Switching Device" > "Print..." 
menu command. You can make the following settings in this dialog, for example: 

● Printer selection 

● Select the pages to be printed (e.g., pages 1 to 11) 

● Number of copies 

● Printer driver settings 
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Further print options 
You can also print a document by selecting the "Printer" icon in the toolbar. The document is 
then printed with the current print settings. You can also print documents from page 1 of the 
"Page setup" dialog box (General settings) by closing the dialog box. 

 

 Note 
Setting the language  

This is a standard Windows dialog. The language is determined by the operating system and 
cannot be changed via SIRIUS engineering! 

 

 

6.4.1.13 List of the files last used 
 
Menu option Button Basic license Standard 

license 
Premium 
license 

Switching 
device 

Most recently 
used files 

- - ✓ ✓ 

Actions   
With the "Switching device" > "List of the files last used" menu command, you can list the 
nine files last used. 

When you click one of the files, it is displayed. 

6.4.1.14 Exit 
 
Menu option Button Basic license Standard 

license 
Premium 
license 

Switching 
device 

Exit - ✓ ✓ ✓ 

Actions   
To exit the program, select "Switching device" > "Exit". If you have changed any parameters, 
you are asked if you want to save the changes before you exit the program. 
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6.4.2 Edit menu 

6.4.2.1 Undo 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Undo  - ✓ ✓ 

Actions   
The menu command "Edit" > "Undo" performs the following actions: 

● You can undo changes to parameters and changes in the logic diagram (moving blocks, 
changing connections, etc.). 

Position changes (e.g. dialog selection, scroll, select) cannot be undone. 

● Once you have executed this menu command, the system displays the view that was 
active before the action you have just undone. 

● File functions (e.g. "Save," "Load," "Download," "Open Online") delete the entire undo 
history ("Undo" can no longer be used). 

6.4.2.2 Redo 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Restore  - ✓ ✓ 

Actions   
The menu command "Edit" > "Redo" cancels one (or more) previous undo actions. 
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6.4.2.3 Cut 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Cut  - ✓ ✓ 

Actions   
The menu command "Edit" > "Cut" transfers selected objects to the clipboard which can then 
be pasted using the "Edit" > "Paste" menu command. The selected objects are deleted at the 
source location. 

6.4.2.4 Copy 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Copy  - ✓ ✓ 

Actions   
The menu command "Edit" > "Copy" transfers selected objects to the clipboard which can 
then be pasted using the "Edit" > "Paste" menu command. 

6.4.2.5 Paste 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Paste  - ✓ ✓ 

Actions   
The menu command "Edit" > "Paste" pastes objects that were copied to the clipboard by the 
menu command "Edit" > "Copy". 
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6.4.2.6 Delete 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Delete  ✓ ✓ ✓ 

Actions   
The menu command "Edit" > "Delete" removes selected objects. 

6.4.2.7 Select all 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Select all - - ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active. 

Actions   
The "Edit" > "Select all" menu command selects all of the graphical objects (circuit elements, 
connections, comments and reference points). 
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6.4.2.8 Go to... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Go to... - - ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active. 

Actions   
The "Edit" > "Go to..." menu command opens a dialog box in which you can select and enter 
the search criteria: 

 
Action Result 
Searching by "Element number" The chosen function element is selected. 
Searching by "Name" The function element to which the specified element 

identifier is assigned is selected. 
Searching by "Page" The page with the page number selected by you in the 

current diagram is displayed. 
The page number is structured as follows: <Diagram 
name:H1V1>. 
This page number is indicated in the logic diagram view 
and on every printout at the bottom right. 

6.4.2.9 Insert comment 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Insert 
comment 

 - ✓ ✓ 

Requirements 
This menu command can only be selected if you are in the offline mode and the logic 
diagram is active. 

Actions   
Using the "Edit" > "Insert comment" menu command, you can insert a comment anywhere in 
the logic diagram. 
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6.4.2.10 Realign graphic 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Realign 
graphic 

 - ✓ ✓ 

Requirements 
This menu command can only be selected if you are in the offline mode and the logic 
diagram is active. 

Actions   
Using the "Edit" > "Realign graphic" menu command, you can optimize the arrangement of 
the safety circuit in the graphical view (in the logic diagram): 

● Overlaps are removed. 

● Function elements that overlap connections, each other, or page limits are moved. 

● Connections that overlap each other are moved. 

● The function elements are arranged according to the signal flow. 

6.4.2.11 Interrupt connection 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Interrupt 
connection 

 - ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active and an interrupted 
connection is selected. 

Actions   
The "Edit" > "Interrupt connection" menu command replaces the connecting line between 
two function elements with arrows to keep the configuration in the logic diagram clear. The 
connection is retained. 
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6.4.2.12 Redraw partial connection 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Redraw partial 
connection 

 - ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active and an interrupted 
connection is selected. 

Actions   
The "Edit" > "Redraw partial connection" menu command undoes the "Interrupt connection" 
command. The connecting line reappears. 

6.4.2.13 Add diagram 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Add diagram  - ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active and the "Online" 
connection to the safety relay is not available. 

Actions   
Using the "Edit" > "Add diagram" menu command, you can insert another diagram for your 
safety logic. 

Naming / renaming a diagram 
You can modify the diagram name by double-clicking on "Diagram 1" in the navigation 
window. Enter the desired name in the "Properties - Diagram" dialog box. 



Description of the software  
6.4 Description of the menu commands 

 Modular Safety System 3RK3 

178 System Manual, 06/2012, 9262530-02 Rev 004 

6.4.2.14 Remove diagram 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Remove 
diagram 

 - ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active. 

Actions   
The "Edit" > "Remove diagram" menu command deletes the current diagram from the 
navigation window. 

 

 Note 

It is only possible to split up the safety logic in connection with an offline project. 

If you have not created an offline configuration for a safety relay that is configured online, 
you can read the configuration from the safety relay and create a diagram using "Switching 
device > Open online" or "Download to PC". This automatically positions all of the function 
elements in the diagram. 

 

NOTICE  
Remove diagram 

If you delete a diagram, all of the connections, function elements, and comments will also 
be deleted with it. 
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6.4.2.15 Create macro... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Create macro - - - ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active and at least one 
function element is selected. 

Actions   
With the "Edit" > "Create macro" menu command, you create a macro from the selected 
function elements that you can reuse as a block in other projects. 

6.4.2.16 Edit terminal identifier... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Edit terminal 
identifier... 

- - ✓ ✓ 

Requirements 
This menu command can only be selected if a module or a real AS-i slave has been selected 
in the main system or subsystem. Only terminal identifiers of AS-i slaves that are monitored 
by MSS 3RK3 Advanced, MSS 3RK3 ASIsafe basic or MSS 3RK3 ASIsafe extended can be 
edited. 

Actions   
The "Edit" > "Edit terminal identifier..." menu command opens a dialog box for entering the 
identifiers for the terminals.  
The result only appears in the logic diagram when the relevant checkbox on the "Logic" tab 
under "Options" > "Settings of Modular Safety System ES" is selected. 
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6.4.2.17 Object properties... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Object 
properties 

- ✓ ✓ ✓ 

Requirements 
This menu command can only be selected if a module or a real AS-i slave has been selected 
in the main system or subsystem.  

Actions   
Using the "Edit" > "Object properties" menu command, you can call up the parameter 
assignment dialogs for the circuit elements of the safety circuit or for the modules. 

6.4.2.18 Check consistency 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Check 
consistency 

- ✓ ✓ ✓ 

Actions   
The "Edit" > "Check consistency" menu command is used to check the configuration for 
consistency. 

 

 Note 

A consistency check is carried out every time the configuration is saved. 
 

The errors found during this check appear in the output window "Consistency check results" 
below the work space. 
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6.4.2.19 Password for project access... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Password for 
project 
access... 

- ✓ ✓ ✓ 

Requirements 
This menu command can only be selected if an offline configuration is opened in MSS ES. 

Actions  
Using the "Edit" > "Password for project access..." menu command, you can perform the 
following actions:  

● Assigning the password for project access for the first time. 

● To modify the password for project access: enter the old password and then enter the 
new password twice. 

● To reset the password protection for project access: enter the old password and then 
leave the new password empty (do not enter any content) and confirm with "OK." 

● If the password for project access is lost: create a code for release with the "Forgotten 
password" button. 

Password prompt 
This password prompt appears in the "Enter password" dialog box when you open an offline 
configuration. 
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6.4.2.20 Forgot password 

Actions 
With the "Edit" > "Password for project access..." menu command, you can request a file for 
releasing the password from the Siemens hotline if the password is lost.   

Activate password 
If lost, activate the password as follows: 

● Under the "Password for project access..." menu command, click on the "Forgot 
password..." button. 

In the dialog box, enter "Forgot password": 

– Your name 

– Company name 

– The name of the file in which your password is encoded and saved 

● Send this file with the activation information to the Siemens hotline. 

technical-assistance@siemens.com 

● The Siemens hotline will send you a file with an activation code. 

● Import the file with the activation code using the "Edit" > "Password for project access..." 
menu command. This menu command can only be selected if you have previously 
created the activation data. 

● Assign a new project access password. 

 

 Note 

The activation code is only valid once. 
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6.4.2.21 Reset password for project access... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Reset 
password for 
project access 

- ✓ ✓ ✓ 

Requirements 
This menu command can only be selected if you have previously created the file for resetting 
forgotten passwords in the "Forgot password" dialog box using the "Password for project 
access" menu command.   

Actions 
Reset the password as follows: 

● In the "Reset password for project access" dialog box, click on the "Import" button. 

● In the "Open" window that follows, open the file containing the data saved for resetting 
the passwords, which you received from the Siemens hotline. 

● When prompted, assign a new password for project access. 

● After the password has been correctly assigned, you will receive confirmation that the 
access password has been successfully reset. 
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6.4.2.22 Password for device access... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Password for 
device access 

- ✓ ✓ ✓ 

Requirements 
This menu command can only be selected if there is a connection with the safety relay. 

Actions   
Using the "Edit" > "Password for device access..." menu command, you can carry out the 
following actions:  

● Assign/change/reset the password for device access 

● Set the protection level 

Password prompt 
This password prompt appears in the "Enter password" dialog box when you open a 
password-protected device access or when you open an online configuration. 

 

 Note 

If you have forgotten the password for device access, you must restore the factory settings 
of the MSS 3RK3. You must do this on the safety relay because commands in MSS ES are 
password-protected. You must then load the required configuration into the MSS 3RK3 
again. 
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6.4.2.23 Password for test mode... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Password for 
test mode... 

- ✓ ✓ ✓ 

Requirements 
This menu command can only be selected if there is a connection with the safety relay. 

Actions   
With the "Edit" > "Password for test mode..." menu command, you can assign and change a 
password for switching to test mode. 

Password prompt 
This password is prompted when you switch to test mode using the "Target system" > "Test 
mode" menu command. 

 

 Note 

If you have forgotten the password for changing to test mode, you must restore the factory 
settings of the MSS 3RK3. You can do this on the safety relay or by means of a command in 
the MSS ES. You must then load the required configuration into the MSS 3RK3 again. 
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6.4.2.24 Compare with file... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Compare with 
file... 

- - ✓ ✓ 

Actions   
The "Edit" > "Compare with file..." menu command compares the parameters in the current 
configuration with the parameters of a selected file. 

Result 
the system lists any differences. 

6.4.2.25 Compare with switching device... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Edit Compare with 
switching 
device... 

- - ✓ ✓ 

Actions   
The "Edit" > "Compare with switching device..." menu command compares the parameters in 
the current configuration with the parameters of a safety relay that has been opened online. 

Result 
the system lists any differences. 
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6.4.3 Target system menu 

6.4.3.1 Load to switching device... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system Load to 
switching 
device... 

 ✓ ✓ ✓ 

Actions   
The "Target system" > "Load to switching device..." menu command saves the parameters of 
the current configuration to a safety relay over an online connection. 

 

 Note 
Overwriting the parameters 

When you choose this menu command, the parameters in the safety relay are overwritten 
without you being prompted to confirm this. 

 

Transferring the parameters 
Transfer the parameters as follows: 

● Open an online connection to a safety relay via the connection dialog box. 

● Click "OK" to close the dialog box. 

● The program establishes a connection with the specified safety relay, checks whether the 
parameters that are currently displayed are compatible with this safety relay, and then 
loads all the parameters to the safety relay. 
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6.4.3.2 Load to PC... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system Load to PC...  ✓ ✓ ✓ 

Actions   
The "Target system" > "Load to PC..." menu command downloads the parameters currently 
stored in the safety relay to the PC over an online connection. 

 

 Note 
Overwriting the parameters 

When you choose this menu command, the parameters in the main memory are immediately 
overwritten. 

 

Transferring the data 
Transfer the data as follows: 

● Open an online connection to a safety relay via the connection dialog box. 

● Click "OK" to close the dialog box. 

● The program establishes a connection with the specified switching device and reads all 
parameters from the device to the PC. 
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6.4.3.3 Go offline 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system Go Offline  ✓ ✓ ✓ 

Actions   
The menu command "Target system" > "Go offline" terminates an existing online connection 
to a switching device. Before the connection is terminated, the system asks whether the 
current parameters are to be first downloaded to the switching device. 

The application remembers the status it was in prior to setting up the online connection. It 
does this by taking a snapshot of all important information in the background. (Which SIRIUS 
engineering product was launched? Is a file open? What values do the individual parameters 
have? …) 

After the online connection has been terminated, you are asked whether you want to keep 
the parameters that are currently displayed now that you are offline. 

● If you answer "No", the snapshot is restored. 

● If you answer "Yes", nothing happens (except that the online connection has been 
terminated). 

Exception: 

If the parameter values stored in the snapshot are identical to the parameter values that are 
currently displayed, the above question is skipped because both answers would have the 
same effect. 

6.4.3.4 Undo the fixed assignment of the interface 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system Undo the fixed 
assignment of 
the interface 

 ✓ ✓ ✓ 

Actions   
The "Target system" > "Undo the fixed assignment of the interface" menu command undoes 
the assignment set in the "Load to switching device" dialog box. By clicking the menu option 
or the corresponding icon in the toolbar, you reopen the connection dialog the next time the 
software attempts to establish an online connection. 
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6.4.3.5 PROFIBUS DP line view 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system PROFIBUS DP 
line view... 

- ✓ ✓ ✓ 

Displaying all the existing switching devices 
To display all the devices in the PROFIBUS segment, choose "Target System" > "Line view."     

Device representation 
 
Kind Representation Example 
Devices that can be edited with SIRIUS 
engineering. 

Device icon 

 
Devices that cannot be edited with 
SIRIUS engineering. 

Standard graphic: "Standard" 
 

Devices that signal a fault. Graphic with a gray background and a 
red border. 

 
Devices that were previously available 
but can no longer be accessed via 
PROFIBUS. 

Graphic with a gray background, a red 
border, and a red strike-through. 

 

Functions of the buttons 
To find the slaves in the bus segment, choose "Search for slaves". The PROFIBUS DP 
address and the PNO number are displayed. With some switching devices, the item 
designation (AKZ) is displayed too. 

To update the bus segment, choose "Update diagnosis". If some slaves are no longer 
available since the last time the bus segment was updated, these are crossed out. 

Display variants 
You can choose between two display variants: 

● Line topology 

● Meander 
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Other buttons 
To close the dialog, choose "Close". 

To call up an overview of device-specific data, choose "Identification". 
 

 Note 

With modular devices, you are prompted to specify the slot number of the slave (for more 
information, see "Slot number"). In this case, you must type in the slot number of the slave 
about which you want to see more information. 

 

To open a second SIRIUS engineering screen in which the device opens online, choose 
"Device Diagnostics". Alternatively, double-click the icon for a switching device with an AKZ.   

 

 Note 

With modular devices, you must specify the slot number of the device you want to diagnose.
 

To open a dialog in which you can set various display options for the line view, choose 
"Options". 

 
Figure 6-5 PROFIBUS DP line view 
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Slot numbers 

Entering the slot number   
You can enter a slot number for a modular device in the "Slot number" dialog. This dialog is 
displayed if a modular device is marked in the PROFIBUS DP line view and you click 
"Identification" or "Device diagnostics". 

You are prompted to type the slot number in an input field. In this case, the higher-level 
process refers to the device at the specified slot number. 

If there is no device at the specified slot number, you see an error message. If you select 
"Device diagnostics", you must specify the slot number of a SIRIUS device or the diagnosis 
will be terminated with an error message. 

Buttons 
● If you click "OK", the selected slot is saved. 

● To abort the higher-level process, click "Cancel". In this case, no identification data is 
displayed or the device is not diagnosed. 

● "Help" activates the context sensitive help. 

 
Figure 6-6 Slot numbers 
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Identification 

Device-specific data  
To call up an overview of device-specific data, choose "Identification". The overview can be 
used for system documentation purposes, for example.   

 

 
Figure 6-7 Overview of device-specific data 
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Options 

Setting options  
Access point: 
the scroll box contains the current access point for the application.   

Circular update: 
the "Circular update" checkbox allows you to set whether or not the line view is to be 
updated on a regular basis.   

Circular update interval: 
the circular update interval allows you to define the interval between two updates.   

 

 
Figure 6-8 "Options" dialog 
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6.4.3.6 Learn ASIsafe code tables... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system Learn ASIsafe 
code tables... 

-- ✓ ✓ ✓ 

Requirements 
This menu command can only be selected if the 3RK3 Advanced, 3RK3 ASIsafe basic or 
3RK3 ASIsafe extended central unit is configured and an online connection exists with a 
device. 

Actions   
With the "Target system" > "Learn ASIsafe code tables..." menu command, you can open the 
dialog box for teaching and diagnosing the code tables of the safety-related AS-i input 
slaves. 
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Slave status 0..15 / slave status 16..31   
 
Status Color Meaning 
Addr. 0 ... 31 -- Address of F slave 

red One configured AS-i slave is missing. 
yellow An AS-i slave that does not correspond to the target configuration has been 

detected. 
green A new AS-i slave has been detected. The AS-i slave has not be configured in MSS 

ES. 
Green with 
check mark 

The configured AS-i slave has been detected. The structure corresponds to the set 
configuration. 

Slave 

gray No AS-i slave exists at this address and no AS-i slave has been configured. 
red The code table is missing or is unknown. 
yellow At least 2 AS-i slaves have the same code table. 
green A new code table has been detected; the code tables can be learned. The code 

tables can be applied using the "Apply code tables" button. 
Green with 
check mark 

The configured code table has been detected. The structure corresponds to the set 
configuration. 

Code table 

gray No slave exists at this address and no slave has been configured. 
red The signal is erroneous. 
yellow A safety-related AS-i slave has been detected, but no code sequence transmitted. 
green The signal is 1. 
White The signal is 0. 

F-IN1 / 2 
F-OUT 1 ... 4 

gray This terminal does not exist. 
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Teach 
● Start teaching  

If the MSS 3RK3 Advanced, MSS 3RK3 ASIsafe basic or MSS 3RK3 ASIsafe extended 
detects missing code sequence tables during startup or after changes to the AS-i bus, an 
automatic attempt is made to teach these. 

NOTICE  
 

Each slave only transmits the code sequence if the inputs are closed. For that reason, 
you must set and reset all input contacts of the safety-related input slaves during the 
teaching phase and control the safety-related outputs, so that all code sequences can 
be determined.   

● Progress bar "Teaching in progress": 

The active teaching operation is displayed with a continuous progress bar. 

● Slaves after teaching: 

The slaves whose code sequence has been acquired by teaching and the total number of 
safety-related slaves with a code sequence are displayed. The progress is additionally 
displayed as a percentage. 

● "Apply code table" button: 

To apply the determined code tables and store them as targets, click the "Apply code 
tables" button. 

The code sequences are stored in the memory module. No reteaching of code sequences is 
therefore necessary when devices are replaced. 



Description of the software  
6.4 Description of the menu commands 

 Modular Safety System 3RK3 

198 System Manual, 06/2012, 9262530-02 Rev 004 

6.4.3.7 Prepare configuration test... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system Prepare 
configuration 
test... 

- ✓ ✓ ✓ 

The prerequisite for approving a configuration is a successfully carried out configuration test.   

Requirements 
This menu command can only be selected if offline configuration is opened. 

Actions   
Using the "Target system" > "Prepare configuration test..." menu command, you can create 
the printouts that you can use to support the configuration test.   

Create configuration data 
● Call up the "Target system" > "Prepare configuration test..." menu command. 

● In the dialog box that now opens, define the access path (local device interface, COM or 
PROFIBUS). 

● Confirm with "OK". A connection to the safety relay is established. 

● Then the following actions are carried out: 

– Comparison to see whether the opened configuration matches the online configuration 
in the MSS 3RK3. If the comparison reveals differences, it is aborted and an error 
message is displayed. 

– Consistency check (also of the logic diagram) 

– If an error is detected, the process is aborted. 

– The online configuration is opened. 

– Print preview in which you can decide whether the configuration data should be 
printed out or saved as a PDF file. 

Additional information 
You can find additional information on this topic in the "3RK3 Modular Safety System" 
manual in Chapter "Operation." 



 Description of the software 
 6.4 Description of the menu commands 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 199 

6.4.3.8 Approve configuration... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system Approve 
configuration... 

- ✓ ✓ ✓ 

Requirements 
This menu command can only be selected under the following conditions: 

● An offline configuration is open. 

● A connection to the safety relay exists. 

● MSS 3RK3 is in configuring mode. 

 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 
Release of the configuration only after completed function test 

A configuration may only be released if a complete function test of the configuration has 
been successfully completed. 

 

Actions   
Using the "Target system" > "Approve configuration..." menu command, you create a file with 
the release data for a configuration.   
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Approve configuration 
To create a printout with the required configuration release specifications, proceed as 
follows:   

● Call up the "Target system" > "Approve configuration..." menu command. 

● In the dialog box that now opens, define the access path (local device interface, COM or 
PROFIBUS). 

● Confirm with "OK". A connection to the safety relay is established. 

● Then the following actions are carried out: 

– Comparison to see whether the opened configuration matches the online configuration 
in the MSS 3RK3. If not, an error message is displayed. 

– Displaying the dialog box 

The CRC is displayed. Check whether this matches the CRC of the system 
documentation. 

Then enter the following data: 

◆ Your name 

◆ Your company name 

– Password prompt for device access, if assigned. 

– Print preview in which you can decide whether the release data should be printed out 
or saved as a PDF file.  

Result 
After the configuration is released, you can switch the MSS 3RK3 to safety mode. 
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6.4.3.9 Cancel configuration release 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system Cancel 
configuration 
release 

- ✓ ✓ ✓ 

Requirements   
This menu command can only be selected under the following conditions: 

● A safety relay is opened online 

● The safety relay is in "configuring mode." 

Actions   
The "Target system" > "Cancel configuration release" menu command cancels the release of 
the configuration on the MSS 3RK3. 

6.4.3.10 Configuring mode 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system Configuring 
mode 

- ✓ ✓ ✓ 

Actions 
Using the "Target system" > "Configuring mode" menu command, you switch the operating 
mode of the MSS 3RK3 to configuring mode. 

Result 
In configuring mode, the MSS 3RK3 will be in the following condition:   

● The safety relay is ready to accept new configuration data. 

● No logic processing is performed. 



Description of the software  
6.4 Description of the menu commands 

 Modular Safety System 3RK3 

202 System Manual, 06/2012, 9262530-02 Rev 004 

6.4.3.11 Test mode 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system Test mode - - ✓ ✓ 

Requirements 
This menu command can only be selected under the following conditions: 

● A safety relay is opened online 

● The safety relay is in "configuring mode." 

● The configuration must be error-free. However, the configuration does not have to be 
released. 

● To switch to test mode, you must enter the password for "Switching to test mode". 

 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 

In this operating mode, the safety program is executed and the outputs are controlled 
according to the safety program. 

For this reason, you must ensure that the safety of your system is ensured by means of 
organizational measures. 

 

Actions 
Using the "Target system" > "Test mode" menu command, you switch the operating mode of 
the target system to test mode. 

Application   
You can use this operating mode for support when conducting the prescribed function test of 
the safety circuit. For example, you can force the outputs of function elements in test mode. 
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6.4.3.12 Safety mode 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system Safety mode - ✓ ✓ ✓ 

Requirements 
This menu command can only be selected under the following conditions: 

● A safety relay is opened online. 

● The safety relay is in "configuring mode." 

● The configuration must be fault-free and released. 

Actions 
Using the "Target system" > "Safety mode" menu command, you switch the operating mode 
of the target system to safety mode. 

Result 
In safety mode, the MSS 3RK3 will be in the following condition:   

● The configured safety circuit is active. 

● The outputs are controlled according to the "Circuit parameter assignment" (= circuit 
diagram). 
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6.4.3.13 Commands... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system Commands... - - ✓ ✓ 

Requirements 
This menu command can only be selected under the following conditions: 

● A safety relay is opened online. 

● The available commands also depend on the mode; see the table below. 

Actions 
Using the "Target system" > "Commands" menu command, you can activate device 
commands as additional functions on the safety relay. 

The procedure is as follows: 

● Select the "Target system" > "Commands" menu command. The "Commands" dialog box 
opens. 

● Select a command from the drop down list. 

● Send the command to the safety relay using the "Send" button. 

You can start another command once the previous command is executed and the "Send" 
button is active again. 

Monitoring command processing   
A list in the "Commands" dialog box shows the current status of the command processing 
and the feedback messages from the diagnostics data memory determined by the MSS ES 
safety relay. The list is expanded with each sent command. It is deleted when the dialog box 
is closed. 



 Description of the software 
 6.4 Description of the menu commands 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 205 

Device commands   
The following device commands are available: 

 
Device 
commands 

Description Can be activated in Feedback 

Factory settings   All of the parameter values are reset to 
their default values. 
After the factory settings have been 
restored, the device executes a restart 
autonomously, the connection to the 
safety relay is interrupted, and the 
configuration is closed. 

• Configuring 
mode 

• Factory settings restored 
• The restart is executed. 

Reset   Tripping, i.e., a shutdown due to a 
protection violation, can be 
acknowledged using this command. All 
of the errors whose causes have been 
eliminated are acknowledged together 

• Configuring 
mode 

• Test mode 
• Safety mode 

• Reset implemented. 
• Reset not possible. 

Restart   Causes a "hardware reset" of the safety 
relay.  

• Configuring 
mode 

• Test mode 
• Safety mode 

• The restart is carried out. 

Delete memory 
module   

Deletes the data on the memory module 
of the connected safety relay. 
Note: 
With this command, the connection to 
the safety relay is interrupted and the 
configuration is closed. 
After the memory module has been 
deleted, a reset (using the RESET 
button) or a complete restart of the safety 
relay has to be performed as otherwise 
an online connection to the safety relay 
is not possible. 

• Configuring 
mode 

• Memory module not plugged in 
• Memory module defective 
• Programming active 
• Programming successful 
• Programming error 

Cancel access 
rights 

Cancels all passwords, i.e., all access 
rights are revoked. 

• Configuring 
mode 

• Safety mode 

• Access authorization exists: No 

Apply code 
tables 

The determined code tables are applied 
and stored as the target setting. 

• Configuring 
mode 

• Test mode 
• Safety mode 

• Code tables missing 
• 8x4-bit code sequence errors 
• Multiple code tables 
• New codes tables 
• Code tables known 



Description of the software  
6.4 Description of the menu commands 

 Modular Safety System 3RK3 

206 System Manual, 06/2012, 9262530-02 Rev 004 

Device 
commands 

Description Can be activated in Feedback 

Open access 
path 

The required access path is opened by 
the safety relay (if no other access path 
is already open): Write/controlling access

• Configuring 
mode 

• Safety mode 

• Access path to fieldbus control is 
open 

• Access path to fieldbus MSS ES 
is open 

• Access path to device interface is 
open 

Close access 
path 

The open access path is closed • Configuring 
mode 

• Safety mode 

• Access path is closed 

6.4.3.14 Diagnostics configuration 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system Diagnostics 
configuration 

- ✓ ✓ ✓ 

Actions   
Using the "Target system" > "Diagnostics configuration" menu command, activate the 
following submenu options: 

Module status 
● Module status: You activate the module status display which is displayed in color in the 

configuration table. 

● This menu command can only be selected if the following conditions are met: 

– A safety relay is opened online. 

– The main system / subsystem is activated in the navigation window. 

Device messages   
● Device messages: You activate the "Device messages" dialog box. 

● This menu command can only be selected if the following conditions are met: 

– A safety relay is opened online. 
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6.4.3.15 Diagnostics logic 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Target system Diagnostics 
logic 

- ✓ ✓ ✓ 

Actions 
Using the "Target system" > "Diagnostics logic" menu command, activate the following 
submenu options: 

Monitoring    
● The "Target system" > "Diagnostics logic" > "Monitor" menu command shows the 

statuses of the inputs and outputs, of the function elements and of the connections 
between the function elements according to their status. 

● This menu command can only be selected if the following conditions are met: 

– A safety relay is opened online. 

– The device is in safety or test mode. 

– The logic diagram with the safety circuit is activated. 

Element messages...   
● The "Target system" > "Diagnostics logic" > "Element messages" menu command shows 

the status messages for a function element that is selected in the logic diagram. You can 
monitor status messages of several function elements simultaneously. 

● This menu command can only be selected if the following conditions are met: 

– The safety relay is opened online. 

– The device is in safety or test mode. 

– The logic diagram with the safety circuit is active. 

– At least one function element must be selected. 
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Element reset   
● The "Target system" > "Diagnostics logic" > "Element reset" menu command 

acknowledges the errors of one or several selected function elements. 

● This menu command can only be selected if the following conditions are met: 

– A safety relay is opened online. 

– The device is in safety or test mode. 

– The logic diagram with the safety circuit is activated. 

– One or more function elements are selected. 

Forcing   
● The "Target system" > "Diagnostics logic" > "Force" menu command preassigns fixed 

values to the outputs of function elements (= forcing). You can select the following 
assignments: 

– Force to "0" 

– Force to "1" 

– Cancel forcing 

– Cancel forcing (all) 

● This menu command can only be selected if the following conditions are met: 

– The "test mode" is activated. 

– The logic diagram with the safety circuit is activated. 

– An online connection is available. 

– At least one connection of a function element is selected. 
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6.4.4 View menu 

6.4.4.1 Zoom in 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

View Zoom in  ✓ ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active. 

Actions   
The "View" > "Zoom in" command enlarges the current view by one zoom level. 

6.4.4.2 Zoom out 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

View Zoom out  ✓ ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active. 

Actions   
The "View" > "Zoom out" command reduces the current view by one zoom level. 
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6.4.4.3 Zoom dialog 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

View Zoom dialog  - ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active. 

Actions   
The "View" > "Zoom dialog" menu command opens the zoom dialog box of the logic 
diagram. A zoom level can be selected there. 

6.4.4.4 Overall view 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

View Overall view  - ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active. 

Actions   
Using the "View" > "Overall view" menu command, you can set the zoom level in such a way 
that the entire diagram is visible on the screen. 
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6.4.4.5 Display settings 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

View Display 
settings 

 - ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active. 

Actions   
With the "View" > "Display properties" menu command, you open the "Display properties" 
dialog box. You can set the display properties there. 

6.4.4.6 Grid settings 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

View Grid setting  - ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active. 

Actions   
With the "View" > "Grid settings" menu command, you open the "Screen grid" dialog box. 
You can set the grid there. 
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6.4.4.7 Move diagram 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

View Move diagram  - ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active. 

Actions   
With the "View" > "Move diagram" menu command, you switch to move mode. The diagram 
can only be moved with the mouse. 

6.4.4.8 Highlight signal flow 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

View Highlight signal 
flow 

 - ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active and an element (e.g. 
a function element or connection) is selected. 

Actions   
The "View" > "Highlight signal flow" menu command visually highlights all of the elements 
located in the signal flow to the left (input side) and right (output side) of the selected 
element. 
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6.4.4.9 Delete highlighting 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

View Delete 
highlighting 

 - ✓ ✓ 

Requirements 
This menu command can only be selected if the logic diagram is active and a signal flow is 
highlighted. 

Actions   
The "View" > "Delete highlighting" menu command deletes all markings that resulted from 
the "Highlight signal flow" menu command. 

6.4.4.10 Navigation window 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

View Navigation 
window 

 ✓ ✓ ✓ 

Actions   
The "View" > "Navigation window" menu command shows/hides the navigation window. 
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6.4.4.11 Output window 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

View Output window  ✓ ✓ ✓ 

Actions   
The "View" > "Output window" menu command shows/hides the output window. 

6.4.4.12 Catalog window 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

View Catalog 
window 

 ✓ ✓ ✓ 

Actions   
The "View" > "Catalog window" menu command shows/hides the catalog window. 
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6.4.4.13 Minimize / restore online dialogs 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

View Minimize / 
restore online 
dialogs 

 - ✓ ✓ 

Requirements 
A safety relay is opened online and at least one online dialog box is open. 

Actions   
Use the "View" > "Minimize/restore online dialogs" menu command to collectively minimize 
or restore the display of all open online dialog boxes. 

Which commands are executed? 
● If an online dialog box is open, the menu command executes the function: "Minimize all 

open online dialog boxes". 

● If all open online dialog boxes are minimized, the menu command executes the function: 
"Restore all minimized online dialog boxes". 
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6.4.5 Options menu 

6.4.5.1 Basic settings... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Options Basic 
Settings... 

- ✓ ✓ ✓ 

Changing the basic settings   
The menu command "Options" > "Basic settings..." starts a dialog box in which you can 
change the basic behavior and appearance of SIRIUS engineering. Any changes you make 
do not become effective until you choose "OK" or "Apply".  

Change options 
You can make the following settings in this dialog box: 

● "Language"  

All available languages are shown in the selection list. When you change the language, 
this affects all the displayed texts in MSS ES (menu texts, dialog texts, parameter names, 
etc.). Other installed SIRIUS engineering products are not affected. Switching to a 
different language does not in any way affect how SIRIUS engineering functions. 

● "Show picture at startup of SIRIUS engineering" 

If you activate this checkbox, SIRIUS engineering displays a picture for a few seconds in 
the middle of the screen when the program starts. 



 Description of the software 
 6.4 Description of the menu commands 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 217 

● In "Offline" state: Automatic "Online" after “Load to switching device” 

This setting is only effective if you choose "Target system" > "Load to switching device" 
before an online connection to a safety relay has been established. In this case, the 
program establishes a new connection, transfers the parameters to the device, and then 
terminates the connection immediately afterwards. 

The behavior at this point depends on whether you have activated the checkbox: In 
"Offline" state: Automatic "Online" after "Load to switching device": 

– Activated: the program reestablishes a connection with the same device, loads its 
parameters to the PC, and maintains the online connection. You can check the 
parameters and determine how they affect the behavior of the device. 

– Deactivated: no further automatic actions are carried out. The program has the same 
status as it did before the action "Load to switching device". 

● "Show startup wizard"  

If you activate this checkbox, a startup wizard opens when you start MSS ES. With the 
help of this startup wizard, you can: 

– Create a new project 

– Open an existing project 

– Open a project online with an existing connection to the safety relay 
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6.4.5.2 Settings of Modular Safety System ES - "General settings" tab 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Options Modular Safety 
System ES 
settings 

- ✓ ✓ ✓ 

Actions   
Using the "Options" > "Settings of Modular Safety System ES" menu command, you can set 
the desired behavior of the MSS ES. 

"General settings" tab 
The "General settings" tab contains the following settings: 

● "Display object properties automatically on insert": 

If you select "Display object properties automatically on insert," a dialog box for the 
properties of the respective object (in which you can set the parameters) will immediately 
appear after a module is inserted in the hardware configuration tables or after a function 
element is inserted in the logic diagram. 

● "Show consistency check messages when saving" 

● "Cyclic data updates in online dialogs every ... seconds": 

The data sets required for open online dialog boxes are read from the safety relay in this 
time interval. 
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6.4.5.3 Settings of Modular Safety System ES - "Download settings" tab 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Options Modular Safety 
System ES 
settings 

- ✓ ✓ ✓ 

Actions   
Using the "Options" > "Settings of Modular Safety System ES" menu command, you can set 
the desired behavior of the MSS ES. 

"Download settings" tab 
In the "Download settings" tab, you can define which parts of the system documentation are 
to be loaded to the safety relay when the configuration is downloaded: 

● Equipment identifier (BMK) 

● Element name 

● Element comment 

● Terminal identifier 

Save memory space  
You do not have to load the system documentation to the safety relay because the system 
documentation is not evaluated by the safety relay and is therefore not needed for the safety 
relay to function. 
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6.4.5.4 Settings of Modular Safety System ES - "Logic" tab 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Options Modular Safety 
System ES 
settings 

- ✓ ✓ ✓ 

Actions   
Using the "Options" > "Settings of Modular Safety System ES" menu command, you can set 
the desired behavior of the MSS ES. 

"Logic" tab 
The "Logic" tab contains the following settings for the display options: 

● "Label page transitions of connections also on screen": 

Defines whether the labels of the connections on the page transitions will be visible on 
the screen. 

● "Displaying element comments"  

The comments of the function elements are visible in the logic diagram. 

● "Display terminal identifiers":  

Here you can set whether the terminal identifiers are to be displayed. 

● "Retain element numbers in macros if possible"  

If the element number is not yet used in the current diagram, the element number that the 
function element had when the macro was created (and that is stored in it) will be 
assigned to the function element again when it is reused. 

If this setting is deactivated, the next free element number will be assigned to the function 
element, starting at 1. 

● "Display settings" button: 

– Select a display element. 

– The current color of the selected element is specified. 

– You can change the color of the selected element. 

– You can restore the basic settings. 

– Confirm with "OK," to apply your changes. 

– You will find additional information in Chapter "Display settings (Page 211)." 
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● "Realign graphic" button: 

– Here, you can define the layout strategy by selecting whether and how to "Avoid 
connections crossing function elements." 

◆ Interrupt connections if possible 

◆ Move function elements down 

– You can also apply a "Standard column grid across all subnetworks of a function 
diagram" if you select the corresponding checkbox. 

– You can position the output cells in a separate column on the far right (for each 
subnetwork) if you select the lowermost checkbox. 

– Confirm with "OK," to apply your changes. 

● "Screen grid" button: 

– The graphical grid influences the moving of graphical elements. You can choose 
whether objects are to be aligned to the grid and / or whether objects are to be aligned 
to other objects. Select the appropriate checkboxes for this. 

– You can set the grid size (mm) in "Distance." 

– You can define how the grid will be displayed by setting which grid points will be 
shown. 

– You can activate or deactivate display of the grid by selecting the relevant 
checkboxes. 

– Confirm with "OK," to apply your changes. 

– You will find additional information in Chapter "Grids and lines (Page 261)." 
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6.4.5.5 Cross references 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Options Cross 
references 

- - ✓ ✓ 

Actions   
The "Options" > "Cross references" menu command shows the cross references in tabular 
form in the output window. 

Structure of the cross reference list 
 
Operand Kind Type Usage 

location 
Diagram Page 

Module 
Channel 
Terminal identifier 
Device status function 

Access: 
WR = write 
RO = read 

Type of 
operand

Element type 
and element 
number of the 
function 
element. 

Name of the 
diagram in which 
the function 
element is located. 

Page on which the function 
block that is connected to 
the function element is 
located. 

 
 

 Note 

The cross reference list only displays the operands used in the safety circuit. 
 

Edit cross references 
With the context menu (right mouse button) or by double-clicking on the item, you can go to 
the position where the cross reference is used in order to edit it. 
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6.4.5.6 Symbol list 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Options Symbol list - - ✓ ✓ 

Actions 
The "Options" > "Symbol list" menu command shows the plant identifier you assigned in the 
form of a table in the output window.   

To improve the legibility of the configuration, you can assign identifiers for parts of your 
configuration data within the context of the system documentation. The symbol list gives an 
overview of the identifiers assigned by you, their assignments, and the type. 

Example of a symbol list 
 
Identifier Assignment Type 
Anna SLOT5 Equipment identifier (BMK) 
Terminal_1 SLOT3_F-IN1 Terminal identifier 
Terminal_2 SLOT4_Q6 Terminal identifier 
Press - Plant identifier 
Hall 1 - Location identifier 
EMERGENCY STOP_1 EMERGENCY STOP [35] Name 
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Editing entries in the symbol list 
You can perform the following actions in the context menu (right mouse button): 

● Delete: The selected identifier is deleted. 

● Editing: The selected identifier can be changed (can also be activated if the identifier is 
selected and you click on it again or press F2). 

If you change or delete identifiers, then the display in the respective view is immediately 
updated. 

● Go to: You jump to the corresponding icon, which is then selected (can also be activated 
by double-clicking). 

Sorting: 

● If you click on the column header in the columns "Identifier" and "Assignment," the items 
will be sorted alphabetically by this column. 

● Clicking on the "Type" column header sorts the column as follows: Equipment identifier, 
Name, Comment, Terminal identifier, Location identifier, Plant identifier. 

 

 Note 
Editing rules 

You cannot assign the same identifier twice. 
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6.4.5.7 Terminal list 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Options Terminal list - - ✓ ✓ 

Actions   
The "Options" > "Terminal list" menu command lists all available terminals of the slot and 
subslot (AS-i-) modules in the output window with the relevant terminal identifier (right-hand 
column) and the interconnection status in the logic diagram (left-hand column).   

The terminals are also shown for which no identifier has been assigned and also those 
terminals that are not yet interconnected. 

Example of a terminal list 
 
Terminal Terminal marking 
ASi#02_IN1 Pushbutton_1 
SLOT3_F-IN1 Terminal_1 

Editing entries in the terminal list 
You can perform the following actions in the context menu (right mouse button): 

● Delete: The selected terminal identifier is deleted. 

● Editing: The selected terminal identifier can be changed (can even be activated if the 
identifier is selected and you click on it again or press F2). 

If you change or delete identifiers, then the display in the respective view is immediately 
updated. 

● Go to: Interconnecting terminal is in the logic will take you to the corresponding function 
element and select it (can also be activated by double-clicking). 

Sorting:  

● Clicking on the column header of the first column sorts the items of this column by their 
interconnection status. 

● Clicking on the relevant column header sorts the items of the "Terminal" and "Terminal 
identifier" columns alphabetically. 

  Note 
Editing rules 

You cannot assign the same terminal identifier twice. 
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6.4.5.8 Export macros... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Options Export 
macros... 

- - - ✓ 

Actions   
With the "Options" > "Export macro..." menu command, you can save the existing macros on 
any data medium to make it available to other users. 

See also Chapter "Macro functionality (Page 263)." 

6.4.5.9 Import macros... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Options Import 
macros... 

- - - ✓ 

Actions   
With the "Options" > "Import macro..." menu command, you can import exported macros 
from other users to use them in your project. 

See also Chapter "Macro functionality (Page 263)" 



 Description of the software 
 6.4 Description of the menu commands 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 227 

6.4.5.10 Release information... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Options Release 
information... 

- ✓ ✓ ✓ 

Requirements 
This menu command can only be activated if the configuration has been released. 

Actions   
The "Options" > "Release information..." menu command displays the following release data 
in the "Display release information" dialog box for the configuration currently in the MSS ES:   

● Name of the person releasing 

● Name of the company of the person releasing 

● Release status 

● Configuration CRC 

● Release time stamp 

The release information can be printed out via the "Print" button.   
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6.4.5.11 Set PG/PC interface... 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Options Set the PG/PC 
interface... 

- - - ✓ 

Actions 
The "Options" > "Set the PG/PC interface..." menu command opens a dialog box in which 
you can set the PG/PC interface. 

More detailed information in the help file   
You will find detailed information in the S7DOS help file s7epatda.chm in the Windows 
system directory. Depending on the configuration of your operating system, you will find the 
help file either in C:\Windows\system32\s7epatda.chm or in 
C:\Winnt\system32\s7epatda.chm. 

This can only be set if communication with SIRIUS engineering is supported via PROFIBUS 
DP, PROFINET IO or the SIMATIC network. 
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6.4.6 Help Menu 

6.4.6.1 Help topics 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Help Help topics  ✓ ✓ ✓ 

Actions   
The menu command "Help" > "Help Topics" starts the online help for MSS ESS. 

The online help is structured as follows: 

● The left window contains the table of contents, index, and find function of the online help. 

● The main window contains the individual help topics. 

● You can find topics of relevance to all SIRIUS engineering products in the higher-level 
online help. 

6.4.6.2 Info 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Help Info - ✓ ✓ ✓ 

Actions   
The "Help" > "Info" menu command provides information about the following: 

● All the SIRIUS engineering products that have been installed 

● Copyright 

● Technical assistance 
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6.5 Identification and configuration 

6.5.1 Identification 

6.5.1.1 Central unit 

"Central unit" view  
The "Identification" > "Central unit" view contains an overview of the device-specific 
information. You can read from the file using the "Switching device" > "Open" menu 
command or from the central unit using the "Switching device" > "Open online" command. 

 

 Note 

When you create a new safety relay, the content will be empty.  

If no 3RK3 central unit is configured, all the fields are gray in offline mode. 
If a central unit is configured, the contents are partially available in offline mode. They are all 
available in online mode. 

 

Information in the "Central unit" dialog box    
The "Identification" > "Central unit" view contains the following information:  

 
Information Meaning 
Order No. Order number of the safety relay. 
Short designation Short designation of the safety relay, e.g. 3RK3 Basic. 
System Designation of the line of products, e.g. "3RK3 Modular Safety System". 
Manufacturer Name of manufacturer, e.g. "Siemens AG" 
PI profile Gives information about the PROFIBUS profile supported by the safety 

relay and the line of products belonging to the safety relay. 
This field is gray in offline mode. 

Device family Designation of the overall device family, e.g. safety-related switching 
device. 

Device subfamily Designation of the subfamily that is subordinate to the switching device 
family, devices with the same process view and data sets of identical 
content, e.g. safety relays. 

Device class Designation of the device class that is subordinate to the subfamily, e.g. 
modular. 

Function group Describes the device-specific, identical characteristics within a device 
subfamily, e.g. use of the same parameters from the parameter data set. 

Fieldbus interface Information on the fieldbus interface (e.g. "PROFIBUS DP") supported by 
the safety relay. 
This field is gray in offline mode. 
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Information Meaning 
System interface Information on the internal system interface supported by the safety relay. 

This field is gray in offline mode. 
Device interface Information on the local interface supported by the safety relay. 

This field is gray in offline mode. 
ID no. Specifies the communication ID number of the safety relay. 

This field is gray in offline mode. 
HW revision level Product version which is entered prior to delivery. 

This field is gray in offline mode. 
FW revision level Information on the version of the device firmware. 

This field is gray in offline mode. 
Revision counter Labels changes of HW-related parameters and cannot be edited. 

This field is gray in offline mode. 
I&M version Version of the I&M (Identification & Maintenance) function in the safety 

relay. 
This field is gray in offline mode. 

Supported I&M data Specify which I&M blocks are supported by the safety relay. 
This field is gray in offline mode. 

Serial number Contains a production label with production information. 
This field is gray in offline mode. 

Time stamp The time stamp is written to the safety relay when the safety relay is 
named in the factory and specifies the date and time of production. 
This field is gray in offline mode. 
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6.5.1.2 Marking 

"Identification" view    
In the "Identification" > "Marking" view, you can enter descriptions about the safety relay or 
system.  

The descriptions are part of the plant documentation. You can read from the file using the 
"Switching device" > "Open" menu command or from the safety relay using the "Switching 
device" > "Open online" menu command.   

 
Information Meaning 
Plant identifier The plant identifier specifies in which part of the plant a safety relay will 

be installed and operated. Max length: 32 characters. 
Location identifier The location identifier specifies at which location in the plant a safety 

relay will be installed and operated. Max length: 22 characters. 
Installation date Enter the date the safety relay was installed in the plant here. Max. 

length: 16 characters. 
Description You can enter additional information here. Max length: 54 characters 
Author You can enter the name of the author of the entries here. 
Comment Here you can store additional information in the system or in the safety 

relay. 
Max. length for the Author and Comment input fields, taken together: 187 
characters. 

 
 

 Note 

This view cannot be edited in the online view. 
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6.5.1.3 Project 

"Project" view    
In the "Identification" > "Project" view, you can enter the following descriptions:  

● Project name 

● Name of configuration engineer 

● Configuration engineer's company name 

 
Information Meaning 
Project name Enter at least one character 
Name of configuration engineer Enter at least one character 
Configuration engineer's 
company name 

Enter at least one character 

Configuration CRC   Cyclic Redundancy Check which saves all safety-relevant 
configuration data (4 bytes). 
The transfer of safety-relevant configuration data through insecure 
communication channels must be secured for the MSS 3RK3 
safety relay. 

Configuration time stamp The MSS ES enters the current time stamp when a configuration 
is saved. 

Configuration released Release status of the configuration. Details can be determined via 
"Options" > "Release information". 

Configuring tool Specifies the software with which the opened configuration was 
created, e.g. Modular Safety System ES 

Version of the configuring tool Specifies the version of the software with which the opened 
configuration was created, e.g. K1.0.2.0 

Number of slot modules Number of slot modules in the device configuration 
Number of subslot modules Number of subslot modules (AS-i slaves) in the device 

configuration 
Number of function elements Number of function elements in the device parameter assignment. 
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6.5.1.4 Messages during the consistency check - Identification 
The consistency check is used to check whether the configuration is correct and complete.    

A consistency check is carried out for the following actions: 

● With the "Edit" > "Check consistency" menu command 

● When a configuration is saved 

● With the "Target system" > "Prepare configuration test..." menu command 

The messages are displayed in the output window. By clicking on a message in the output 
window, you can jump to the corresponding error location. 

The following messages may appear during the consistency check: 

 
Message Kind Message text Remedy 
Name of configuration 
engineer is missing 

Error "General configuration: Name of 
configuration engineer is missing." 

Enter the name of the configuration 
engineer in the "Project" parameter 
assignment view 

Name of the the 
configuration engineer's 
company is missing 

Error "General configuration: Name of 
configuration engineer's company is 
missing." 

Enter the name of the company of the 
configuration engineer in the "Project" 
parameter assignment view 

Project name is missing Error "General configuration: Project name 
is missing." 

Enter the project name in the "Project" 
parameter assignment view 

The memory module is full Error "General configuration: The memory 
of the memory module is full. Reduce 
the plant documentation or optimize 
the logic (if applicable). 

Reduce the memory requirements on 
the memory module 
You will find more information in 
Chapter "Settings of Modular Safety 
System ES - "Download settings" tab 
(Page 219)" 
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6.5.2 Configuration 

6.5.2.1 Main system 

Configuration   
The hardware of the MSS 3RK3 is configured in the "Main system" configuration table. The 
rows represent the slots of the MSS 3RK3: The fixed slots 1 to 3 and the maximum number 
of expansion modules supported by the selectable 3RK3 central unit.  

 

 Note 
Procedures for the configuration 

The procedure for configuration in MSS ES has an effect on various functions.  

There are two ways of configuring in MSS ES: 
1. You start with configuration of the hardware structure and then configure the logic. Once 

you have configured an MSS 3RK3 Basic, all non-supported function elements will no 
longer be available in the catalog window of the logic diagram. 

2. You start with configuration of the logic and then configure the hardware configuration. If 
you use the function elements in the logic diagram that are not supported by 
MSS 3RK3 Basic, the MSS 3RK3 Basic will no longer be available in the hardware 
catalog of the configuration. 

 

 

Slot assignment    
Slots are assigned to the following modules: 

● MSS slot 1: HMI modules (optional) 

● MSS slot 2: Interface module (optional) 

● MSS slot 3: Central units 

● MSS slot 4 or higher: Expansion module (optional) 

Modules can be assigned to slots in 2 different manners: 

● Drag the module out of the catalog window and drop it into the table. 
When a module is selected in the catalog window, the rows in the table where the module 
can be positioned are highlighted in color. 

● Select the row in the table where the module is to be inserted. 
Double-click on the module in the catalog window that you want to add to the table. If no 
row is selected, the module is inserted in the first possible row. 
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Changing and editing entries in the configuration table 
You can edit positioned modules directly in the configuration table: 

● You can delete modules unless their inputs/outputs are already connected in the safety 
circuit. In this case, all interconnections must first be removed. If you confirm the 
message with "Yes", this occurs automatically. 

● You can drag and drop modules from one row to another. 

● When you switch or move modules, the assignment of the affected inputs/outputs in the 
safety circuit is adapted accordingly. 

● You can copy and paste expansion modules including their parameters or swap their 
slots using the command "Swap slot". 

  Note 

An equipment identifier must not exist twice. Therefore a number is added to the 
equipment identifier when copying. If the maximum number of characters is exceeded by 
adding the number, the equipment identifier is shortened.   

Editing the configuration table using the context menu 
By pressing the right mouse button and selecting a module in the configuration table, a 
context menu pops up with which you can edit the entries in the table. 

"Swap slot" command 
You can swap slots of modules. 

"Delete blank rows automatically" command 
With this command you can correct an erroneous configuration in the main system. There 
will be no more blank rows between modules in the table. 

The assignment of the affected inputs/outputs in the safety circuit is adapted accordingly, 
just as it is when modules are moved. 

"Edit terminal identifier" command   
The dialog box shows you the existing terminals in the "Terminal" column and you can edit 
the following: 

● "Terminal identifer" column: A terminal designation can be entered (max. 32 characters). 

● "Supplement identifiers" button: Inserts the terminal identifiers in the unassigned fields. 

● "Delete identifiers" button: Deletes the terminal identifiers in the selected fields. 
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"Object properties" command 
Information on the selected module is displayed in this properties window, and you can 
define parameters in it. 

"Optimize column width" command 
Adapts the column width optimally to the column contents. 

Further editing options in the configuration view 
In the configuration view, you have the following editing options: 

● Determine online  

When an MSS 3RK3 is connected, you can adopt the actual configuration, i.e. the 
hardware configuration of the MSS 3RK3, by clicking the "Determine online" button. The 
user is asked if the current configuration is to be replaced. 

  Note 
Diagnostics display 

The connected diagnostic display is not recognized by "Determine online." 

● Show hardware configuration  

When the checkbox "Show hardware configuration" is selected, an image with the 
modules and their required arrangement is shown in the area below the checkbox. 

● Consistency check  

The user can execute a consistency check by means of the menu command "Edit" > 
"Check consistency" to determine whether the configuration is possible. 

6.5.2.2 Swap slots 
If, for example, all the slots are assigned and you want to reorganize your configuration, you 
can swap the position of two expansion modules by means of the dialog "Swap slots":    

● Select the slot in the configuration table where one of the two expansion modules is 
positioned. 

● Click the right mouse button. 

● Select "Swap slot" from the context menu. 

● The "Swap slot" dialog is opened. 

● Select the slot in the drop-down list where the other expansion module is positioned. 

Result 
The slots of the two modules will be swapped. 
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6.5.2.3 Properties of the HMI module 

Description     
You can open the "Properties of HMI module" dialog box as follows: 

● Double-click on the module in the configuration table. 

● Choose the "Object properties" menu option from the context menu (right mouse button). 

● In the "Options" > "Settings of Modular Safety System ES" menu under the "General 
settings" tab, select the "Display object properties automatically on insert" checkbox. The 
properties dialog box will then pop up automatically when you drag the module from the 
catalog window into the configuration table of the project window. 

 

Parameters 
The parameters are described in the following table: 

 
Parameter name Parameter value 
Configuration 
Module The designation of the selected module is displayed here. The field has a gray background 

and cannot be changed by the user. 
Order No. The order number of the selected module is shown here. The field has a gray background 

and cannot be changed by the user. 
Firmware The firmware of the selected module is shown here. The field has a gray background and 

cannot be changed by the user. 
Equipment identifier  Here you can specify a user-defined equipment identifier (max. 32 characters) for the 

selected module and assign it to inputs and outputs. 
Inputs The number of inputs of the selected module is shown here. 
Outputs The number of outputs of the selected module is shown here. 

6.5.2.4 Properties of interface module 

Description     
You can open the "Properties of interface module" dialog box as follows: 

● Double-click on a module in the configuration table. 

● Choose the "Object properties" menu option from the context menu (right mouse button). 

● In the "Options" > "Settings of Modular Safety System ES" menu under the "General 
settings" tab, select the "Display object properties automatically on insert" checkbox. The 
properties dialog box will then pop up automatically when you drag a module from the 
catalog window into the configuration table of the project window. 

 



 Description of the software 
 6.5 Identification and configuration 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 239 

Parameters 
The parameters are described in the following table: 

 
Parameter name Parameter value 
Configuration 
Module The designation of the selected module is displayed here. The field has 

a gray background and cannot be changed by the user. 
Order No. The order number of the selected module is shown here. The field has 

a gray background and cannot be changed by the user. 
Firmware The firmware of the selected module is shown here. The field has a 

gray background and cannot be changed by the user. 
Equipment identifier Here you can specify a user-defined equipment identifier (max. 32 

characters) for the selected module and assign it to inputs and outputs. 
Inputs The number of inputs of the selected module is shown here. 
Outputs The number of outputs of the selected module is shown here. 
Parameter assignment - PROFIBUS DP    
Baud rate   The baud rate is automatically detected by the safety relay. The field 

has a gray background and cannot be changed by the user. 
Station address This is where you define the station address. 
Station address - Change authorizations Here you can define the following change authorizations at the station 

address: 
• Changes possible without restrictions (e.g. by means of the fieldbus 

command "SET_SLAVE_ADD," DS 160, or setting element). 
• Can only be changed by means of data set (DS 160), which can be 

sent from the controller or from the MSS ES, or by means of the 
setting element (on the safety relay). 

• Can only be changed by means of data set (DS 160). 

Group diagnostics   Here you select whether the group diagnostics is blocked or released. 
If this parameter is set to "block," the "Group error diagnostics," "Group 
warning diagnostics," and "Group prewarning diagnostics" parameters 
are not significant, i.e. they are ignored by MSS 3RK3. 

Group error diagnostics Here you select whether the group error diagnostics is blocked or 
released. 

General warning diagnostics Here you select whether the group warning diagnostics is blocked or 
released. 

Group prewarning diagnostics Here you select whether the group prewarning diagnostics is inhibited 
or released. 
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6.5.2.5 Central unit properties 

Description    
You can open the "Central unit properties" dialog box as follows: 

● Double-click on a module in the configuration table. 

● Choose the "Object properties" menu option from the context menu (right mouse button). 

● In the menu "Options" > "Settings of Modular Safety System ES" under the tab "General 
settings", activate the checkbox "Display object properties automatically on insert". The 
properties dialog box will then pop up automatically when you drag a module from the 
catalog window into the configuration table of the project window. 

Parameters 
The parameters are described in the following table: 

 
Parameter name Parameter value 
Configuration 
Module The designation of the selected module is displayed here. The field has a gray 

background and cannot be changed by the user. 
Order No. The order number of the selected module is shown here. The field has a gray background 

and cannot be changed by the user. 
Firmware The firmware of the selected module is shown here. The field has a gray background and 

cannot be changed by the user. 
Equipment identifier Here you can specify a user-defined equipment identifier (max. 32 characters) for the 

selected module and assign it to inputs and outputs. 
Inputs The maximum number of available inputs is indicated here. 
Outputs The maximum number of available outputs is indicated here. 
Parameter assignment - Device response 
Program cycle time [ms]   Here you define the program cycle time within a range of 10 to 60 ms in steps of 5 ms. 

On the MSS 3RK3 Advanced, MSS 3RK3 ASIsafe basic and MSS 3RK3 ASIsafe 
extended, a program cycle time of 15 to 60 ms is possible when the AS-Interface is used. 

DP process data structure Here you specify the process data width that is processed by MSS 3RK3. The following 
values are available: 
• MSS: 32DI/32DO 
• MSS: 64DI/64DO (MSS 3RK3 Advanced, MSS 3RK3 ASIsafe basic, and 

MSS 3RK3 ASIsafe extended only) 
Note: 
Note that the GSD file version si02814d.gsg or higher must be installed in HW Config or in 
the engineering software of the PLC. 
For additional information on the GSD file, see the "3RK3 Modular Safety System" 
manual, Chapter "7.5.2.4 Configuring with GSD file." 
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Parameter name Parameter value 
Parameter assignment - AS-Interface   
AS-Interface 
(MSS 3RK3 Advanced, 
MSS 3RK3 ASIsafe basic and 
MSS 3RK3 ASIsafe extended 
only) 

Activate the AS-i interface in order to be able to use standard and safety-related AS-i 
slaves in your configuration. If AS-i slaves are already used in the logic diagram, the AS-i 
interface can no longer be deactivated. 

Parameter assignment - AS-Interface - Simulated slaves   
Slave profile to address 
(MSS 3RK3 Advanced, 
MSS 3RK3 ASIsafe basic and 
MSS 3RK3 ASIsafe extended 
only) 

Here you can specify whether the MSS 3RK3 is to simulate AS-i slaves on the AS-i bus. 
The 3RK3 central unit supports various profiles, which can be selected. The simulated 
slaves determined here are entered in the subsystem and can no longer be processed 
there. If you have allocated an address to a slave, the MSS 3RK3 will assign the 
corresponding selected profile to this address on the AS-Interface.   
Addresses at which a slave is already configured in the subsystem can no longer be 
assigned and are therefore displayed grayed out. 

6.5.2.6 Properties of expansion module 

Description    
You can open the "Properties of expansion module" dialog box as follows: 

● Double-click on a module in the configuration table. 

● Choose the "Object properties" menu option from the context menu (right mouse button). 

● In the "Options" > "Settings of Modular Safety System ES" menu under the "General 
settings" tab, select the "Display object properties automatically on insert" checkbox. The 
properties dialog box will then pop up automatically when you drag a module from the 
catalog window into the configuration table of the project window. 

Parameters 
The parameters are described in the following table: 

 
Parameter name Parameter value 
Configuration 
Module The designation of the selected module is displayed here. The field has a gray background 

and cannot be changed by the user. 
Order No. The order number of the selected module is shown here. The field has a gray background 

and cannot be changed by the user. 
Firmware The firmware of the selected module is shown here. The field has a gray background and 

cannot be changed by the user. 
Equipment identifier Here you can specify a user-defined equipment identifier (max. 32 characters) for the 

selected module and assign it to inputs and outputs. 
Inputs The number of inputs of the selected module is shown here. 
Outputs The number of outputs of the selected module is shown here. 
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6.5.2.7 AS-i subsystem 

Configuration 
You configure the AS-Interface hardware of the MSS 3RK3 in the "Subsystem AS-i" 
configuration table.    

Determining the AS-i subslot configuration online 
If a 3RK3 Advanced, 3RK3 ASIsafe basic or 3RK3 ASIsafe extended central unit with an AS-
i connection is used in a 3RK3 Modular Safety System, you can apply the actual 
configuration, i.e. the hardware configuration of the AS-i subslot configuration, by clicking on 
the "Determine online" button.  

The result will depend on the master and slaves used. Slave profile values that cannot be 
determined or calculated are shown as "?" and have to be adjusted manually. 

 

 Note 
Determine online   

If the AS-i master is running and the MSS 3RK3 is connected, only the ID codes of the 
slaves on the AS-i bus can be determined. 

If the MSS 3RK3 is running and the AS-i master is connected, all available information 
concerning the slave profiles can be determined. 

 

The user is asked if the current configuration is to be replaced. 

Determining an existing subslot configuration online 
● If the ID code at an address determined online is identical tp the configured code, the 

parameter assignment entered will remain unchanged, even if the other values of the 
slave profile differ. 

● If the ID code is different, the value determined online will be applied. 

● If an entered AS-i slave cannot be determined online, the configured value will be 
retained. 

AS-i slaves   
The catalog window contains slaves that you can use in your configuring: 

● Safety-related slaves: 

Slaves that read the safety-related "On" or "Off" status of the connected sensor or the 
control device and transfer it to the master or safety monitor. The latter then switches 
outputs off if applicable (e.g. EMERGENCY STOP). 

● AS-i standard slaves 

● AS-i A/B slaves 
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Simulated slaves     
No more than four non-safety-related AS-i slaves can be simulated, including one as a CTT2 
slave. This enables diagnostics using the CTT2 protocol. In so doing, the CTT2 protocol data 
are interconnected via the "Slot3_ASi#xx_Sx.y" and "Slot3_ASi#xx_Qy.z" terminals in the 
logic diagram. Up to 12 safety-related AS-i slaves can additionally be simulated. The number 
of safety-related AS-i slaves depends on the central unit used: 

 
 MSS 3RK3  

ASIsafe basic 
MSS 3RK3 
ASIsafe extended 

MSS 3RK3 
Advanced 

Maximum number of simulated 
safety-related AS-i slaves 

8 10 12  

 

A simulated slave is provided by the 3RK3 central unit on the AS-i bus. With this function, 
signals from the logic diagram can be exchange with other stations on the AS-i bus. 

You assign parameters to the simulated slaves in the "Central unit properties - MSS slot 3" 
dialog box. They will then be shown (in italics) in the "Subsystem AS-i" table.  

Rules for slot allocation 
● The table for the AS-i subsystem contains 62 rows. According to AS-i Spec as from 

Version 2.11, you can configure no more than the following: 

– 31 standard slaves or safety-related input slaves 

– 62 A/B slaves 

– a mixture of the above 

● Standard or safety-related slaves can only be inserted at A addresses. If an A address is 
allocated, the corresponding B address is no longer available. 

● Simulated slaves are determined in the Properties dialog box of the corresponding 
3RK3 Advanced, 3RK3 ASIsafe basic or 3RK3 ASIsafe extended central unit and 
inserted at A/B addresses (addressing of the simulated AS-i slaves). Simulated slaves 
are shown in italics and provided with the icon of the 3RK3 central unit. They cannot be 
edited.  

● Entries can be inserted, deleted, or cut out in any way, i.e. gaps between addresses are 
permitted. 

Module catalog for subsystem AS-i 
This catalog contains all AS-i slaves marketed by Siemens AG that were known at the time 
of publication of this version of MSS ES. A universal slave must be used to incorporate more 
recent slaves from Siemens AG or to incorporate slaves from other manufacturers. 
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6.5.2.8 Properties of AS-i slaves 

Description   
You can open the "Slave properties" dialog box as follows:  

● Double-click on a module in the configuration table. 

● Choose the "Object properties" menu option from the context menu (right mouse button). 

● In the "Options > Settings of Modular Safety System" menu under the "General settings" 
tab, select the "Display object properties automatically on insert" checkbox. The 
properties dialog box will then pop up automatically when you drag a module from the 
selection window into the configuration table of the project window. 

Parameters 
The parameters are described in the following table: 

 
Parameter name Parameter value 
Configuration 
Slave type The designation of the selected module is displayed here. The field has a gray 

background and cannot be changed by the user. 
Order No. The order number of the selected module is shown here. The field has a gray background 

and cannot be changed by the user. 
Equipment identifier Here you can specify a user-defined equipment identifier (max. 16 characters) for the 

selected module and assign it to inputs and outputs. 
IO code If you use a universal slave, set the profile for this slave here. 
ID code If you use a universal slave, set the profile for this slave here. 
ID1 code If you use a universal slave, set the profile for this slave here. 
ID2 code If you use a universal slave, set the profile for this slave here. 
Monitor non-safety-related 
I/Os 

Select the checkbox for monitoring non-safety-related slaves or the non-safety-related 
information items of a safety-related AS-i slave. You can then interconnect the terminals 
in the logic diagram. The "Monitor non safe I/O" option can be set up to 14 times in one 
configuration. 
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6.5.2.9 Messages during the consistency check - Configuration 
The consistency check is used to check whether the configuration is correct and complete.    

A consistency check is carried out for the following actions: 

● With the "Edit" > "Check consistency" menu command 

● When a configuration is saved 

● With the "Target system" > "Prepare configuration test..." menu command 

The messages are displayed in the output window. By clicking on a message in the output 
window, you can jump to the corresponding error location. 

The following messages may appear during the consistency check: 

 
Message Kind Message text Remedy 
The expansion modules must 
be configured in succession. 

Error "Configuration: There is a gap in front 
of an expansion module." 

Correct the configuration "manually," 
possibly using the "Delete blank rows 
automatically" function from the 
context menu. 

The central unit must be 
available. 

Error "Configuration: A central unit always 
needs to be configured at slot 3." 

Drag the central unit from the catalog 
window to slot 3 in the configuration 
table.  
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6.6 Logic diagram 
You can switch to the logic diagram view by selecting a diagram in the navigation window.  

6.6.1 Features of the logic diagram 
The logic diagram has the following features:   

● Graphical connection of the function elements used and representation as a function 
diagram: 

– Representation of the switching elements as function elements with input connections 
and output connections 

– Representation of physical and logic addresses in the form of address elements 

– Representation of interconnections as connecting lines between function elements 

– Display of relevant function element parameters 

● Documentation management: 

– The pages are divided automatically. 

– The individual pages are displayed on the screen as they are printed. 

● Current states (e.g. digital outputs of function elements) of the MSS 3RK3 can be 
monitored in the diagnostics mode. 

● Working with the logic diagram: 

– The user can switch between languages during operation. 

– Optimization functions (e.g. arranging the function elements according to the signal 
flow). 

– Placing and connecting the function elements by drag & drop. 

– Function elements and connections can be moved as required. 

– Comments can be placed in the screen and printout as required. 

– Structuring of the logic by generating partial diagrams (e.g. one output circuit per 
diagram). 

– The clarity of a diagram can be enhanced by interrupting connections and replacing 
them by freely movable reference points. 
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 Note 
Procedures for the configuration 

The procedure for configuration in MSS ES has an effect on various functions.  

There are two ways of configuring in MSS ES: 
1. You start with configuration of the hardware structure and then configure the logic. Once 

you have configured an MSS 3RK3 Basic, all non-supported function elements will no 
longer be available in the catalog window of the logic diagram. 

2. You start with configuration of the logic and then configure the hardware configuration. If 
you use the function elements in the logic diagram that are not supported by 
MSS 3RK3 Basic, the MSS 3RK3 Basic will no longer be available in the hardware 
catalog of the configuration. 

 

 

6.6.2 Working with the logic diagram 

6.6.2.1 Selecting function elements and using them in the diagram 

Inserting function elements   
Insert the function elements by selecting them in the catalog window and then drag and drop 
them into the work space. 

Defining parameters 
When you drag a function element into the work space, a dialog box pops up where you can 
define the function element parameters. For this you must activate the checkbox "Display 
object properties automatically on insert" in the menu "Options" > "Settings of Modular 
Safety System ES" under the tab "General settings". 

You can also open the dialog box subsequently by double-clicking the function element on 
the work space, or by choosing "Object properties" from the context menu (right mouse 
button). 

You will find more information about the parameters in Chapter "Function elements 
(Page 271)." 

Finding function elements in the diagram 
To display a function element already inserted in the diagram, double-click the entry of this 
function element in the catalog window. The first function element that is found in the 
diagram will be displayed. By double-clicking on this function element in the catalog window 
again, the next function element of this type is selected in the diagram. 



Description of the software  
6.6 Logic diagram 

 Modular Safety System 3RK3 

248 System Manual, 06/2012, 9262530-02 Rev 004 

6.6.2.2 Connecting function elements 

Rules for drawing connections   
● Several connections can originate from an output of a function element. 

● Only one connection can be connected to an input of a function element. 

Drawing a connection between functions 
To interconnect connections of function elements, perform the following steps: 

● Move the mouse pointer over an unconnected input. It is then highlighted in blue. 

● Press the left mouse button and keep it pressed. 

● Keep the mouse button pressed and draw a connection to an output until it is highlighted 
in blue. 

● Release the mouse button. 

Result: A connection is established between the two terminals. 
 

 Note 

You can also draw the connection from the output to the input. 
 

Connections between function elements in different diagrams 
To connect function elements in different diagrams, proceed as follows: 

● Select the connection point of the function element in the first diagram. 

● In the context menu (right mouse button), select the command "Begin drawing 
connection". 

● Switch to the second diagram. 

● Select the connection point of the second function element. 

● In the context menu (right mouse button), select the command "Finish drawing 
connection". 

 

Crossover points of connections 
● Crossover points of connections are not specifically marked. The route of the lines is 

usually apparent. 

● If due to the high number of connections the route of the lines is not immediately 
apparent, then select the connection and its exact route will be highlighted. 
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Branches 
● Branches are identified by a point. 

● The system automatically sets the branch points. They cannot be selected and moved 
directly. 

● You can move branch points indirectly by moving connections. 

 
Figure 6-9 Branches 

 

Rerouting of connections 
If you want to reroute the end (or beginning) of an existing connection to a different terminal, 
then draw a new connection as follows: 

● Click on the corresponding connection (line) to select it. 

● Keep the mouse button pressed and drag one of the end points to another terminal. 

 

Alternatively, you can reroute several connections to a terminal simultaneously: 

● Move the mouse pointer to the end point of a connection line until it is highlighted in blue. 

● Click into the blue rectangle. 

● Keep the mouse button pressed and reroute the connections to the respective terminal. 
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Moving a function element/connection 
● Keep the mouse button pressed to move function elements and connections. 

● When function elements are moved, the start and end points of connections are fixed, 
since they are linked to the terminals of function elements. 

6.6.2.3 Selecting 

Select all   
Use the "Edit" > "Select all" menu command to select all function elements, connections, and 
comments. 

Lasso function 
Use the lasso function to select all objects within a specific area: 

Keep the left mouse button pressed and drag open a rectangle. 

All objects that are completely within the rectangle are automatically marked. 

Multiple selection 
● You can select more than one element at once by pressing the "<Ctrl>" key and selecting 

individual elements successively. 

6.6.2.4 Delete 
Use the menu command "Edit" > "Delete" to delete one or several selected objects and 
connections.   

You can also delete objects/connections via the context menu (right mouse button) and the 
"Delete" command or by pressing the "<Del>" key. 

Call: 

 
Button Command 

 "Edit" > "Delete" 

 
 

NOTICE  
Deleting an object 

When you delete an object, you also delete all connections or interrupted connections that 
are linked to this function element. 
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6.6.2.5 Display of graphical conflicts 
Graphical conflicts (part of a connection line/block is on top of another, connection lines that 
cross over blocks, blocks on top of page margins) are automatically highlighted in red.   

Use the "Edit" > "Realign graphic" menu command to arrange the objects in succession 
according to the signal flow. 

 

 Note 

After the "Realign graphic" command, existing comments are positioned below the 
interconnections on the logic diagram. 

 

Types of conflict 
The following types of conflict are shown in the figure below: 

● Part of a connection line is on top of another connection line 

● Part of a block is on top of another block 

● Connection lines cross over blocks 

● Blocks on top of page margins 

 
Figure 6-10 Graphical conflicts in the logic diagram 

 
 

 Note 

Please note the following: 
• Graphical conflicts can also occur at reference points. 
• During graphical configuration, it is continuously checked whether graphical conflicts 

occur. 
• During the consistency check, graphical conflicts are listed as warning messages in the 

output window. 
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6.6.2.6 Realign graphic 
Use the "Edit" > "Realign graphic" menu command to arrange the function elements and 
connections according to the signal flow.   

Call: 

 
Button Command 

 "Edit" > "Realign graphic" 

Defining options 
● In the menu "Options" > "Settings of Modular Safety System ES" > "Logic", click on the 

button "Realign graphic". 

The window "Options - Realign graphic" is opened. 

– Select the "Avoid connections crossing functions" checkbox if you want to prevent 
connections from crossing function elements. 

– If the checkbox is selected, you can choose whether connections will be interrupted or 
whether the affected function elements will be moved down until there is no longer a 
conflict with connections. 

– You can also apply a "Standard column grid across all subnetworks of a function 
diagram" if you select the corresponding checkbox. 

– You can position the output cells in a separate column on the far right (for each 
subnetwork) if you select the lowermost checkbox. 

Realignment principles 
● Only a graphical realignment of the objects is implemented. The configuration remains 

unchanged. 

● Graphical conflicts are automatically eliminated. 

● Automatic arrangement is also possible when the configuration is read from the safety 
relay (open online). 

● After automatic arrangement, function elements and connections can be moved and 
adjusted. 

● Use the menu command "Edit" > "Undo" to undo the new arrangement. 

 

 Note 

After the "Realign graphic" command, existing comments are positioned below the 
interconnections on the logic diagram. 
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6.6.2.7 Move diagram 

Activating and deactivating the move mode   
With the "View" > "Change grid settings" menu command, you can switch to move mode. In 
the move mode, you can move the diagram using the mouse if it is larger than the current 
window. 

Call: 

 
Button Command 

 "View" > "Change grid settings" 

 

Click the button again or choose "View" > "Change grid settings" to deactivate move mode. 

 
 

 Note 
Special features in the move mode   
• When the move mode is activated, you cannot select and move objects or draw 

connections. 
• The mouse pointer is represented by a hand symbol when the move mode is activated. 

 

 

Alternately, the diagram can also be moved with the cursor keys even while move mode is 
not active. 
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6.6.2.8 Zooming 
You can zoom in or zoom out in a diagram step by step using the menu command "View" > 
"Zoom in" or "View" > "Zoom out". The zoom factor is increased or decreased by a fixed 
value.    

Zooming in and out can also be executed as follows: 

● Mouse click on the graphical work space > Keep the key "<Ctrl>" pressed > Use the 
mouse wheel. 

● Mouse click on the graphical work space > Click on the "+" or "-" key. 

Call: 

 
Button Command 

 "View" > "Zoom in" 

 "View" > "Zoom out" 

 "View" > "Zoom dialog" 

Zoom dialog   
With the menu command "View" > "Zoom dialog", you can open a zoom dialog where you 
can directly set a zoom factor: 

Zoom center point 
If no object is selected in the diagram, the center point of the screen is selected for zooming. 

If one or several objects are selected in the diagram, the center point of the selected 
object/area is selected for zooming. 

If the zoom function is carried out repeatedly this zoom center point is moved step by step to 
the center of the screen. 

6.6.2.9 Overall view 

Network overview   
Use the menu command "View" > "Overall view" to obtain an overview of the network. 

Call: 

 
Button Command 

 "View" > "Overall view" 
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6.6.2.10 Insert comment 
Use the menu command "Edit" > "Insert comment" to insert comments in the diagram 
wherever required.   

Call: 

 
Button Command 

 "Edit" > "Insert comment" 

Procedure 
● Select "Insert comment" at the current mouse position in the context menu. The mouse 

pointer then becomes a symbol that represents a comment. 

● Or click on the "Insert comment" button. 

● Left-click on the required position in the diagram. 

● A dialog box opens in which you can enter the comment. 

Editing a comment element 
You can edit a comment element: 

● Edit the comment text: 

– "Edit comment" context menu (double-click on the comment) 

– A dialog field for entering the text pops up. 

● Move by means of drag and drop 

● Change the size. Line breaks are automatically inserted to adapt the text to the size. 

● Delete 

● Print 
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6.6.2.11 Interrupt connection 

Clear representation of large diagrams   
With the "Edit" > "Interrupt connection" menu command, you can interrupt connections to 
achieve clearer representation of large diagrams with many function elements and 
connections. 

Call: 

 
Button Command 

 "Edit > "Interrupt connection" 

Procedure 
● 1. Select the connection: 

 
● 2. Click the button or choose "Interrupt connection" from the context menu (right mouse 

button). 

● 3. The connection is interrupted. Reference points are generated that indicate to which 
function element each connection is routed. 
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Reference points   
A reference point indicates to which function element and terminal of the function element 
the connection is routed (with any relevant diagram name). 

You cam select, move, and delete a reference point: 

● Selecting a reference point 

– Single mouse click (on the tip of the arrow): 

The reference point and the corresponding reference point are selected:  

 
– Double mouse click (on the tip of the arrow): 

The corresponding reference point is selected (if necessary, the window is scrolled 
down so that the corresponding reference point becomes visible): 

 
● Deleting a reference point 

– Select the reference point. 

– Delete the reference point and thus the entire connection between the respective 
function elements with the "Edit" > "Delete" menu command. 

– You can also "Delete" using the context menu (right mouse button), "Delete" 
command or by selecting the reference point and pressing the "<Del>" key. 

 

 Note 

When a reference point or an individual partial connection is deleted, the entire connection 
(including the second partial connection) is deleted. 
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6.6.2.12 Redraw partial connection 

Restoring an interrupted connection   
Use the menu command "Edit" > "Redraw partial connection" to restore an interrupted 
connection. 

Call: 

 
Button Command 

 "Edit" > "Redraw partial connection"  

Procedure 
● Select the partial connection. 

Alternatively, you can also select the reference point. 

● Select the menu command "Edit" > "Redraw partial connection" or click on the button 
"Redraw partial connection". Alternately, you can connect the partial connection using the 
context menu (right mouse button). 

6.6.2.13 Highlight signal flow 

Highlight objects in color   
With the menu command "View" > "Highlight signal flow", you highlight the following objects 
in the logic diagram in color: 

● All function elements and connections that indirectly send signals to an input of the 
selected block (signal flow on the input side). 

● All function elements and connections to which the signals of all outputs of the selected 
function element are sent directly or indirectly (signal flow on the output side). 

Call: 

 
Button Command 

 "View" > "Highlight signal flow" 
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Highlighted elements 

 
Figure 6-11 Highlight signal flow 

Delete highlighting   
The highlighting is independent of the selection of the objects and is retained until one of the 
following events occurs: 

● Another element is graphically highlighted. 

● The structure of the diagram is changed, for example, by deleting an element or inserting 
a connection. 

● A reference point is selected (in the case of an interrupted connection). 

● The menu command "View" > "Delete highlighting" is executed. 

6.6.2.14 Delete highlighting 
The menu command "View" > "Delete highlighting" cancels the graphical highlighting of the 
selected objects.   

Call: 

 
Button Command 

 "View" > "Delete highlighting" 
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6.6.2.15 Display settings 

Selection of the display category   
In the "View" > "Display settings" dialog box, you can set how function elements will be 
displayed. 

You can also call up this dialog with the menu command "Options" > "Settings of Modular 
Safety System ES" under the tab "Logic" by clicking on the "Display settings" button. 

Call: 

 
Button Command 

 "View" > "Display settings" 

Selecting a display element 
All changeable display elements are entered in the "Display element" list. 

When you select an element, its current color is shown in the box "Current color" below it: 

 
Figure 6-12 Display settings 
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Change color 
● Click on the "Change color" button. 

● The standard Windows color dialog is opened. 

● Select a predefined basic color. 

● Define user-specific colors: 

– Expand the window with the button "Define colors". 

– In the expanded window, use the mouse to either select a color from the colors offered 
or define a corresponding color using the keyboard (tone, saturation, brightness, red, 
green, blue color components). 

– Click the "Add colors" button and your self-defined color will be added to the range of 
user-defined colors. 

– The color settings are stored and are available for further sessions. They apply for all 
projects. 

Reset settings 
Use the button "Reset all" to restore the state after installation. 

6.6.2.16 Grids and lines 

Screen grid button    
With the "View" > "Grid settings" command or the "Change grid settings" button, you can 
manually optimize the graphical display in the "Screen grid" dialog box. 

You can also call up this dialog with the menu command "Options" > "Settings of Modular 
Safety System ES" under the tab "Logic" by clicking on the "Screen grid" button. 

Call: 

 
Button Command 

 "View" > "Change grid settings"  
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"Screen grid" dialog box 
 
Align objects Grid settings 
Align objects with grid The distance between the individual grid points can be 

set from 5 to 50 mm in steps of 5 mm. 
Align objects with other objects You can choose whether every first, second, third, 

fourth, fifth, or sixth grid point is to be shown. 
Both options together Activate the option "Display grid on the screen" to 

display a screen grid. 
 Basic settings 

The grid settings are preassigned: 
• Distance: 40 mm 
• Show every first grid point, display grid on the 

screen 

6.6.2.17 Errors and system callbacks 
If you execute impermissible actions when working with the logic diagram, error messages 
are displayed. 

Meaning of the error messages and system callbacks    
 
Error message Meaning 
It is not permitted to connect inputs to 
each other. 

You have tried to interconnect two inputs. This is not permitted. It is only possible 
to connect one input to one output and vice versa. 

Connection of two outputs not possible. You have tried to interconnect two outputs. This is not permitted. It is only 
possible to connect one input to one output and vice versa. 

This connection is prohibited. You have tried to create a connection that is not possible. 
Inputs and outputs cannot be interconnected at will (see above). 

Inputs can only be used once. You have tried to connect to an input that is already assigned. An input can only 
be the output point of one connection. 

Feedbacks are not permissible. You have tried to establish a connection between outputs and inputs with the 
same function element. Note that this does not have to be a direct connection, 
the feedback can be established across multiple function elements. Check the 
signal flow. 
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6.6.2.18 Macro functionality 
You can use the macrofunction as follows:   

● To put together a library of function units that you use particularly. 

● To combine blocks (= macros) from function elements and interposed connections, partial 
diagrams, or whole diagrams. 

● To export and import macros out of your project or into other projects. 

● To reuse the macros in other projects. 

Properties of macrofunctionality 
● All macros are stored in a file in a user-specific area on the hard disk. 

● Each user sees his or her own macros. Macros can be made available to other users 
using the export function (e.g. through a central storage location on a server). 

● The number of elements in a macro is not limited. 

● A macro can only be created from the elements of a single diagram. 

● Freely positioned comments can be included in a macro. 

● Interrupted connections are stored as such in the macro and will be interrupted when the 
macro is used. 

● When a macro is created, connections are only included if they have a defined start and 
end point. 

● Macros can be deleted using the context menu (right mouse button). 

● Name and description of the macros can be modified subsequently using the context 
menu (right mouse button). 

● The following actions cannot be undone: 

– Importing and exporting macros 

– Creation and deletion of macros 

– Modifying the properties of a macro 
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Creation of a macro 
To create a macro perform the following steps: 

● In the diagram, select the function elements from which you want to assemble the macro, 
being sure to select the required connection lines, too. 

● Choose "Create macro..." from the context menu using the right mouse button. 

● The properties dialog box of the newly create macro will be shown. Enter the following 
details: 

– Name: Name of the macro, with which the macro will be stored in the "Macros" folder 
in the catalog window. 

– Description: You can enter a description of the macro here. 

Using macros 
If you want to use an existing macro in your diagram, please proceed as follows: 

● Define the type of element number assignment in the "Options" > "Settings" menu: 

– Assign a new element number: Starting at 1, the next free element number is 
assigned to the function element. 

– Retain old element numbers if possible: If the element number is not yet used in the 
current diagram, the element number that the function element had when the macro 
was created (and that is stored in it) will be assigned to the function element again 
when it is reused. 

● Drag the macro out of the "Macros" folder in the function catalog into the diagram. This 
breaks down the macro into individual connections and function elements. You can 
modify the individual components. 

The following rules apply when inserting function elements: 

– Interconnections to input/output terminals are reset (to avoid duplicate assignments). 

– The elements of the macro are inserted at the current mouse position. 

– All elements of the macro are selected after insertion (for example, to be able to move 
them afterward). 

– The element parameters of each individual element are retained. (They are stored in 
the macro.) 

Storing macros 
The macros you created and imported are stored in the "Macros" folder in the function 
catalog with the name you assigned to them. 
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Export macros   
● To export macros, choose the "Export macros..." menu command from the "Options" 

menu. The "Export macros" dialog box opens. 

● Choose the macros from the "Existing macros" list (identical with the list of the macros in 
the function catalog) that you wish to export. 

● Insert the selected macros into the "Macros to be exported" list using the "Add" button. 

● Click the "Export" button. 

● In the "Save macro file as" dialog box, enter the path and filename of the macro file to be 
created. 

Import macros   
● To import macros, choose the "Import macros..." menu command from the "Options" 

menu. The "Import macros" dialog box opens. 

● Choose the macros you want to import from the "Importable macros" list. 

● Insert the selected macros into the "Macros to be imported" list using the "Add" button. 

● Click the "Import" button. 

6.6.3 Connection rules 
Because of the hardware properties or safety regulations, there are connection rules that 
must be checked or monitored when function elements are edited.       

General 
● Signals must not be connected recursively, i.e. "backward." 

● Non-fail-safe input signals (= standard inputs) can only be added to a safety circuit if they 
are ANDed with a safe signal. 

● Input terminals (fail-safe/non-fail-safe) can only be used once as an input (input cell or 
monitoring functions).  

● Output terminals (fail-safe/non-fail-safe) can only be used once as an output (output cell / 
switching output), However, each output terminal can also be used once as an input 
terminal with an input cell.  
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Monitoring functions 
● Only fail-safe signals must be connected to a signal input (INx) of a monitoring function.  

● "Mixed connection" of signals is not possible, i.e. for multi-channel function elements 
capable of cross-circuit detection, only channels of the same module can be connected. 
(Exception: mode selector switch). 

  Note 

For cross-circuit detection, channels are assigned to "channel groups" on 3RK3 central 
units or expansion modules:   

Channel group 1: IN1/IN2 

Channel group 2: IN3/IN4 

Channel group 3: IN5/IN6 

Channel group 4: IN7/IN8 

● The following rules apply for interconnecting channels on these modules to multi-channel 
monitoring functions with the exception of the mode selector switch:  

– If an input in a channel group is used with one channel, the assigned second input 
must no longer be used with two channels. It can still be used with one channel. 

– If an input of a channel group is used with two channels, the second associated input 
is automatically configured to the still unused input of the element (e.g. emergency 
stop: IN1 is configured to SLOT3_F-IN1, IN2 is automatically assigned to SLOT3_F-
IN2). 

The test cycle inputs for detecting cross-circuits are assigned as follows: 

T1: IN1 IN3 IN5 IN7 

T2: IN2 IN4 IN6 IN8 

  Note 

A 2-channel enabling button can only be connected via the test cycle.   

NOTICE  
 

If a safety shutdown mat (cross-circuit principle) is connected to a slot (expansion 
module or central unit), cross-circuit detection must be deactivated for the remaining 
inputs on this slot because otherwise the monitoring functions configured for these 
inputs will also signal a cross-circuit when somebody steps on the safety shutdown 
mat.   
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Cell functions can be placed by the user 
● Fail-safe and non-fail-safe input signals as well as fail-safe and non-fail-safe output 

signals can be connected once to an input cell function. 

● Only fail-safe and non-fail-safe output signals can be connected to an output cell function. 

  Note 

If you do not observe the rules described above, you are either guided through editing, 
i.e. incorrect connections are not possible, or a corresponding error or warning message 
is displayed. 

Interconnection of AS-i slaves 
● Safety-related AS-i input slaves 

When safety-related AS-i input slaves are used, only the "two-channel" and "2xsingle-
channel" input type parameters are permissible for monitoring functions. It is not 
permitted to use a safety-related AS-i input slave with one channel.  

AS-i terminals may only be used together with the "NCNC" input type parameter for the 
following monitoring functions: "Monitoring Universal", "EMERGENCY STOP", "Protective 
door", "Protective door with lock", and "Safety shutdown mat (NC principle)".  

For enabling-type input functions (two-hand operation and enabling button), AS-i 
terminals may only be used together with the "NONO" input type parameter. 

The "NCNO" input type parameter must not be used. 

– Two-hand operation 

When safety-related AS-i input slaves are used with two-hand operation, only the 
"2x2xsingle-channel (NONONONO)" and "four-channel (NONONONO)" input type 
parameters are permissible.  

The "four-channel (NONCNONC)" input type parameter is not permitted for AS-i since 
the transferred value 0 is not safe. 

● The two safety-related input signals of a monitoring function (F-IN1 and F-IN2) must 
originate from the same safety-related AS-i input slave. 
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● Discrepancy monitoring and sequence monitoring 

If the input signal is present at an AS-i slave and the "2xsingle-channel" input type 
parameter is assigned, the discrepancy and sequence monitoring parameters are 
automatically deactivated. 

This applies to the following function elements: 

– Monitoring Universal 

– EMERGENCY STOP 

– Safety shutdown mat with NC principle 

– Protective door 

– Protective door with lock 

– Enabling button 

– Two-hand operation 

● Safety shutdown mat with cross-circuit principle 

There must not be any AS-i terminals connected to the "Safety shutdown mat with cross-
circuit principle" function element. 

● Setting/resetting of safety-related AS-i outputs using "AS-i 1..4F-DO" 

Only the terminals of one safety-related AS-i output may be connected to the outputs of 
the "AS-i 1..4F-DO" output function.  

Connection of other terminals and the distribution among several safety-related AS-i 
outputs are not permitted. 

An output cell sets/resets only the first channel Q1 of a safety-related AS-i output. 
Outputs Q2 ... Q4 and AUX1 and AUX2 are set/reset only using the "AS-i 1..4F-DO" 
output function. 

● Representation of safety-related AS-i outputs 

The received Q1 ... Q4, AUX1, and AUX2 signals of another MSS 3RK3 Advanced, 
MSS 3RK3 ASIsafe basic or MSS 3RK3 ASIsafe extended may only be wired to input 
cells. 

● Monitoring of safety-related input slaves 

The IN1 and IN2 receive signals may only be interconnected to input elements. 
Interconnecting to input cells is not permitted. Only the safety-related F-IN1&2 receive 
signal may be interconnected to an input cell. 

The monitoring function "AS-i 2F-DI" is used instead of an input cell if you want to 
diagnose both of the input terminal signals of the ASIsafe input slave. 

● Representation of safety-related input slaves 

The send signals for a safety-related AS-i input slave may be interconnected only via an 
output cell. 
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6.6.4 Messages during the consistency check - Logic 
The consistency check is used to check whether the configuration is correct and complete.    

A consistency check is carried out for the following actions: 

● With the "Edit" > "Check consistency" menu command 

● When a configuration is saved 

● With the "Target system" > "Prepare configuration test..." menu command 

The messages are displayed in the output window. By clicking on a message in the output 
window, you can jump to the corresponding error location. 

Logic diagram 
The following messages exist for the logic diagram: 

 
Rule Kind Message Remedy 
All address elements must 
be assigned to valid 
addresses.  
(Exception: FAULT output) 

Error Logic: Terminal not connected 
<[element type]> (no. [element 
number]). 

Assign a valid address in the object 
properties dialog of the address 
element or of the associated 
input/output element. 

Non-fail-safe input signals 
can only be added to a 
safety circuit if they are 
ANDed with a safe signal. 

Warning Logic: Signal flow terminal <[element 
type]> (no. [element number]): Non-
safety-relevant signal is connected 
with a safety-relevant signal to a 
safety output without ANDing. 

Change the safety circuit accordingly. 

Inputs of logic elements must 
be connected. 
(Exceptions:  
• STOP and RESTART of 

the muting functions 
• AUX1/2 for AS-i 1 to 

4F-DO) 

Error Logic: Input <[element type]> (no. 
[element number]) not connected. 

Change the safety circuit accordingly. 

Outputs of logic elements 
must be connected.  
(Exception: FAULT output) 

Error Logic: Output <[element type]> (no. 
[element number]) not connected. 

Change the safety circuit accordingly. 

A function element must not 
overlap a page limit. 

Warning Logic: The function element <function 
name> (no. [element number]) 
overlaps the page limit. 

Move the function element or execute 
the "Realign graphic" command. 

A function element must not 
overlap a connection. 

Warning Logic: The function element <\1> [no. 
\2] overlaps a connection. 

Move the function element or execute 
"Realign graphic." 

A function element must not 
overlap another function 
element. 

Warning Logic: The function element <function 
name> (no. [element number]) 
overlaps another function element. 

Move the function element or execute 
"Realign graphic." 

A connection must not 
overlap another one. 

Warning Logic: A connection overlaps another 
connection. 

Move the connection or associated 
function element, or execute "Realign 
graphic." 

A comment field overlaps a 
page limit. 

Warning Logic: A comment field overlaps the 
page limit. 

Move the comment. 
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Rule Kind Message Remedy 
A comment field overlaps 
another comment field. 

Warning Logic: A comment field overlaps 
another comment field. 

Move the comment. 

A comment field overlaps a 
connection. 

Warning Logic: A comment field overlaps a 
connection. 

Move the comment/connection. 

A function element overlaps 
a comment field. 

Warning Logic: The function element <\1> [no. 
\2] overlaps a comment field. 

Move the function element/comment 
field. 

A reference point of an 
interrupted connection 
overlaps a connection. 

Warning Logic: A reference point of an 
interrupted connection overlaps 
another connection. 

Move the connection or execute 
"Realign graphic". 

A reference point of an 
interrupted connection 
overlaps another reference 
point. 

Warning Logic: A reference point of an 
interrupted connection overlaps with 
another reference point. 

Change the safety circuit accordingly 
or execute "Realign graphic." 

A function element overlaps 
a reference point of an 
interrupted connection. 

Warning Logic: The function element <\1> [no. 
\2] overlaps a reference point of an 
interrupted connection. 

Change the safety circuit accordingly 
or execute "Realign graphic." 

A reference point of an 
interrupted connection 
overlaps the page limit. 

Warning Logic: A reference point of an 
interrupted connection overlaps the 
page limit. 

Change the safety circuit accordingly 
or execute "Realign graphic." 

A comment field element 
overlaps a reference point of 
an interrupted connection. 

Warning Logic: A comment field overlaps a 
reference point of an interrupted 
connection. 

Change the safety circuit accordingly 
or execute "Realign graphic." 

The set program cycle time 
has been exceeded   

Error Logic: The set program cycle time 
has been exceeded. Reduce the 
number of function elements. 

Alter safety circuit accordingly or 
increase program cycle time 

If the channels of a module 
are wired to the "Safety 
shutdown mat (cross-circuit 
principle)" monitoring 
function, the other channels 
of this module should not be 
used with: 
• another monitoring 

function "Safety 
shutdown mat (cross-
circuit principle)" 

• another monitoring 
function with activated 
cross-circuit. 

Warning  Logic: <[element type]> (no. [element 
number]) - cross-circuit detection 
activated (channels of 
<[BMK/slot/subslot no.]> are wired to 
the monitoring function <safety 
shutdown mat (cross-circuit 
principle)> <[element type]> (no. 
[element number]> wired). 

Change the safety circuit accordingly. 

The internal memory on the 
MSS 3RK3 is full 

Error "General configuration: The internal 
memory of the MSS ES is full. 
Reduce the scope of the logic" 

Reduce the scope of the logic (by 
optimization, for example). 

A function element has an 
interconnection level larger 
than 255 (parameter is only 1 
byte in size) 

Error Logic: No more than 255 function 
elements can be connected one 
behind the other. The rule is violated 
by the function element with the 
number \1. 

Optimize the logic in such a way that 
no more than 255 interconnection 
levels are required (e.g. by use of 
output and input cells in pairs). 
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6.7 Function elements 

6.7.1 Properties across function elements 
 

WARNING  
Can cause death, serious injury, or property damage. 

The value of each time setting must always be selected at the lowest possible value that 
the application requires (permits). The selection of the times must comply with the 
requirements resulting from the risk evaluation for the respective hazardous situation. 
Otherwise additional measures have to be taken to avoid circumventing the safety 
application. 

 

Input delay    
The input delay is required for bouncing contacts (protective door) to stabilize the signals 
before they can be processed further by the function elements. 

The input delay can be set to anywhere between 0 to 150 ms for all function elements. 

If the inputs of the PROFIBUS process image are used, no input delay times can be set. 

If safety-related AS-Interface inputs are used, the input delay time can be deactivated (= 0 s) 
or set to a value between 50 ...150 ms. 

For master calls on the AS-i bus, an input delay time cannot be set. 

For logic-driven signals that are read back, it is also not possible to set an input delay time; 
this pertains to all terminal types. 

 

WARNING  
Can cause death, serious injury, or property damage. 

If the input delay increases, the overall response time of the safety program increases.    
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Start conditions   
The following start conditions must be fulfilled before the output of a function element is set: 

● When the startup test is active, the sensor that is being monitored must be actuated 
once. Faults must not occur here.  

● If any faults do occur, they must be rectified and acknowledged. 

Monitored / manual start      
During a monitored start, the start pulse of the safety equipment must be between 150 and 
2000 ms. 

A monitored start can be carried out with the following function elements: 

● Monitoring Universal 

● EMERGENCY STOP 

● ESPE (electro-sensitive protective equipment) 

● Safety shutdown mat (NC principle) 

● Safety shutdown mat (cross-circuit principle) 

● Protective door 

● Protective door with lock 

● Standard output 

● Start functions 

● F output 

● AS-i 1..4F-DO 

In the case of a manual start, a rising edge 0->1 is required as the start condition at the 
START input. 
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Discrepancy monitoring   
The discrepancy monitoring tolerates, within a defined time window, that associated signals 
are not available at the same time. If this time is exceeded, an enable signal is not output. 
The following table provides an overview of discrepancy monitoring for the monitoring 
functions when they are connected to two-channel sensors: 

 
Monitoring function Discrepancy monitoring Discrepancy time   
Monitoring Universal can be set to on/off ∞ or 

can be set from/to: 0 to 
60000 ms, 

EMERGENCY STOP On 5000 ms 
ESPE (electro-sensitive protective 
equipment) 

On ∞ 

Safety shutdown mat (NC principle) On 5000 ms 
Safety shutdown mat (cross-circuit 
principle) 

off  
(cross-circuit same as with single 
channel) 

∞ 

Protective door can be set to on/off ∞ or 
can be set from/to: 0 to 
60000 ms, 

Protective door with lock can be set to on/off ∞ or 
can be set from/to: 0 to 
60000 ms, 

Enabling button On ∞ 
Two-hand operation On 5000 ms 
Mode selector switch off - 
AS-i 2F-DI off - 

 
 

NOTICE  
The configured discrepancy time of the "protective door" and "protective door with lock" 
monitoring functions must be greater than the configured input delay because otherwise a 
discrepancy time violation may occur with bouncing contacts, e.g. when the protective door 
is closed. 

 

 Note 

The combination of "Discrepancy time monitoring on" and "Discrepancy time ∞" means that 
no discrepancy time violation exists and, as such, no fault is triggered. The system cannot be 
switched on, however, until after the discrepancy condition violation has been rectified. 
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Cross-circuit detection   
A cross-circuit, which is a short-circuit between channels, can only occur with multi-channel 
device controllers. Cross-circuit detection is only possible when the sensor is operated on 
T1 / T2 of the relevant expansion module or central unit, see also "Guidelines for wiring the 
MSS 3RK3 (Page 124)." 

Since a cross-circuit is an error requiring acknowledgment, a cross-circuit that has been 
rectified must be acknowledged by means of a reset. 

 

 Note 
AS-i slaves 

If AS-i slaves are used, cross-circuit detection is not possible. 
 

The following table provides an overview of cross-circuit detection for the monitoring 
functions: 

 
Monitoring function Cross-circuit detection Note 
Monitoring Universal can be set to on/off - 
EMERGENCY STOP can be set to on/off - 
ESPE (electro-sensitive 
protective equipment) 

can be set to on/off If the ESPE is equipped with solid-state 
outputs, cross-circuit detection must be 
deactivated. 

Safety shutdown mat (NC 
principle) 

can be set to on/off - 

Safety shutdown mat (cross-
circuit principle) 

On Cross-circuit detection must not be 
activated for any other sensor on the 
expansion module used. 
A cross-circuit is not an error for this 
monitoring function and does not need to 
be acknowledged. 

Protective door can be set to on/off - 
Protective door with lock can be set to on/off - 
Enabling button On - 
Two-hand operation can be set to on/off A two-hand control of type III C (Cat. 4) 

can only be implemented if cross-circuit 
detection is activated. 

Mode selector switch off - 
AS-i 2F-DI off - 
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Parameter - input type 
The "2xsingle-channel (NCNC)" and "2x2xsingle-channel (NONONONO)" types of the 
"Input" parameter are only available for AS-i terminals. 

 

 Note 
Parameter "Type" 2xsingle-channel 

With this input circuit type, the discrepancy monitoring, sequence monitoring, and cross-
circuit detection are deactivated. 

 

Fault signaling output (FAULT)   
The fault signaling output (FAULT) is activated for all monitoring and output functions and 
does not need to be wired. The fault signaling output indicates wiring and logic errors. 
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6.7.2 Cell functions 

6.7.2.1 Input cell 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced 

MSS 3RK3 ASIsafe 
Cell functions Input cell  ✓ ✓ 

Description    
The input cell provides signal states for further processing in the safety logic. The signal 
states can be read in, for example, from the terminals of the input modules or also through a 
bus system. 

The signal of an input cell can be used multiple times in the safety logic.  

Parameters 
 
Parameter name Description/parameter value  

Element number Consecutive number that is automatically assigned. You can change the 
number. 

Element activated When this parameter is active, the function element is processed in the safety 
logic.  
When this parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Terminal - Input Select the input to be processed by the function element. Parameters 
Input delay [ms] Select here when the function elements further process the signals:  

• Input delay = "0" 
The input signals are further processed by the function element without time 
delay when there is a signal change. 

• Input delay not "0" 
This parameter can be used to suppress signal interference. The signal state 
that was pending for most of the duration of the input delay is further 
processed. 

Note that the delay time you specified is a multiple of the program cycle time you 
specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 Modular 
Safety System" manual, Ch. "Response times." 
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6.7.2.2 Output cell 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Cell functions Output cell  ✓ ✓ 

Description    
The output cell forwards the signal states from the safety logic to an output. The signal states 
can be output, for example, at the terminal of an output module or also through a bus 
system. 

 

 Note 
Setting/resetting of a safety-related AS-i output 

For interconnection of multiple outputs of a safety-related AS-i output or auxiliary signals 
(AUX), you can use the output function "AS-i 1..4F-DO." 

 

Parameters 
 
Parameter name Description/parameter value 

Element number Consecutive number that is automatically assigned. You can change the 
number. 

Element activated When this parameter is active, the function element is processed in the safety 
logic.  
When this parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value  

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Parameter  Terminal - Output Select the output to be processed by the function element. 



Description of the software  
6.7 Function elements 

 Modular Safety System 3RK3 

278 System Manual, 06/2012, 9262530-02 Rev 004 

6.7.3 Monitoring functions 

6.7.3.1 Monitoring Universal 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Monitoring functions Monitoring Universal  - ✓ 

 
 

 Note 

The function element is available in MSS ES only when using an MSS 3RK3 Advanced, 
MSS 3RK3 ASIsafe basic or MSS 3RK3 ASIsafe extended. If an MSS 3RK3 Basic is 
configured in the configuration, the function element will be hidden in the catalog window. 

 

Description    
With the "Monitoring Universal" function element, you evaluate signals of any sensors using 
contacts with a positive opening operation, normally-open contacts, or a normally-
closed/normally-open combination. 

When the sensor is actuated, function output Q is deactivated, i.e., set to "0." 
 

WARNING  
Erroneous start on transmission error at fieldbus inputs 
Will Cause Death, Serious Injury or Property Damage 

Transmission errors at the fieldbus inputs can result in an erroneous start in which the 
system starts accidentally. To prevent this, the start type must be parameterized as 
"monitored." This is necessary to achieve SIL 3 as per EN 61508 and PL e as per 
EN ISO 13849-1. 
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Parameters 
 
Parameter name Description parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This 

may, for example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change 

the number. 
This number ensures a unique reference to the function element 
during diagnostics. 

Element activated When this parameter is active, the function element is processed in 
the safety logic.  
When this parameter is deactivated, the set substitute value is made 
available at output Q. 

General 

Function output substitute 
value 

"0" or "1" can be assigned to the substitute value when the element 
is deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Discrepancy monitoring This parameter is only available with Parameter - Input > Type "two-
channel."  
You can choose whether this function will be deactivated or whether 
the discrepancy time between the inputs will be monitored. 

Discrepancy time infinite You can set the discrepancy time to infinite. 
Discrepancy time [ms] You can set the discrepancy time between 0 and 60000 ms. 

Note that the discrepancy time you specified is a multiple of the 
program cycle time you specified in the properties of the 3RK3 
central unit. 
For additional information on the program cycle time, see the "3RK3 
Modular Safety System" manual, Chapter "Response times." 

Parameters  

Sequence monitoring You can deactivate the sequence monitoring of the inputs or define 
whether they will be monitored in ascending (IN1 > IN2) or 
descending (IN2 > IN1) order. 
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Parameter name Description parameter value 
Type Use these parameters to determine the input type of the function 

element: 
• single-channel (NC) 

IN1 is monitored for "1," i.e., function output Q is deactivated 
when there is a "0" signal.  

• single-channel (NO) 

IN1 is monitored for "0," i.e., function output Q is deactivated 
when there is a "1" signal. 

• two-channel (NCNC) 

IN1 and IN2 are monitored for "1," i.e., function output Q is 
deactivated when there is at least one "0" signal. 

• two-channel (NONO) 

IN1 and IN2 are monitored for "0," i.e., function output Q is 
deactivated when there is at least one "1" signal. 

• two-channel (NCNO) 

IN1 (NC) is monitored for "1" and IN2 (NO) is monitored for "0" 
(antivalent), i.e., function output Q is deactivated when there is a 
signal change at IN1 or IN2. 

• 2xsingle-channel (NCNC) 

IN1 and IN2 are monitored for "1," i.e., function output Q is 
deactivated when there is at least one "0" signal. There are no 
further dependencies between the two signals. 

IN1 Select the input to be processed by the function element.  
IN2 This parameter is only available if the following selection is made 

under parameter - Input > Type: 
• two-channel 
• 2xsingle-channel 
IN2 is automatically assigned depending on the selected input IN1. 

Input delay [ms] Select here when the function elements further process the signals: 
• Input delay = "0" 

The input signals are further processed by the function element 
without time delay when there is a signal change. 

• Input delay not "0" 

This parameter can be used to suppress signal interference. The 
signal state that was pending for most of the duration of the input 
delay is further processed. 

Note that the delay time you specified is a multiple of the program 
cycle time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 
Modular Safety System" manual, Chapter "Response times." 

Parameter - Input 

Cross-circuit detection When this parameter is activated, cross-circuits are detected with the 
aid of test outputs at the inputs. 
If AS-i slaves are used, cross-circuit detection is not possible. 
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Parameter name Description parameter value 
Startup test • Activated: 

After the switch from substitute value to real value or after the 
switch to safety or test mode, a start test must be conducted. 

For this purpose, the sensor to be monitored must be actuated 
once. Only then can function output Q be activated depending on 
the type of start. 

• Deactivated: 

A start test is not required. 

Parameter - Start 

Start type • Automatic: 

The function output is set as soon as all start conditions are 
fulfilled. 

• Monitored: 

Function output Q is set as soon as all start conditions are 
fulfilled and the start signal has changed from "0 → 1 → 0." 

• Manual: 

Function output Q is set as soon as all start conditions are 
fulfilled and the start signal is changed from "0 → 1." 
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6.7.3.2 EMERGENCY STOP 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Monitoring functions EMERGENCY 

STOP 
 ✓ ✓ 

Description    
With the "EMERGENCY STOP" function element, signals from the EMERGENCY STOP 
control devices with forcibly guided contacts are evaluated. 

After the EMERGENCY STOP control device has been operated, function output Q is 
deactivated, i.e., set to "0." 

 

WARNING  
Erroneous start on transmission error at fieldbus inputs 
Will Cause Death, Serious Injury or Property Damage 

Transmission errors at the fieldbus inputs can result in an erroneous start in which the 
system starts accidentally. To prevent this, the start type must be parameterized as 
"monitored." This is necessary to achieve SIL 3 as per EN 61508 and PL e as per 
EN ISO 13849-1. 
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Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, 

for example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change 

the number. 
Element activated When this parameter is active, the function element is processed in the 

safety logic.  
When this parameter is deactivated, the set substitute value is made 
available at output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Type This parameter defines the input type of the function element. 
• single-channel (NC): 

IN1 is monitored for "1," i.e., function output Q is deactivated when 
there is a "0" signal.  

• two-channel (NCNC): 

IN1 and IN2 are monitored for "1," i.e., function output Q is 
deactivated when there is at least one "0" signal. 

• 2xsingle-channel (NCNC) 

IN1 and IN2 are monitored for "1," i.e., function output Q is 
deactivated when there is at least one "0" signal. There are no 
further dependencies between the two signals. 

IN1 Select the input to be processed by the function element.  
IN2 Only available with the parameter - Input > Type two-channel (NCNC) 

or 2xsingle-channel (NCNC). 
IN2 is automatically assigned depending on the selected input IN1. 

Input delay [ms] Select here when the function elements further process the signals:  
• Input delay = "0": 

The input signals are further processed by the function element 
without time delay when there is a signal change. 

• Input delay not "0": 

This parameter can be used to suppress signal interference. The 
signal state that was pending for most of the duration of the input 
delay is further processed. 

Note that the delay time you specified is a multiple of the program 
cycle time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 
Modular Safety System" manual, Chapter "Response times." 

Parameter - Input 

Cross-circuit detection When this parameter is activated, cross-circuits are detected with the 
aid of test outputs at the inputs. 
If AS-i slaves are used, cross-circuit detection is not possible. 
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Parameter name Description/parameter value 
Startup test • Activated: 

After the switch from substitute value to real value or after the 
switch to safety or test mode, a start test must be conducted. 

For this purpose, the sensor to be monitored must be actuated 
once. Only then can function output Q be activated depending on 
the type of start. 

• Deactivated: 

A start test is not required. 

Parameter - Start 

Start type • Automatic: 

The function output is set as soon as all start conditions are fulfilled.
• Monitored: 

The function output is set as soon as all start conditions are fulfilled 
and the start signal is changed from "0 → 1 → 0." 

• Manual: 

Function output Q is set as soon as all start conditions are fulfilled 
and the start signal is changed from "0 → 1." 
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6.7.3.3 ESPE (electro-sensitive protective equipment) 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced 

MSS 3RK3 ASIsafe 
Monitoring functions ESPE  ✓ ✓ 

Description    
With the function element "ESPE" (electro-sensitive protective equipment) signals from, for 
example, light curtains and laser scanners are evaluated.  

When something enters the protective field of the ESPE, the function output Q is 
deactivated, i.e., set to "0". 

 

WARNING  
Erroneous start on transmission error at fieldbus inputs 
Will Cause Death, Serious Injury or Property Damage 

Transmission errors at the fieldbus inputs can result in an erroneous start in which the 
system starts accidentally. To prevent this, the start type must be parameterized as 
"monitored." This is necessary to achieve SIL 3 as per EN 61508 and PL e as per 
EN ISO 13849-1. 
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Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, 

for example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change 

the number. 
Element activated When this parameter is active, the function element is processed in the 

safety logic.  
When this parameter is deactivated, the set substitute value is made 
available at output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Type Use these parameters to determine the input type of the function 
element. 
• single-channel (NC): 

IN1 is monitored for "1," i.e., function output Q is deactivated when 
there is a "0" signal.  

• two-channel (NCNC): 

IN1 and IN2 are monitored for "1," i.e., function output Q is 
deactivated when there is at least one "0" signal. 

• 2xsingle-channel (NCNC) 

IN1 and IN2 are monitored for "1," i.e., function output Q is 
deactivated when there is at least one "0" signal. On restart, the 
other channel must not have passed through zero. 

IN1 Select the input to be processed by the function element.  
IN2 This parameter is available with parameter - Input > Type two-channel 

(NCNC) and with 2xsingle-channel (NCNC).  
IN2 is automatically assigned depending on the selected input IN1. 

Parameter - Input 

Input delay [ms] Select here when the function elements further process the signals:  
• Input delay = "0": 

The input signals are further processed by the function element 
without time delay when there is a signal change. 

• Input delay not "0": 

This parameter can be used to suppress signal interference. The 
signal state that was pending for most of the duration of the input 
delay is further processed. 

Note that the delay time you specified is a multiple of the program 
cycle time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 
Modular Safety System" manual, Chapter "Response times." 
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Parameter name Description/parameter value 
Cross-circuit detection When this parameter is activated, cross-circuits are detected with the 

aid of test outputs at the inputs. 
If you use ESPE with electronic outputs you must deactivate cross-
circuit detection. 
If AS-i slaves are used, cross-circuit detection is not possible. 

Startup test • Activated: 

After the switch from substitute value to real value or after the 
switch to safety or test mode, a start test must be conducted. 

For this purpose, the sensor to be monitored must be actuated 
once. Only then can function output Q be activated depending on 
the type of start. 

• Deactivated: 

A start test is not required. 

Parameter - Start 

Start type • Automatic: 

The function output is set as soon as all start conditions are fulfilled.
• Monitored: 

The function output is set as soon as all start conditions are fulfilled 
and the start signal is changed from "0 → 1 → 0." 

• Manual: 

Function output Q is set as soon as all start conditions are fulfilled 
and the start signal is changed from "0 → 1." 
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6.7.3.4 Safety shutdown mat (NC principle) 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Monitoring functions Safety shutdown mat (NC 

principle) 
 ✓ ✓ 

Description    
With the "Safety shutdown mat (NC principle)" function element, the signals from the safety 
shutdown mats with NC contacts are evaluated.  

When the safety shutdown mat is actuated, function output Q is deactivated, i.e., set to "0." 
 

WARNING  
Erroneous start on transmission error at fieldbus inputs 
Will Cause Death, Serious Injury or Property Damage 

Transmission errors at the fieldbus inputs can result in an erroneous start in which the 
system starts accidentally. To prevent this, the start type must be parameterized as 
"monitored." This is necessary to achieve SIL 3 as per EN 61508 and PL e as per 
EN ISO 13849-1. 
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Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, 

for example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change 

the number. 
Element activated When this parameter is active, the function element is processed in the 

safety logic.  
When this parameter is deactivated, the set substitute value is made 
available at output Q. 

General 

Function output 
substitute value  

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Type Use these parameters to determine the input type of the function 
element: 
• single-channel (NC): 

IN1 is monitored for "1," i.e., function output Q is deactivated when 
there is a "0" signal.  

• two-channel (NCNC): 

IN1 and IN2 are monitored for "1," i.e., function output Q is 
deactivated when there is at least one "0" signal. 

• 2xsingle-channel (NCNC) 

IN1 and IN2 are monitored for "1," i.e., function output Q is 
deactivated when there is at least one "0" signal. There are no 
further dependencies between the two signals. 

IN1 Select the input to be processed by the function element.  
IN2 This parameter is available with parameter - Input > Type two-channel 

(NCNC) and with 2xsingle-channel (NCNC).  
IN2 is automatically assigned depending on the selected input IN1. 

Parameter - Input 

Input delay [ms] Select here when the function elements further process the signals:  
• Input delay = "0": 

The input signals are further processed by the function element 
without time delay when there is a signal change. 

• Input delay not "0": 

This parameter can be used to suppress signal interference. The 
signal state that was pending for most of the duration of the input 
delay is further processed. 

Note that the delay time you specified is a multiple of the program 
cycle time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 
Modular Safety System" manual, Chapter "Response times." 
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Parameter name Description/parameter value 
Cross-circuit detection When this parameter is activated, cross-circuits are detected with the 

aid of test outputs at the inputs. 
If AS-i slaves are used, cross-circuit detection is not possible. 

Startup test • Activated: 

After the switch from substitute value to real value or after the 
switch to safety or test mode, a start test must be conducted. 

For this purpose, the sensor to be monitored must be actuated 
once. Only then can function output Q be activated depending on 
the type of start. 

• Deactivated: 

A start test is not required. 

Parameter - Start 

Start type • Automatic: 

The function output is set as soon as all start conditions are fulfilled.
• Monitored: 

The function output is set as soon as all start conditions are fulfilled 
and the start signal is changed from "0 → 1 → 0." 

• Manual: 

Function output Q is set as soon as all start conditions are fulfilled 
and the start signal is changed from "0 → 1." 
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6.7.3.5 Safety shutdown mat (cross-circuit principle) 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Monitoring functions Safety shutdown mat (cross-circuit 

principle) 
 ✓ ✓ 

Description    
With the "Safety shutdown mat (cross-circuit principle)" function element, the signals from 
the safety shutdown mats with cross-circuit detection are evaluated. 

When the safety shutdown mat is actuated, function output Q is deactivated, i.e., set to "0." 
 

WARNING  
Erroneous start on transmission error at fieldbus inputs 
Will Cause Death, Serious Injury or Property Damage 

Transmission errors at the fieldbus inputs can result in an erroneous start in which the 
system starts accidentally. To prevent this, the start type must be parameterized as 
"monitored." This is necessary to achieve SIL 3 as per EN 61508 and PL e as per 
EN ISO 13849-1. 

 

 Note 

If the safety shutdown mat with cross-circuit principle is used, cross-circuit detection must be 
deactivated in the monitoring functions for the remaining inputs of the module used because 
otherwise the monitoring functions configured with the remaining inputs also signal a cross-
circuit when the safety shutdown mat is stepped on.  
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Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, 

for example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change 

the number. 
Element activated When this parameter is active, the function element is processed in the 

safety logic.  
When this parameter is deactivated, the set substitute value is made 
available at output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Type The input type of the function element is defined: 
• two-channel (NCNC): 

IN1 and IN2 are monitored for "1," i.e., shutdown on operation of 
the safety shutdown mat. 

IN1 Select the input to be processed by the function element. 
IN2 IN2 is automatically assigned depending on the selected input IN1. 

Parameter - Input 

Input delay [ms] Select here when the function elements further process the signals:  
• Input delay = "0": 

The input signals are further processed by the function element 
without time delay when there is a signal change. 

• Input delay not "0": 

This parameter can be used to suppress signal interference. The 
signal state that was pending for most of the duration of the input 
delay is further processed. 

Note that the delay time you specified is a multiple of the program 
cycle time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 
Modular Safety System" manual, Chapter "Response times." 
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Parameter name Description/parameter value 
Startup test • Activated: 

After the switch from substitute value to real value or after the 
switch to safety or test mode, a start test must be conducted. 

For this purpose, the sensor to be monitored must be actuated 
once. Only then can function output Q be activated depending on 
the type of start. 

• Deactivated: 

A start test is not required. 

Parameter - Start 

Start type • Automatic: 

The function output is set as soon as all start conditions are fulfilled.
• Monitored: 

The function output is set as soon as all start conditions are fulfilled 
and the start signal is changed from "0 → 1 → 0." 

• Manual: 

Function output Q is set as soon as all start conditions are fulfilled 
and the start signal is changed from "0 → 1."  
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6.7.3.6 Protective door 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Monitoring functions Protective door  ✓ ✓ 

Description    
With the "Protective door" function element, the signals from the protective doors or safety 
flaps are evaluated by means of positive opening contacts or an NC/NO combination. 

When the protective door is actuated, function output Q is deactivated, i.e., set to "0." 
 

WARNING  
Erroneous start on transmission error at fieldbus inputs 
Will Cause Death, Serious Injury or Property Damage 

Transmission errors at the fieldbus inputs can result in an erroneous start in which the 
system starts accidentally. To prevent this, the start type must be parameterized as 
"monitored." This is necessary to achieve SIL 3 as per EN 61508 and PL e as per 
EN ISO 13849-1. 
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Parameters 
 
Parameter name Description parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This 

may, for example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change 

the number. 
Element activated When this parameter is active, the function element is processed in 

the safety logic.  
When this parameter is deactivated, the set substitute value is made 
available at output Q. 

General 

Function output substitute 
value 

"0" or "1" can be assigned to the substitute value when the element 
is deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Discrepancy monitoring This parameter is only available with Parameter - Input > Type "two-
channel."  
You can choose whether this function will be deactivated or whether 
the discrepancy time between the inputs will be monitored. 

Discrepancy time infinite You can set the discrepancy time to infinite. 
Discrepancy time [ms] You can set the discrepancy time between 0 and 60000 ms. 

Note that the discrepancy time you specified is a multiple of the 
program cycle time you specified in the properties of the 3RK3 
central unit. 
For additional information on the program cycle time, see the "3RK3 
Modular Safety System" manual, Chapter "Response times." 

Parameters  

Sequence monitoring You can deactivate the sequence monitoring of the inputs or define 
whether they will be monitored in ascending (IN1 > IN2) or 
descending (IN2 > IN1) order. 

Type Use these parameters to determine the input type of the function 
element: 
• single-channel (NC) 

IN1 is monitored for "1," i.e., function output Q is deactivated 
when there is a "0" signal.  

• two-channel (NCNC) 

IN1 and IN2 are monitored for "1," i.e., function output Q is 
deactivated when there is at least one "0" signal. 

• two-channel (NCNO) 

IN1 (NC) is monitored for "1" and IN2 (NO) is monitored for "0" 
(antivalent), i.e., function output Q is deactivated when there is a 
signal change at IN1 or IN2. 

• 2xsingle-channel (NCNC) 

IN1 and IN2 are monitored for "1," i.e., function output Q is 
deactivated when there is at least one "0" signal. There are no 
further dependencies between the two signals. 

Parameter - Input 

IN1 Select the input to be processed by the function element.  
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Parameter name Description parameter value 
IN2 This parameter is only available if the following selection is made 

under parameter - Input > Type: 
• two-channel 
• 2xsingle-channel 
IN2 is automatically assigned depending on the selected input IN1. 

Input delay [ms] Select here when the function elements further process the signals: 
• Input delay = "0" 

The input signals are further processed by the function element 
without time delay when there is a signal change. 

• Input delay not "0" 

This parameter can be used to suppress signal interference. The 
signal state that was pending for most of the duration of the input 
delay is further processed. 

Note that the delay time you specified is a multiple of the program 
cycle time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 
Modular Safety System" manual, Chapter "Response times." 

Cross-circuit detection When this parameter is activated, cross-circuits are detected with the 
aid of test outputs at the inputs. 
If AS-i slaves are used, cross-circuit detection is not possible. 

Startup test • Activated: 

After the switch from substitute value to real value or after the 
switch to safety or test mode, a start test must be conducted. 

For this purpose, the sensor to be monitored must be actuated 
once. Only then can function output Q be activated depending on 
the type of start. 

• Deactivated: 

A start test is not required. 

Parameter - Start 

Start type • Automatic: 

The function output is set as soon as all start conditions are 
fulfilled. 

• Monitored: 

Function output Q is set as soon as all start conditions are 
fulfilled and the start signal has changed from "0 → 1 → 0." 

• Manual: 

Function output Q is set as soon as all start conditions are 
fulfilled and the start signal is changed from "0 → 1." 
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NOTICE  
The configured discrepancy time of the "protective door" monitoring function must be 
greater than the configured input delay because otherwise a discrepancy time violation may 
occur with bouncing contacts, e.g., when the protective door is closed. 
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6.7.3.7 Protective door with lock 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Monitoring functions Protective door with lock  - ✓ 

 
 

 Note 

The function element is available in MSS ES only when using an MSS 3RK3 Advanced, 
MSS 3RK3 ASIsafe basic or MSS 3RK3 ASIsafe extended. If an MSS 3RK3 Basic is 
configured in the configuration, the function element will be hidden in the catalog window. 

 

 

Description    
With the "Protective door with lock" function element, you evaluate signals from protective 
doors. You can control the door lock and monitor its status. 

For this purpose, the element has the following inputs: 

● two function inputs IN1 and IN2 for position detection of the protective door. 

● a "FEEDBACK_LOCK" function input for acquiring the locking status of the lock. 

● an "IN_LOCK" function input for controlling the lock. 

The element provides the following signals as the result: 

● The switch-off signal for the system is output through function output "Q." 

● The control signal for the lock is output through function output "LOCK." 

● Error messages are output through function output "FAULT." 

Functional principle 
Function output Q of this element is only set to the value "1" if the protective door is closed 
and locked.  

When an unlocking command (= value "1") is applied to function input "IN_LOCK," function 
output Q is immediately set to "0" and the lock is unlocked after a settable unlocking time 
through function output LOCK.  

If the unlocking command is applied to function input "IN_LOCK" before the unlocking time 
has elapsed, the lock will remain closed and the system can restart. 

To lock a disengaged lock again, it is not necessary for the protective door to have been 
opened in the meantime. It can remain closed and be relocked immediately. 



 Description of the software 
 6.7 Function elements 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 299 

Start override 
The start override enables function output Q to be set to the value "1" although an unlocking 
command is pending. This function can be used if the locking or unlocking command comes 
from a standstill monitor. (The standstill monitor only transmits the locking command when 
standstill is no longer detected.) 

You can define the length of the start time in the "Start time" parameter. 

This setting has the following properties: 

● When the START command is applied to function input START, the lock of the element is 
automatically engaged if the unlocking command is pending at function input IN_LOCK 
and the protective door is closed. Function output Q is set to "1." Concurrently with this, 
the start time is started and the "Start override active" message is set. 

If the protective door is open, locking is only performed if this is permitted in the "Lock 
with open protective door" parameter. 

● You can adapt the length of the start time to the application using the "Start time" 
parameter. At the latest after the start time has elapsed, the "Start override active" 
message will be reset. The locking command must then be pending at function input 
IN_LOCK. If no locking command is pending, function output Q will be set to value "0" 
again and the lock will be disengaged after the unlocking time has elapsed. If the locking 
command is detected before the start time has elapsed, the start time will be interrupted. 
The lock remains locked and the function output retains the value "1." 

● If another start command is detected at function input START while the start time is 
running, the start time is "retriggered," i.e., started from the beginning without the signal 
state of function inputs Q and LOCK being changed. 

● This function is deactivated if the "start time" parameter is parameterized to value "0." A 
value not equal to "0" activates the function. 

Interlock types 
The "protective door with lock" function element can be used for spring-locked or solenoid-
locked position switches. 

● Spring-locked according to closed-circuit current principle 

The lock is locked passively and unlocked actively, i.e., spring tension keeps the lock 
engaged. On a power failure, the lock remains engaged. 

● Solenoid-locked according to open-circuit current principle 

The lock has to be locked actively, i.e., magnetic force (solenoid energized) keeps the 
lock engaged. On a power failure, the lock is automatically unlocked and thus allows the 
service personnel to enter the system while it is de-energized. 
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WARNING  
Protective door unlocking on power failure 
Can Cause Death, Serious Injury, or Property Damage. 

Note that this variant of the locking on power failure takes no account of possible run-down 
times of the system. If this can result in a hazard for persons, locking must not be 
implemented in this way. 

 

 
 

WARNING  
Erroneous start on transmission error at fieldbus inputs 
Will Cause Death, Serious Injury or Property Damage 

Transmission errors at the fieldbus inputs can result in an erroneous start in which the 
system starts accidentally. To prevent this, the start type must be parameterized as 
"monitored." This is necessary to achieve SIL 3 as per EN 61508 and PL e as per 
EN ISO 13849-1. 

 

NOTICE  
The configured discrepancy time of the "protective door with lock" monitoring function must 
be greater than the configured input delay because otherwise a discrepancy time violation 
may occur with bouncing contacts, e.g., when the protective door is closed. 

 

 Note 

On a signal change at the FEEDBACK_LOCK function input, an error is generated 
immediately, if the signal at function output LOCK has not changed. 
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Parameters 
 
Parameter name Description parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This 

may, for example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can 

change the number. 
Element activated When this parameter is active, the function element is processed 

in the safety logic.  
If this parameter is deactivated, the set substitute value is made 
available at outputs Q and LOCK. 

Function output substitute 
value 

"0" or "1" can be assigned to the substitute value when the 
element is deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

General 

Substitute value LOCK "0" or "1" can be assigned to the substitute value when the 
element is deactivated. 
Substitute value "0" means output LOCK = 0 
substitute value "1" means output LOCK = 1 

Discrepancy monitoring This parameter is only available with Parameter - Input > Type 
"two-channel."  
You can choose whether this function will be deactivated or 
whether the discrepancy time between the inputs will be 
monitored. 

Discrepancy time infinite You can set the discrepancy time to infinite. 
Discrepancy time [ms] You can set the discrepancy time between 0 and 60000 ms. 

Note that the discrepancy time you specified is a multiple of the 
program cycle time you specified in the properties of the 3RK3 
central unit. 
For additional information on the program cycle time, see the 
"3RK3 Modular Safety System" manual, Chapter "Response 
times." 

Parameters  

Sequence monitoring You can deactivate the sequence monitoring of the inputs or 
define whether they will monitored in ascending (IN1 > IN2) or 
descending (IN2 > IN1) order. 
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Parameter name Description parameter value 
Type Use these parameters to determine the input type of the function 

element: 
• single-channel (NC) 

IN1 is monitored for "1," i.e., function output Q is deactivated 
when there is a "0" signal.  

• two-channel (NCNC) 

IN1 and IN2 are monitored for "1," i.e., function output Q is 
deactivated when there is at least one "0" signal. 

• two-channel (NCNO) 

IN1 (NC) is monitored for "1" and IN2 (NO) is monitored for "0" 
(antivalent), i.e., function output Q is deactivated when there 
is a signal change at IN1 or IN2. 

• 2xsingle-channel (NCNC) 

IN1 and IN2 are monitored for "1," i.e., function output Q is 
deactivated when there is at least one "0" signal. There are no 
further dependencies between the two signals. 

IN1 Select the input to be processed by the function element.  
IN2 This parameter is only available if the following selection is made 

under parameter - Input > Type: 
• two-channel 
• 2xsingle-channel 
IN2 is automatically assigned depending on the selected input 
IN1. 

Input delay [ms] Select here when the function elements further process the 
signals: 
• Input delay = "0" 

The input signals are further processed by the function 
element without time delay when there is a signal change. 

• Input delay not "0" 

This parameter can be used to suppress signal interference. 
The signal state that was pending for most of the duration of 
the input delay is further processed. 

Note that the delay time you specified is a multiple of the program 
cycle time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the 
"3RK3 Modular Safety System" manual, Chapter "Response 
times." 

Parameter - Input 

Cross-circuit detection When this parameter is activated, cross-circuits are detected with 
the aid of test outputs at the inputs. 
If AS-i slaves are used, cross-circuit detection is not possible. 
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Parameter name Description parameter value 
Lock with the open 
protective door 

The lock can only be engaged while the protective door is closed 
or open, depending on the "lock with open protective door" 
parameter.  
You can set the following parameters: 
• not lockable 

The lock cannot be engaged while the protective door is open.
• lockable 

The lock can be locked or unlocked irrespective of the position 
of the protective door. 

Note: 
When position switches whose door and lock contacts act on the 
same slave are used, "lockable" must always be chosen in order 
to enable proper operation. 

Interlock type Define the type of lock here: 
• Spring locking 
• Solenoid locking 

Unlocking time [s] Here, you can define the unlocking time from 0 to 655 seconds. 
This parameter permits time-delayed unlocking of the protective 
door after the system has been shut down. 

Feedback circuit monitoring The feedback circuit permits monitoring of the lock connected to 
the LOCK function output for correct locking. You can set the 
following parameters: 
• Deactivated 
• Enabled 
While the feedback circuit monitoring is activated, the following 
values are expected at the feedback input FEEDBACK_LOCK: 
• Protective door unlocked: expected feedback circuit signal = 

"1" 
• Protective door locked: expected feedback circuit signal = "0" 

Parameters - Feedback 
circuit 

Feedback circuit switching 
time [s] 

Parameter only available if parameter - Feedback circuit - 
Monitoring is active. 
If the feedback circuit signal FEEDBACK_LOCK does not match 
the output signal LOCK no later than after the switching time has 
elapsed, function output "Q" will be switched off. 
Note that the entered feedback circuit switching time is a multiple 
of the program cycle time you specified in the properties of the 
3RK3 central unit. 
For additional information on the program cycle time, see the 
"3RK3 Modular Safety System" manual, Chapter "Response 
times." 
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Parameter name Description parameter value 
Startup test You can set the following parameters: 

• Activated: 

After the switch from substitute value to real value or after the 
switch to safety or test mode, a start test must be conducted. 

For this purpose, the sensor to be monitored must be 
actuated once. Only then can function output Q be activated 
depending on the type of start. 

• Deactivated: 

A start test is not required. 
Startup time [s] Here you can define a time between 0 and 60000 ms, during 

which the "IN_LOCK" locking command is to be overridden. 

Parameter - Start 

Start type • Automatic: 

The function output is set as soon as all start conditions are 
fulfilled. 

• Monitored: 

Function output Q is set as soon as all start conditions are 
fulfilled and the start signal has changed from "0 → 1 → 0." 

• Manual: 

Function output Q is set as soon as all start conditions are 
fulfilled and the start signal is changed from "0 → 1." 
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6.7.3.8 Enabling button 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Monitoring functions Enabling button  ✓ ✓ 

Description    
With the "Enabling button" function element, the signals from the enabling buttons are 
evaluated by means of an NO contact. 

An enabling button is always monitored for cross-circuit. This is achieved using test cycle 
outputs. 

When the enabling button is actuated, function output Q is activated, i.e. set to "1." 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, 

for example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change 

the number. 
Element activated When this parameter is active, the function element is processed in the 

safety logic. 
When the parameter is deactivated, the set substitute value is made 
available at output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 
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Parameter name Description/parameter value 
Type Use these parameters to determine the input type of the function 

element: 
• single-channel (NO) 

IN1 is monitored for "1," i.e. function output Q is activated when 
there is a "1" signal. 

• two-channel (NONO) 

IN1 and IN2 are monitored for "1," i.e. function output Q is activated 
when there are two "1" signals. 

• 2xsingle-channel (NONO) 

IN1 and IN2 are monitored for "1," i.e. function output Q is activated 
when there are two "1" signals. There are no further dependencies 
between the two signals. 

IN1 Select the input to be processed by the function element.  
IN2 Only available with the parameter - Input > Type two-channel type 

(NONO) or 2xsingle-channel (NONO). 
IN2 is automatically assigned depending on the selected input IN1. 

Parameter - Input 

Input delay [ms] Select here when the function elements further process the signals: 
• Input delay = "0" 

The input signals are further processed by the function element 
without time delay when there is a signal change. 

• Input delay not "0" 

This parameter can be used to suppress signal interference. The 
signal state that was pending for most of the duration of the input 
delay is further processed. 

Note that the delay time you specified is a multiple of the program cycle 
time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 
Modular Safety System" manual, Ch. "Response times." 
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6.7.3.9 Two-hand operation 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Monitoring functions Two-hand operation  ✓ ✓ 

Description    
With the "Two-hand operation" function element, the signals from the two-hand control unit 
are evaluated.  

When both buttons of the two-hand operator panel are operated, the function output Q is 
activated within 500 ms (synchronous operation time), i.e. set to "1". 

The following table shows the type as defined by EN 574 that is achieved for the various 
requirements. 

 
Input type Input Cross-circuit Achievable type 

according to EN 574 
NONO Fail-safe input terminal on MSS X III a 
NONO Fail-safe AS-i input slave - III a  
NONCNONC  Fail-safe input terminal on MSS X III c 
NONCNONC  Fail-safe input terminal on MSS - III c 
NONONONO Fail-safe input terminal on MSS X III c 
NONONONO Fail-safe input terminal on MSS - III a 
NONONONO Fail-safe AS-i input slave - III c 

X: enabled 
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Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, 

for example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change 

the number. 
Element activated When this parameter is active, the function element is processed in the 

safety logic.  
When this parameter is deactivated, the set substitute value is made 
available at output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Type Use these parameters to determine the input type of the function 
element: 
• two-channel (NONO) 

IN1 and IN2 are monitored for "1," i.e. function output Q is activated 
when there are two "1" signals. 

• four-channel (NONONONO) 

IN1 / IN2 and IN3 / IN4 are monitored for "1," i.e. function output Q 
is activated when there are four "1" signals. 

• four-channel (NONCNONC) 

IN1 / IN3 (NC) are monitored for "1", and IN2 / IN4 (NO) are 
monitored for "0" (antivalent), i.e. function output Q is activated 
when there is a signal change at IN1 / IN2 and IN3 / IN4. 

• 2x2xsingle-channel (NONONONO) 

IN1 / IN2 and IN3 / IN4 are monitored for "1," i.e. function output Q 
is activated when all four signals are "1." There are no further 
dependencies between the two signals. 

IN1 Select the input to be processed by the function element.  
IN2 IN2 is automatically assigned depending on the selected input IN1. 
IN3 This parameter is only available if the following selection is made under 

parameter - Input > Type: 
• four-channel 
• 2x2xsingle-channel 
Select the input to be processed by the function element.  

Parameter - Input 

IN4 This parameter is only available if the following selection is made under 
parameter - Input > Type: 
• four-channel 
• 2x2xsingle-channel 
IN4 is automatically assigned depending on the selected input IN3. 
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Parameter name Description/parameter value 
Cross-circuit detection When this parameter is activated, cross-circuits are detected with the 

aid of test outputs at the inputs. 
If AS-i slaves are used, cross-circuit detection is not possible. 

Input delay [ms] Select here when the function elements further process the signals: 
• Input delay = "0" 

The input signals are further processed by the function element 
without time delay when there is a signal change. 

• Input delay not "0" 

This parameter can be used to suppress signal interference. The 
signal state that was pending for most of the duration of the input 
delay is further processed. 

A two-hand control of type III C (Cat. 4) can only be implemented if 
cross-circuit detection is activated. 
Note that the delay time you specified is a multiple of the program 
cycle time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 
Modular Safety System" manual, Ch. "Response times." 
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6.7.3.10 Mode selector switch 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Monitoring functions Mode selector switch  ✓ ✓ 

Description    
With the "Mode selector switch" function element, the signals from the mode selector switch 
are evaluated by means of NO contacts. Up to 5 operating modes can be defined. In the 
downstream logic, you can parameterize the operating mode to be implemented as required. 

The outputs Q1 to Q5 are assigned to the inputs IN1 to IN5. When the input IN1 is activated, 
the function output Q1 is activated, i.e. set to "1." Further input and output pairs respond 
analogously. 

If a start function is required for releasing an operating mode, this can be implemented with 
the "Start functions". 

The contact switchover time is 1000 ms, that is, a switch must be made between the 
operating modes within this time. 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, 

for example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change 

the number. 
Element activated When this parameter is active, the function element is processed in the 

safety logic.  
When this parameter is deactivated, the set substitute value is made 
available at output Q. 

General 

Function output 
substitute value 

The substitute value "1" can only be assigned to one output at a time. 
"0" is automatically assigned to all others. 

Parameter  Type of switch Select the required step switch: 
1 out of 2, 1 out of 3, 1 out of 4, 1 out of 5 

Type The input type of the function element is defined: 
• single-channel (NO) 

INx is monitored for "1," i.e. the function output Qx is deactivated 
when there is a "0" signal.  

IN1 Select the input to be processed by the function element. 
IN2 Select the input to be processed by the function element. 

Parameter - Input 

IN3 This parameter is available for switch type 1 out of 3; 1 out of 4, or 1 
out of 5. 
Select the input that is to be processed by the function element. 
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Parameter name Description/parameter value 
IN4 This parameter is available for switch type 1 of 4 or 1 of 5.  

Select the input to be processed by the function element. 
IN5 This parameter is available for switch type 1 of 5.  

Select the input to be processed by the function element. 
Input delay [ms] Select here when the function elements further process the signals:  

• Input delay = "0" 

The input signals are further processed by the function element 
without time delay when there is a signal change. 

• Input delay not "0" 

This parameter can be used to suppress signal interference. The 
signal state that was pending for most of the duration of the input 
delay is further processed. 

Note that the delay time you specified is a multiple of the program 
cycle time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 
Modular Safety System" manual, Ch. "Response times." 
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6.7.3.11 AS-i 2F-DI 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Monitoring functions AS-i 2F-DI  - ✓ 

 
 

 Note 

The function element is available in MSS ES only when using an MSS 3RK3 Advanced, 
MSS 3RK3 ASIsafe basic or MSS 3RK3 ASIsafe extended. If an MSS 3RK3 Basic is 
configured in the configuration, the function element will be hidden in the catalog window. 

 

 

Description    
The monitoring function "AS-i 2F-DI" is used instead of an input cell if you want to diagnose 
both of the input terminal signals of the ASIsafe input slave. 

The ANDed signal from both input terminal signals is provided at function output Q, which 
can be further connected in the user program. 

RLO = 1 when all logic inputs have the state "1." 

Background  
The ASIsafe transmission protocol specifies that both the safety-related inputs of an AS-i 
slave must have the state "1" for the transmitted signal to be considered safe. If only one of 
the two states is "0," the system must enter the safe state.  
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Parameters 
 
Parameter name Description/parameter value 

Name Enter a name for the element. 
Comment This text appears above the function element in the diagram. This may, 

for example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change 

the number. 
Element activated When this parameter is active, the function element is processed in the 

safety logic.  
When this parameter is deactivated, the substitute value is used. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 

IN1 IN1 and IN2 are monitored for "1," i.e. function output Q is deactivated 
when there is at least one "0" signal. 

IN2 IN2 is automatically assigned depending on the selected input IN1. 

Parameter - Input 

Input delay [ms] Select here when the function element will further process the signals:  
• Input delay = "0": 

The input signals are further processed by the function element 
without time delay when there is a signal change. 

• Input delay not "0": 

This parameter can be used to suppress signal interference. The 
signal state that was pending for most of the duration of the input 
delay is further processed. 

Note that the delay time you specified is a multiple of the program 
cycle time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 
Modular Safety System" manual, Ch. "Response times." 
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6.7.4 Muting functions 

6.7.4.1 Muting safety circuit 

Application    
If materials have to be conveyed into or out of a hazardous zone for further processing, the 
openings of the access paths can be large enough to enable a person to reach into or enter 
the hazardous zone. The requirement is to protect persons who may attempt to enter the 
hazardous zone from harm while allowing the materials to pass automatically unhindered. 
This is achieved with a special safety circuit that monitors the opening to the hazardous zone 
with electro-sensitive protective equipment (ESPE) and deactivates or "overrides" the 
protective equipment briefly when the material is conveyed. This safety circuit is known as 
"muting" and is described in the standard EN 61496-1-A.7.   

Properties 
The function element has the following inputs: 

● Function input "FREE" for acquiring the signal of the protection equipment (e.g. ESPE) 

● 2 or 4 function inputs "MS1" ... "MS4" for acquiring the signals of the muting sensors 

● a "STOP" function input for acquiring the system status 

● a function input "RESTART" for clearing the muting section 

The function element provides the following signals as the result: 

● The switch-on/off signal for the system is output through function output "Q." 

● The "Muting active" or "Muting restart possible" status (0.5-Hz flashing) is output through 
function output "MUT." 

● Error messages are output through function output "FAULT" 

  Note 

The sensors for starting and ending muting operation must be mutually independent and 
permanently wired. 
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Description 
The "Muting" function element permits temporary suppression (muting) of a protective field 
safety function for a specific purpose, e.g. for conveying materials through the protective 
field. 

This muting mode has the following properties: 

● Muting cannot be disabled from the application. 

● Muting is time-monitored and is possible for no longer than the parameterized "max. 
muting time." 

● The signal of the protective field safety function is read in by the function element at 
function input FREE. 

● If the value "1" is applied to function input FREE (protective field free), function output Q 
is set to the value "1" (system running), provided that the "Muting" function element has 
not detected an error. 

● If muting operation has been started, the value at function input FREE will be 
suppressed, i.e. the value "1" is still output at function output Q despite the protective field 
violation. The safety function is suppressed and the system continues to run. 

● After muting has ended, the value at function input FREE is evaluated again. The 
overridden safety function is activated again. 

Muting operation 
The following figure shows a typical muting arrangement 

 
① Muting display lamp 
② Light array 
③ Muting sensors 

Figure 6-13 Typical muting equipment 
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Muting can be divided into five "muting phases": 

● Phase 1 (= muting off) 

– The muting section is free 

– The material is in front of the opening or still in front of the muting sensors. 

– The protective equipment is still active and the muting display lamp is off. 

● Phase 2 (= start muting) 

– The material is moving into the muting section and the material triggers the muting 
sensors for starting muting. 

– The protective equipment is now overridden and the muting display lamp is on. 

● Phase 3 (= in muting) 

– The material moves from the input to the output area of the muting section and the 
material triggers both the muting sensors for starting muting and the muting sensors 
for ending muting. 

– The protective equipment is overridden and the muting display lamp is on. 

● Phase 4 (= stop muting) 

– The material moves out of the muting section. 

– The material has passed the muting sensor for starting muting. Now only the muting 
sensors for stopping muting are triggered. 

– The protective equipment is still overridden and the muting display lamp is still on. 

● Phase 5 (= end muting) 

– The material exits the muting section. 

– The material has passed the muting sensors for ending muting. 

– The protective equipment is active again and the muting display lamp is off. 
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Muting modes   
Two mode groups are used for the "muting" function element with up to four muting sensors 
(= two pairs of sensors) at function inputs MS1 to 4: 

● Parallel muting 

– 2-sensor parallel muting is possible if the dimensions of the conveyed material are not 
constant or too little space is available. This muting type must be operated with two 
muting sensors whose beams cross behind the protective field in the hazardous zone. 
To prevent tampering, the point where the muting sensor light barriers cross must be 
far enough inside the hazardous zone. No direction monitoring is possible because it 
is not possible to detect from which side the conveyed material is coming. 

!

 
– 4-sensor parallel muting is used for very small conveyed materials. This type of muting 

is the functional equivalent to 2-sensor parallel muting but the activation and 
deactivation signal is obtained from two pairs of sensors each. Material conveying is 
possible in both directions. 

!
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● Sequential (= serial) muting 

– 4-sensor sequential muting is used, above all, if the material to be conveyed into the 
hazardous zone always has the same dimensions and there is no lack of space. 
Material conveying is possible in both directions. 

!

 

6.7.4.2 Description of the "muting" function 
The signals of the muting sensors are monitored for signal discrepancy and signal sequence, 
depending on the muting mode. 

Discrepancy monitoring    

Signal discrepancy 

For the duration of the discrepancy time, different signal states are accepted at the two 
muting sensors forming a sensor pair without an error being signaled. On a signal 
discrepancy, only the signals of the muting sensor belonging to a muting sensor pair are 
monitored. In the case of muting sensor pair 1, these are the muting sensors MS1 and MS2; 
for muting sensor pair 2, muting sensor MS3 and MS4. For a definable max. time (= 
"Discrepancy time" parameter), the signal states of the associated muting sensors must be 
different. On violation of the signal discrepancy condition, muting is ended and a discrepancy 
error (= logic error) is signaled. This error is automatically acknowledged as soon as the 
corresponding muting sensors have the value "0," i.e. they are no longer being triggered. 
While a discrepancy error is pending, the muting section can be cleared using the RESTART 
function. This is indicated, e.g. by the flashing muting display lamp.  

Discrepancy monitoring is not performed in "4-sensor sequential" muting mode. 

Signal dropout 

The discrepancy time also allows signal dropouts of muting sensors, e.g. due to "gaps in 
conveyed materials", to be overridden for a period of time. Signal dropouts that are shorter 
than the assigned discrepancy time do not terminate muting. 

The signal dropout suppression action of the "Discrepancy time" parameter affects all muting 
sensors, even in "4-sensor sequential" muting mode. 
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Sequence monitoring   
Signal sequence monitoring is only possible in muting modes with more than 2 muting 
sensors. In the case of 4-sensor sequential muting, the signals of all four muting sensors 
and, in the case of 4-sensor parallel muting, the signals of the muting sensor pairs are 
monitored for their sequence. On violation of the sequence condition, muting is ended and a 
sequence error (= logic error) is signaled. This error is automatically acknowledged as soon 
as all muting sensors have the value "0," i.e. they are no longer being triggered. While a 
sequence error is pending, the muting section can be cleared using the RESTART function. 
This is indicated, e.g. by the flashing muting display lamp. 

Muting time limit   
Correctly started muting is only possible for a defined maximum duration. Muting is ended no 
later than when the max. muting time has elapsed. Muting can only be restarted after a valid 
muting sensor sequence has been detected or, if the muting section is still occupied, after 
the RESTART command has been detected. 

The muting time limit has no effect in the following cases: 

● During clearance of the muting section with the RESTART command. 

● If function input STOP is providing the information "System stopped." 

  Note 

If it is possible that the conveyed material may remain in the muting section for a long 
time, for example, because the conveyor belt has been stopped, the answer is not to set 
the muting time limit to a very large value or to deactivate it. Instead, function input STOP 
should be linked with the "belt drive signal." 

● If the time limit has been deactivated by parameter assignment. 

WARNING  
 

The muting time limit must only be shut down in justified cases, e.g. if the flow of 
materials is not normally interrupted in the muting section and if this does not pose a 
hazard to any person. If the muting time limit is deactivated, access to the hazardous 
locations must be prevented by suitable means. 
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System status "STOP" 
If the system is operationally shut down while muting is active, this results in a (muting) error, 
e.g. because of a discrepancy error of the muting sensor signals or because the maximum 
muting time has elapsed. To avoid this (muting) error, the system status must be acquired 
and evaluated. 

The "muting" element acquires the state of the system using function input STOP: 

● STOP = 0: System running. All monitoring functions of the "muting" element are 
processed according to their parameter assignment. 

● STOP = 1: System stopped. While muting operation is active, the time monitoring 
functions "muting time limit" and "discrepancy time monitoring of the muting sensors" are 
deactivated automatically. This prevents muting error messages due to elapsed times 
resulting from system shutdown. 

The signal sequence and signal discrepancy evaluation (but without discrepancy time 
monitoring) of the muting sensor signals remains active. The value of function output Q is 
not changed. When the system is started again, the timers of the time monitoring function 
are reset or restarted. The signal sequence and signal discrepancy monitoring of the 
muting sensors is continued normally. 

If the STOP function input is not connected, the system status will not be evaluated, i.e. the 
time monitoring functions are not affected. 

Muting - RESTART function 
A valid muting sequence can be interrupted operationally, e.g. on a power failure, while 
materials are being conveyed through the muting section. On power recovery, muting is not 
automatically resumed because the expected muting sensor sequence is not provided by the 
muting sensors already triggered. It may also be necessary to clear the muting section, for 
example, if the load of a pallet is unfavorably distributed so that only one muting sensor was 
triggered. To be able to remove conveyed material from the muting section without danger, 
the "muting" element provides the RESTART function for clearing the muting section. 

Function input FEEDBACK_MUT 
See "Muting display lamp" section 

Function output MUT 
The "muting active" state is output through a dedicated function output MUT at which, for 
example, a muting display lamp or a logical output terminal (e.g. PROFIBUS) can be 
connected. 
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Muting display lamp 
● The muting display lamp signals the following states: 

– Steady light: muting has been correctly started and the protective equipment for 
monitoring the protective field is overridden. 

– Flashing: clearance of the muting section is possible. 

● Properties: 

– To be able to control a muting display lamp, the "muting" element sets function output 
MUT to the value "1" if muting is active. This function output can be connected to a 
hardware or logical output terminal (e.g. PROFIBUS). 

– It is optionally possible to monitor a muting display lamp connected to function output 
MUT using function input FEEDBACK_MUT. Depending on the available information 
about the status of the display lamp, e.g. directly from the display lamp itself or from a 
higher-level PLC, the evaluation logic of the signal can be selected at function input 
FEEDBACK_MUT using parameter "Monitoring - Muting display lamp." This parameter 
also enables deactivation of the monitoring function. 

● Parameter "Monitoring - Muting display lamp" 

– Deactivated: The muting display lamp is not monitored. 

– statically for "1" = OK: 

With this parameter assignment, for example, the feedback signals of a "self-
monitoring muting display lamp" can be monitored. 

FEEDBACK_MUT value "0": => Muting display lamp defective 

FEEDBACK_MUT value "1": => Muting display lamp OK 

– dynamically for MUT: 

Signal evaluation at the FEEDBACK_MUT function input is performed by comparison 
with the output signal of function output MUT. On a signal change at function output 
MUT, the inverted signal from function output MUT is expected no later than after the 
parameterized "switching time muting display lamp" has elapsed. 

When the 0.5-Hz flashing signal is output, the feedback signal is not monitored, i.e. 
the signal at function input FEEDBACK_MUT, can have any value. On deactivation of 
the flashing signal, however, the feedback signal corresponds to the inverted value of 
function output MUT no later than after the "switching time" has elapsed. Otherwise, 
an error will be generated. 

● If a display lamp is defective, function output Q is set to the value "0" and the "muting 
display lamp defective" error message is set. This error message must be acknowledged 
with reset after the error has been corrected. 
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6.7.4.3 Clearing the muting section 

Prerequisites   
Clearance of the muting section can only be started if all the following conditions have been 
fulfilled:  

● At least one muting sensor is being triggered. 

● Function input RESTART is connected. 

If function input RESTART is not connected, the protective equipment cannot be cleared.  

● The "muting restart possible" message is set. 

● A 0.5-Hz flashing signal is output at function output MUT. The muting display lamp 
flashes. 

Starting clearance 
 

WARNING  
The clearance operation must be observed. It must be possible to respond to a hazardous 
situation by releasing the RESTART button at any time. The button must be installed in a 
location from which the entire hazardous area can be seen. 

 

To start clearance of the muting section, the following steps (1 to 3) must be completed 
within 4 s. 

● Press the RESTART button connected to the function input for at least 0.15 s. 

● Then release the RESTART button for at least 0.15 s. 

● Press the RESTART button again and hold it down. 

● The following messages will then appear: 

– The "muting restart possible" message is reset. 

– The "muting active" message is set. 

– Function output MUT outputs a 1 signal. 

Duration of muting with the RESTART button 
Muting remains active if one of the following conditions applies: 

● As long as the button remains pressed with an invalid muting sensor signal combination. 

● Until the muting sensors end muting while the button is pressed. 

● If a valid muting sensor signal combination is detected when the button is released the 
second time, assuming there are no other errors such as a signal discrepancy. 
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6.7.4.4 Muting (2-sensor-parallel) 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Muting functions Muting (2-sensor-parallel)  - ✓ 

 
 

 Note 

The function element is available in MSS ES only when using an MSS 3RK3 Advanced, 
MSS 3RK3 ASIsafe basic or MSS 3RK3 ASIsafe extended. If an MSS 3RK3 Basic is 
configured in the configuration, the function element will be hidden in the catalog window. 

 

 

Description   
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Figure 6-14 Muting 2-sensor parallel scheme 
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With the "Muting (2 sensor-parallel)" function element, you monitor an override circuit (= 
muting) with the following properties using signals from a pair of sensors: 

● Muting can be performed at very short intervals without incurring a muting error. 

● When a gap is detected between two conveyed items, muting is ended correctly and 
started again immediately when the next conveyed item is detected. 

● If no gap is detected, muting is not ended. Only the maximum permissible muting time 
ends muting. 

● The muting sensors are monitored for signal discrepancy. 

WARNING  
 

To prevent tampering, the beams of the two muting sensors must cross far enough 
behind protective field. If possible, the beams should point downward at different 
heights. 

  Note 

On a signal change at the FEEDBACK_MUT function input, an error is generated 
immediately, if the signal at function output MUT has not changed. 
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Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the 

number. 
Element activated If this parameter is active, the function element is processed in the safety logic.

If the parameter is deactivated, the set substitute values are made available at 
outputs Q and MUT. 

Function output substitute 
value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

General 

Substitute value for 
function output MUT 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output MUT = 0 
substitute value "1" means output MUT = 1 

Muting time infinite You can set the muting time to infinite. 
See the safety instructions in the "3RK3 Modular Safety System" manual, Ch. 
"Description of the "muting" function." 

Max. muting time [s] Enter the time after which operational muting will have ended at the latest. 
You can set the max. muting time between 1 and 10800 s [3 h] in steps of 1 
ms. 
The muting time is started when muting is correctly started by the muting 
sensors. 

Discrepancy time [ms] You can set the discrepancy time between 0 and 60000 ms. 
• For the duration of the discrepancy time, different signal states are 

accepted at the two muting sensors forming a sensor pair without an error 
being signaled. 

• During active muting, signal dropouts of muting sensors are accepted for 
the duration of the discrepancy time without ending muting. 

Note that the discrepancy time you specified is a multiple of the program cycle 
time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 Modular 
Safety System" manual, Ch. "Response times." 
While a discrepancy error is pending, you can clear the muting section using 
the RESTART function. This is indicated (e.g. flashing muting display lamp). 

Monitoring of the muting 
display lamp 

You can activate the monitoring function for the muting display lamp and 
choose the desired evaluation logic of the feedback signal at function input 
FEEDBACK_MUT: 
• Deactivated 
• statically for "1" = OK 
• dynamically for MUT 

Parameters  

switching time muting 
display lamp [s] 

You can adapt the monitoring function for the display lamp to the switching 
time depending on the display lamp. 
You can set the switching time between 0.01 and 30 s. 
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6.7.4.5 Muting (4-sensor-sequential) 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Muting functions Muting (4-sensor-sequential)  - ✓ 

 
 

 Note 

The function element is available in MSS ES only when using an MSS 3RK3 Advanced, 
MSS 3RK3 ASIsafe basic or MSS 3RK3 ASIsafe extended. If an MSS 3RK3 Basic is 
configured in the configuration, the function element will be hidden in the catalog window. 
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Figure 6-15 Muting 4-sensor-sequential scheme 
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With the "Muting (4 sensor-sequential)" function element, you monitor an override circuit (= 
muting) with the following properties using signals from four independent sensors (MS1 to 
MS4): 

● This muting mode is used if there is sufficient space for entry into and exit from the 
hazardous zone and the conveyed material always has the same dimensions. 

● The muting sensors are only monitored for sequence of triggering and non-triggering. 

The following are possible as a sequence: 

– triggering of "MS1 -> MS2 -> MS3 -> MS4" and ending triggering of "MS1 -> MS2 -> 
MS3 -> MS4" 

– triggering of "MS4 -> MS3 -> MS2 -> MS1" and ending triggering of "MS4 -> MS3 -> 
MS2 -> MS1" 

● For the sequence conditions to be fulfilled, the conveyed material must be as long as the 
distance between MS1 and MS4. On deviation from the permissible sequence, muting is 
ended and a sequence error is output. 

● The time interval between the sensor signals is not relevant. 

● Muting is not specific to a direction. 

 

 Note 
STOP function 

When STOP is activated, the interference suppression is deactivated automatically. This 
results in limited usability of the STOP function for conveyed material with gaps. In this case, 
4-sensor parallel muting must be used. 

 

WARNING  
If the conveyed material feed is stopped in muting phase 2 (see the "Muting safety circuit 
(Page 314)" chapter) and the conveyed material is moved again in the opposite direction, 
muting remains active initially. After ending triggering of the last muting sensor and 
expiration of the assigned discrepancy time in which signal dropouts are accepted, muting 
is deactivated. Monitoring of the protective field is resumed only afterwards. For this 
reason, the shortest possible discrepancy time must be chosen. 

 

 
 

 Note 

On a signal change at the FEEDBACK_MUT function input, an error is generated 
immediately, if the signal at function output MUT has not changed. 
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Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the 

number. 
Element activated If this parameter is active, the function element is processed in the safety logic.

If the parameter is deactivated, the set substitute values are made available at 
outputs Q and MUT. 

Function output substitute 
value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

General 

Substitute value for 
function output MUT 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output MUT = 0 
substitute value "1" means output MUT = 1 

Muting time infinite You can set the muting time to infinite. 
See the safety instructions in the "3RK3 Modular Safety System" manual, Ch. 
"Description of the "muting" function." 

Max. muting time [s] Enter the time after which operational muting will have ended at the latest. 
You can set the max. muting time between 1 and 10800 s [3 h] in steps of 1 
ms. 
The muting time is started when muting is correctly started by the muting 
sensors. 

Discrepancy time [ms] You can set the discrepancy time between 0 and 60000 ms. 
• During active muting, signal dropouts of muting sensors are accepted for 

the duration of the discrepancy time without ending muting. 
Note that the discrepancy time you specified is a multiple of the program cycle 
time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 Modular 
Safety System" manual, Ch. "Response times." 

Monitoring of the muting 
display lamp 

You can activate the monitoring function for the muting display lamp and 
choose the desired evaluation logic of the feedback signal at function input 
FEEDBACK_MUT: 
• Deactivated 
• statically for "1" = OK 
• dynamically for MUT 

Parameters  

switching time muting 
display lamp [s] 

You can adapt the monitoring function for the display lamp to the switching 
time depending on the display lamp. 
You can set the switching time between 0.01 and 30 s. 
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6.7.4.6 Muting (4-sensor-parallel) 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Muting functions Muting (4-sensor-parallel)  - ✓ 

 
 

 Note 

The function element is available in MSS ES only when using an MSS 3RK3 Advanced, 
MSS 3RK3 ASIsafe basic or MSS 3RK3 ASIsafe extended. If an MSS 3RK3 Basic is 
configured in the configuration, the function element will be hidden in the catalog window. 

 

 

Description   

!

 
Figure 6-16 4-sensor-parallel scheme 

With the "Muting (4 sensor-parallel)" function element, you monitor a override circuit (= 
muting) with the following properties using signals from two pairs of sensors (MS1 & MS2 
and MS3 & MS4): 

● This muting mode is used where there is little space. 

● The muting sensors are time-monitored in pairs for signal discrepancy. 

● The muting is triggered if either sensors MS1 and MS2 (= sensor pair 1) or MS3 and MS4 
(= sensor pair 2) are activated within a certain discrepancy time. 
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● The muting sensors are monitored for sequence. The following are possible as a 
sequence: 

– activation of "MS1 & MS2 → MS3 & MS4" and then deactivation of 
"MS1 & MS2 → MS3 & MS4" 

– activation of "MS3 & MS4 → MS1 & MS2" and then deactivation of 
"MS3 & MS4 → MS1 & MS2" 

● For the sequence conditions to be fulfilled, the conveyed material must be as long as the 
distance between MS1 & MS2 and MS3 & S4. 

● On deviation from the permissible sequence, muting is ended and a sequence error is 
output. 

● Muting is not specific to a direction. 

 

 Note 

On a signal change at the FEEDBACK_MUT function input, an error is generated 
immediately, if the signal at function output MUT has not changed. 

 

 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the 

number. 
Element activated If this parameter is active, the function element is processed in the safety logic. 

If the parameter is deactivated, the set substitute values are made available at 
outputs Q and MUT. 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

General 

Substitute value for 
function output MUT 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output MUT = 0 
substitute value "1" means output MUT = 1 

Muting time infinite You can set the muting time to infinite. 
See the safety instructions in the "3RK3 Modular Safety System" manual, Ch. 
"Description of the "muting" function." 

Parameters  

Max. muting time [s] Specify the time after which operational muting will have ended at the latest. 
You can set the max. muting time between 1 and 10800 s [3 h] in steps of 1 ms. 
The muting time is started when muting is correctly started by the muting 
sensors. 



 Description of the software 
 6.7 Function elements 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 331 

Parameter name Description/parameter value 
Discrepancy time [ms] You can set the discrepancy time between 0 and 60000 ms. 

• For the duration of the discrepancy time, different signal states are accepted 
at the two muting sensors forming a sensor pair without an error being 
signaled. 

• During active muting, muting sensor signal dropouts are accepted for the 
duration of the discrepancy time without ending muting. 

Note that the discrepancy time you specified is a multiple of the program cycle 
time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 Modular 
Safety System" manual, Ch. "Response times." 
While a discrepancy error is pending, you can clear the muting section using the 
RESTART function. This is indicated (e.g. flashing muting display lamp). 

Monitoring of the muting 
display lamp 

You can activate the monitoring function for the muting display lamp and choose 
the desired evaluation logic of the feedback signal at function input 
FEEDBACK_MUT: 
• Deactivated 
• statically for "1" = OK 
• dynamically for MUT 

switching time muting 
display lamp [s] 

You can adapt the monitoring function for the display lamp to the switching time 
depending on the display lamp. 
You can set the switching time between 0.01 and 30 s. 
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6.7.5 Status functions 

6.7.5.1 Device status 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Status functions Device status  ✓ ✓ 

Description    
The "Device status" function element provides status information about the MSS 3RK3 
safety relay. When the status activated in the parameter "Status type" exists, the function 
output Q is set to "1". 

With the "Device status" function element, defined responses can be implemented in the 
downstream logic by connecting the function output Q in the logic diagram. 
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Parameters 
 
Parameter name Description/parameter value  

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety 

logic. 
When the parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Parameter  Status type Select the status message to be displayed at the function output Q. Your options 
are: 
• No status information 
• Group error 
• Group warning (MSS 3RK3 Advanced, MSS 3RK3 ASIsafe basic and 

MSS 3RK3 ASIsafe extended) 
• Group prewarning (MSS 3RK3 Advanced, MSS 3RK3 ASIsafe basic and 

MSS 3RK3 ASIsafe extended) 
• Logic error 
• Test mode active 
• Safety mode active 
For further information on the status message, see the manual entitled "Modular 
Safety System 3RK3", section entitled "Diagnostics/Service" > "Diagnostics via 
PROFIBUS" > "Data set 92". 



Description of the software  
6.7 Function elements 

 Modular Safety System 3RK3 

334 System Manual, 06/2012, 9262530-02 Rev 004 

6.7.5.2 Element status 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Status functions Element status  - ✓ 

 
 

 Note 

The function element is available in MSS ES only when using an MSS 3RK3 Advanced, 
MSS 3RK3 ASIsafe basic or MSS 3RK3 ASIsafe extended. If an MSS 3RK3 Basic is 
configured in the configuration, the function element will be hidden in the catalog window. 

 

 

Description    
The "Element status" function element allows you to connect certain messages of a function 
element in the safety circuit. For example, a specific error can be displayed on the system by 
means of a signal lamp. 
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Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number.
Element activated When this parameter is active, the function element is processed in the safety 

logic. 
When the parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Status element no. The parameter specifies the function element from which the element status will 
be provided. 

Parameters  

Status type You can select a status information item for a particular function element, which 
will then be output at the function output: 
• No status information 

This parameter setting enables, for example, use of this element as a space 
holder. The function output outputs the value "0." 

• Timer is active 
• Function waiting for startup test 
• Logic error 
• Wiring error 
• Substitute input value active 
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6.7.6 Control functions 

6.7.6.1 Device command 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Control functions Device command  ✓ ✓ 

Description    
With the "Device command" function element, commands can be integrated into the safety 
relay and connected device-specifically. For example, a reset can be triggered through an 
external button or over PROFIBUS. 

When there is a positive edge "0 → 1" at the input IN, the command is executed. 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 

General 

Element activated If this parameter is active, the function element is processed in the safety logic. 
If the parameter is deactivated, the command is not executed. 

Parameter  Command type • Execute no command 
• Reset 
• Apply code tables (MSS 3RK3 Advanced, MSS 3RK3 ASIsafe basic and 

MSS 3RK3 ASIsafe extended) 
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6.7.7 Logic functions 

6.7.7.1 AND 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Logic functions AND  ✓ ✓ 

Description    
The logic function "AND" has 1 to 5 logic inputs IN and one function output Q for the result of 
logic operation (RLO).  

RLO = 1 when all logic inputs have the status "1". 

Parameters  
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number  Consecutive number that is automatically assigned. You can change the 

number. 
Element activated  When this parameter is active, the function element is processed in the safety 

logic. 
When the parameter is deactivated, the set substitute value is made available 
at output Q. 

General 

Function output substitute 
value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Parameters  Number of logic inputs 1 to 5 elements can be parameterized for the element. 
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6.7.7.2 OR 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Logic functions OR  ✓ ✓ 

Description    
The logic function "OR" has 1 to 5 logic inputs and one function output Q for the result of 
logic operation (RLO). 

RLO = 1 when at least one logic input has the status "1." 

Parameters  
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number  Consecutive number that is automatically assigned. You can change the 

number. 
Element activated  When this parameter is active, the function element is processed in the safety 

logic. 
When the parameter is deactivated, the set substitute value is made available 
at output Q. 

General 

Function output substitute 
value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Parameter  Number of logic inputs 1 to 5 elements can be parameterized for the element. 
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6.7.7.3 XOR 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Logic functions XOR  ✓ ✓ 

Description    
The logic function "XOR" has 1 to 5 logic inputs and one function output Q for the result of 
logic operation (RLO). 

RLO = 1 when only one logic input has the status "1" at the same time. 

Parameters  
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number  Consecutive number that is automatically assigned. You can change the 

number. 
Element activated  When this parameter is active, the function element is processed in the safety 

logic. 
When the parameter is deactivated, the set substitute value is made available 
at output Q. 

General 

Function output substitute 
value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Parameter  Number of logic inputs 1 to 5 elements can be parameterized for the element. 
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6.7.7.4 NAND 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Logic functions NAND  ✓ ✓ 

Description    
The logic function "NAND" has 1 to 5 logic inputs and one function output Q for the result of 
logic operation (RLO). 

RLO = 0 when all logic inputs have the status "1". 

Parameters  
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number  Consecutive number that is automatically assigned. You can change the 

number. 
Element activated  When this parameter is active, the function element is processed in the safety 

logic. 
When the parameter is deactivated, the set substitute value is made available 
at output Q. 

General 

Function output substitute 
value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Parameter  Number of logic inputs 1 to 5 elements can be parameterized for the element. 
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6.7.7.5 NOR 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Logic functions NOR  ✓ ✓ 

Description    
The logic function "NOR" has 1 to 5 logic inputs and one function output Q for the result of 
logic operation (RLO). 

RLO = 0 when at least one logic input has the status "1". 

Parameters  
 
Parameter name Description/parameter value 

Name  You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number  Consecutive number that is automatically assigned. You can change the 

number. 
Element activated  When this parameter is active, the function element is processed in the safety 

logic. 
When the parameter is deactivated, the set substitute value is made available 
at output Q. 

General 

Function output substitute 
value 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Parameters  Number of logic inputs 1 to 5 elements can be parameterized for the element. 
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6.7.7.6 NEGATION (NEG) 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Logic functions NEGATION  ✓ ✓ 

Description    
The logic operation "NEGATION" has one input IN and one function output Q for the result of 
logic operation (RLO). 

An inverted input signal is output at the function output Q.  

RLO = 1 when input IN has the status "0". 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety 

logic.  
When this parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is deactivated.
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 
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6.7.8 Flip-flop 

6.7.8.1 FF-SR 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Flip-flop FF-SR  ✓ ✓ 

Description   
The safety relay supports the reset-dominant function "FF-SR".  
"Reset-dominant" means that the result of logic operation (RLO) cannot be set to "1" when 
the reset input R is "1". 

The function element has: 

● 2 inputs: Input for setting S, input for resetting R 

● A function output Q for the RLO 

The RLO is formed according to the following truth table: 

 
Input for setting S Input for resetting R RLO 

0 0 - 
0 1 0 
1 0 1 
1 1 0 

0 = low level 
1 = high level  
- no change in the output status 

RLO = 1, when the input for setting S = "1" and the input for resetting R = "0". 

RLO = 0, when the input for resetting R = "1". 
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Parameters  
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety 

logic.  
When this parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is deactivated.
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

6.7.9 Counter functions 

6.7.9.1 Counter (0 -> 1) 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Counter functions Counter (0 → 1)  ✓ ✓ 

Description   
 

 Note 

The count value is not stored. At the start of safety or test mode, all counters begin with their 
initial values. 

 

The safety relay supports the counter function "Counter (0 → 1)". The counter value is only 
changed when there is a positive edge at the counter inputs. The current counter value can 
be counted up or down via one proprietary counter input each. When a parameterizable 
counter limit value is achieved or overshot, the function output Q is set.  

The counter function has:  

● 3 inputs: CU - Counter input up, CD - Counter input down, R - Reset (parameterizable) 

● A function output Q for the result of logic operation (RLO) 
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Functional principle 
● The counter value is increased by 1 with every positive edge at the "Counter input up", 

except when the counter value reaches the maximum value 65535. 

● The count value is decreased by 1 with every positive edge at the "Count input down", 
except when the count value reaches the value 0. 

● The counter value remains unchanged when there is a positive edge simultaneously at 
both counter inputs. 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety 

logic.  
When this parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is deactivated.
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Counter limit value (CV) Set a counter limit value which is to be monitored (between 0 and 65535): 
• Function output Q = "1" when the current counter value reaches this limit 

value. 
• Function output Q = "0" when the current counter value falls below this limit 

value. 

Parameters 

Reset You can select whether the counter value is set to "0" automatically or manually: 
• Automatic 

When the function output Q = "1", the counter value and function output Q are 
set to "0" after one program cycle of the safety relay. 

• Manual 

The counter value is set to "0", irrespective of the state of the function output 
Q. 

If the counter value is not deleted after the limit value is exceeded, counting 
will continue. 

• Automatic with manual reset 

When the function output Q = "1", the counter value and function output Q are 
set to "0" after one program cycle of the safety relay. 
The counter value can be reset to "0" when the function output Q = "0". 
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6.7.9.2 Counter (1 -> 0) 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Counter functions Counter (1 → 0)  ✓ ✓ 

Description   
 

 Note 

The count value is not stored. At the start of safety or test mode, all counters begin with their 
initial values. 

 

The safety relay supports the counter function "Counter (1 → 0)". The counter value is only 
changed when there is a negative edge. The current counter value can be counted up or 
down via one proprietary counter input each. When a parameterizable counter limit value is 
achieved or overshot, the function output Q is set.  

The counter function has:  

● 3 inputs: CU - Counter input up, CD - Counter input down, R - Reset (parameterizable) 

● A function output Q for the result of logic operation (RLO) 

Functional principle 
● The counter value is increased by 1 with every negative edge at the "Counter input up", 

except when the counter value reaches the maximum value 65535. 

● The counter value is decreased by 1 with every negative edge at the "Counter input 
down", except when the counter value reaches the value 0. 

● The counter value remains unchanged when there is a positive edge simultaneously at 
both counter inputs. 
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Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for example, 

be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety logic. 

When this parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Counter limit value 
(CV) 

Set a counter limit value which is to be monitored (between 0 and 65535): 
• Function output Q = "1" when the current counter value reaches this limit value. 
• Function output Q = "0" when the current counter value falls below this limit 

value. 

Parameters 

Reset You can select whether the counter value is set to "0" automatically or manually: 
• Automatic 

When the function output Q = "1", the counter value and function output Q are 
set to "0" after one program cycle of the safety relay. 

• Manual 

The counter value is set to "0," irrespective of the state of function output Q. 

If the counter value is not deleted after the limit value is exceeded, counting will 
continue. 

• Automatic with manual reset 

When the function output Q = "1", the counter value and function output Q are 
set to "0" after one program cycle of the safety relay. 
The counter value can be reset to "0" when the function output Q = "0". 
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6.7.9.3 Counter (0 -> 1 / 1 -> 0) 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Counter functions Counter (0 → 1 / 1 → 0)  ✓ ✓ 

Description   
 

 Note 

The count value is not stored. At the start of safety or test mode, all counters begin with their 
initial values. 

 

The safety relay supports the counter function "Counter (0 → 1 / 1 → 0)". The counter value is 
only changed when there is a positive and negative edge. The current counter value can be 
counted up or down via one proprietary counter input each. When a parameterizable counter 
limit value is achieved or overshot, the function output Q is set.  

The counter function has:  

● 3 inputs: CU - Counter input up, CD - Counter input down, R - Reset (parameterizable) 

● A function output Q for the result of logic operation (RLO) 

Functional principle 
● The counter value is increased by 1 with every positive and negative edge at the 

"Counter input up", except when the counter value reaches the maximum value 65535. 

● The counter value is decreased by 1 with every positive and negative edge at the 
"Counter input down", except when the counter value reaches the value 0. 

● The counter value remains unchanged when there is a positive edge simultaneously at 
both counter inputs. 
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Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety logic. 

When this parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is deactivated.
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Counter limit value 
(CV)  

Set a counter limit value which is to be monitored (between 0 and 65535): 
• Function output Q = "1" when the current counter value reaches this limit value. 
• Function output Q = "0" when the current counter value falls below this limit 

value. 

Parameters 

Reset You can select whether the counter value is set to "0" automatically or manually: 
• Automatic 

When the function output Q = "1", the counter value and output Q are set to "0" 
after one program cycle of the safety relay. 

• Manual 

The counter value is set to "0", irrespective of the state of the function output Q. 

If the counter value is not deleted after the limit value is exceeded, counting will 
continue. 

• Automatic with manual reset 

When the function output Q = "1", the counter value and function output Q are 
set to "0" after one program cycle of the safety relay. 
The counter value can be reset to "0" when the function output Q = "0". 
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6.7.10 Timer functions 

6.7.10.1 With ON delay 
 

 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Timer functions With ON delay  ✓ ✓ 

Description    
 

 Note 

The time value is not stored. At the start of safety or test mode, all time values begin with 
their initial values. 

 

The safety relay supports the timer function "With ON delay". The function output Q is 
activated after the input (with a parameterizable delay time). 

The timer function has: 

● 2 inputs: IN, R - Reset 

● A function output Q for the result of logic operation (RLO) 

 

 Note 
MSS 3RK3 Basic limitation 

MSS 3RK3 Basic does not support a reset input for this function element.  

The MSS 3RK3 Basic responds as if the "Reset" parameter has "deactivated" the value. 
 

Functional principle 
● If a "1" is detected at input IN and no reset is active, the delay time "t1" starts. 

● After the delay time, function output Q is activated, i.e. set to "1", as long as there is a "1" 
at input IN. 

● When there is an edge change at input IN before the the end of delay time "t1", the delay 
time continues. The function output Q remains deactivated, i.e. "0", if there is a "0" at 
input IN after the end of the delay time. 
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"Reset" = "deactivated" and "Reset" = "with positive edge" or "with negative edge" 
The following diagram shows the behavior of the function element when "Reset" = 
"deactivated". It also applies for "Reset" = "with positive edge" or "with negative edge", if 
there is no edge change at input R. 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 
① Either "1" or "0" is present. 

Figure 6-17 Timer function "With ON delay" when "Reset" = "deactivated", "with negative edge", or 
"with positive edge". 
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"Reset" = "with positive edge" or "with negative edge" 
The following diagram shows the behavior of the function element when "Reset" = "with 
positive edge". 

 

 Note 
"Reset" = "with negative edge" 

The behavior of the function element when "Reset" = "with negative edge" is exactly the 
same as when "Reset" = "with positive edge", except that the signal from R is inverted. 
Negative edge "1" > "0" is evaluated here. 

 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 
tC Program cycle time 

Figure 6-18 Timer function "With ON delay" when "Reset" = "with positive edge" 
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"Reset" = "with level 1" 
The following diagram shows the behavior of the function element when "Reset" = "with 
level 1". 

 

 Note 
Value "0" is present at function input R 

If the value "0" is present at function input R, the behavior of the function element is the 
same as for the edge evaluation shown in the first diagram. 

 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 

Figure 6-19 Timer function "With ON delay" when "Reset" = "with level 1" 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety logic. 

When this parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is deactivated.
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 
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Parameter name Description/parameter value 
t1[s] • You enter the delay time here. 

• The maximum value is 655 s, increment: 5 ms 
Note that the delay time you specified is a multiple of the program cycle time you 
specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 Modular 
Safety System" manual, Ch. "Response times." 

Parameters 

Reset 
(not in the case of 
MSS 3RK3 Basic) 

• deactivated 

The timer cannot be reset selectively to the "initial position".  

The RLO is set/reset according to the input signal and the timer function.  
• with positive edge 

When a positive edge is detected at the reset input, all timers and the RLO are 
reset once to the value "0". The signal status at the timer trigger input is ignored 
in this process. The RLO assumes the value "0" for at least one program cycle. 

Afterwards, the element starts over with its functionality.1) The value of the reset 
input only becomes irrelevant when a positive edge is detected again.  

• with negative edge 

When a negative edge is detected at the reset input, all timers and the RLO are 
reset once to the value "0". The signal status at the timer trigger input is ignored 
in this process. The RLO assumes the value "0" for at least one program cycle. 

Afterwards, the element starts over with its functionality.1) The value of the reset 
input only becomes irrelevant when a negative edge is detected again.  

• with level 1 

When the value "1" is detected at the reset input, all timers and the RLO are 
reset to the value "0" as long as the value "1" is present. The signal status at 
the timer trigger input is ignored in this process. The RLO assumes the value 
"0" for at least one program cycle. 

The element starts over with its functionality only when the value "0" is detected 
again at the reset input. 1) 

1) "Starts over" applies to timer functions that are started by level 1 at the timer trigger input: The timers are started if the 
value "1" is present at the timer trigger input. 
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6.7.10.2 With ON delay (trigger) 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Timer functions With ON delay (trigger)  ✓ ✓ 

Description    
 

 Note 

The time value is not stored. At the start of safety or test mode, all time values begin with 
their initial values. 

 

The safety relay supports the timer function "With ON delay (trigger)". The function output Q 
is activated after the input (with a parameterizable delay time). 

The timer function has:  

● 2 inputs: IN, R - Reset 

● A function output Q for the result of logic operation (RLO) 

 

 Note 
MSS 3RK3 Basic limitation 

MSS 3RK3 Basic does not support a reset input for this function element.  

The MSS 3RK3 Basic responds as if the "Reset" parameter has "deactivated" the value. 
 

Functional principle 
● If a "1" is detected at input IN and no reset is active, the delay time "t1" starts. 

● After the delay time, function output Q is activated, i.e. set to "1", as long as there is a "1" 
at input IN. 

● The delay time is stopped on a 1 → 0 edge change at input IN On another 0 → 1 edge 
change, the delay time will restart. The function output Q remains deactivated, i.e. "0", if 
there is a "0" at input IN after the end of the delay time. 
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"Reset" = "deactivated" and "Reset" = "with positive edge" or "with negative edge" 
The following diagram shows the behavior of the function element when "Reset" = 
"deactivated". It also applies for "Reset" = "with positive edge" or "with negative edge", if 
there is no edge change at input R. 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 
① Either "1" or "0" is present. 

Figure 6-20 Timer function "With ON delay (trigger)" when "Reset" = "deactivated", "with negative 
edge", or "with positive edge". 
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"Reset" = "with positive edge" or "with negative edge" 
The following diagram shows the behavior of the function element when "Reset" = "with 
positive edge". 

 

 Note 
"Reset" = "with negative edge" 

The behavior of the function element when "Reset" = "with negative edge" is exactly the 
same as when "Reset" = "with positive edge", except that the signal from R is inverted. 
Negative edge "1" > "0" is evaluated here. 

 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 
tC Program cycle time 

Figure 6-21 Timer function "With ON delay (trigger)" when "Reset" = "with positive edge" 
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"Reset" = "with level 1" 
The following diagram shows the behavior of the function element when "Reset" = "with 
level 1". 

 

 Note 
Value "0" is present at function input R 

If the value "0" is present at function input "R", the behavior of the function element is the 
same as for the edge evaluation shown in the first diagram. 

 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 

Figure 6-22 Timer function "With ON delay (trigger)" when "Reset" = "with level 1" 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety logic.

When the parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Substitute value "0" or "1" can be assigned to the substitute value when the element is deactivated.
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 
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Parameter name Description/parameter value 
t1[s] • You enter the delay time here. 

• The maximum value is 655 s, increment: 5 ms 
Note that the delay time you specified is a multiple of the program cycle time you 
specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 Modular 
Safety System" manual, ch. "Response times". 

Parameters 

Reset 
(not in the case of 
MSS 3RK3 Basic) 

• deactivated 

The timer cannot be reset selectively to the "initial position".  

The RLO is set/reset according to the input signal and the timer function.  
• with positive edge 

When a positive edge is detected at the reset input, all timers and the RLO are 
reset once to the value "0". The signal status at the timer trigger input is ignored 
in this process. The RLO assumes the value "0" for at least one program cycle. 

Afterwards, the element starts over with its functionality.1) The value of the reset 
input only becomes irrelevant when a positive edge is detected again.  

• with negative edge 

When a negative edge is detected at the reset input, all timers and the RLO are 
reset once to the value "0". The signal status at the timer trigger input is ignored 
in this process. The RLO assumes the value "0" for at least one program cycle. 

Afterwards, the element starts over with its functionality.1) The value of the reset 
input only becomes irrelevant when a negative edge is detected again.  

• with level 1 

When the value "1" is detected at the reset input, all timers and the RLO are 
reset to the value "0" as long as the value "1" is present. The signal status at 
the timer trigger input is ignored in this process. The RLO assumes the value 
"0" for at least one program cycle. 

The element starts over with its functionality only when the value "0" is detected 
again at the reset input. 1) 

1) "Starts over" applies to timer functions that are started by level 1 at the timer trigger input: The timers are started if the 
value "1" is present at the timer trigger input. 
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6.7.10.3 Passing make contact 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Timer functions Passing make contact  ✓ ✓ 

Description    
 

 Note 

The time value is not stored. At the start of safety or test mode, all time values begin with 
their initial values. 

 

The safety relay supports the timer function "Passing make contact". An input signal 
generates a signal with parameterizable duration at function output Q. 

The timer function has: 

● 2 inputs: IN, R - Reset 

● A function output Q for the result of logic operation (RLO) 

 

 Note 
MSS 3RK3 Basic limitation 

MSS 3RK3 Basic does not support a reset input for this function element.  

The MSS 3RK3 Basic responds as if the "Reset" parameter has "deactivated" the value. 
 

Functional principle 
● If a "1" is detected at input IN and no reset is active, the delay time "t1" starts and function 

output Q is switched to "1". 

● When there is a negative edge "1 → 0" at input IN before the the end of the time "t1", the 
time is reset. Function output Q is deactivated, i.e. set to "0". 

● After the time period "t1", function output Q is deactivated, i.e. set to "0". 
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"Reset" = "deactivated" and "Reset" = "with positive edge" or "with negative edge" 
The following diagram shows the behavior of the function element when "Reset" = 
"deactivated". It also applies for "Reset" = "with positive edge" or "with negative edge", if 
there is no edge change at input R. 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 
① Either "1" or "0" is present. 

Figure 6-23 Timer function "Passing make contact" when "Reset" = "deactivated", "with negative 
edge", or "with positive edge". 
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"Reset" = "with positive edge" or "with negative edge" 
The following diagram shows the behavior of the function element when "Reset" = "with 
positive edge". 

 

 Note 
"Reset" = "with negative edge" 

The behavior of the function element when "Reset" = "with negative edge" is exactly the 
same as when "Reset" = "with positive edge", except that the signal from R is inverted. 
Negative edge "1" > "0" is evaluated here. 

 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 
tC Program cycle time 

Figure 6-24 Timer function "Passing make contact" when "Reset" = "with positive edge" 
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"Reset" = "with level 1" 
The following diagram shows the behavior of the function element when "Reset" = "with 
level 1". 

 

 Note 
Value "0" is present at function input R 

If the value "0" is present at function input R, the behavior of the function element is the 
same as for the edge evaluation shown in the first diagram. 

 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 

Figure 6-25 Timer function "Passing make contact" when "Reset" = "with level 1" 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety logic. 

When this parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Substitute value "0" or "1" can be assigned to the substitute value when the element is deactivated.
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 
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Parameter name Description/parameter value 
t1[s] • You enter the make time here. 

• The maximum value is 655 s, increment: 5 ms 
Please note that the delay time specified by you can be a multiple of the program 
cycle time specified by you in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 Modular 
Safety System" manual, ch. "Response times". 

Parameters 

Reset 
(not in the case of 
MSS 3RK3 Basic) 

• deactivated 

The timer cannot be reset selectively to the "initial position".  

The RLO is set/reset according to the input signal and the timer function.  
• with positive edge 

When a positive edge is detected at the reset input, all timers and the RLO are 
reset once to the value "0". The signal status at the timer trigger input is ignored 
in this process. The RLO assumes the value "0" for at least one program cycle. 

Afterwards, the element starts over with its functionality.1) The value of the reset 
input only becomes irrelevant when a positive edge is detected again.  

• with negative edge 

When a negative edge is detected at the reset input, all timers and the RLO are 
reset once to the value "0". The signal status at the timer trigger input is ignored 
in this process. The RLO assumes the value "0" for at least one program cycle. 

Afterwards, the element starts over with its functionality.1) The value of the reset 
input only becomes irrelevant when a negative edge is detected again.  

• with level 1 

When the value "1" is detected at the reset input, all timers and the RLO are 
reset to the value "0" as long as the value "1" is present. The signal status at 
the timer trigger input is ignored in this process. The RLO assumes the value 
"0" for at least one program cycle. 

The element starts over with its functionality only when the value "0" is detected 
again at the reset input. 1) 

1) "Starts over" applies to timer functions that are started by level 1 at the timer trigger input: The timers are started if the 
value "1" is present at the timer trigger input. 
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6.7.10.4 Passing make contact (trigger) 
 
Function element Icons MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Timer functions Passing make contact 

(trigger) 
 ✓ ✓ 

Description    
 

 Note 

The time value is not stored. At the start of safety or test mode, all time values begin with 
their initial values. 

 

The safety relay supports the timer function "Passing make contact (trigger)". An input signal 
generates a signal with parameterizable delay time at function output Q.  

The timer function has: 

● 2 inputs: IN, R - Reset 

● A function output Q for the result of logic operation (RLO) 

 

 Note 
MSS 3RK3 Basic limitation 

MSS 3RK3 Basic does not support a reset input for this function element. 

The MSS 3RK3 Basic responds as if the "Reset" parameter has "deactivated" the value. 
 

Functional principle 
● If a "1" is detected at input IN and no reset is active, the delay time "t1" starts and function 

output Q is switched to "1". 

● When there is a negative edge "1 → 0" at input IN before the the end of the time "t1", the 
time continues to elapse. Function output Q remains active, i.e. set to "1", during the time 
period "t1". When there is another positive edge "0 → 1" at input IN, time "t1" begins 
again. 

● After the time period, function output Q is deactivated, i.e. set to "0". 



Description of the software  
6.7 Function elements 

 Modular Safety System 3RK3 

366 System Manual, 06/2012, 9262530-02 Rev 004 

"Reset" = "deactivated" and "Reset" = "with positive edge" or "with negative edge" 
The following diagram shows the behavior of the function element when "Reset" = 
"deactivated". It also applies for "Reset" = "with positive edge" or "with negative edge", if 
there is no edge change at input R. 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 
① Either "1" or "0" is present. 

Figure 6-26 Timer function "Passing make contact (trigger)" when "Reset" = "deactivated", "with 
negative edge", or "with positive edge". 
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"Reset" = "with positive edge" or "with negative edge" 
The following diagram shows the behavior of the function element when "Reset" = "with 
positive edge". 

 

 Note 
"Reset" = "with negative edge" 

The behavior of the function element when "Reset" = "with negative edge" is exactly the 
same as when "Reset" = "with positive edge", except that the signal from R is inverted. 
Negative edge "1" > "0" is evaluated here. 

 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 
tC Program cycle time 

Figure 6-27 Timer function "Passing make contact (trigger)" when "Reset" = "with positive edge" 
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"Reset" = "with level 1" 
The following diagram shows the behavior of the function element when "Reset" = "with 
level 1". 

 

 Note 
Value "0" is present at function input R 

If the value "0" is present at function input R, the behavior of the function element is the 
same as for the edge evaluation shown in the first diagram. 

 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 

Figure 6-28 Timer function "Passing make contact (trigger)" when "Reset" = "with level 1" 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for example, 

be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety logic. 

When the parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Substitute value "0" or "1" can be assigned to the substitute value when the element is deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 
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Parameter name Description/parameter value 
t1[s] • You enter the make time here. 

• The maximum value is 655 s, increment: 5 ms 
Note that the delay time you specified is a multiple of the program cycle time you 
specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 Modular Safety 
System" manual, ch. "Response times". 

Parameters 

Reset 
(not in the case of 
MSS 3RK3 Basic) 

• deactivated 

The timer cannot be reset selectively to the "initial position".  

The RLO is set/reset according to the input signal and the timer function.  
• with positive edge 

When a positive edge is detected at the reset input, all timers and the RLO are 
reset once to the value "0". The signal status at the timer trigger input is ignored in 
this process. The RLO assumes the value "0" for at least one program cycle. 

Afterwards, the element starts over with its functionality.1) The value of the reset 
input only becomes irrelevant when a positive edge is detected again.  

• with negative edge 

When a negative edge is detected at the reset input, all timers and the RLO are 
reset once to the value "0". The signal status at the timer trigger input is ignored in 
this process. The RLO assumes the value "0" for at least one program cycle. 

Afterwards, the element starts over with its functionality.1) The value of the reset 
input only becomes irrelevant when a negative edge is detected again.  

• with level 1 

When the value "1" is detected at the reset input, all timers and the RLO are reset 
to the value "0" as long as the value "1" is present. The signal status at the timer 
trigger input is ignored in this process. The RLO assumes the value "0" for at least 
one program cycle. 

The element starts over with its functionality only when the value "0" is detected 
again at the reset input. 1) 

1) "Starts over" applies to timer functions that are started by level 1 at the timer trigger input: The timers are started if the 
value "1" is present at the timer trigger input. 
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6.7.10.5 With OFF delay 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Timer functions With OFF delay  ✓ ✓ 

Description    
 

 Note 

The time value is not stored. At the start of safety or test mode, all time values begin with 
their initial values. 

 

The safety relay supports the timer function "With OFF delay". The function output Q is 
deactivated after the input (with a parameterizable delay time).  

The timer function has: 

● 2 inputs: IN, R - Reset 

● A function output Q for the result of logic operation (RLO) 

 

 Note 
MSS 3RK3 Basic limitation 

MSS 3RK3 Basic does not support a reset input for this function element. 

The MSS 3RK3 Basic responds as if the "Reset" parameter has "deactivated" the value. 
 

Functional principle 
● If a "1" is detected at input IN and no reset is active, function output Q is set to "1". 

● When there is a negative edge "1 → 0" at input IN, delay time "t1" begins. 

● After the delay time, function output Q is deactivated, i.e. set to "0". 

● When there is a positive edge "0 → 1" at input IN before the the end of the delay time "t1", 
the delay time continues. Function output Q remains active, i.e. set to "1". 
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"Reset" = "deactivated" and "Reset" = "with positive edge" or "with negative edge" 
The following diagram shows the behavior of the function element when "Reset" = 
"deactivated". It also applies for "Reset" = "with positive edge" or "with negative edge", if 
there is no edge change at input R. 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 
① Either "1" or "0" is present. 

Figure 6-29 Timer function "With OFF delay" when "Reset" = "deactivated", "with negative edge", or 
"with positive edge". 
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"Reset" = "with positive edge" or "with negative edge" 
The following diagram shows the behavior of the function element when "Reset" = "with 
positive edge". 

 

 Note 
"Reset" = "with negative edge" 

The behavior of the function element when "Reset" = "with negative edge" is exactly the 
same as when "Reset" = "with positive edge", except that the signal from R is inverted. 
Negative edge "1" > "0" is evaluated here. 

 

 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 
tC Program cycle time 

Figure 6-30 Timer function "With OFF delay" when "Reset" = "with positive edge" 
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"Reset" = "with level 1" 
The following diagram shows the behavior of the function element when "Reset" = "with 
level 1". 

 

 Note 
Value "0" is present at function input R 

If the value "0" is present at function input R, the behavior of the function element is the 
same as for the edge evaluation shown in the first diagram. 

 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 

Figure 6-31 Timer function "With OFF delay" when "Reset" = "with level 1" 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for example, 

be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety logic. 

When the parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 
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Parameter name Description/parameter value 
t1[s] • You enter the delay time here. 

• The maximum value is 655 s, increment: 5 ms 
Note that the delay time you specified is a multiple of the program cycle time you 
specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 Modular Safety 
System" manual, ch. "Response times". 

Parameters 

Reset 
(not in the case of 
MSS 3RK3 Basic) 

• deactivated 

The timer cannot be reset selectively to the "initial position".  

The RLO is set/reset according to the input signal and the timer function.  
• with positive edge 

When a positive edge is detected at the reset input, all timers and the RLO are 
reset once to the value "0". The signal status at the timer trigger input is ignored in 
this process. The RLO assumes the value "0" for at least one program cycle. 

Afterwards, the element starts over with its functionality.1) The value of the reset 
input only becomes irrelevant when a positive edge is detected again.  

• with negative edge 

When a negative edge is detected at the reset input, all timers and the RLO are 
reset once to the value "0". The signal status at the timer trigger input is ignored in 
this process. The RLO assumes the value "0" for at least one program cycle. 

Afterwards, the element starts over with its functionality.1) The value of the reset 
input only becomes irrelevant when a negative edge is detected again.  

• with level 1 

When the value "1" is detected at the reset input, all timers and the RLO are reset 
to the value "0" as long as the value "1" is present. The signal status at the timer 
trigger input is ignored in this process. The RLO assumes the value "0" for at least 
one program cycle. 

The element starts over with its functionality only when the value "0" is detected 
again at the reset input. 1) 

1) "Starts over" applies to timer functions that are started by level 1 at the timer trigger input: The timers are started if the 
value "1" is present at the timer trigger input. 
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6.7.10.6 With OFF delay (trigger) 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Timer functions With OFF delay (trigger)  ✓ ✓ 

Description    
 

 Note 

The time value is not stored. At the start of safety or test mode, all time values begin with 
their initial values. 

 

The safety relay supports the timer function "With OFF delay (trigger)". The function output Q 
is deactivated after the input (with a parameterizable delay time).  

The timer function has: 

● 2 inputs: IN, R - Reset 

● A function output Q for the result of logic operation (RLO) 

 

 Note 
MSS 3RK3 Basic limitation 

MSS 3RK3 Basic does not support a reset input for this function element. 

The MSS 3RK3 Basic responds as if the "Reset" parameter has "deactivated" the value. 
 

Functional principle 
● If a "1" is detected at input IN and no reset is active, function output Q is set to "1". 

● When there is a negative edge "1 → 0" at input IN, delay time "t1" begins. 

● When there is a positive edge "0 → 1" at input IN before the the end of delay time "t1", the 
delay time is reset. Function output Q remains active, i.e. set to "1". 

● After the delay time, function output Q is deactivated, i.e. set to "0". 
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"Reset" = "deactivated" and "Reset" = "with positive edge" or "with negative edge" 
The following diagram shows the behavior of the function element when "Reset" = 
"deactivated". It also applies for "Reset" = "with positive edge" or "with negative edge", if 
there is no edge change at input R. 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 
① Either "1" or "0" is present. 

Figure 6-32 Timer function "With OFF delay (trigger)" when "Reset" = "deactivated", "with negative 
edge", or "with positive edge". 
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"Reset" = "with positive edge" or "with negative edge" 
The following diagram shows the behavior of the function element when "Reset" = "with 
positive edge". 

 

 Note 
"Reset" = "with negative edge" 

The behavior of the function element when "Reset" = "with negative edge" is exactly the 
same as when "Reset" = "with positive edge", except that the signal from R is inverted. 
Negative edge "1" > "0" is evaluated here. 

 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 
tC Program cycle time 

Figure 6-33 Timer function "With OFF delay (trigger)" when "Reset" = "with positive edge" 
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"Reset" = "with level 1" 
The following diagram shows the behavior of the function element when "Reset" = "with 
level 1". 

 

 Note 
Value "0" is present at function input R 

If the value "0" is present at function input R, the behavior of the function element is the 
same as for the edge evaluation shown in the first diagram. 

 

 

 
PWR Power supply 
IN Function input 
Q Function output 
R Reset 
t1 Delay time 

Figure 6-34 Timer function "With OFF delay (trigger)" when "Reset" = "with level 1" 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety 

logic. 
When the parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is deactivated.
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 
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Parameter name Description/parameter value 
t1[s] • You enter the delay time here. 

• The maximum value is 655 s, increment: 5 ms 
Note that the delay time you specified is a multiple of the program cycle time you 
specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 Modular 
Safety System" manual, ch. "Response times". 

Parameters 

Reset 
(not in the case of 
MSS 3RK3 Basic) 

• deactivated 

The timer cannot be reset selectively to the "initial position".  

The RLO is set/reset according to the input signal and the timer function.  
• with positive edge 

When a positive edge is detected at the reset input, all timers and the RLO are 
reset once to the value "0". The signal status at the timer trigger input is ignored 
in this process. The RLO assumes the value "0" for at least one program cycle. 

Afterwards, the element starts over with its functionality.1) The value of the reset 
input only becomes irrelevant when a positive edge is detected again.  

• with negative edge 

When a negative edge is detected at the reset input, all timers and the RLO are 
reset once to the value "0". The signal status at the timer trigger input is ignored 
in this process. The RLO assumes the value "0" for at least one program cycle. 

Afterwards, the element starts over with its functionality.1) The value of the reset 
input only becomes irrelevant when a negative edge is detected again.  

• with level 1 

When the value "1" is detected at the reset input, all timers and the RLO are 
reset to the value "0" as long as the value "1" is present. The signal status at 
the timer trigger input is ignored in this process. The RLO assumes the value 
"0" for at least one program cycle. 

The element starts over with its functionality only when the value "0" is detected 
again at the reset input. 1) 

1) "Starts over" applies to timer functions that are started by level 1 at the timer trigger input: The timers are started if the 
value "1" is present at the timer trigger input. 
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6.7.10.7 Clocking 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Timer functions Clocking  ✓ ✓ 

Description    
 

 Note 

The time value is not stored. At the start of safety mode, all time values begin with their initial 
values. 

 

The safety relay supports the timer function "Clocking". The output is switched on and off 
periodically based on a parameterizable pulse/interval ratio. 

The timer function has: 

● 2 inputs: IN, R - Reset 

● A function output Q for the result of logic operation (RLO) 

 

 Note 
MSS 3RK3 Basic limitation 

MSS 3RK3 Basic does not support a reset input for this function element.  

The MSS 3RK3 Basic responds as if the "Reset" parameter has "deactivated" the value. 
 

Functional principle 
● If a "1" is detected at input IN and no reset is active, the clock pulse generator starts. The 

function output Q sends pulses as long as the input is set to "1". 

● When there is a negative edge "1 → 0" at input IN, the clock pulse generator stops and 
sets the function output Q to "0". 
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"Reset" = "deactivated" and "Reset" = "with positive edge" or "with negative edge" 
The following diagram shows the behavior of the function element when "Reset" = 
"deactivated". It also applies for "Reset" = "with positive edge" or "with negative edge", if 
there is no edge change at input R. 

 
PWR Power supply  
IN Function input 
Q Function output 
R Reset 
t1 Delay time 
① Either "1" or "0" is present. 

Figure 6-35 Timer function "Clocking" when "Reset" = "deactivated", "with negative edge", or "with 
positive edge". 
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"Reset" = "with positive edge" or "with negative edge" 
The following diagram shows the behavior of the function element when "Reset" = "with 
positive edge". 

 

 Note 
"Reset" = "with negative edge" 

The behavior of the function element when "Reset" = "with negative edge" is exactly the 
same as when "Reset" = "with positive edge", except that the signal from R is inverted. 
Negative edge "1" > "0" is evaluated here. 

 

 
PWR Power supply  
IN Function input 
Q Function output 
R Reset 
t1 Delay time 
tC Program cycle time 

Figure 6-36 Timer function "Clocking" when "Reset" = "with positive edge" 
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"Reset" = "with level 1" 
The following diagram shows the behavior of the function element when "Reset" = "with 
level 1". 

 

 Note 
Value "0" is present at function input R 

If the value "0" is present at function input R, the behavior of the function element is the 
same as for the edge evaluation shown in the first diagram. 

 

 

 
PWR Power supply  
IN Function input 
Q Function output 
R Reset 
t1 Delay time 

Figure 6-37 Timer function "Clocking" when "Reset" = "with level 1" 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for example, 

be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety logic.

When the parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 
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Parameter name Description/parameter value 
t1[s] 
t2[s] 

• Enter the pulse time t1 and the pause time t2 for the clock-pulse generator. 
• The maximum value is 655 s, increment: 5 ms 
Please note that the times you specified are a multiple of the program cycle time 
you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 Modular Safety 
System" manual, ch. "Response times". 

Parameters 

Reset 
(not in the case of 
MSS 3RK3 Basic) 

• deactivated 

The timer cannot be reset selectively to the "initial position".  

The RLO is set/reset according to the input signal and the timer function.  
• with positive edge 

When a positive edge is detected at the reset input, all timers and the RLO are 
reset once to the value "0". The signal status at the timer trigger input is ignored 
in this process. The RLO assumes the value "0" for at least one program cycle. 

Afterwards, the element starts over with its functionality.1) The value of the reset 
input only becomes irrelevant when a positive edge is detected again.  

• with negative edge 

When a negative edge is detected at the reset input, all timers and the RLO are 
reset once to the value "0". The signal status at the timer trigger input is ignored 
in this process. The RLO assumes the value "0" for at least one program cycle. 

Afterwards, the element starts over with its functionality.1) The value of the reset 
input only becomes irrelevant when a negative edge is detected again.  

• with level 1 

When the value "1" is detected at the reset input, all timers and the RLO are 
reset to the value "0" as long as the value "1" is present. The signal status at the 
timer trigger input is ignored in this process. The RLO assumes the value "0" for 
at least one program cycle. 

The element starts over with its functionality only when the value "0" is detected 
again at the reset input. 1) 

1) "Starts over" applies to timer functions that are started by level 1 at the timer trigger input: The timers are started if the 
value "1" is present at the timer trigger input. 
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6.7.11 Start functions 

6.7.11.1 Monitored start 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Start functions Monitored start  ✓ ✓ 

Description    
The "Monitored start" function element requires as start condition status "1" at input IN and 
input START. When this condition is fulfilled, the function output Q is activated, i.e. set to "1". 

The start signal at the START input is only valid when the following applies: 

● The time sequence of the START signal corresponds to the values "0 → 1 → 0". 

● Value "1" must be present for 0.15 to 2 s. 

 
Figure 6-38 Start function "Monitored start" 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety 

logic. 
When the parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is deactivated.
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 
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6.7.11.2 Manual start 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Start functions Manual start  ✓ ✓ 

Description    
The "Manual start" function element requires as start condition status "1" at input IN and 
input START. When this condition is fulfilled, the function output Q is activated, i.e. set to "1". 

The start signal at the START input is only valid when the following applies: 

The time sequence of the START signal corresponds to the values "0 → 1". 

 
Figure 6-39 Manual start 

Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for example, 

be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element activated When this parameter is active, the function element is processed in the safety logic. 

When the parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Function output 
substitute value 

"0" or "1" can be assigned to the substitute value when the element is deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 
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6.7.12 Output functions 

6.7.12.1 Standard output 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Output functions Standard output  ✓ ✓ 

Description   
The "Standard output" function element is required to switch the hardware outputs of the 
standard output group.   

 

WARNING  
Erroneous start on transmission error at fieldbus inputs 
Will Cause Death, Serious Injury or Property Damage 

Transmission errors at the fieldbus inputs can result in an erroneous start in which the 
system starts accidentally. To prevent this, the start type must be parameterized as 
"monitored." 
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Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the number. 
Element 
activated 

When this parameter is active, the function element is processed in the safety 
logic. 
When the parameter is deactivated, the set substitute value is made available at 
output Q. 

General 

Substitute value 
- Q1 

"0" or "1" can be assigned to the substitute value when the element is deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

Q1 Select the output for the processed signal. 
Auxiliary outputs Select whether auxiliary outputs are to be activated: 

• No 
• One auxiliary output 
• Two auxiliary outputs 

AUX1 Only available when at least one auxiliary output is activated: 
Select the output to which the processed signal is to be output. The auxiliary output 
AUX1 supplies the same signal as Q. It can be switched with safe or standard 
modules.  

Parameters - 
Output circuit 

AUX2 Only available when two auxiliary outputs are activated: 
Select the output for the processed signal. The auxiliary output AUX2 supplies the 
same signal as Q. It can be switched with safe or standard modules. 

Parameter -  
Start 
(not in the case of 
MSS 3RK3 Basic) 

Start type • Automatic: 

The function output is set as soon as all start conditions are fulfilled. 
• Monitored: 

Function output Q is set as soon as all start conditions are fulfilled and the start 
signal is changed from "0 → 1 → 0." 

• Manual: 

Function output Q is set as soon as all start conditions are fulfilled and the start 
signal is changed from "0 → 1." 
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6.7.12.2 F output 
 
Function element  Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Output functions F output  ✓ ✓ 

Description    
The "F output" function element can be used to switch the hardware outputs of the safety-
related modules on one or two channels. 

 

WARNING  
Erroneous start on transmission error at fieldbus inputs 
Will Cause Death, Serious Injury or Property Damage 

Transmission errors at the fieldbus inputs can result in an erroneous start in which the 
system starts accidentally. To prevent this, the start type must be parameterized as 
"monitored." This is necessary to achieve SIL 3 as per EN 61508 and PL e as per 
EN ISO 13849-1. 

 

 Note 

On a signal change at function input FEEDBACK, an error is generated immediately if the 
signal at function output FAULT has not changed. 
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Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the 

number. 
Element activated When this parameter is active, the function element is processed in the safety 

logic.  
When this parameter is deactivated, the set substitute value is made available at 
output Q. 

Substitute value - 
Q1 

"0" or "1" can be assigned to the substitute value when the element is 
deactivated. 
Substitute value "0" means output Q = 0 
substitute value "1" means output Q = 1 

General 

Substitute value - 
Q2 

Only available with output type "Redundant F output":  
"0" or "1" can be assigned to the substitute value when the element is 
deactivated.  

Parameters  Output type Select the output type: 
• Single F output 
• Redundant F output 

Monitoring The signal at the feedback circuit input is monitored with time delay by 
comparing it with the current status of the function output. 
Select the type of feedback circuit monitoring: 
• Deactivated 
• For OFF and ON status 
• For OFF status 

Parameters - 
Feedback circuit  

Switching time [s] Parameters are only available when Parameters - Feedback circuit monitoring 
"For OFF and ON status" or "For OFF status" is activated. 
Select the switching time of the "auxiliary contacts" that depends on the function 
element. 
Note that the entered feedback circuit switching time is a multiple of the program 
cycle time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 Modular 
Safety System" manual, Chapter "Response times." 
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Parameter name Description/parameter value 
Q1 Select the output for the processed signal. 

Q1 can only be interconnected with the output of a safe module of the main 
system. 

Q2 Only available with output type "Redundant F output":  
Select the output for the processed signal. 
Q2 can only be interconnected with the output of a safe module of the main 
system. 

Auxiliary outputs Select whether auxiliary outputs are to be activated: 
• No 
• One auxiliary output 
• Two auxiliary outputs 

AUX1 Only available when at least one auxiliary output is activated: 
Select the output to which the processed signal is to be output. The auxiliary 
output AUX1 supplies the same signal as Q. It can be switched with safe or 
standard modules.  

AUX2 Only available when two auxiliary outputs are activated: 
Select the output for the processed signal. The auxiliary output AUX2 supplies 
the same signal as Q. It can be switched with safe or standard modules. 

Parameters - 
Output circuit 

FAULT Select the output for the processed signal. 
Parameter -  
Start 
(not in the case of 
MSS 3RK3 Basic) 

Start type • Automatic: 

The function output is set as soon as all start conditions are fulfilled. 
• Monitored: 

Function output Q is set as soon as all start conditions are fulfilled and the 
start signal is changed from "0 → 1 → 0." 

• Manual: 

Function output Q is set as soon as all start conditions are fulfilled and the 
start signal is changed from "0 → 1." 
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6.7.12.3 AS-i 1..4F-DO 
 
Function element Symbol MSS 3RK3 Basic MSS 3RK3 Advanced  

MSS 3RK3 ASIsafe 
Output functions AS-i 1..4F-DO  - ✓ 

 
 

 Note 

The function element is available in MSS ES only when using an MSS 3RK3 Advanced, 
MSS 3RK3 ASIsafe basic or MSS 3RK3 ASIsafe extended. If an MSS 3RK3 Basic is 
configured in the configuration, the function element will be hidden in the catalog window. 

 

 

Description    
With the "AS-i 1..4F-DO" function element, safety-related AS-i outputs can be switched. A 
safety-related AS-i output module can contain up to four safe outputs, wherein only one fail-
safe output can be active at any given time.   

Up to 12 safety-related AS-i-outputs can be set/reset independently. The element can be 
placed multiple times for this purpose. You connect the F-OUT1 ... 4 signals from the safety-
related AS-i output with the corresponding AS-i address to the "output terminals" of the 
individual function elements. 

Properties 
The "AS-i 1..4F-DO" function element has the following properties: 

● 4 function outputs for setting/resetting the 4 safety-related F-OUT1..4 outputs of an 
ASIsafe output slave. The equipment identifier (BMK) in the terminal address is that of 
the safety relay and not that of the ASIsafe output slave. 

● One function input each for setting/resetting the 4 safety-related AS-i outputs. These 
function inputs are monitored in such a way that only one of the function inputs can have 
the value "1" at any one time. If this condition is violated, all safety-related outputs of this 
function element will be shut down and an error message to this effect is generated. 

● 2 function inputs with which you can set and reset the two non-safety-related auxiliary 
control signals AUX1 and AUX2. 
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  Note 
Non-safety-related auxiliary control signals (AUX1/AUX2) 

In addition to the safety-related control signals (code sequences) of the AS-i outputs, 
non-safety-related auxiliary control signals (AUX1, AUX2) can also be transmitted. These 
are used, for example, to acknowledge a restart inhibit or to release errors at AS-i 
outputs. Additional information can be found in the relevant documentation of the safety-
related AS-i output. 

The auxiliary control signals AUX1 and AUX2 are defined as pulses. That is why these 
terminals must not be used for static signals. This pulse is generated as soon as an edge 
change from zero to one is detected at the respective AUX input (an edge change from 
one to zero is not taken into consideration). 

If a simultaneous edge change is detected for both inputs, the pulse for AUX2 is output 
after the pulse for AUX1. 

  Note 
Forcing 

Only one of the function outputs can have the value "1" at any one time. The other 
outputs are automatically forced to the value "0." If forcing of an output is canceled, 
forcing of all other outputs will also be canceled. If multiple outputs are forced to "1," the 
code sequence of the output with the lowest number will be output. 

WARNING  
 

Erroneous start on transmission error at fieldbus inputs 
Will Cause Death, Serious Injury or Property Damage 

Transmission errors at the fieldbus inputs can result in an erroneous start in which the 
system starts accidentally. To prevent this, the start type must be parameterized as 
"monitored." This is necessary to achieve SIL 3 as per EN 61508 and PL e as per 
EN ISO 13849-1. 

  Note 

On a signal change at function input FEEDBACK_1 ... 4, an error is generated 
immediately if the signal at function output FAULT has not changed. 
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Parameters 
 
Parameter name Description/parameter value 

Name You can enter a name for the element here. 
Comment This text appears above the function element in the diagram. This may, for 

example, be information about this function element. 
Element number Consecutive number that is automatically assigned. You can change the 

number. 
Element activated When this parameter is active, the function element is processed in the 

safety logic.  
When this parameter is deactivated, the set substitute value is made 
available at output Q. 

General 

Function output 
substitute value 

The substitute value "1" can only be assigned to one output at a time. "0" is 
automatically assigned to all others. "0" or "1" can be assigned to the 
substitute value when the element is deactivated. 

Parameters  Output type Select the number of safety-related outputs required: 
• 1F-DO 
• 2F-DO 
• 3F-DO 
• 4F-DO 

Monitoring The signal at the feedback circuit input is monitored with time delay by 
comparing it with the current status of the function output. 
Select the type of feedback circuit monitoring: 
• Deactivated 
• For OFF and ON status 
• For OFF status 

Parameter - 
Feedback circuit -  
for outputs 1 to 4 

Switching time [s] Parameters are only available when Parameters - Feedback circuit 
monitoring "For OFF and ON status" or "For OFF status" is activated. 
Select the switching time of the "auxiliary contacts" that depends on the 
function element. 
Note that the entered feedback circuit switching time is a multiple of the 
program cycle time you specified in the properties of the 3RK3 central unit. 
For additional information on the program cycle time, see the "3RK3 
Modular Safety System" manual, Chapter "Response times". 

Q1 Select the output for the processed signal. 
Q2-Q4 The fields are activated by the Output type parameter. 

The outputs are assigned automatically according to the selected output Q1.
All 4 outputs must be on the same slave. 

Parameters - Output 
circuit 

FAULT Select the output for the processed signal. 
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Parameter name Description/parameter value 
Parameter - Start Start type • Automatic: 

The function output is set as soon as all start conditions are fulfilled. 
• Monitored: 

Function output Q is set as soon as all start conditions are fulfilled and 
the start signal is changed from "0 → 1 → 0." 

• Manual: 

Function output Q is set as soon as all start conditions are fulfilled and 
the start signal is changed from "0 → 1." 
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Operation 7
7.1 Response times 

Verification of response times in the case of safety circuits   
When safety equipment is commissioned, steps must be taken to verify that a safety-related 
output will switch off within a maximum permissible response time if the input signal changes 
at the relevant input. 

To provide this verification, you must determine the total response time of the application you 
have configured.  

 

WARNING  
Note that the calculation of the response time affects the level of safety and governs the 
overall design of the system. 

 

 
 

 Note 

If field bus and EM signals are logically combined, runtime synchronism must be considered. 
It is the responsibility of the manufacturer to ensure that the system or machine is functioning 
properly as a whole. 
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7.1.1 Response time of the logic of the MSS 3RK3 
When calculating the response time of the logic of the MSS 3RK3, the following times 
configured in the MSS ES must be considered:   

● Program cycle time of the central unit  

– Without AS-i interface (3RK3 Basic): 10 ... 60 ms 

– With AS-i interface (3RK3 Advanced, 3RK3 ASIsafe basic, and 3RK3 ASIsafe 
extended): 

 

Program cycle time  

3RK3 Advanced 3RK3 ASIsafe basic 3RK3 ASIsafe 
extended 

AS-i interface 
activated 

15 ... 60 ms 15 ... 60 ms 15 ... 60 ms 

AS-i interface 
deactivated 

10 ... 60 ms 10 ... 60 ms 10 ... 60 ms 

● Relevant input delay times for monitoring functions and input cells at the inputs of the 
expansion modules 

● Relevant timer functions in the logic (timer)  

 

Maximum response time tRL of the logic of the MSS 3RK3 

 
Figure 7-1 Maximum response time of the logic of the MSS 3RK3   

Calculation formula for the maximum response time of the logic of the MSS 3RK3 
 

tRL = (2 x tCYCL) + tDELAY + tTIMER 
 

 
Formula Description 
tRL Maximum response time of the logic of the MSS 3RK3 
tCYCL Program cycle time of the MSS 3RK3 
tDELAY Input delay for monitoring functions and input cells at the inputs 
tTIMER Timer functions in the logic (timer) 
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7.1.2 Total response time "sensor - actuator" 
The total response time of the MSS 3RK3 is dependent on the functions that the MSS 3RK3 
performs in the respective case. In both graphics below, all times that can occur are shown 
in compact form.  

These times are dependent on two factors: 

● Type of terminals used to connect the sensor or actuator to the logic of MSS 3RK3, e.g., 
terminal on the device or via AS-i bus 

● Signal change: 

– "OFF signal" means the change from the ON state to the OFF state (1 > 0). 

– "ON signal" means the change from the OFF state to the ON state (0 > 1). 
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* This response time only applies if transmission of the cyclic data is not delayed by acyclic data 

transfer. In this case, the response time of input terminals tIN or the response time of the output 
terminals tQ is 256 x tCYCLasi + 16 s. 

Figure 7-2 Total response time "sensor - actuator" - part 1 
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Figure 7-3 Total response time "sensor - actuator" - part 2 
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S Sensor (provides an OFF or ON signal) 
IN Input terminal 
Q Output terminal 
A Actuator 
tRSA Total response time of the system from a sensor (S) to an actuator (A) 
tS For the response time of the sensor (S), see the documentation of the sensor 
tIN Transmission duration from signal acquisition at the input terminal (IN) to the logic 

of the MSS 3RK3; depending on the signal 
tRL Response time of the logic of the MSS 3RK3, see Chapter "Response time of the 

logic of the MSS 3RK3 (Page 398)" 
tDELAY Input delay for monitoring functions and input cells at the inputs 
tTIMER Timer functions in the logic (timer) 
tQ Transmission duration from the logic of the MSS 3RK3 to the output terminal (Q); 

depending on the signal; for values, see the graphic above 
tA For the response time of the actuator (A) including the time until the signal has 

been received and processed by the actuator, see the documentation of the 
actuator. 

tCYCL Program cycle time of the MSS 3RK3, configured in MSS ES 
tCYCLasi AS-i cycle time, max. 5 ms 
tOUT Response time of the output terminal on the expansion module (EM Q) 

• Solid-state outputs: 10 ms 
• Relay outputs: 20 ms 

tRT Restart standby time of the  
• safe outputs: 420 ms 
• non-safety-related outputs: 0 ms 

tFAULTasi Response time of the MSS 3RK3 in case of an error on the AS-i bus: Max. 32 ms
tFAULTasi-A Response time of the AS-i actuator in case of an error on the AS-i bus: see the 

documentation of the AS-i actuator 
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Calculation formula for the overall response time of the system   
 

tRSA = tS + tIN + tRL + tQ + tA 

 

 
Formula Description 
tRSA Total response time of the system from a sensor (S) to an actuator (A) 
tS For the response time of the sensor (S), see the documentation of the sensor 
tIN Transmission duration from signal acquisition at the input terminal (IN) to the logic of the 

MSS 3RK3; depending on the signal 
tRL Response time of the logic of the MSS 3RK3 
tQ Transmission duration from the logic of the MSS 3RK3 to the output terminal (Q); 

depending on the signal; for values, see the graphic above 
tA For the response time of the actuator (A), see the documentation of the actuator 
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7.1.3 Examples of the total response time with MSS 3RK3 Advanced 

Example 1 

1 43 5 62  
① AS-i master 
② AS-i power section 
③ Fail-safe AS-i EMERGENCY STOP 
④ MSS 3RK3 Advanced 
⑤ Safety-related AS-i output 
⑥ Contactor 

Figure 7-4 Configuration MSS 3RK3 Advanced - example 1 

This case considers the signal flow from a safety-related AS-i sensor (AS-i EMERGENCY 
STOP) to a safety-related AS-i output. The EMERGENCY STOP transmits an OFF signal to 
the MSS 3RK3 Advanced. The MSS 3RK3 monitors this safety-related AS-i input slave. After 
taking input delay times and timer functions in the logic into account, the MSS 3RK3 
Advanced transmits a signal to the safety-related AS-i output that shuts down the system. In 
this way, MSS 3RK3 controls a safety-related AS-i output. 
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6

 
Figure 7-5 Signal flow of example 1 
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The total response time is calculated as follows: 

 
Figure 7-6 Total response time MSS 3RK3 Advanced - example 1 

 
tRSA_1 = tS + (2 x tCYCLasi) + tRL + (2 x tCYCLasi) + tA  

= tS + (4 x tCYCLasi) + tRL + tA 
 

 
Formula Description 
tRSA_1 Total response time of the system from a safety-related AS-i sensor (ASI S) to a safety-

related AS-i output (ASI A) 
tS Response time of the AS-i sensor (ASI S), see the documentation of the sensor 
tCYCLasi • Transmission duration from signal acquisition on the safety-related AS-i input slave 

(ASI IN) to the logic of the MSS 3RK3 
• Transmission duration from the logic of the MSS 3RK3 to the input terminal on the 

safety-related AS-i output (ASI Q) 
AS-i cycle time, max. 5 ms 

tRL For the response time of the logic of the MSS 3RK3, see Chapter "Response time of the 
logic of the MSS 3RK3 (Page 398)" 

tA Response time of the AS-i output (ASI A), see the documentation of AS-i output 
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Example 2   

1 43 62 5  
① AS-i master 
② AS-i power section 
③ Safety-related AS-i input slave 
④ Fail-safe EMERGENCY STOP 
⑤ MSS 3RK3 Advanced 
⑥ Contactor 

Figure 7-7 Configuration MSS 3RK3 Advanced - example 2 

This case considers the signal flow from an EMERGENCY STOP on a safety-related AS-i 
input slave to an actuator (contactor) via the output terminal of an expansion module. 

The EMERGENCY STOP transmits an OFF signal to the input slave. The slave transfers the 
signal via the AS-i bus in a safety-related manner. MSS 3RK3 monitors this safety-related 
AS-i input slave and processes the information in the logic. After taking input delay times and 
timer functions in the logic into account, the MSS 3RK3 Advanced shuts the system down by 
means of a contactor.  
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Figure 7-8 Signal flow of example 2 
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The total response time is calculated as follows: 

 
Figure 7-9 Total response time MSS 3RK3 Advanced - example 2 

*The AS-i slave only has to be considered if the utilized slave does not forward the changed 
input signal directly to the bus and its signal processing thus contributes to the system 
response time. Refer to the documentation of the input slave for the appropriate value. 

 
tRSA_2 = tS + (2 x tCYCLasi) + tRL + tOUT + tA  

 

 
Formula Description 
tRSA_2 Total response time of the system from an EMERGENCY STOP (S) on a safety-

related AS-i input slave to an actuator (A) 
tS For the response time of the sensor (S), see the documentation of the sensor. 

(If an immediate response cannot be assumed for the AS-i slave, the response time 
of the AS-i slave must also be considered at this point. Note also example 3.) 

tCYCLasi Transmission duration of the signals evaluated by the AS-i input slave (ASI IN) via the 
AS-i bus up until the logic of the MSS 3RK3: 
AS-i cycle time, max. 5 ms 

tRL For the response time of the logic of the MSS 3RK3, see Chapter "Response time of 
the logic of the MSS 3RK3 (Page 398)" 

tOUT Transmission duration from the logic of the MSS 3RK3 to the output terminal on the 
expansion module (EM Q) 
• Solid-state outputs: 10 ms 
• Relay outputs: 20 ms 

tA For the response time of the actuator (A), see the documentation of the actuator 
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Example 3   

1 43 62 5  
① AS-i master 
② AS-i power section 
③ MSS 3RK3 Advanced No. 1 
④ Fail-safe EMERGENCY STOP 
⑤ MSS 3RK3 Advanced No. 2 
⑥ Contactor 

Figure 7-10 Configuration MSS 3RK3 Advanced - example 3  

This case considers the signal flow from an EMERGENCY STOP on an input of an 
MSS 3RK3 Advanced via the AS-i bus (direct data exchange) to another MSS 3RK3 
Advanced and then to an actuator (contactor) via the output terminal of an expansion 
module. 

The EMERGENCY STOP transmits an OFF signal to the first MSS 3RK3 Advanced. This 
unit processes the signal in its logic. After taking input delay times and timer functions in the 
logic into account, it forwards the information to the AS-i bus via a simulated AS-i input slave. 
The second MSS 3RK3 monitors this safety-related AS-i input slave and, in turn, processes 
the information in its logic. After taking input delay times and timer functions in the logic into 
account, the second MSS 3RK3 Advanced shuts the system down by means of a contactor. 
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Figure 7-11 Signal flow of example 3 for MSS 3RK3 Advanced No. 1 
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The total response time of subsystem 1 is calculated as follows: 

 
Figure 7-12 Total response time MSS 3RK3 Advanced No. 1 - example 3 

 
tRSA_3-1 = tS + tCYCL_1 + tRL_1 + (2x tCYCLasi) 

 

 
Formula Description 
tRSA_3-1 Total response time of the subsystem from a safety-related EMERGENCY STOP (S) 

to transmission of the switching status to the AS-i bus. 
Only subsystem 1 is considered. 

tS For the response time of the sensor (EMERGENCY STOP), see the documentation of 
the sensor. 

tCYCL_1 Set cycle time of MSS 3RK3 Advanced No. 1 
When AS-i is used, values between 15 ms and 60 ms can be set. 

tRL_1 For the response time of the logic of the MSS 3RK3, see Chapter "Response time of 
the logic of the MSS 3RK3 (Page 398)" 

tCYCLasi AS-i cycle time, max. 5 ms 
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Figure 7-13 Signal flow of example 3 for MSS 3RK3 Advanced No. 2 
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The total response time of subsystem 2 is calculated as follows: 

 
Figure 7-14 Total response time MSS 3RK3 Advanced No. 2 - example 3 

 
tRSA_3-2 = (2x tCYCLasi) + tRL_2 + tOUT + tA 

 

 
Formula Description 
tRSA_3-2 Total response time of the subsystem from a safety-related EMERGENCY STOP (S) 

to transmission of the switching status to the AS-i bus.  
Only subsystem 1 is considered. 

tRL_2 For the response time of the logic of the MSS 3RK3, see Chapter "Response time of 
the logic of the MSS 3RK3 (Page 398)" 

tCYCLasi AS-i cycle time, max. 5 ms 
tA For the response time of the actuator (A), see the documentation of the actuator 

 

The total response time is calculated as follows: 

To calculate the total response time from the sensor up to the actuator, the two sub-
response times must be added. Because no sensor or actuator hangs between the two MSS 
3RK3 units, tS and tA do not have to be considered at this point. 

 
tRSA_3 = tRSA_3-1 + tRSA_3-2 

= (tS + tCYCL_1 + tRL_1 + (2 x tCYCLasi)) + ((2 x tCYCLasi) + tRL_2 + tOUT + tA) 
= tS + tCYCL_1 + tRL_1 + (4 x tCYCLasi) + tRL_2 + tOUT + tA 

 
 

 Note 

It must be noted that tCYCL and tRL may differ for the two systems. They must each be 
assigned to the correct system. 
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7.1.4 Time settings in MSS ES 

Parameterizing the program cycle time tCYCL of the MSS MSS 3RK3 in MSS ES   
The parameter for the program cycle time can be defined as follows: 

1. In the "Configuration > Main system" work window, double-click the configured 3RK3 
central unit. 

2. Enter a value for "Program cycle time [ms]" that is suitable for the scope of your 
configuration in the "Central unit properties - MSS Slot 3" dialog box. 

– 3RK3 Basic: 10 ... 60 ms 

– 3RK3 Advanced/ 3RK3 ASIsafe basic/ 3RK3 ASIsafe extended: 15 ... 60 ms 

(without AS-Interface: 10 ... 60 ms) 
 

 Note 
Support by MSS ES 

MSS ES helps you configure the program cycle time. The "Status bar (Page 159)" displays 
the current utilization of the parameterized program cycle time. 

 

Parameterization of the input delay time tDELAY in MSS ES   
 

WARNING  
If the input delay increases, the overall response time of the safety program increases.   

 

The parameter for the input delay time can be defined as follows: 

1. Double-click the monitoring function/input cell in the work window of the logic diagram for 
which an input delay time is to be parameterized. 

2. Enter a value between 0 ms and 150 ms for "Input delay [ms]" that is suitable for the 
scope of your configuration in the "Central unit properties" dialog box. 

 

 Note 
Input delay 

The input delay time must be an integer multiple of the program cycle time. If that is not the 
case, MSS 3RK3 rounds the input delay time to an integer multiple of the program cycle time 
for safety reasons and MSS ES outputs a warning. If you use safety-related AS-i input 
terminals, the smallest settable input delay time is 50 ms. 
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Parameterization of the delay time tTIMER in MSS ES   
In MSS ES there are various timer functions with which delay times can be parameterized in 
the logic: 

● With ON delay 

● With ON delay (trigger) 

● Passing make contact 

● Passing make contact (trigger) 

● With OFF delay 

● With OFF delay (trigger) 

● Clocking 

 

 Note 
Response time when powering down 

Not every delay time has to be considered in the response time of the MSS 3RK3 For 
example, for calculating of the response time when powering down, a parameterized start 
delay time can be ignored because it does not apply in this case. 

 

The parameter for the delay time can be defined as follows: 

1. Double-click on the timer function in the work window of the logic diagram for which a 
delay time is to be parameterized. 

2. Enter an integer multiple of the program cycle time that is suitable for the scope of our 
configuration for "Time t1 [ms]" in the "Properties ..." dialog box. Setting range: 
10 ms ... 655 s. 

 

 Note 
Delay time  

The delay time must be an integer multiple of the program cycle time. If that is not the case, 
MSS 3RK3 rounds the delay time to an integer multiple of the program cycle time for safety 
reasons and MSS ES outputs a warning. 

 



 Operation 
 7.1 Response times 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 417 

7.1.5 Minimum actuating duration at the inputs 
The minimum actuating duration at the input is the length of time for which a signal must be 
present at the input to ensure that it can be reliably detected. 

Calculation formula for minimum actuating duration tMIN at the inputs of the MSS 3RK3  
(central unit and expansion modules)   

 
tMIN = 2 x tCYCL 

 

 
tMIN Minimum actuating duration at the input terminals of the MSS 3RK3 
tCYCL Program cycle time of the MSS 3RK3 

 
 

 Note 
Minimum actuating duration of AS-i sensors 

The minimum actuating duration of the AS-i sensors depends on the AS-i slave used. 
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7.2 Passwords 
Configuration of and access to the MSS 3RK3 are subject to special password protection 
because of the safety technology. You can assign three passwords:   

● Password for device access (optional) 

● Password for project access (optional) 

● Password for changing to test mode (mandatory) 

 

WARNING  
To prevent unauthorized access to the MSS 3RK3 through the PROFIBUS network, you 
assign a password for device access. 

 

Passwords - Overview 
 
 Password for device access Password for project access Password for changing to test 

mode 
Description • This password prevents 

unauthorized access to the 
MSS 3RK3. The password is 
assigned when the protection 
level is set. 

• You can control access to the 
MSS 3RK3 by setting a 
protection level. For the MSS 
3RK3, the following protection 
levels can be set: 
– Write protection 
– Project write/read protection 

• This password protects an 
offline configuration from 
unauthorized access. 

• If you do not enter a 
password, the configuration is 
opened as "read only", i.e. 
you cannot change the 
configuration 

• This password prevents an 
unauthorized change to "test 
mode". 

• It is only possible to change 
to "test mode" if a valid 
password has been entered. 
If no password has yet been 
assigned for test mode, you 
have to assign one when 
changing to test mode. 

• The default password is 
"0000". 

Assigning / 
Changing 

In MSS ES, via the "Edit" > 
"Password for device access" 
menu command. 
Requirement: You are now in 
configuring mode and are online. 

In MSS ES, via the "Edit" > 
"Password for project access" 
menu command. 
Requirement: You are offline. 

In MSS ES, via the "Edit" > 
"Password for test mode" menu 
command. 
Requirement: You are now in 
configuring mode and are online. 
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 Password for device access Password for project access Password for changing to test 
mode 

Prompt • Independently of the set 
protection level: 
– When changing the device 

access password. 
• "Write protection" protection 

level: 
– For write access to a safety 

relay (e.g. when loading), if 
no access rights exist. 

• Protection level "Project write 
protection/read protection": 
– Just as for the "Write 

protection" protection level 
– When opening an online 

configuration 

• When opening an offline 
configuration 

• When changing the project 
access password. 

• When switching to test mode 
via the "Target system" > 
"Test mode" menu command. 

Validity As long as an access authorization 
for the safety relay exists. 

As long as the offline 
configuration is open. 

The password must be re-
entered for each change to test 
mode. 

 

 

 Note 

If you change the passwords, this has no effect on the release status of a configuration. 
 

Deactivate password protection (only password for project access and password for device access) 
You can deactivate the password protection again by entering a blank password. To do this, 
you must first enter the old password. The fields "New password" and "Confirm password" 
must remain empty. 

Forgot password 
● The password for project access can be reset. 

● Both the password for device access and the password for switching to test mode can 
only be reset by restoring the factory settings. 
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Dialog box "Edit" > "Password for project access" 
● This password prompt appears in the "Enter password" dialog box when you open an 

offline configuration. 

● If you have still not assigned a password for project access, enter a new password at the 
prompt "New password" and enter it again to "Confirm password". 

● Change the project access password by entering the old password and then entering the 
new password twice 

● Deactivate the password protection for the project by first entering the old password and 
then entering a blank password twice. 

● Use the "Forgot password" button to create a file with the encrypted password if you lose 
the project access password. Send this file with the activation information to the Siemens 
hotline. The Siemens hotline will send you a file with an activation code. You will find 
additional information in Chapter " Forgot password (Page 182)." 

Dialog box "Edit" > "Password for device access" 
● This password is requested in the case of password-protected write device access (e.g. 

loading new configuration) or when going online (only in the case of protection level 
"Project write/read protection"). 

● You can assign/change/reset the password for device access. 

● You can set the protection level with this menu command. 

 

 Note 

If you have forgotten the password for device access, you must restore the factory settings 
of the MSS 3RK3. You must do this on the safety relay because commands in MSS ES are 
password-protected. 

 

Dialog box "Edit" > "Password for test mode" 
● This password is requested every time you switch to test mode via the "Target system" > 

"Test mode" menu command. 

● You can assign/change the password for changing to test mode. 

 

 Note 

If you have forgotten the password for changing to test mode, you must restore the factory 
settings of the MSS 3RK3. You can do this on the safety relay or by means of a command in 
the MSS ES. 
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Prompt for passwords 
● Enter password 

– The "Enter password" dialog appears if you open a password-protected configuration, 
for example. 

– Enter the password and confirm with "OK". 

● Password forgotten: 

– If you have forgotten the project access password, you can open the configuration 
write-protected. To do this, click on the "Cancel" button. An online configuration can 
only be opened if the protection level has been set to "Write protection". 
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7.3 Planning/configuring 

7.3.1 Modes 
The MSS 3RK3 always differentiates between three operating modes:  

● Configuring mode 

● Test mode 

● Safety mode 

Configuring mode (DEVICE LED: yellow)   
The monitoring functions are not active in configuring mode. No signals are output at the 
terminals. In configuring mode, you can modify existing parameters. This is done by creating 
a configuration in the PC / PG with MSS ES and downloading this to the 3RK3 central unit. It 
is also possible to upload and edit a configuration available in the 3RK3 central unit. 

 
LED display The 3RK3 central unit enters configuring mode after switch-on if 

DEVICE SF 
There is no configuration in the device. yellow off 
The configuration in the device has not been released. yellow off 
The configuration in the device is incorrect. yellow red 
A configuration error was identified in test mode. yellow red 
The connection is interrupted in test mode. yellow red 
A Category 1 error occurs in safety or test mode. 
Only diagnosis and reset possible; see Chapter " Diagnostics / service 
(Page 489)." 

Flashing 
red 

red 

Test mode (DEVICE LED: flickering green)   
Test mode can only be accessed online from configuring mode using a password-protected 
command. You can switch to test mode even if the configuration has not been released. 

The user program is processed in test mode. All monitoring functions are active in 
accordance with the set parameterization. Logical outputs of function elements can be set, 
see Chapter "Forcing (Page 431)." This makes it easier to carry out troubleshooting in the 
application and check the wiring. 
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Safety mode (DEVICE LED: green)   
In safety mode, all monitoring functions are active in accordance with the set 
parameterization. Safety mode can only be exited by means of a command. 

 
Display The 3RK3 central unit changes to safety mode: 

DEVICE SF 
Once the system has been switched on and if the configuration has been 
released and the test results of the device startup are OK. 

green off 

From configuring mode by means of the relevant command. green off 

7.3.2 Creating a configuration in MSS ES 

Requirements 
Before you start configuring in MSS ES, you require the following information:   

● Structure/wiring of the system 

● Required safety functions 

● Expanded configuration/wiring of the main system (MSS 3RK3) 

● Expanded configuration of the AS-i bus (= subsystems) (not for 3RK3 Basic) 

Procedures for configuring in MSS ES 
The procedure for configuring in MSS ES has an effect on various functions. 

There are basically two ways of configuring: 

1. You start with configuring the expanded hardware configuration and then configure the 
logic. Once you have configured an MSS 3RK3 Basic, all non-supported function 
elements will no longer be available in the catalog window of the logic diagram. 

2. You start with configuring the logic and then configure the expanded hardware 
configuration. If you use the function elements in the logic diagram that are not supported 
by MSS 3RK3 Basic, the MSS 3RK3 Basic will no longer be available in the hardware 
catalog of the configuration. 
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Configuration 

Main system   

In MSS ES, the various modules from the hardware catalog are assigned to their slot. Drag 
each module into the central work space and onto the slot that they really occupy in the 
expanded configuration. 

The minimum expanded configuration consists of one 3RK3 central unit on slot 3. Up to 
7 expansion modules can be added for MSS 3RK3 Basic, while MSS 3RK3 Advanced 
supports up to 9 expansion modules and 3RK3 ASIsafe extended supports a maximum of 2 
expansion modules. 

An interface module for connection to a higher-level bus system can be optionally configured 
in slot 2. 

An operator control and monitoring module can be configured for MSS 3RK3 Basic in slot 1. 

Sub-system   

In the subsystem, the real AS-i slaves and AS-i components are configured at their 
respective AS-i addresses. The hardware catalog contains all supported AS-i components 
from SIEMENS. Just like in the main system, they can be dragged into the work space and 
have their AS-i address assigned. Using the universal modules, the profiles of standard and 
A/B slaves can be defined independently of manufacturer. 

 

 Note 
Configuration of simulated slaves   

Simulated slaves are allocated their AS-i addresses in the properties of the 3RK3 central 
unit, and the profile is selected. The simulated slaves are displayed in italics in the 
subsystem. 

 

You will find additional information in Chapter "Configuration (Page 235)." 

Logic   
The safety logic is created in the logic diagram. The inputs and outputs of the modules of the 
main system and of the AS-i slaves of the subsystem are combined with function elements. 
Drag the required function elements onto the work space. Parameterize the individual 
elements in the relevant element properties that you can open by double-clicking the 
element. Here, you can set the various parameters and connect the inputs and outputs of the 
function elements with the inputs and outputs of the modules. 

You will find additional information in Chapters "Logic diagram (Page 246)" and "Function 
elements (Page 271)." 
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7.3.3 Commissioning 
 

NOTICE  
Since commissioning of the MSS 3RK3 is an important, safety-related step, it must be 
carried out by qualified personnel. 

 

Options for access to the MSS 3RK3   
The following graphic shows the various ways of accessing the MSS 3RK3. 

1

2

3

5

 
① PC or programming device via device interface on the MSS 3RK3 or DP interface 
② PC/device interface with diagnostics display on the MSS 3RK3 or DP interface 
③ MSS 3RK3 
④ PLC over PROFIBUS and DP-Interface 
⑤ DP interface 

Figure 7-15 Options for access to the MSS 3RK3 
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Requirements 
The following requirements must be met for commissioning:   

● The device is mounted. 

You will find additional information in Chapter "Mounting / installing / attaching 
(Page 110)." 

Check all the latches to ensure that they are properly engaged. 

● The device is correctly wired. 

You will find additional information in Chapter "Connecting / wiring (Page 117)." 

● The MSS ES software is installed on your PC or programming device with the correct 
license. 

You will find additional information in Chapter "Installation and program start (Page 152)." 

  

● The configuration is available in a consistent form and saved. 

● The utilization of the memory module, of the internal memory, and the program cycle time 
were monitored.  

You will find additional information in the following chapters: 

– "Status bar (Page 159)" 

– "Settings of Modular Safety System ES - "Download settings" tab (Page 219)" 

– "Response times (Page 397)". 

  Note 
Number of function elements 

The number of function elements that can be processed by one MSS 3RK3 depends on 
the type of function elements. A typical value is 250. 

● The power supply unit for the MSS 3RK3 is connected. 

● Programming device or PC and MSS 3RK3 are connected. 

WARNING  
 

To prevent unauthorized access to the MSS 3RK3 through the PROFIBUS network, you 
assign a password for device access. 

● The consistency check must only output warnings. Error messages must be remedied. 

 



 Operation 
 7.3 Planning/configuring 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 427 

Load to switching device...   
 

 Note 

If there is already a released configuration on the 3RK3 central unit, cancel this configuration 
release with the "Target system" > "Cancel configuration release" menu command. 

 

START

Safety mode /
test mode?

Test modeSafety mode

Check consistency
Ctrl + Alt  + K

Load to switching device

Consistent configuration

Online

Go offline

Preparing the
configuration test

Online

Go offline

Enable the
configuration

Test mode

Test mode

Go online

Safety mode

Safety mode
 

Figure 7-16 Main procedure for commissioning the MSS 3RK3 with factory settings 
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Perform the following steps to load a configuration into the MSS 3RK3: 
 
Step Action Result 

1 Switch on the power supply. The central unit executes a self-test. 
2 Open the project in MSS ES. - 
3 Choose the "Target system" > "Load to switching 

device" menu command and confirm the memory 
dialog box with "Yes" if you have changed the 
configuration. 

The "Load to switching device" dialog box opens. 

4 Set the interface and confirm with "OK". The configuration data is now downloaded. A message is 
displayed on completion of the download. 

5 Confirm with "OK". You are now online in configuring mode. 

7.3.4 Testing the configuration 
Before you can switch the MSS 3RK3 to safety mode, you must conduct a full function test 
and then release the configuration. 

 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 
Carrying out a function test of the configuration 

A configuration can only be released if a complete function test of the configuration has 
been successfully completed (hardware configuration and parameterization of the safety 
functions). 
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Project printouts for the test     
Use the printouts of the project to support the test. 

 
Step Action Result 

1 Open the parameter file containing the configuration that 
you downloaded to the MSS 3RK3. 

The configuration is displayed. You are offline. 

2 Activate "Target system" > "Prepare configuration test". The "Prepare configuration test" dialog box opens. 
3 Set the interface via which you have access to the device 

(e.g. COM1) and confirm with "OK". 
The project printouts are generated as PDFs. The 
project switches to online mode. 

 

● The printout contains all the configuration data stored in the safety relay. 

● The configuration CRC is given on each page of the printout in the tabular footer. The 
printout is thus always uniquely assigned to one configuration and can later be used for 
the plant documentation. 

● If deviations or errors occur in these checks, test the configuration and wiring and start 
commissioning again. 

 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 
Testing the configuration on the MSS 3RK3 

It is not enough just to check the printout; the configuration must also be tested on the MSS 
3RK3 of the system. 
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Switching to test mode   
The MSS 3RK3 can be switched to "test mode" so that the full function test can be 
conducted. Outputs of function elements can be forced in this operating mode. 

 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage.  

In this operating mode, the safety program is executed and the outputs are controlled 
according to the safety program. 

For this reason, organizational measures must be taken to ensure the safety of your 
system. 

 

 Note 

A consistent configuration is the requirement for switching to test mode. 
 

 Note 

If you have not yet assigned a password, you must assign one now. 
The default password is: 0000   

 

 

Execute the following steps to switch to test mode: 
 
Step Action Result 

1 Go online with the menu command "Switching 
device" > "Open online". 

 

2 Choose "Target system" > "Test mode" and confirm 
the message "Activate test mode" with "Yes". 

The "Change password for test mode" dialog box opens. 

3 Enter the password for test mode or assign a 
password. 

The MSS 3RK3 changes from configuring mode to test 
mode. 
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7.3.5 Forcing 
Forcing means that an output of a function element can be preset to a certain value ("0" or 
"1"), for example, to make it easier to perform troubleshooting. 

Requirements 
The following requirements must be met to activate the icons in the toolbar: 

● The online view is activated. 

● Test mode is activated on the safety relay. 

● The logic diagram with the safety circuit is active. 

● At least one connection of a function element is selected. 

Forcing   
 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 

In this operating mode, the safety program is executed and the outputs are controlled 
according to the safety program. 

For this reason, you must ensure that the safety of your system is ensured by means of 
organizational measures. 

 

With the "Target system" >Diagnostics logic" > "Force" > "Force to 0" and "Target system" > 
"Diagnostics logic" > "Force" > "Force to 1" menu commands or the corresponding icons in 
the toolbar, you can set the values "0"  or "1"  for selected outputs of function 
elements.  

If a connection is forced, an icon above the connection shows the value "0" (blue symbol) or 
"1" (green symbol) in the logic diagram. 

Cancel forcing 
You can cancel forcing for an individual forced output as follows: 

● Using the "Target system" > "Diagnostics logic" > "Force" > "Cancel forcing" menu 
command. 

● By clicking on the icon  in the toolbar. 
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Cancel forcing (all) 
You can cancel forcing for all forced outputs as follows: 

● Using the "Target system" > "Diagnostics logic" > "Force" > "Cancel forcing (all)" menu 
command. 

● By clicking on the icon  in the toolbar. 

Interruption of the online connection  
If the online connection is interrupted in test mode, e.g. by removing the PC cable, it can 
take up to 10 s before forcing of an output to "1" is canceled. 

7.3.6 Configuration release 

Follow these instructions:    
 

WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 

Before the safety equipment is released for safety mode, you must ensure that all function 
elements are working correctly in accordance with the safety regulations. This 
encompasses the I/Os connected to the MSS 3RK3 (sensors and actuators) as well as the 
entire configuration of the MSS 3RK3. 

When the configuration is released, you can (as an "authorized person") confirm that the 
system is correctly installed and that all the safety-relevant regulations and standards for 
the application are observed. 

 

 Note 

The release procedure described below refers only to the configuration of the MSS 3RK3 
and not to the system test. The system test must be documented separately and is not an 
integral part of this documentation. 
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Once the function test has been successfully carried out, you can release the configuration. 
To do so, proceed as follows: 

 
Step Action Response 

1 Select the menu command "Target system" > "Go 
offline". 

The offline configuration is opened. 

2 Choose "Target system" > "Approve configuration". The "Approve configuration" dialog box is opened, thereby 
confirming that the system has been configured properly. 

3 Set the interface via which you have access to the 
device (e.g., COM1) and confirm with "OK". 

The "Approve configuration" dialog box opens. 

4 Acknowledge the message text. The "Approve configuration" dialog box opens. 
5 Enter the name and approving company and 

confirm with "OK". 
The "Approve configuration" dialog box opens. The 
configuration has been successfully approved. 

6 Acknowledge the message with "OK". The printout of the release information is created. 

 
 

 Note 

If the report could not be printed when the project was released, e.g., because no printer was 
available, the printout must be created at the latest by the time of acceptance by selecting 
"Options" > "Release information."    

 

Printout of the release information   
The printout of the release information contains the following information.   

● Name of the person releasing 

● Name of the company of the person releasing 

● Release status 

● Release timestamp 

● Configuration CRC 
This must match the configuration CRC in the footer on the printout of the configuration. 
The release printout is thus always uniquely assigned to one configuration and can later 
be used for the plant documentation. 

Result of the release 
Once the MSS 3RK3 has been released, the device is in configuring mode and can be 
switched to safety mode. 
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7.3.7 Safety mode 

Requirements 
If the 3RK3 central unit of the MSS 3RK3 contains a valid, released configuration, you can 
switch the MSS 3RK3 from configuring mode to safety mode.   

 

 Note 

Before switching the system to safety mode, ensure that the printout containing the release 
information is available.   

 

DANGER  
Danger of death! 

When the system is switched on it switches to safety mode and the safety program is 
executed as soon as a valid, released configuration is available. 

Take appropriate measures (e.g. start button) to guarantee a defined start of the system. 
 

Switching to safety mode 
 
Step Action Response 

1 Establish up an online connection with the MSS 3RK3 
using the "Switching device" > "Open online" menu 
command. 

The Set interface dialog box appears. 

2 Set the interface and confirm with "OK". The project opens online. 
3 Activate the menu command "Target system" > "Safety 

mode". 
If a password has been assigned for device access, 
the "Enter password" dialog box appears. If a 
password for accessing the device has not yet been 
assigned, a message is displayed indicating that the 
switching device is not protected against 
unauthorized access. 

4 Enter the password for device access and confirm this 
with "OK," or acknowledge the message with "Yes" if you 
have not assigned a password for device access. 

The safety relay changes to safety mode. 
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"Safety mode" 
● When the system is switched on, it automatically switches to safety mode if a valid and 

released configuration already exists in the 3RK3 central unit. 

● After starting safety mode, the status bar in MSS ES informs you of the change to the 
new operating mode. The operating mode is only displayed when a project is open 
online. 

● In safety mode, the created safety circuit is processed. Safety mode does not allow you 
to force function outputs.  
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7.4 Tips and tricks for working with MSS ES 

7.4.1 Comparison function 
 
Menu option Basic license Standard license Premium license 
Edit Compare with 

switching device 
- ✓ ✓ 

Edit Compare with file - ✓ ✓ 

 

MSS ES provides a function for comparing two configurations. The configuration that is 
currently open in MSS ES (source configuration) is compared to a configuration to be 
defined by you. This can either be online in the safety relay or offline in an *.sdp file.   

You can call up the comparison function with the following menu commands: 

● "Edit" > "Compare with switching device" 

● "Edit" > "Compare with file" 

The "Comparison of configurations" dialog box displays the results. 

Compare with switching device   
Requirement: You must load the first configuration. 

Carry out the comparison as follows: 

1. Open the first configuration. 

2. Select the "Edit" > "Compare with switching device" menu command. The "Compare with 
switching device" dialog box appears. 

3. Select the safety relay that you would like to compare with the open configuration. 

4. Click on the "OK" button. 

Result: The source configuration is compared with the configuration in the safety relay.  
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Compare with file  
Requirement: You must load the first configuration. 

Carry out the comparison as follows: 

1. Open the first configuration. 

2. Select the "Edit" > "Compare with file" menu command. The "Compare with file" dialog 
box appears. 

3. Select the file that you would like to compare with the open configuration. 

4. Click on the "Open" button. 

Result: The source configuration is compared with the configuration in the *.sdp file.  

"Comparison of configurations" dialog box   
The "Comparison of configurations" dialog box contains any deviating results from the 
comparison in tabular form: 

● "Parameter name" column: Contains the names of the parameters with deviations, these 
are displayed in a tree structure: 
Configuration > Data structure > Element > Individual parameter 

● "Source configuration" column: Contains the parameter value belonging to the parameter 
name in the open configuration. 

● "Comparison configuration" column: Contains the parameter value belonging to the 
parameter name in the comparison configuration. 

"Go to" button   
If you click on the "Go to" button in the "Comparison of configurations" dialog box, the 
respective view opens in the work space in which the object belonging to the selected 
parameter can be edited. 

The prerequisite is that an element be selected in the tree structure in the table of 
differences. 

Example: A function element is selected in the "Comparison of configurations" dialog box. 
"Go to" takes you to the relevant function element in the logic diagram. 

"Print" button:   
Using the "Print" button in the "Comparison of configurations" dialog box, open a print 
preview of the results of the comparison. Define whether you want to print out the results of 
the comparison or to save them in PDF format. 
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7.4.2 Cross references 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Options Cross 
references 

- - ✓ ✓ 

Actions   
The "Options" > "Cross references" menu command shows the cross references in tabular 
form in the output window. 

Structure of the cross reference list 
 
Operand Kind Type Usage 

location 
Diagram Page 

Module 
Channel 
Terminal identifier 
Device status function 

Access: 
WR = write 
RO = read 

Type of 
operand

Element type 
and element 
number of the 
function 
element. 

Name of the 
diagram in which 
the function 
element is located. 

Page on which the function 
block that is connected to 
the function element is 
located. 

 
 

 Note 

The cross reference list only displays the operands used in the safety circuit. 
 

Edit cross references 
With the context menu (right mouse button) or by double-clicking on the item, you can go to 
the position where the cross reference is used in order to edit it. 

7.4.3 Symbol list 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Options Symbol list - - ✓ ✓ 
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Actions 
The "Options" > "Symbol list" menu command shows the plant identifier you assigned in the 
form of a table in the output window.   

To improve the legibility of the configuration, you can assign identifiers for parts of your 
configuration data within the context of the system documentation. The symbol list gives an 
overview of the identifiers assigned by you, their assignments, and the type. 

Example of a symbol list 
 
Identifier Assignment Type 
Anna SLOT5 Equipment identifier (BMK) 
Terminal_1 SLOT3_F-IN1 Terminal identifier 
Terminal_2 SLOT4_Q6 Terminal identifier 
Press - Plant identifier 
Hall 1 - Location identifier 
EMERGENCY STOP_1 EMERGENCY STOP [35] Name 

Editing entries in the symbol list 
You can perform the following actions in the context menu (right mouse button): 

● Delete: The selected identifier is deleted. 

● Editing: The selected identifier can be changed (can also be activated if the identifier is 
selected and you click on it again or press F2). 

If you change or delete identifiers, then the display in the respective view is immediately 
updated. 

● Go to: You jump to the corresponding icon, which is then selected (can also be activated 
by double-clicking). 

Sorting: 

● If you click on the column header in the columns "Identifier" and "Assignment," the items 
will be sorted alphabetically by this column. 

● Clicking on the "Type" column header sorts the column as follows: Equipment identifier, 
Name, Comment, Terminal identifier, Location identifier, Plant identifier. 

 

 Note 
Editing rules 

You cannot assign the same identifier twice. 
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7.4.4 Terminal list 
 
Menu option Symbol Basic license Standard 

license 
Premium 
license 

Options Terminal list - - ✓ ✓ 

Actions   
The "Options" > "Terminal list" menu command lists all available terminals of the slot and 
subslot (AS-i-) modules in the output window with the relevant terminal identifier (right-hand 
column) and the interconnection status in the logic diagram (left-hand column).   

The terminals are also shown for which no identifier has been assigned and also those 
terminals that are not yet interconnected. 

Example of a terminal list 
 
Terminal Terminal marking 
ASi#02_IN1 Pushbutton_1 
SLOT3_F-IN1 Terminal_1 

Editing entries in the terminal list 
You can perform the following actions in the context menu (right mouse button): 

● Delete: The selected terminal identifier is deleted. 

● Editing: The selected terminal identifier can be changed (can even be activated if the 
identifier is selected and you click on it again or press F2). 

If you change or delete identifiers, then the display in the respective view is immediately 
updated. 

● Go to: Interconnecting terminal is in the logic will take you to the corresponding function 
element and select it (can also be activated by double-clicking). 

Sorting:  

● Clicking on the column header of the first column sorts the items of this column by their 
interconnection status. 

● Clicking on the relevant column header sorts the items of the "Terminal" and "Terminal 
identifier" columns alphabetically. 

  Note 
Editing rules 

You cannot assign the same terminal identifier twice. 
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7.5 Integrating the Modular Safety System 3RK3 in DP master systems 

7.5.1 Setting and changing the DP address 
The DP interface offers three ways of setting and changing the DP address:    

● Assignment in MSS ES during configuration ① 

● Setting on the DP interface using the pushbuttons and display ③ 

● Setting using the PROFIBUS service SET_SLAVE_ADD, e.g. in SIMATIC Manager: 
"Target system" > "PROFIBUS" > "Assign PROFIBUS address" ④  

3

1 2

4

 
① PC / PG with MSS ES through the device interface on the DP interface 
② MSS 3RK3 with DP interface 
③ Manual setting on the DP interface using the pushbuttons and display 
④ PC / PG with PROFIBUS interface 
Figure 7-17 Options for setting the DP address 

The DP address can in principle be changed using all three access channels. The DP 
address last written or set in the DP interface is the valid address.  

Individual access paths for changing the DP address can also be disabled. This can be 
carried out via the parameterization of the DP interface in MSS ES. 

 

WARNING  
To prevent unauthorized access to the MSS 3RK3 through PROFIBUS DP, you assign a 
password for device access. 
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Setting and disabling the DP address in MSS ES 
In MSS ES, the DP address is set in the object properties of the DP interface module during 
configuration (see also Chapter "Properties of interface module (Page 238)." When 
downloading the entire configuration, the DP address (station address) is transferred to the 
device. 

In MSS ES, individual methods of changing the DP address can also be disabled. The 
following protection levels are available for this purpose: 

● Can be changed without restriction 
The DP address can be changed by downloading the configuration to the device (data 
set) by means of MSS ES, on the DP interface itself using the pushbuttons and display, 
and using the PROFIBUS service SET_SLAVE_ADD.   

● Can only be changed using MSS ES or a setting element on the device 
The DP address can only be changed using MSS ES and on the device itself using the 
pushbuttons and display. 
The DP address cannot be changed using SET_SLAVE_ADD. 

● Can only be changed via the data set 
The DP address can only be changed with MSS ES. 
The "DP-Adr" menu command is still available, but the DP address cannot be changed 
and is rejected with the message "Lock". 

Setting the DP address on the DP interface 
The DP address can be set and changed on the DP interface itself using the pushbuttons 
and display. The DP interface displays the current DP address. 

Example 
In SIMATIC Manager, you can assign a new DP address using the "Target system" > 
"PROFIBUS" > "PROFIBUS address" menu command (PROFIBUS service 
SET_SLAVE_ADD). If the 3RK3 central unit does not yet have a configuration, the DP 
interface will display the default address 126. 

Further changes to the DP address can be blocked via the PROFIBUS service 
SET_SLAVE_ADD. This block can only be revoked as follows: 

● By restoring the factory settings of the 3RK3 central unit (deleting the configuration). 

● By downloading the new configuration to the device. 
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7.5.2 DP interface 

7.5.2.1 DP interface device statuses 
The display has two display statuses:   

● Standard mode with status display 
In standard mode, different status messages are output. To scroll through the messages, 
choose "MODE." 
With error messages, the first line flashes and displays the type of error. If more than one 
error type is present, the cursor will appear on this line as a chaser. 
The second line may contain a parameter providing information about the type of error. If 
more than one error type is present, the cursor appears in this line as a chaser.  
This indicates that you can call additional messages or parameters by choosing "MODE." 
If more than one error type is present and these have more than one parameter, you can 
scroll through the parameters by choosing "MODE" (cursor on the second line). The next 
error type is then displayed (cursor on the first line). The sequence of messages is 
defined by a prioritization indicator. Parameters are sorted in ascending order within an 
error type. 
An error that has been rectified is immediately deleted from the display (you do not need 
to refresh the screen). 
If you do not press any buttons for 30 seconds, the display automatically returns to the 
error with the highest priority. 

● Menu mode with user control 
In menu mode, a menu system can be used to call up or change different settings. To 
switch from standard mode to menu mode, choose "SET". The system returns to 
standard mode when you choose the relevant menu option or after an extended period of 
inactivity (30 s). 
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7.5.2.2 DP interface menu navigation 
   

The menu navigation tree is displayed below: 

MENU
DP•••

MENU
RST••

MENU
EXIT•

DP••
ADR••

DP••
••xXX

DP••
••XxX

DP••
••XXx

XXX•
OK•••

DP••
EXIT•

ADR•
LOCK•

RST•
EXIT•

RST•
DO•••

RST•
LOCK•

XXX

x

•

 
Figure 7-18 DP interface menu 

 

7.5.2.3 Menu mode with user control 
In menu mode, the title of each menu appears on the first line on the display.   

The second line may contain a menu entry or a parameter providing information about the 
type of error. If this line is flashing, you can call up additional options by choosing "MODE". 

When you press "SET", this either confirms a selection or executes an action. 

When you press "MODE" and "SET" at the same time, the entry "EXIT" is always selected 
and the current action is interrupted. You then have to release both buttons and confirm with 
"SET". 

When you double-click "MODE", the previous entry is selected. 

If you do not press any buttons for 30 seconds, the display automatically switches to 
standard mode with status display. 
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Main menu  
To switch from standard mode to menu mode (main menu), choose "SET". Various sub-
menus can be selected in the main menu. To switch between the various sub-menus, 
choose "MODE". To confirm a selection, choose "SET". 

 
Display 
MENU 
DP••• 1. row: not flashing 

2nd row: flashing 

 

The following submenus are available (2nd line of the display): 

● DP (change the PROFIBUS address)   

● RST (restore factory settings) 

● EXIT (exit) 

To switch between the sub-menus, choose "MODE". 

When you confirm "EXIT" with "SET", the system switches to standard mode. 

When you confirm the other entries with "SET", the system switches to the relevant sub-
menu. 

DP sub-menu 
This menu option is used to change the PROFIBUS address. 

 
Display 
MENU 
DP••• 1st line: not flashing 

2nd line: flashing 

 

The following submenus are available (2nd line of the display): 

● "ADR" (change address) 

● "EXIT" (exit) 

To switch between the sub-menus, choose "MODE". 

When you confirm "EXIT" with "SET", the system switches to standard mode. 

When you confirm "ADR" with "SET", the system switches to the sub-menu. 
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Changing the DP address   
 

 Note 

Only addresses 1 to 126 can be set. Other addresses are not possible. 
 

 

 
Display 
DP•• 
ADR•• 1st line: not flashing 

2nd line: flashing 

 

When you press "SET", the system switches to the editing screen 1: 

When you press "MODE" and "SET" at the same time, editing screen 1 with the entry "EXIT" 
is selected. "When you press "EXIT", this must then be confirmed by pressing "SET". 

If the DP address cannot be changed on a device, the following message is displayed when 
you choose "ADR": 

 
Display 
ADR• 
LOCK• 1st line: not flashing 

2nd line: flashing 

 

You can acknowledge this message by choosing "SET" or "MODE". After 30 seconds of 
inactivity, the display automatically returns to standard mode. 

 
Display (editing screen 1) 
DP•• 
••126 1st line: not flashing 

2nd line: 1st digit in DP address flashing 

 

The 2nd row in the display contains the current DP address (0 ... 126; right-justified). If an 
address has not yet been set, the default address 126 is displayed. 

When you choose "MODE", the hundreds are incremented (sequence: 0, 1, 0, etc.). 

When you choose "SET", this digit is confirmed and the system switches to the tens. When 
you double-click "SET", you can go back one digit (i.e. from the hundreds to the ones). The 
address is not applied when you do this. 
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Display (editing screen 2) 
DP•• 
••X26 1st line: not flashing 

2nd line: 2nd digit in DP address flashing 

 

When you press "MODE", the tens are incremented (sequence: 0, 1, 2, to 9); double-clicking 
"MODE" counts back one digit. 

When you choose "SET", this digit is confirmed and the system switches to the next digit. 
When you double-click "SET", you can go back one digit (i.e. from the tens to the hundreds). 

 
Display (editing screen 3) 
DP•• 
••XX6 1st line: not flashing 

2nd line: 3rd digit in DP address flashing 

 

When you press "MODE", the ones are incremented (sequence: 0, 1, 2, to 9); double-
clicking "MODE" counts back one digit. 

When you press "SET", this digit is applied and the set PROFIBUS address (indicated here 
by "•XXX") is displayed. When you double-click "SET", the system goes back one digit (i.e. 
from the ones to the tens). 

 
Display 
•XXX 
OK••• 1st line: not flashing 

2nd line: flashing 

 

The message above indicates that the PROFIBUS address was successfully saved. You can 
acknowledge this message by choosing "SET" or "MODE". The display then returns to 
standard mode. 

The set PROFIBUS address is applied immediately on the bus side. You do not need to 
switch the power OFF and then ON again.  

If the set address cannot be transferred to the 3RK3 central unit, the following message will 
be output: 

 
Display 
•XXX 
NOK•• 1st line: not flashing 

2nd line: flashing 

 

You can acknowledge this message by choosing "SET" or "MODE". The display then returns 
to standard mode. 
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RST sub-menu 
You can use this menu option to restore the device factory settings.   

 
Display 
RST• 
XXX• 1st line: not flashing 

2nd line: flashing 

 

The following entries can appear in the second row: 

● "EXIT" (exit) 

● "DO" (restore factory settings) 

You can use the "MODE" button to switch between the two menu options. 

To confirm a selection, choose "SET". 

When you choose "EXIT", the process of restoring the factory settings is interrupted and the 
display returns to standard mode. 

To restore the factory settings, choose "DO". 

If you are not permitted to restore the factory settings because the DP interface is currently 
exchanging data cyclically with a DP master, the following message is displayed when you 
choose "RST": 

 
Display 
RST• 
LOCK 1st line: not flashing 

2nd line: flashing 

 

You can acknowledge this message by choosing "SET" or "MODE". After 30 seconds of 
inactivity, the display automatically returns to standard mode. 
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7.5.2.4 Configuration with a GSD file 

Introduction    
Once the the system has been configured with MSS-ES, the DP interface must be 
configured as a PROFIBUS DP slave using the configuration tool of the PROFIBUS master 
(e.g., STEP 7). The slave properties (PROFIBUS address, DP process data structure width 
32-bit/64-bit) set in the configuring tool must be identical to the properties set in MSS ES. 
Otherwise, the configuration is rejected by the DP interface.   

Requirements 
You require a GSD file for the DP interface. You can download this file from the following 
Internet address: http://support.automation.siemens.com/WW/view/en/113630 

● SI0x814D.GSG is the German language version of the GSD file (x: version of file) 

● SI0x814D.GSD is the English language version of the GSD file (x: version of file) 

You also require a configuration tool that supports configuration using the GSD file (GSD 
version 5 or higher). 

Installation of the GSD file with STEP 7   
Install the GSD file, e.g., in STEP 7, as follows:   

1. Start the SIMATIC Manager and select "Options" > "Install GSD Files" in "HW Config." 

2. Use the "Search" button to select the path containing the GSD file for the DP interface. 

3. Select the appropriate GSD file in the list and confirm with the "Install" button. 

4. In the menu bar, select "Options" > "Update catalog". 
Result: You will find the newly installed device in the catalog under "PROFIBUS DP" > 
"Additional field devices." 

5. Acknowledge the installation with "Close". 
Result: You can now integrate the DP slave into your project. 

http://support.automation.siemens.com/WW/view/en/113630
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Configuring the DP interface on the PROFIBUS DP with STEP 7   
 

1. Open your STEP 7 project. 

2. Open the HW Config of the PROFIBUS DP master. 

3. Select the DP interface in the "Hardware Catalog" window. 

Path: "PROFIBUS-DP" > "Additional FIELD DEVICES" > "Switching devices" > "Safety 
relays" > "Modular Safety System 3RK3" > "DP interface MSS V1.0" 

4. Set the properties of the PROFIBUS sub-network.  
DP alarm mode must be set for operation behind a Y link on DPV1. You can select 
various PROFIBUS diagnoses in the device-specific parameters. The length of the 
diagnostics frame must be adjusted accordingly. If all diagnoses are transmitted, the 
length of the diagnostics frame is 42 bytes. The diagnoses must only be deselected from 
bottom to top in the hierarchy. For example, it is not permissible to deselect on the 
module status; the channel-specific diagnosis must then also be deactivated.  

5. Save your settings with "OK". 

6. Select the appropriate DP process data structure (32 DI/32 DO or 64 DI/64 DO). The 
standard value is 32 DI/32 DO. 

7. Select the PROFIBUS address for the DP interface. 

The following table shows the length of the DP diagnosis to be set when deselecting 
diagnoses: 

 
Diagnostic type Activated Deactivated Length 
ID-specific diagnosis X - 
Module status X - 
Channel-specific diagnosis X - 

42 

ID-specific diagnosis X - 
Module status X - 
Channel-specific diagnosis - X 

24 

ID-specific diagnosis X - 
Module status - X 
Channel-specific diagnosis - X 

12 

ID-specific diagnosis - X 
Module status - X 
Channel-specific diagnosis - X 

6 
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Changing the PROFIBUS address in STEP 7 SIMATIC Manager 
DP slaves connected to the PROFIBUS sub-network must have a unique PROFIBUS 
address. If the DP slave to be connected supports the function SET_SLAVE_ADD, you can 
assign the address using HW Config: 

In HW Config, you can assign a new PROFIBUS address using the menu command "Target 
system" > "PROFIBUS" > "Assign PROFIBUS address". 

 

 Note 

If the current DP addresses are not completely certain, connect the DP slaves individually to 
the programming device/PC and re-address the DP slaves.  

 

7.5.2.5 Failure and restoration in the case of PROFIBUS 

PROFIBUS failure    
The DP interface reports a PROFIBUS interruption to the 3RK3 central unit. The 3RK3 
central unit then uses the substitute value "0" for the PROFIBUS logic inputs. Safety mode is 
not exited. The bus failure can be diagnosed in MSS ES.   

 
Indication failure PROFIBUS 
LED DP-IF Display DP-IF Central unit 
DEVICE Green BF 

DPXXX 
Green 

BF Red  - 
SF off  off 

Restoration of PROFIBUS 
Once the PROFIBUS connection has been re-established, the 3RK3 central unit will work 
with real values again. 

 
Indication of PROFIBUS restoration 
LED DP-IF Display DP-IF Central unit 
DEVICE Green RUN 

DPXXX 
Green 

BF Off  - 
SF off  off 

XXX stands for the set PROFIBUS address. 
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7.6 Integrating the 3RK3 modular safety system into the AS-i bus 

7.6.1 3RK3 central unit with AS-i interface 
Three central units with an AS-i interface are available for integrating the 3RK3 modular 
safety system on the AS-i bus. 

● 3RK3 Advanced 

● 3RK3 ASIsafe basic 

● 3RK3 ASIsafe extended 

 

 Note 
Name 

References to "MSS 3RK3" or "3RK3 central units" in Chapter "Central unit with AS-i 
interface" always mean "MSS 3RK3 with AS-i interface" and "3RK3 central units with AS-i 
interface". Exceptions are explicitly identified. 

 

The differences between these 3RK3 central units are listed in the table: 

 
Feature 3RK3 ASIsafe 

basic 
3RK3 ASIsafe 
extended 

3RK3 Advanced 

Safety-related, freely 
parameterizable sensor inputs 

2 4 8 

Digital standard inputs (single-
channel) 

6 4 0 

Single-channel safety-related 
relay outputs 

1 1 1 

Two-channel safety-related solid-
state outputs 

1 1 1 

Expansion modules 0 2 9 
Maximum number of simulated 
safety-related AS-i slaves 

8 10 12 

DP interface Yes Yes Yes 
Diagnostics module Yes Yes Yes 

 
 

 Note 
Examples 

The examples in this chapter are all represented with a 3RK3 Advanced central unit. 
However, they apply equally to all other central units with AS-i interface. However, you must 
note the limitations on the number of expansion modules. 
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7.6.2 Communication of MSS 3RK3 with AS-i interface 

Requirements   
The MSS 3RK3 is an AS-i safety monitor and/or an AS-i slave on the AS-i bus. You therefore 
additionally need an AS-i master and an AS-i power section on the AS-i bus to operate the 
AS-i network. MSS 3RK3 also supports conventional AS-i components as well as AS-i 
Power24V components. 

Before the MSS 3RK3 can participate in AS-i communication, it must be informed by means 
of configuration in the MSS ES as to which AS-i slaves on the AS-i  line are relevant for 
MSS 3RK3 and which AS-i slaves the MSS 3RK3 is to represent/simulate. 

Communication   
Unlike MSS 3RK3 Basic, the 3RK3 central units with AS-i interface can be connected to an 
AS-i bus. Otherwise, the same interfaces are available as on the MSS 3RK3 Basic. 

1

2

4

3

 
① PC or programming device via device interface on MSS 3RK3 with AS-i interface or DP 

interface 
② DP interface 
③ MSS 3RK3 with connection to the AS-Interface 
④ PC or programming device over PROFIBUS and DP-Interface 

Figure 7-19 Communication of MSS 3RK3 Advanced 

Reference 
You will find additional information on AS-Interface in " AS-Interface system manual (edition 
11/2008) with expansions (edition 09/2010 - for displaying and configuring see Entry ID 
44365425) (http://support.automation.siemens.com/WW/view/en/26250840)." 

http://support.automation.siemens.com/WW/view/en/26250840�
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7.6.3 ASIsafe 
The ASIsafe (AS-Interface Safety at Work) concept allows the integration of safety-related 
components in an AS-Interface network. The use of safety-related AS-i input slaves, safety 
monitors and safety-related AS-i outputs enables the transfer and evaluation of safety-
related data and the safety-related control of actuators on the bus level.   

ASIsafe principle of operation 

Safety-related signals from sensors (8 x 4-bit code sequences)   

Each safety-related AS-i input slave has its own, unique 8 x 4-bit code sequence to be able 
to transmit safety-related signals to a safety monitor. These code sequences must be made 
known to the MSS 3RK3 by teaching. The integrated safety monitor listens in to the 8 x 4-bit 
code sequences of all safety-related AS-i input slaves as a passive participant and evaluates 
them safely.  

You will find more information about teaching code sequences in Chapter "Teaching the 
code sequences (Page 482)." 

Safety-related signals to actuators (7 x 4-bit code sequences)   

These safety-related signals are transmitted to the safety-related AS-i outputs as 7 x 4-bit 
code sequences. For this purpose, the safety monitor simulates a safety-related AS-i slave 
with an AS-i address and a special 7 x 4-bit code sequence. The safety-related output listens 
out for this 7 x 4-bit code sequence without having an address assigned to it, that is, it 
behaves like a monitor. The safety-related output evaluates the 7 x 4-bit code sequences 
and switches the connected actuators on or off as required. 
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Example 
The graphic shows a typical structure of an AS-i-Bus. A safety monitor monitors the 8 x 4-bit 
code sequences of an EMERGENCY-STOP (safety-related AS-i input slave) and evaluates 
the safety information. A safety-related AS-i slave is integrated in the safety monitor. This 
slave controls a safety-related AS-i output using 7 x 4 bit sequences. The safety-related AS-i 
output responds to the address of the integrated slave and switches the system on or off 
based on the safety information using an actuator. 

An MSS 3RK3 with AS-i interface can perform any function of these safe AS-i components: 

1

2

5

3

4 6

7

8

 
① AS-i master 
② AS-i power section 
③ Safety-related AS-i input slave 
④ Transmission of the 8 x 4 bit-code sequences 
⑤ AS-i-safety monitor with integrated safety-related AS-i slave 
⑥ Transmission of the 7 x 4 bit-code sequences 
⑦ Safety-related AS-i output 
⑧ Actuator 

Figure 7-20 Example ASIsafe  

An MSS 3RK3 with AS-i interface can perform the functions of the components "safety-
related AS-i input slave" ③, "AS-i safety monitor with integrated safety-related AS-i Slave" 
⑤, and "safety-related AS-i output" ⑦ in the AS-i network. 

Reference 
You will find more information about ASIsafe and safety-related AS-i output in the  
"AS-Interface System Manual (11/2008 Edition) with Supplements (09/2010 Edition)" 
(http://support.automation.siemens.com/WW/view/en/26250840) order number  
3RK2703-3AB02-1AA1. 

http://support.automation.siemens.com/WW/view/en/26250840�
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7.6.4 Functions of the MSS 3RK3 on the AS-i bus 
The MSS 3RK3 with AS-i interface can perform various functions on the AS-i bus: 

● Simulation of slaves 

– Simulation of non-safety-related AS-i slaves 

The MSS 3RK3 with AS-i interface can simulate up to 4 non-safety-related AS-i 
slaves. 

– Simulation of safety-related AS-i slaves 

The MSS 3RK3 with AS-i interface can simulate safety-related AS-i slaves and 
perform one of the following functions on the AS-i bus in each case: 

◆ Simulation of safety-related AS-i input slaves  

◆ Setting/resetting of safety-related AS-i outputs  

The MSS 3RK3 ASIsafe basic can simulate up to 8 safety-related AS-i slaves. 

The MSS 3RK3 ASIsafe extended can simulate up to 10 safety-related AS-i slaves.  

The MSS 3RK3 Advanced can simulate up to 12 safety-related AS-i slaves. 

● Representation of safety-related AS-i outputs 

The MSS 3RK3 with AS-i interface can represent up to 31 safety-related AS-i outputs on 
the AS-i bus, where each of these AS-i outputs can have up to 4 safety-related output 
functions. 

● Monitoring slaves 

The MSS 3RK3 with AS-i interface is configured as an AS-i safety monitor and can 
monitor and evaluate all frames on the AS-i bus.  

– Monitoring of non-safety-related AS-i slaves 

MSS 3RK3 evaluates up to 14 non-safety-related AS-i slaves. 

– Monitoring of safety-related AS-i input slaves 

MSS 3RK3 evaluates up to 31 safety-related AS-i input slaves. 
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 Note 
Maximum expanded configuration of the AS-Interface   

Up to 31 standard addresses can be assigned on an AS-i bus. Once all standard addresses 
are assigned, maximum 4 safety monitors without an address can be additionally installed. 

If fewer than 31 standard addresses are assigned, an additional safety monitor or another 
AS-i component without an address (e.g., ground fault monitoring modules) can be installed 
for every unassigned standard address. 

You will find more information in the "AS-Interface System Manual (11/2008 edition) with 
Supplements (09/2010 edition) 
(http://support.automation.siemens.com/WW/view/de/26250840/0/en)" (order number: 
3RK2703-3AB02-1AA1). 

 

 Note 
MSS 3RK3 bus load 

The MSS 3RK3 is always a physical bus load from an A/B slave on the AS-i bus. This bus 
load does not depend on how many slaves can be simulated by the MSS 3RK3 or whether 
only AS-i slaves are monitored. 

 

Reference 
Examples of various applications of the MSS 3RK3 with AS-i interface and combinations can 
be found in the following chapter. 

http://support.automation.siemens.com/WW/view/de/26250840/0/en�
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7.6.5 Safety-related data exchange, for example, in multiple subnetworks 

Combination of multiple MSS 3RK3 units with AS-i interface in various subnets. 

3
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 AS-Interface 

 PROFIBUS with PROFIsafe 

 ASIsafe 

① F-PLC 
② DP/AS-i F-Link 
③ MSS 3RK3 Advanced monitors ⑨ and ⑩ 
④ AS-i-safety-related monitor monitors ⑩, ⑪, and ⑫ 
⑤ Unidirectional data exchange from the MSS 3RK3 Advanced to the F-Link   
⑥ Data exchange between MSS 3RK3 Advanced and the safety monitor 
⑦ AS-i power section 
⑧ ... ⑫ Safety-related and non-safety-related AS-i slaves 

Figure 7-21 AS-Interface with different subnetworks 
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It is possible to operate multiple AS-i devices with monitor functionality on one AS-i line. That 
way, they can monitor different groups of AS-i slaves on the same AS-i line (subnets) that 
contain no restrictions, that is, the groups may contain the same AS-i slaves, or only 
subsets, or no common AS-i slaves. The individual 3RK3 central units with AS-i interface can 
also monitor one another and communicate with one another.  

 

 Note 
Exchange of up to 12 safety-related signals  

The MSS 3RK3 with AS-i interface can simulate multiple safety-related AS-i slaves on the 
AS-i bus. These can be either safety-related input slaves for controlling an F-link or safety 
monitors, or safety-related output slaves for controlling safety-related AS-i outputs or a 
combination of the two.  

The number of simulated safety-related AS-i slaves depends on the type of central unit:  
• The MSS 3RK3 ASIsafe basic can simulate up to 8 safety-related AS-i slaves. 
• The MSS 3RK3 ASIsafe extended can simulate up to 10 safety-related AS-i slaves. 
• The MSS 3RK3 Advanced can simulate up to 12 safety-related AS-i slaves. 
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7.6.6 Addressing and configuring AS-i components in MSS ES 

Configuration of real AS-i slaves   
In MSS ES, the real AS-i slaves are communicated to the MSS 3RK3 in the subsystem 
(navigation window). The hardware catalog contains all supported SIEMENS AS-i 
components. Just like in the main system they can be dragged into the work space and have 
their AS-i address assigned. Using the universal modules, the profiles of AS-i slaves can be 
defined independently of their manufacturers. 

Alternately, it is also possible to determine the expanded configuration of the AS-Interface in 
the subsystem online: The actual configuration, that is, the hardware configuration of the 
AS-i subslot expanded configuration can be applied by clicking the "Determine online" 
button. The result will depend on the master and slaves used. You will find additional 
information in Chapter "AS-i subsystem (Page 242)." 

Configuration and addressing of simulated AS-i slaves 
The addresses of the simulated non-safety-relevant AS-i slaves can be freely assigned. The 
AS-i slave addresses are assigned in the MSS ES in the properties for the 3RK3 central unit. 
This is also where the profile of the simulated slave is selected. The simulated slaves are 
displayed in italics in the subsystem. 

 

 Note 

The addresses cannot be changed during runtime because it would require modification of 
the configuration data. That is why no addressing and no address changes can be 
performed on the MSS 3RK3 using the addressing device.   

 

Configuring the safety logic   
The parameterizable safety logic of the MSS 3RK3 with AS-i interface allows the following 
signals to be interconnected in MSS ES via input and output terminals: 

● Inputs and outputs of expansion modules, if supported by the 3RK3 central unit 

● Inputs and outputs of the DP interface 

● Inputs and outputs of real, non-safety-related AS-i slaves 

● Inputs and outputs of real, safety-related AS-i slaves 

● Inputs and outputs of simulated, non-safety-related AS-i slaves 

● Inputs and outputs of simulated, safety-related AS-i slaves 

 

Reference 
You will find additional information in Chapter "Creating a configuration in MSS ES 
(Page 423)." 
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7.6.7 Simulation of AS-i slaves 

7.6.7.1 Simulated AS-i slaves 

AS-i slave function - simulated slaves    
Simulated slaves are required for transmitting bit information to other devices on the AS-i 
bus, for example, to the safety monitor or to an additional MSS 3RK3 unit with AS-i interface. 
In principle, they have the same properties as real slaves, in particular regarding their AS-i 
address, process data exchange, terminal identifiers, and equipment identifier (BMK). 

The following must be noted for simulated slaves: 

● The MSS 3RK3 does not monitor its own simulated AS-i slaves with its monitoring 
function. 

Where values from output terminals of simulated slaves are used again as an input in the 
logic, the input value is not derived using the monitor function but the value of the output 
terminal is used. This means that the value will be available to the safety logic in the next 
processing cycle of the MSS 3RK3. There are no asynchronous dependencies between 
the cycle time of the MSS 3RK3 and the cycle time of the AS-i bus. 

● Simulated AS-i slaves are also visible on the AS-i bus outside safety mode and test 
mode. 

However, only zeros are returned as output values in configuration mode. All received 
input values are ignored. 

One exception to this is the simulated AS-i slave with CTT2 profile, as this is used for 
device diagnostics of the MSS 3RK3 and therefore supplies correct diagnostics data 
using the CTT2 protocol in configuration mode, too. 

You will find additional information in Chapter "Diagnosis using AS-Interface (CTT2 
protocol) (Page 582)." 

● Downloading a new configuration 

No AS-i slaves are simulated while a new configuration is being downloaded. Therefore 
no simulated slaves are visible. Only after the correctness of the configuration has been 
evaluated are the AS-i slaves in the new configuration simulated on the bus again. 
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7.6.7.2 Simulation of non-safety-related AS-i slaves 
An MSS 3RK3 with AS-i interface can identify itself as a slave on the AS-i bus. For this, a 
maximum of 4 non-safety-related standard slaves or a maximumb of 4 A/B slaves are 
simulated on the bus. One of these AS-i slaves can be configured as a CTT2 diagnostics 
slave.    

The following non-safety-related slaves can be simulated: 

● Standard slaves type S-7.F.F (Std 4I/4O) 

● A/B slaves type S-7.A.E (A/B 4I/3O) 

● CTT2 diagnostic slave type S-7.5.5 (CTT2 + 2I/2O) 

With a simulated non-safety-related AS-i slave, master calls to the simulated slave can be 
incorporated in the safety logic and signals sent to the master. 

CTT2 slave   

With a simulated CTT2 slave, diagnostic data can be exchanged with the AS-i master via the 
CTT2 protocol (message and control data). The CTT2 slave also has 2 non-fail-safe inputs 
and outputs. 

Terminal designation in the MSS ES 
Input terminals for non-safety-related signals can have input signals of the simulated slaves 
assigned to them in the interconnection logic in MSS ES. 

 
Terminal designation in the input cell Explanation 
SLOT3_ASI#xx(AB)_Qc Master call from AS-i master to simulated non-safety-

related AS-i slave of the MSS 3RK3 
SLOT3_ASI#xx_Qy.z Master call (CTT2 protocol) from AS-i master to 

simulated non-safety-related AS-i slave (CTT2) of the 
MSS 3RK3 (see Chapter "Diagnosis using AS-Interface 
(CTT2 protocol) (Page 582)") 
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Output terminals for non-safety-related signals can be configured as output signals of the 
simulated slaves in the interconnection logic in MSS ES. 

 
Terminal designation in the output cell Explanation 
SLOT3_ASI#xx(AB)-Sc Sensor signal from MSS 3RK3 to AS-i master: Non-

safety-related AS-i output data range of the simulated 
AS-i slave designates "non-safety-related" output 

SLOT3_ASI#xx-Sy.z Signal from simulated CTT2 slave of MSS 3RK3 to AS-i 
master (see Chapter "Diagnosis using AS-Interface 
(CTT2 protocol) (Page 582)"). 

xx: AS-i address 
(AB): A or B can be entered here if the monitored slave is an A/B slave. This identifier is omitted for 

standard slaves. MSS 3RK3 supports only standard slaves for CTT2. 
c: Channel number of AS-i slave process image  
y.z: Defines bit position in CTT2 frame 

 

 

 Note 

The signals of the output cells can be included in the logic again through input cells. 
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Example 
The MSS 3RK3 Advanced simulates a non-safety-related AS-i slave on the AS-i bus. The 
signals from and to the master can be fed into and processed in the logic of the MSS 3RK3 
Advanced. The sensor signals from the simulated, non-safety-related AS-i slaves to the 
master are output to the AS-i bus through the output terminals in the logic.  

3a

1

3

2

4  
① CPU/PLC 
② AS-i power section 
③ MSS 3RK3 Advanced (AS-i address #01) with connected motor (3a) 
④ AS-i master 

Figure 7-22 Simulation of non-safety-related AS-i slaves 

 

In this case, the input and output terminals of the logic diagram in MSS ES are designated 
as follows: 

4 3

3 4  
Figure 7-23 Simulation of non-safety-related AS-i slaves in the logic diagram 
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7.6.7.3 Simulation of safety-related AS-i input slaves 
An MSS 3RK3 with AS-i interface can simulate safety-related AS-i input slaves on the AS-i 
bus in order to send safety-related signals to the AS-i bus: 

● The MSS 3RK3 ASIsafe basic can simulate up to 8 safety-related AS-i input slaves. 

● The MSS 3RK3 ASIsafe extended can simulate up to 10 safety-related AS-i input slaves. 

● The MSS 3RK3 Advanced can simulate up to 12 safety-related AS-i input slaves. 

These signals can be monitored and evaluated by other safety monitors. 
 

 Note 
Exchange of safety-related signals 

If safety-related output slaves for controlling safety-related AS-i outputs are simulated 
simultaneously, the number of simulated safety-related AS-i input slaves are reduced 
accordingly. 

 

    

Terminal designation in the MSS ES 
The input signals of the expansion modules of the MSS 3RK3 can be wired in the 
interconnection logic in MSS ES to logical terminals, which provide their values as simulated 
safety-related AS-i input slaves on the AS-i bus. 

 
Terminal designation of the output cell Explanation 
SLOT3_ASI#xx-F-S1&2 Sensor signal from MSS 3RK3 to AS-i master that can be 

evaluated by an AS-i safety monitor 

xx: AS-i address 
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Example 
The MSS 3RK3 Advanced simulates a safety-related AS-i input slave on the AS-i bus. The 
signals of terminals of the expansion modules can be entered in the logic of the MSS 3RK3 
Advanced as AS-i signals on the AS-i bus. A safety monitor, for example, an AS-i safety 
monitor, can evaluate these signals and shut down the motors safely. 

3a

3b

1

4

2

6

3

5

4a

 
① CPU/PLC 
② AS-i power section 
③ As-i safety monitor with connected motors on Q1/Q2 
④ MSS 3RK3 Advanced (AS-i address #01) with emergency stop on IN1/IN2 
⑤ Data exchange between MSS 3RK3 Advanced and the AS-i safety monitor 
⑥ AS-i master 

Figure 7-24 Simulation of safety-related AS-i input slaves  

In this case, the input and output terminals of the logic diagram in MSS ES are designated 
as follows: 

4a 4

4 3

 
Figure 7-25 Simulation of safety-related AS-i input slaves in the logic diagram  
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7.6.7.4 Control of safety-related AS-i outputs 
The MSS 3RK3 with AS-i interface can control safety-related AS-i outputs. Safety-related 
AS-i output slaves are simulated on the AS-i bus for this purpose.  

● The MSS 3RK3 ASIsafe basic can simulate up to 8 safety-related AS-i output slaves. 

● The MSS 3RK3 ASIsafe extended can simulate up to 10 safety-related AS-i output 
slaves. 

● The MSS 3RK3 Advanced can simulate up to 12 safety-related AS-i output slaves. 

These AS-i output slaves are each assigned an AS-i address to which the safety-related AS-i 
output being set or reset responds.  

 

 Note 
Exchange of safety-related signals 

If safety-related AS-i input slaves are simulated simultaneously, the number of simulated 
safety-related AS-i output slaves for controlling safety-related AS-i outputs is reduced 
accordingly. 

 

    

Safety-related AS-i outputs can be set or reset using the "AS-i1..4F-DO" output function and 
"Output cell" cell function. 

Up to four fail-safe signals can be transmitted for each AS-i address using output functions 
"AS-i1..4F-DO." At any one time, only one of these fail-safe signals may be active. 

If the output is set and reset using the "Output cell" cell function, only the first of the four fail-
safe signals can be used.    

7 x 4 bit code sequences of the safety-related AS-i output slaves   
These slaves send 7 x 4 bit code sequences, which are permanently assigned for each 
address, on the address configured for this. The safety-related AS-i outputs to be set and 
reset behave like safety monitors and monitor the address assigned to them on the AS-i bus.  
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Non-safety-related auxiliary control signals (AUX1/AUX2)    
In addition to the safety-related control signals (code sequences) of the AS-i outputs, non-
safety-related auxiliary control signals (AUX1, AUX2) can also be transmitted. These are 
used, for example, to acknowledge a restart inhibit or to release errors at AS-i outputs. 
Additional information can be found in the relevant documentation of the safety-related AS-i 
output. 

The auxiliary control signals AUX1 and AUX2 are defined as pulses. That is why these 
terminals must not be used for static signals. This pulse is generated as soon as an edge 
change from zero to one is detected at the respective AUX input (an edge change from one 
to zero is not taken into consideration). 

If a simultaneous edge change is detected for both inputs, the pulse for AUX2 is output after 
the pulse for AUX1. 

Interconnection in the logic diagram 
The AS-i outputs are set or reset in the interconnection logic either by means of an "output 
cell" (Q1 only) or by means of the function element "AS-i 1..4F-DO."  

Terminal designation in the MSS ES 
 
Terminal designation BMK.OUT Explanation 
SLOT3_ASI#xx-F-Qc Sensor signal from MSS 3RK3 to AS-i master that can be 

evaluated by an AS-i output. 

xx: AS-i address 
c: Number of the output (1 ... 4) 
 



 Operation 
 7.6 Integrating the 3RK3 modular safety system into the AS-i bus 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 469 

Example 
The MSS 3RK3 monitors the safety-related AS-i input slave "EMERGENCY STOP" and sets 
and resets the safety-related AS-i output, which switches the motor off. 

4a1

5

2
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4

6

3

7
 

① CPU/PLC 
② AS-i power section 
③ Safety-related AS-i input slave (AS-i address #01) 
④ Safety-related AS-i output (responds to AS-i address #02) with motor (4a) connected to Q1 
⑤ MSS 3RK3 Advanced sets and resets the AS-i output at address #02 
⑥ Data exchange between MSS 3RK3 Advanced and the safety-related AS-i output 
⑦ Data exchange between safety-related AS-i input slave and MSS 3RK3 Advanced 
⑧ AS-i master 

Figure 7-26 Setting/resetting of safety-related AS-i output 

In this case, the input and output terminals of the logic diagram in MSS ES are designated 
as follows: 

3 5

5 4

 
Figure 7-27 Setting/resetting of safety-related AS-i output in the logic diagram 
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 Note 
Setting/resetting of a safety-related AS-i output 

If a safety-related AS-i output is set and reset using the "Output cell" cell function, only the 
first of the four fail-safe signals can be used. 

You can use output function "AS-i1..4F-DO" to interconnect multiple outputs of a safety-
related AS-i output or auxiliary signals (AUX) and to monitor the switching status. 

 

Another method of interconnecting the signals in the logic is demonstrated below:  

3 5

5 4

 
Figure 7-28 Controlling safety-related AS-i outputs using function element AS-i 1..4F-DO 
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7.6.8 Representation of safety-related AS-i outputs 
The MSS 3RK3 with AS-i interface can represent a maximum of 31 safety-related AS-i 
outputs. Safety-related AS-i outputs do not have an explicit address on the AS-i bus. A 
safety-related AS-i output behaves like a safety monitor that responds to a 7 x 4 bit code 
sequence of an AS-i address. In this way, actuators can be switched safely.     

Switching response of safety-related output signals  
No zero signal has to be transferred in order to switch between two output signals of an AS-i 
output slave. The active output stays on until the full code sequence of another output of this 
output slave has been received. If an error occurs while the new code sequences are being 
transmitted or if a zero sequence is transmitted, all outputs will be deactivated.  

Terminal designation in the MSS ES 
The signal source (e.g., a safety monitor or an additional MSS 3RK3 with AS-i interface) 
transmits a 7 x 4-bit code sequence depending on the AS-i address, which is received and 
evaluated by the MSS 3RK3. The input values are available for processing on the logical 
terminals in the logic and can be configured as required in the MSS ES. In this way, the 
MSS 3RK3 controls its own outputs. The terminal designations of the input cells for this are 
as follows: 

 
Terminal designation of the input cells Explanation 
ASI#xx_F-OUTc Signal, for example, from an AS-i safety monitor V3.0 or 

from another MSS 3RK3 with AS-i interface 
ASI#xx_AUXm Modulated, non-safety-related auxiliary control signal 

m: Auxiliary signal 1 or 2 
xx: AS-i address 
c: Channel number of the AS-i slave process image, here the identifier OUT is selected as it is not a 

sensor value but a preprocessed signal. 
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Example 
The left MSS 3RK3 Advanced responds to an EMERGENCY STOP and passes a signal for 
a safety-related AS-i output to the right-hand MSS 3RK3 Advanced. The right-hand MSS 
3RK3 Advanced behaves like a safety-related AS-i output and can read and process the 
signal. Both motors are shut down safely through a safety-related output of an expansion 
module. 

4a

4b

3a

1

4

2

6

3

5

 
① CPU/PLC 
② AS-i power section 
③ MSS 3RK3 Advanced (controlling a safety-related AS-i output slave on AS-i address #01) with connected 

EMERGENCY STOP 
④ MSS 3RK3 Advanced (safety-related AS-i output slave monitors AS-i address #01; no AS-i address is assigned) 

with motors connected to Q1/Q2 
⑤ Data exchange between MSS 3RK3 Advanced ③ and MSS 3RK3 Advanced ④ 
⑥ AS-i master 

Figure 7-29 MSS 3RK3 Advanced as a safety-related AS-i output 

In this case, the input and output terminals of the logic diagram in MSS ES of the right-hand 
MSS 3RK3 Advanced are designated as follows: 

3 4

4 4a

 
Figure 7-30 Evaluation of safety-related AS-i output in the logic diagram 
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7.6.9 Monitoring slaves 

Function 
The MSS 3RK3 with AS-i interface also performs the function of a safety monitor. The safety 
monitor is at the heart of ASIsafe. It monitors the information transmitted through the AS-
Interface (master call, response from AS-i slave).    

 

 Note 
Minimum expanded configuration of the AS-i bus   

At least four AS-i slaves must be connected to the AS-i bus to ensure that the safety-related 
AS-i input slaves are correctly evaluated. It does not matter whether the additional slaves are 
safety-related or standard slaves. If fewer than four real AS-i slaves exist, the other slaves 
that are needed can be simulated by MSS 3RK3. 

 

Evaluation in the logic of the MSS 3RK3 
The evaluation of the information produces the values in the input cells. These are 
subsequently further processed in the processing logic of the MSS 3RK3.  

To be able to interconnect a non-safety-related AS-i slave, the "Monitor non safe I/O" 
checkbox must be selected in the subsystem (navigation window) in the properties of the 
AS-i slave.  

The signals of a safety-related AS-i input slave are composed partly of safety-related signals 
and partly of non-safety-related signals. To be able to interconnect the non-safety-related 
information of a safety-related slave, the "Monitor non safe I/O" checkbox must be selected 
in the subsystem (navigation window) in the properties of the slave, like for the non-safety-
related slave. 

 

 Note 
Simulated AS-i slaves    

Where values from output terminals of simulated slaves are used again as an input in the 
logic, the input value is not derived using the monitor function but the value of the output 
terminal is used. This means that the value will be available to the safety logic in the next 
processing cycle of the MSS 3RK3. There are no asynchronous dependencies between the 
cycle time of the MSS 3RK3 and the cycle time of the AS-i bus. 

 

Reference 
You will find additional information on ASIsafe on the Internet 
(http://support.automation.siemens.com/WW/view/en/12834652/133300). 

http://support.automation.siemens.com/WW/view/en/12834652/133300�
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7.6.9.1 Monitoring of non-safety-related AS-i slaves 
The MSS 3RK3 with AS-i interface can monitor up to 14 non-safety-related AS-i slaves of 
type "standard slave," "A/B slave," or "CTT3 slave." In this way, non-safety-related signals 
that are exchanged between the master and the non-safety-related AS-i slaves can be fed 
into the logic of the MSS 3RK3.  

The following CTT3 profiles are supported:   

● IO-Code 0x7, ID-Code 0xA, ID2-Code 0x7 (S-7.A.7): 

A/B slave with 4-bit input and 4-bit output image 

● IO-Code 0x7, ID-Code 0xA, ID2-Code 0xA (S-7.A.A): 

A/B slave with 8-bit input and 8-bit output image 
 

 Note 
Further AS-i slave profiles: 

All slave profiles that are not supported are interpreted as "4I / 4O standard slaves" or as 
"4I / 3O A/B slaves." 

 

Terminal designation in the MSS ES 
Signals from the AS-i-master to the AS-i slave (Q) or from the AS-i slave to the AS-i-master 
(IN) can be incorporated in the interconnection logic via an input cell and interconnected in 
the MSS ES.  

 

 Note 

To be able to interconnect a non-safety-related AS-i slave, the "Monitor non safe I/O" 
checkbox must be selected in the subsystem (navigation window) in the properties of the 
slave. 

 

The designations of the input cells for this are as follows: 

 
Terminal designation in the input cell Explanation 
ASI#xx(AB)_INc Sensor input 
ASI#xx(AB)_Qc Output (master call) 
ASI#xx(AB)_Qc* Master call to the channel that is not part of the slave profile

xx: AS-i address 
(AB): A or B can be entered here if the monitored slave is an A/B slave. This identifier is omitted for 

standard slaves. 
c: Channel number of AS-i slave process image  
c*: The process image of the master call may contain more channels than the slave profile of the 

corresponding AS-i slave. The channels addressed here are not processed on the AS-i slave but 
can be used in the logic. 
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Example 
The MSS 3RK3 Advanced monitors a non-safety-related AS-i slave. A release and an 
indicator light are connected to this AS-i slave. The data traffic between the AS-i master and 
the non-safety-related AS-i slave can be fed into the logic of the MSS 3RK3 Advanced and 
processed. An additional indicator light is connected via an expansion module. 

1

4

2

5

3

3a

3b

4a

 
① CPU/PLC 
② AS-i power section 
③ Non-safety-related AS-i slave (AS-i address #01) with release (3a) connected to IN1 and 

indicator light (3b) to Q4 
④ MSS 3RK3 Advanced with additional indicator light (4a) on expansion module (slot 5) 

connected to Q2 
⑤ AS-i master 

Figure 7-31 Evaluation of a non-safety-related AS-i slave 

In this case, the input and output terminals of the logic diagram in MSS ES are designated 
as follows: 

5 3 4 4a

3 5  
Figure 7-32 Evaluation of the non-safety-related AS-i slave in the logic diagram 
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7.6.9.2 Monitoring of safety-related AS-i input slaves 
The MSS 3RK3 with AS-i interface can monitor up to 31 safety-related AS-i input slaves. 
These can be simulated by real input slaves or by other devices such as additional 
MSS 3RK3 units with AS-i interface, safety monitors, etc.   

Terminal designation in the MSS ES 
Signals from the safety-related AS-i input slave to the AS-i master (IN) can be incorporated 
into the interconnection logic as in input and configured in MSS ES.  

If the AS-i input slave also has non-safety-related outputs, these master calls to the AS-
i slave (Q) can also be monitored and incorporated in the logic. 

The terminal designations of the input cells and the monitoring function "AS-i 2F-DI" for this 
are named: 

 
Terminal designation in the input cell Explanation 
ASi#xx_F-IN1&2 Sensor value: Safety-related signal from the code 

sequence of a two-channel sensor 
ASi#xx_F-INc Input terminal signal of the ASIsafe input slave for the 

monitoring functions. 
If monitoring function "AS-i 2F-DI" is used: 
The monitoring function "AS-i 2F-DI" is used instead of an 
input cell if you want to diagnose both of the input terminal 
signals of the ASIsafe input slave.   

xx: AS-i address 
c: Number of the safety-related input 
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 Note 
Non-safety-related data with combined AS-i slaves 

The signals of combined AS-i slaves with safety-related AS-i inputs and standard AS-i 
outputs are composed partly of safety-related signals and partly of non-safety-related 
signals. To be able to interconnect the non-safety-related information of these slaves, the 
"Monitor non safe I/O" checkbox must be selected as for the non-safety-related slave in the 
subsystem (navigation window) in the properties of the slave. 

 

 
 

 Note 
Single-channel use of safety-related AS-i input slaves 

The safety-related AS-i input slaves have two inputs that cannot be used independently of 
each other, so that a safety-related AS-i input slave can only be used in two channels. If a 
safety-related AS-i input slave is nevertheless to be used in one channel only, the second 
input must be bridged or assigned two single-channel sensors so that the entire code 
sequence can be viewed. 
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Example 1 
The MSS 3RK3 Advanced monitors the AS-i EMERGENCY STOP, a safety-related AS-i 
input slave. The safe data traffic can be fed into the logic of the MSS 3RK3 Advanced 
through input cells and processed. A motor is shut down safely through a safety-related 
output of an expansion module. 

1

4

2

5

3
4a

 
① CPU/PLC 
② AS-i power section 
③ Safety-related AS-i input slave (AS-i address #02) 
④ MSS 3RK3 Advanced with motor (4a) connected to Q2 
⑤ AS-i master 

Figure 7-33 Evaluation of a safety-related AS-i input slave 

In this case, the input and output terminals of the logic diagram in MSS ES are designated 
as follows: 

5 3 4 4a

3 5  
Figure 7-34 Evaluation of the safety-related AS-i input slave in the logic diagram 
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Example 2 
The MSS 3RK3 Advanced monitors the safety-related AS-i input slave to whose inputs an 
EMERGENCY STOP is connected. An indicator light is connected to a standard output of 
the AS-i slave, which is switched by the AS-i master. The MSS 3RK3 Advanced acquires the 
status of the indicator light with "monitoring standard slaves" functionality. This status can be 
fed into the logic of the MSS 3RK3 Advanced via input cells. 

 

 Note 

The standard output can only be interconnected in the logic if the "Monitor non safe I/O" 
checkbox is selected in the subsystem in the slave properties. 

 

The motor of the system is safely shut down through a safety-related output of an expansion 
module and a further indicator light indicates release of the EMERGENCY STOP. 

 

1

4

2

5

3

4b

3a

3b

4a

 
① CPU/PLC 
② AS-i power section 
③ Safety-related AS-i input slave (AS-i address #02) with standard outputs 

An EMERGENCY STOP is connected to the safety-related inputs (IN1/IN2), and an indicator light is connected to 
the standard output (OUT1) 

④ MSS 3RK3 Advanced with connected indicator light (4a) to Q4 and motor (4b) to Q2 
⑤ AS-i master 

Figure 7-35 Evaluation of a safety-related AS-i input slave 
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In this case, the input and output terminals of the logic diagram in MSS ES are designated 
as follows: 

4 4b

5 3b

3a 4

4 4a

4

5

 
Figure 7-36 Evaluation of the safety-related AS-i input slaves and of the standard outputs in the logic 

diagram 
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7.6.10 Overview of possible incoming and outgoing AS-i signals 
The information that can be read by the AS-i bus or written to the AS-i bus is displayed in the 
logic interconnection in the MSS ES software through terminals.    

 

 Note 
Terminal list in MSS ES 

For an overview of all terminals configured in MSS ES, you can have them displayed as a 
list: "Options" > "Terminal list" 

 

 

 
Terminal designation input 
cells in MSS ES 

Explanation Function of  
MSS 3RK3 

ASI#xx(AB)_INc Sensor input 
ASI#xx(AB)_Qc Output (master call) 
ASI#xx(AB)_Qc* Master call to the channel that is not part of the slave profile 

Monitoring of non-safety-
related AS-i slaves 

ASi#xx_F-IN1&2 Sensor value: Safety-related signal from the code sequence 
of a two-channel sensor 

ASi#xx_F-INc Input terminal signal of the ASIsafe input slave for the 
monitoring functions. 
If monitoring function "AS-i 2F-DI" is used: 
Monitoring function "AS-i 2F-DI" is used instead of an input 
cell if you want to diagnose both the input terminal signals of 
the ASIsafe input slave. 

Monitoring of safety-related 
AS-i input slaves 

ASI#xx_F-OUTc Signal, for example, from an AS-i safety monitor or from 
another MSS 3RK3  

ASI#xx_AUXm Modulated, non-safety-related auxiliary control signal 

Representation of a safety-
related AS-i output 

Slot3_ASI#xx(AB)-Qc Master call from AS-i master to the simulated non-safety-
related AS-i slave of the MSS 3RK3  

Slot3_ASI#xx-Qy.z Master call from AS-i master to the simulated non-safety-
related AS-i slave (CTT2) of the MSS 3RK3  

Simulation of non-safety-
related AS-i slaves 
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Function of  
MSS 3RK3  

Explanation Terminal designation of 
output cells in MSS ES 

Sensor signal from MSS 3RK3 to AS-i master: Non-safety-
related AS-i output data range of the simulated AS-i slave 
designates "non-safety-related" output 

Slot3_ASI#xx(AB)-Sc Simulation of non-safety-
related AS-i slaves 

Sensor signal from MSS 3RK3 to AS-i master: Determines 
bit position in CTT2 frame for device diagnostics (see 
Chapter "Diagnosis using AS-Interface (CTT2 protocol) 
(Page 582)"). 

Slot3_ASI#xx-Sy.z 

Simulation of safety-related 
AS-i input slaves 

Sensor signal from MSS 3RK3 to AS-i master that can be 
evaluated by an AS-i safety monitor 

Slot3_ASI#xx-F-S1&2 

Setting/resetting of safety-
related AS-i outputs 

Sensor signal from MSS 3RK3 to AS-i master that can be 
evaluated by an AS-i output. 

Slot3_ASI#xx-F-Qc 

m: Auxiliary signal 1 or 2 
xx: AS-i address 
(AB): A or B can be entered here if the monitored slave is an A/B slave. This identifier is omitted for standard slaves. MSS 

3RK3 supports only standard slaves for CTT2. 
c: Channel number of AS-i slave process image  
c*: The process image of the master call may contain more channels than the slave profile of the corresponding AS-i slave. 

The channels addressed here are not processed on the AS-i slave but can be used for special solutions. 
y.z: Defines bit position in CTT2 frame 

7.6.11 Teaching the code sequences 

7.6.11.1 Code sequences 

Code sequences of safety-related AS-i input slaves    
Code sequences are acquired by a safety monitor As soon as the MSS 3RK3 with AS-i 
interface detects that at least one safety-related AS-i input slave requires processing, the 
monitor functionality is automatically started. That is possible both during startup and after 
transmission of a new configuration in configuring mode. Teaching of 8 x 4 bit code 
sequences is therefore possible in configuring mode, safety mode and test mode. 

Code sequences of safety-related AS-i outputs     
As part of the development of safety-related AS-i outputs new 7 x-4 bit code sequences have 
been added to the 8 x 4 bit code sequences of the safety-related AS-i input slaves. These 
code sequences which uniquely apply to the safety-related AS-i outputs do not have to be 
retaught but are specified for every possible address on the AS-i bus. 
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7.6.11.2 Teaching code sequences 
To be able to monitor safety-related AS-i input slaves, they must be made known to the 
system. This means that the code sequences of all safety-related AS-i input slaves located 
on the AS-i bus must be known so that they can be identified as safety-related information 
on the AS-i bus. The process of recording, checking, and storing these code sequences is 
referred to as "teaching code sequences."    

Determining the actual expanded configuration on the AS-i bus and comparing it with the target 
configuration 

The actual expanded configuration on the AS-i bus can only be determined once the AS-i 
master has completed its power-up phase and all AS-i slaves on the bus have been 
addressed correctly and are active. The MSS 3RK3 with AS-i interface determines all slaves. 
The list of recognized safety-related slaves is derived from this information. Finally, a check 
is made to see whether matching code sequences exist for all safety-related AS-i input 
slaves. 

 

 Note 
Important requirement 

During the teaching process the contacts of the safety-related AS-i input slaves must be 
closed at least once to allow the code sequences to be retaught. 

If the contacts are not closed, calculation continues in the logic diagram with the substitute 
value "0." The current status of the AS-i slaves is displayed in the "Target system" > "Learn 
ASIsafe code tables" dialog box.   

 

Once the actual expanded configuration has been determined, it is compared with the 
predefined target configuration. AS-i slaves that were not found or that have been stored 
with a non-matching code sequence are calculated in the logic processing with the substitute 
value "0." For all others, the current process value is fed into the logic. Then the MSS 3RK3 
enters safety mode. 

Automatic teaching of code sequences in the background 
Irrespective of the current operating status, code sequence teaching is started in the 
background if the code sequence table is empty or incomplete.  

In the following cases, the code sequences are not taught: 

● During power-up 

● During switchover from safety mode to configuring mode due to an error 

● When the system stops 

● If the factory settings apply 
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LED display during teaching of code sequences 
 
LED Behavior Explanation 
DEVICE yellow/green/flicke

ring green 
Device in configuring mode/safety mode/test mode 

AS-i flashing red AS-i bus not ok, code table incomplete 
TEACH yellow flashing Teaching of code sequences in progress 
SF off No error 

 
 

 Note 

Missing code sequences are not interpreted as configuration errors. 
 

LED display when code sequences are complete 
 
LED Behavior Explanation 
DEVICE yellow/green/flicke

ring green 
Device in configuring mode/safety mode/test mode 

AS-i off AS-i bus ok, code table complete 
TEACH yellow The code sequences have been recorded and checked and can 

now be stored. 
SF off No error 
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Apply code tables   
The code sequence table can be transferred into the memory of the MSS 3RK3 in three 
different ways: 

● Pressing the RESET button for 3 s 

● Pressing the "Apply code tables" button in the "Target system" > "ASIsafe code tables" 
dialog box in MSS ES 

● Controlling a device command function element with the "Adopt code tables" command 

The TEACH-LED goes off after the code sequences have been successfully stored.  

If saving was started by pressing the reset button, this button can now be released  

After completion of the teach process, the device remains in its operating state. In test or 
safety mode, the real values of the safety-related AS-i input slaves are now used in the logic.  

The code sequences are stored in the memory module. No reteaching of code sequences is 
therefore necessary when devices are replaced. 

 

 Note 
Deleting code sequences   

The stored code sequences are deleted by restoring the factory settings or clearing the 
memory module. 

 

 Note 
Applying the actual expanded configuration on the AS-i bus 

When the code sequence table is stored, the actual state of all safety-related AS-i slaves on 
the AS-i bus is applied irrespective of the target configuration that is configured. For 
example, an existing code table of a previously taught safety-related AS-i slave is deleted for 
the address of a non-safety-related slave. 

 

LED display after successful teaching of code sequences 
 
LED Behavior Explanation 
DEVICE yellow/green/flicke

ring green 
Device in configuring mode/safety mode/test mode 

AS-i off AS-i bus ok, all safety-related AS-i slaves have been taught 
TEACH off Teaching over 
SF off No error 
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7.6.11.3 Canceling teaching of code sequences 
Teaching can be canceled in two ways, for example, if not enough time is available to 
complete teaching of code sequences:    

● Cancel without storage in buffer with power OFF 

In this case no code sequences are saved, i.e., the code sequences will have to be 
retaught completely the next time the device is started up. 

● Cancel with storage in buffer 

The taught code sequences are saved. Any missing code sequences can be taught when 
the device is next started up. The actual status of the AS-i slaves can be read out to 
ascertain which AS-i slaves still require teaching of code sequences.  

Code sequence teaching can be canceled by: 

– Pressing the RESET buttons for 3 s 

– Pressing the "Apply code tables" button in the "Target system" > "ASIsafe code 
tables" dialog box in MSS ES 

– Controlling a device command function element with the "Adopt code tables" 
command 

LED display after canceling teaching of code sequences 
 
LED Behavior Explanation 
DEVICE yellow/green/flickeri

ng green 
Device in configuring mode/safety mode/test mode 

AS-i flashing red AS-i bus ok, but no code sequences or missing code 
sequences 

TEACH yellow flashing Teaching continues 
SF Off No group error 

7.6.11.4 Missing / incorrect code sequences 

Missing code sequences   
If a code sequence for a safety-related AS-i slave is missing from the code sequence table, it 
is calculated by the logic processing with the substitute value "0" in safety mode and in test 
mode.  

 

 Note 

While the code sequences are being taught, all input contacts of the safety-related AS-i 
slaves must be actuated so that all code sequences can be determined. The resulting code 
sequence is checked for correctness. As soon as all code sequences have been determined, 
they are checked for uniqueness.  
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Incorrect code sequences  
 

 Note 
Important requirement 

During the teaching process the contacts of the safety-related AS-i input slaves must be 
closed at least once to allow the code sequences to be retaught. 

If the contacts are not closed, calculation continues in the logic diagram with the substitute 
value "0." The current status of the AS-i slaves is displayed in the "Target system" > "Learn 
ASIsafe code tables" dialog box.  

 

Safety-related AS-i input slaves and safety-related AS-i outputs can be distinguished using 
the IO code. However, as this cannot be monitored on the AS-i  bus by the monitor, the 
MSS 3RK3 with AS-i interface analyzes the incoming code sequences and recognizes the 
different safety-related slave types based on the identified code sequence type. The 
MSS 3RK3 interprets the data of the safety-related AS-i input slaves as code sequences 
based on its configuring and the detected ID code. If a comparison with the taught code 
sequence fails, for example, due to the replacement of an input slave with another type, the 
safety-related AS-i slave in question is calculated in the interconnection logic using the 
substitute value "0."   

 

 Note 
Incorrect code sequence table during startup 

During startup, the MSS 3RK3 with AS-i interface checks the consistency of the code 
sequence tables stored in the device. If any of the code sequences are shown to be invalid, 
all the stored code sequences are rejected and all safety-related AS-i input slaves on the bus 
have to be retaught. The code sequence table might be invalid, for example, if the voltage 
supply of the device failed during storage of the code sequence table.  

 

Error during teaching of code sequences   
If there are errors in a received code sequence or the code sequence table is not clear, the 
device remains in teach phase until it is successful. Code sequence errors are indicated by a 
red AS-i LED that lights up and can be more precisely defined with the MSS ES software. 

 

 Note 

 

Incorrect code sequences and an unclear code sequence table are not interpreted as a 
configuration error and do not generate a group error (SF).  
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Double code sequences on the AS-i bus 
If the code sequence that a newly inserted safety-related AS-i slave outputs is identical to an 
existing code sequence, the substitute value "0" is used for both slaves.  

Error on replacement of a safety-related AS-i slave 
During a routine replacement of a safety-related AS-i slave, the yellow-lit TEACH-LED of the 
MSS 3RK3 indicates that new code sequences have been detected and can be applied. 
There are cases where new code sequences cannot be taught: 

● Replacement of a safety-related AS-i slave with a non-safety-related AS-i slave 

If a safety-related AS-i slave is replaced by a non-safety-related AS-i slave, this is 
detected by the MSS 3RK3 and the substitute value "0" for this AS-i slave will be retained 
and the taught code sequence of the removed safety-related AS-i slave will be deleted. 

● Incorrect code sequence when replacing a safety-related AS-i slave 

If the replaced AS-i slave sends an incorrect code sequence, it cannot be used. The 
TEACH-LED does not light up or flash. 

 

WARNING  
Additional safety-related AS-i slave on AS-i bus 

For safety reasons, the code sequences of all safety-related slaves must be known to every 
monitor on the AS-i bus. If an additional safety-related AS-i input slave is added to the AS-i 
bus, the code sequence of this slave must be taught or every MSS 3RK3 or safety monitor 
located on the AS-i bus, irrespective of whether or not this new safety-related AS-i slave is 
monitored by the corresponding MSS 3RK3 or safety monitor. 

 

Acknowledging a code sequence error 
When a new slave with a correct new code sequence has been inserted, the existing code 
sequence error must be acknowledged with the RESET button. Only then can the new code 
sequence be stored.  
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Diagnostics / service 8
 

Diagnostics options   
A number of methods are available for diagnosing errors: 

● Diagnostics with MSS ES (Page 525)  

● Diagnostics with LEDs (Page 494)  

● Diagnostics using PROFIBUS (Page 564) 

● Diagnostics with diagnostics display (Page 615) 

● Diagnosis using AS-Interface (CTT2 protocol) (Page 582) 



Diagnostics / service  
8.1 Diagnostics concept 

 Modular Safety System 3RK3 

490 System Manual, 06/2012, 9262530-02 Rev 004 

8.1 Diagnostics concept 
The diagnostics concept of the MSS 3RK3 is illustrated in the following diagram:   

The various device messages result in an entry in DS92. Some of the messages then trigger 
a higher-level error, for example, group errors (SF), bus faults (BF), group warnings (SW), 
and group prewarnings (SVW) in the group status.   

Messages output by the function elements initially result in a certain element status, which 
itself can result in an entry in DS92.    

This status is then indicated by the LEDs. Data set 92 can be read out via the diagnostics via 
PROFIBUS. 

 
Figure 8-1 MSS 3RK3 diagnostics concept 

8.1.1 Display philosphy 
In error management, the following display concept applies:   

● Errors requiring acknowledgment are displayed by a red SF LED. 

● Self-acknowledging errors are displayed by a red flashing SF LED. 

● If more than one error is present at the same time, red has priority over red flashing. 

● The LEDs of the real inputs on the MSS 3RK3 to which the error refers also indicate the 
error by a green flashing LED. 
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8.1.2 Error management 

Error categories 
Error management makes a distinction between five different error categories:   

● Device error 

● System error 

● Logic or wiring error 

● Parameterization or configuration error 

● Handshake error 

Device error    
A device error causes the system to stop. Communication between the modules is not 
possible. The cause of such an error is either internal system error or a defective 3RK3 
central unit. 

This error category can occur in any operating mode. 

 
Display on the central unit Remedy 
LED Display 
DEVICE red 
SF red 

The 3RK3 central unit can only exit the system stop by 
means of a restart initiated by switching the power supply 
off and on. If the error is still present after the system has 
restarted, you must replace the 3RK3 central unit. 
Exception: 
In the event of overvoltage or undervoltage, the device LED 
and SF LED do not light up: 

 

 

 Note 
Diagnostics not possible 

In this state, no diagnostics information can be queried.  
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System error   
If a system error occurs, the 3RK3 central unit switches from safety or test mode into a safe 
state (configuring mode) and switches off all the outputs. Communication with the expansion 
modules continues, however, ensuring that status and diagnostics messages can still read 
out. The causes of such errors are device errors on modules connected to the central unit 
(e.g., expansion module defective), configuration errors, and bus errors. If an expansion 
module has caused this error, the SF LED of the affected expansion module lights up. 

 
Display on the central unit Remedy 
LED Display 
DEVICE • flashing red (in safety 

mode) 
• yellow (in test mode) 

SF red 

Perform a reset or restart the computer. 

Logic or wiring error   
A logic or wiring error does not cause the mode to change; the 3RK3 central unit remains in 
safety/test mode. This error category can have the following causes: 

● Wiring error 

(e.g., feedback circuit switching time violation, cross-circuit between cables): 
 

Display on the central unit Remedy 
LED Display 
SF red 
The warning is signaled when the 
LEDs of the corresponding inputs 
start flashing. 

Resolve the cause and then acknowledge the error with 
reset. 

● Logic error 

(e.g., discrepancy time violation, violation of a signal sequence): 
 

Display on the central unit Remedy 
LED Display 
SF flashing red 
The warning is signaled when the 
LEDs of the corresponding inputs 
start flashing. 

Acknowledgment is not necessary. When the logic is 
correct, the error is automatically canceled. 
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● Group warning (for MSS 3RK3 Basic only)  

(e.g., wait for startup test) 
 

Display on the central unit Remedy 
LED Display 
The warning is signaled when the 
LEDs of the corresponding inputs 
start flashing. 

Acknowledgment is not necessary. When the logic is 
correct, the warning is automatically canceled. 

● Group prewarning (not in the case of MSS 3RK3 Basic)  

(e.g., wait for startup test) 
 

Display on the central unit Remedy 
LED Display 
The warning is signaled when the 
LEDs of the corresponding inputs 
start flashing. 

Acknowledgment is not necessary. When the logic is 
correct, the warning is automatically canceled. 

(e.g., safety sensor triggered) 
 

Display on the central unit Remedy 
LED Display 
The LEDs of the relevant inputs do 
not light up. 

Acknowledgment is not necessary. When the logic is 
correct, the warning is automatically canceled. 

Parameterization or configuration error    
This category of error only occurs in configuring mode. This error is caused if the 
configuration is either not available or is incorrect, for example. 

 
Display on the central unit Remedy 
LED Display 
SF red 

Acknowledgment is not necessary. When the 
parameterization is correct, the error is automatically 
canceled. 

Handshake error   
This category of error only occurs in test mode. This error is caused by an interruption in the 
connection between the MSS ES and the MSS 3RK3. The MSS 3RK3 changes from test 
mode to configuring mode. 

 
Display on the central unit Remedy 
LED Display 
DEVICE yellow 
SF red 

Acknowledgment is not necessary. The error is 
automatically canceled when a connection is re-
established. 
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8.2 Diagnostics with LEDs 
When performing diagnosis of the MSS 3RK3 via LEDs, you must observe all the LEDs on 
every module. The interpretation of the errors depends on how the function element is wired 
to the inputs.   

Requirements 
To be able to diagnose an error, it must be known which function element is wired to the 
flashing IN inputs. 

The following table shows the possible cause of error for a particular LED response on the 
function elements: 

 
LED response 

SF-LED on 
central unit 

Input LEDs on central 
unit or expansion 
module 

Sensor connected to responding IN 
inputs 

Meaning/Causes 

• Monitoring Universal 
• EMERGENCY STOP 
• ESPE 
• Protective door 
• Safety shutdown mat with NC 

principle 
• Two-hand operation 
• Enabling button 

Cross-circuit at input x 

• Protective door with lock • Cross-circuit at input x 
• Protective door opened when 

interlock was active 

• Safety shutdown mat with cross-
circuit principle 

• Wire break at input x 
• Short circuit to P at input x 

• Mode selector switch Invalid operating mode selection 

• Muting functions 
Note:  
To allow diagnosis by LED, only 
function elements with one input and 
one output can be interconnected 
between the input cell and the 
function input. 

Muting indicator light defective 

red The IN LEDs of a sensor 
are flashing green. 

• Output functions 
Note:  
To allow diagnosis by LED, only 
function elements with one input and 
one output can be interconnected 
between the input cell and the 
function input. 

Feedback circuit signal and switching 
status do not match 
In case of inconsistencies, the output 
function immediately switches off all 
its outputs.  
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LED response 

SF-LED on 
central unit 

Input LEDs on central 
unit or expansion 
module 

Sensor connected to responding IN 
inputs 

Meaning/Causes 

• Monitoring Universal 
• EMERGENCY STOP 
• ESPE 
• Protective door 
• Safety shutdown mat with NC 

principle 

Discrepancy condition violated 
For additional information, see "MSS 
ES" 

• Two-hand operation Discrepancy condition violated 
For additional information, see "MSS 
ES" 
Other meanings for 
Advanced/ASIsafe: 
button stuck, 
both buttons not released 

• Enabling button Discrepancy condition violated 
For additional information, see "MSS 
ES" 
Other meanings for 
Advanced/ASIsafe: 
button stuck 

• Protective door with lock • Discrepancy condition violated 
• Interlock not possible because the 

protective door is open 

The IN LEDs of a sensor 
are flashing green. 

• Muting functions Discrepancy condition sensor pair x 
not fulfilled 

-- • Muting functions Max. muting time exceeded 

Basic: The IN LEDs of a 
sensor are flashing 
green.  
Advanced/ASIsafe: The 
sensor that triggered the 
sequence violation is 
flashing green. 

• Monitoring Universal 
• Protective door 
• Protective door with lock 

Sequence condition not fulfilled 
The sequence condition was not 
fulfilled in accordance with the 
parameter assignment. 

flashing red 

One or more IN LEDs 
flashing green. 
The error was detected 
at this input. 

• Muting functions Sequence condition not fulfilled 
(muting) 
The sequence condition was not 
fulfilled in accordance with the 
parameter assignment. 



Diagnostics / service  
8.2 Diagnostics with LEDs 

 Modular Safety System 3RK3 

496 System Manual, 06/2012, 9262530-02 Rev 004 

LED response 

SF-LED on 
central unit 

Input LEDs on central 
unit or expansion 
module 

Sensor connected to responding IN 
inputs 

Meaning/Causes 

The IN LEDs of a sensor 
are flashing green. 

• Monitoring Universal 
• EMERGENCY STOP 
• ESPE 
• Protective door 
• Protective door with lock 
• Safety shutdown mat with NC 

principle 
• Safety shutdown mat with cross-

circuit principle 

Startup test required 
When startup test is parameterized, 
this message is set at every change 
to safety/test mode and at every 
change from substitute value to real 
value and remains set until the 
connected sensor is actuated at least 
once. After the sensor has been 
operated correctly this message is 
automatically reset.  

-- 

The IN LEDs of a sensor 
are off. 

• Monitoring Universal 
• EMERGENCY STOP 
• ESPE 
• Protective door 
• Protective door with lock 
• Safety shutdown mat with NC 

principle 

Safety sensor triggered 
The safety sensor has been actuated. 
This message is automatically reset if 
the value "1" is present for all function 
inputs monitored (set as part of 
configuring). 

 
 

 Note 
SF on the expansion module lights up red  

The cause of errors that result in a red-lit SF-LED on the expansion module are explained in 
Chapter ""SF" on the expansion module lights up red  (Page 497)." 

 

 Note 
Response of IN LEDs 

The way the IN LEDs flash depends on the signal that is present at the input: 
• Input signal present: 1.75 s ON/0.25 s OFF 
• Input signal not present: 0.75 s ON/1.25 s OFF 
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8.2.1 "SF" on the expansion module lights up red 

Error during startup    
After power-up, the modules of the MSS 3RK3 respond as follows: 

 
LED display on the  
faulty EM 

LED display on the  
following EMs 

LED display on  
the central unit  

Meaning / Remedy 

• "SF" 

lights up red 
• "IN" or "Q" 

are off 

• "SF" 

lights up yellow 
• "IN" or "Q" lights up 

green 

• "SF" 

lights up red 
• "DEVICE" 

lights up yellow 

Interruption on the system bus 
Interruption in the connection upstream of the 
faulty expansion module with the red "SF" LED. 
Check the connection cables. 

• "SF" 

lights up red 
• "IN" or "Q" 

are off 

• "SF" 

lights up yellow 
• "IN" or "Q" 

Lights up green 

• "SF" 

lights up red 
• "DEVICE" 

flashes red 

The first EM downstream from the 3RK3 central 
unit on which the "SF" LED lights up is defective 
and must be replaced. 

Error during test mode 
In test mode, the modules of the MSS 3RK3 respond as follows: 

 
LED display on the  
faulty EM 

LED display on the  
following EMs 

LED display on  
the central unit  

Meaning / Remedy 

• "SF" 

lights up red 
• "IN" or "Q" 

are off 

• "SF" 

lights up red 
• "IN" or "Q" 

are off 

• "SF" 

lights up red 
• "DEVICE" 

lights up yellow 

Interruption on the system bus 
Interruption in the connection upstream of the 
expansion module with the red "SF" LED. Check 
the connection cables. 

• "SF" 

lights up red 
• "IN" or "Qx" 

are off 

• "SF" 

are off 
• "IN" or "Q" 

are off 

• "SF" 

lights up red 
• "DEVICE" 

lights up yellow 

The first EM on which the "SF" LED lights up is 
defective and must be replaced. 
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Error in safety mode 
In safety mode, the modules of the MSS 3RK3 respond as follows: 

 
LED display on the  
faulty EM 

LED display on the  
following EMs 

LED display on  
the central unit  

Meaning / Remedy 

• "SF" 

lights up red 
• "IN" or "Q" 

are off 

• "SF" 

lights up red 
• "IN" or "Q" 

are off 

• "SF" 

lights up red 
• "DEVICE" 

flashes red 

Interruption on the system bus 
Interruption in the connection upstream of the 
expansion module with the red "SF" LED. Check 
the connection cables. 

• "SF" 

lights up red 
• "IN" or "Qx" 

are off 

• "SF" 

are off 
• "IN" or "Q" 

are off 

• "SF" 

lights up red 
• "DEVICE" 

flashes red 

The first EM on which the "SF" LED lights up is 
defective and must be replaced. 

8.2.2 LEDs on the modules 

8.2.2.1 Displays on the 3RK3 Basic central unit 
   

 
LED Display Explanation 

off No voltage, undervoltage, overvoltage 
green Device OK, user program in safety mode 
green flashing 
0.5 Hz (ratio 1:1) 

System power-up 

flickering green Device OK, user program in test mode 
yellow User program stopped; device in safe state 

(configuring mode; configuration not released; no 
configuration) 

yellow flashing 
0.5 Hz (ratio 1:1) 

Factory settings restored 

flickering yellow See Chapter "Restoring factory settings (Page 637)" 
red Device defective or wiring error 
red flashing 
0.5 Hz (ratio 1:1) 

Error in configuration 

DEVICE 

flickering red See Chapter "Restoring factory settings (Page 637)" 
off No group error 
red Group error (communications error, etc.) 

SF 

red flashing 
0.5 Hz (ratio 1:1) 

Group error: logic error (sequence, etc.) 
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LED Display Explanation 
off Input signal not present 
green Input signal present 
green flashing 
(1.75 s on / 0.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal present 

IN1, IN2, IN3, IN4, 
IN5, IN6, IN7, IN8 

green flashing 
(0.75 s on / 1.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal not present 

off Output signal not present Q1, Q2 
green Output signal present 

 

Reference 
You will find more information on the LED display during startup in Chapter "Startup / self-
test of the MSS 3RK3 Basic (Page 62)" 

8.2.2.2 Displays on the 3RK3 Advanced central unit 
   

 
LED Display Explanation 

off No voltage, undervoltage, overvoltage 
green Device OK, user program in safety mode 
green flashing 
0.5 Hz (ratio 1:1) 

System power-up 

flickering green Device OK, user program in test mode 
yellow User program stopped; device in safe state 

(configuring mode; user program not released; no 
user program) 

yellow flashing 
0.5 Hz (ratio 1:1) 

Factory settings restored 

flickering yellow See Chapter "Restoring factory settings (Page 637)" 
red Device defective or wiring error 
red flashing 
0.5 Hz (ratio 1:1) 

Error in configuration 

DEVICE 

flickering red See Chapter "Restoring factory settings (Page 637)" 
off AS-i bus OK, code table complete 
red AS-i bus OK, but code sequence error 

AS-i 

red flashing 
0.5 Hz (ratio 1:1) 

AS-i bus not OK, code table either missing or 
incomplete; TARGET ≠ ACTUAL AS-i configuration 
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LED Display Explanation 
off Code sequences complete  
flashing yellow Teaching of code sequences in progress 

TEACH 

yellow Teaching of code sequences successfully completed, 
code sequence tables can now be applied 

off No group error 
red Group error (communications error, etc.) 

SF 

red flashing 
0.5 Hz (ratio 1:1) 

Group error: logic error (sequence, etc.) 

off Input signal not present 
green Input signal present 
green flashing 
(1.75 s on / 0.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal present 

IN1, IN2, IN3, IN4, 
IN5, IN6, IN7, IN8 

green flashing 
(0.75 s on / 1.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal not present 

off Output signal not present Q1, Q2 
green Output signal present 

 

Reference 
You will find more information on the LED display during startup in Chapter "Startup / self-
test of the MSS 3RK3 Advanced (Page 68)" 
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8.2.2.3 Displays on the 3RK3 ASIsafe basic central unit 
   

 
LED Display Description 

Off No voltage, undervoltage, overvoltage 
green Device OK, user program in safety mode 
green flashing 
0.5 Hz (ratio 1:1) 

System power-up 

flickering green Device OK, user program in test mode 
yellow User program stopped; device in safe state 

(configuring mode; user program not released; no 
user program) 

yellow flashing 
0.5 Hz (ratio 1:1) 

Factory settings restored 

flickering yellow See Section "Restoring factory settings (Page 637)" 
red Device defective or wiring error 
red flashing 
0.5 Hz (ratio 1:1) 

Error in configuration 

DEVICE 

flickering red See Section "Restoring factory settings (Page 637)" 
Off AS-i bus OK, code table complete 
red AS-i bus OK, but code sequence error 

AS-i 

red flashing 
0.5 Hz (ratio 1:1) 

AS-i bus not OK, code table either missing or 
incomplete; TARGET ≠ ACTUAL AS-i configuration 

Off Code sequences complete 
Flashing yellow Teaching of code sequences in progress 

TEACH 

yellow Teaching of code sequences successfully completed, 
code sequence tables can now be applied 

Off No group error 
red Group error (communications error, etc.) 

SF 

red flashing 
0.5 Hz (ratio 1:1) 

Group error: logic error (sequence, etc.) 

Off Input signal not present 
green Input signal present 
green flashing 
(1.75 s ON/0.25 s OFF) 

Error detected (cross-circuit at input/wirebreak/short-
circuit to P/discrepancy error/feedback circuit 
error/sequence error/error during startup test) 
 Input signal present 

F-IN1, F-IN2  

green flashing 
(0.75 s ON/1.25 s OFF) 

Error detected (cross-circuit at input/wirebreak/short-
circuit to P/discrepancy error/feedback circuit 
error/sequence error/error during startup test) 
 Input signal not present 
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LED Display Description 
Off Input signal not present 
green Input signal present 
green flashing 
(1.75 s ON/0.25 s OFF) 

Error detected (feedback circuit error/sequence error) 
Input signal present 

IN3, IN4, IN5, IN6, 
IN7, IN8 

green flashing 
(0.75 s ON/1.25 s OFF) 

Error detected (feedback circuit error/sequence error) 
Input signal not present 

Off Output signal not present Q1, Q2 
green Output signal present 

Reference 
You will find more information on the LED display during startup in Chapter "Startup / self-
test of the MSS 3RK3 Advanced (Page 68)" 

8.2.2.4 Displays on the 3RK3 ASIsafe extended central unit 
   

 
LED Display Description 

Off No voltage, undervoltage, overvoltage 
green Device OK, user program in safety mode 
green flashing 
0.5 Hz (ratio 1:1) 

System power-up 

flickering green Device OK, user program in test mode 
yellow User program stopped; device in safe state 

(configuring mode; user program not released; no 
user program) 

yellow flashing 
0.5 Hz (ratio 1:1) 

Factory settings restored 

flickering yellow See Section "Restoring factory settings (Page 637)" 
red Device defective or wiring error 
red flashing 
0.5 Hz (ratio 1:1) 

Error in configuration 

DEVICE 

flickering red See Section "Restoring factory settings (Page 637)" 
Off AS-i bus OK, code table complete 
red AS-i bus OK, but code sequence error 

AS-i 

red flashing 
0.5 Hz (ratio 1:1) 

AS-i bus not OK, code table either missing or 
incomplete; TARGET ≠ ACTUAL AS-i configuration 

Off Code sequences complete 
Flashing yellow Teaching of code sequences in progress 

TEACH 

yellow Teaching of code sequences successfully completed, 
code sequence tables can now be applied 
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LED Display Description 
Off No group error 
red Group error (communications error, etc.) 

SF 

red flashing 
0.5 Hz (ratio 1:1) 

Group error: logic error (sequence, etc.) 

Off Input signal not present 
green Input signal present 
green flashing 
(1.75 s ON/0.25 s OFF) 

Error detected (cross-circuit at input/wirebreak/short-
circuit to P/discrepancy error/feedback circuit 
error/sequence error/error during startup test) 
 Input signal present 

F-IN1, F-IN2, 
F-IN3, F-IN4 

green flashing 
(0.75 s ON/1.25 s OFF) 

Error detected (cross-circuit at input/wirebreak/short-
circuit to P/discrepancy error/feedback circuit 
error/sequence error/error during startup test) 
 Input signal not present 

Off Input signal not present 
green Input signal present 
green flashing 
(1.75 s ON/0.25 s OFF) 

Error detected (feedback circuit error/sequence error) 
Input signal present 

IN5, IN6, IN7, IN8 

green flashing 
(0.75 s ON/1.25 s OFF) 

Error detected (feedback circuit error/sequence error) 
Input signal not present 

Off Output signal not present Q1, Q2 
green Output signal present 

 

Reference 
You will find more information on the LED display during startup in Chapter "Startup / self-
test of the MSS 3RK3 Advanced (Page 68)" 
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8.2.2.5 Displays on the expansion module 4/8F-DI 
   

 
LED Display Explanation 

off Input signal not present 
green Input signal present 
green flashing 
(1.75 s on / 0.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal present 

green flashing 
(0.75 s on / 1.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal not present 

SF / IN1 

red Device defective or error on the system bus 
(see also Chapter ""SF" on the expansion module 
lights up red  (Page 497)") 

off Input signal not present 
green Input signal present 
green flashing 
(1.75 s on / 0.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal present 

IN2, IN3, IN4, IN5, 
IN6, IN7, IN8 

green flashing 
(0.75 s on / 1.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal not present 
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8.2.2.6 Displays on expansion module 2/4F-DI 1/2F-RO 
   

 
LED Display Explanation 

off Input signal not present 
green Input signal present 
green flashing 
(1.75 s on / 0.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal present 

green flashing 
(0.75 s on / 1.25 s off) 

Error detected (cross-circuit at input / discrepancy 
error / feedback circuit error / sequence error / error 
during startup test) 
 Input signal not present  

SF / IN1 

red Device defective or error on the system bus 
(see also Chapter ""SF" on the expansion module 
lights up red  (Page 497)") 

off Input signal not present 
green Input signal present 
green flashing 
(1.75 s on / 0.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal present 

IN2, IN3, IN4, 

green flashing 
(0.75 s on / 1.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal not present 

off Output signal not present Q1, Q2 
green Output signal present 
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8.2.2.7 Displays on expansion module 2/4F-DI 2F-DO 
   

 
LED Display Explanation 

off Input signal not present 
green Input signal present 
green flashing 
(1.75 s on / 0.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal present 

green flashing 
(0.75 s on / 1.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal not present 

SF / IN1 

red Device defective or error on the system bus 
(see also Chapter ""SF" on the expansion module 
lights up red  (Page 497)") 

off Input signal not present 
green Input signal present 
green flashing 
(1.75 s on / 0.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal present 

IN2, IN3, IN4, 

green flashing 
(0.75 s on / 1.25 s off) 

Error detected (cross-circuit at input / wirebreak / 
short-circuit to P / discrepancy error / feedback circuit 
error / sequence error / error during startup test) 
 Input signal not present 

off Output signal not present Q1, Q2 
green Output signal present 

8.2.2.8 Displays on expansion module 4F-DO 
   

 
LED Display Explanation 

off Output signal not present 
green Output signal present 

SF / Q1 

red Device defective or error on the system bus 
(see also Chapter ""SF" on the expansion module 
lights up red  (Page 497)") 

Off Output signal not present Q2, Q3, Q4,  
Green Output signal present 
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8.2.2.9 Displays on expansion module 4/8F-RO 
   

 
LED Display Explanation 

off Output signal not present 
green Output signal present 

SF / Q1 

red Device defective or error on the system bus 
(see also Chapter ""SF" on the expansion module 
lights up red  (Page 497)") 

off Output signal not present Q2, Q3, Q4, Q5, 
Q6, Q7, Q8 green Output signal present 

8.2.2.10 Displays on expansion module 8DI 
   

 
LED Display Explanation 

Off Input signal not present 
Green Input signal present 

SF / IN1 

Red Device defective or error on the system bus 
(see also Chapter ""SF" on the expansion module 
lights up red  (Page 497)") 

Off Input signal not present IN2, IN3, IN4, IN5, 
IN6, IN7, IN8 Green Input signal present 

8.2.2.11 Displays on expansion module 8DO 
   

 
LED Display Explanation 

off Output signal not present 
green Output signal present 

SF / Q1 

red Device defective or error on the system bus 
(see also Chapter ""SF" on the expansion module 
lights up red  (Page 497)") 

off Output signal not present Q2, Q3, Q4, Q5, 
Q6, Q7, Q8 green Output signal present 
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8.2.2.12 Displays on the DP interface 
   

 
LED Display Description 

Off No voltage 
Green Device OK 
green flashing 
0.5 Hz (ratio 1:1) 

Device is in power-up phase 

Red Device defective 

DEVICE 

yellow flashing 
0.5 Hz (ratio 1:1) 

Factory settings restored, see Chapter "Menu mode 
with user control (Page 444)" 

Off PROFIBUS bus communication OK 
Red • DP interface in device power-up 

• PROFIBUS error, e.g. wrong PROFIBUS address 
(DP interface module not addressed) 

BF 

red flashing 
0.5 Hz (ratio 1:1) 

PROFIBUS parameterization/configuration error 

Off No group error SF 
Red Group error (error on communication to 3RK3 central 

unit, ...) 

8.2.2.13 Displays on diagnostic display 
The LEDs on the diagnostic display show the same states as the corresponding LEDs of the 
MSS configuration.   

 
LED Display Description 

Off • No voltage, undervoltage, overvoltage 
• Device error 

green Device OK, user program in safety mode 
flickering green Device OK, user program in test mode 

DEVICE 

yellow User program stopped; device in safe state 
(configuring mode; configuration not released; no 
configuration) 

Off No bus error 
red Error, e.g., incorrect PROFIBUS address  

(DP interface not addressed) 

BF 

red flashing 
0.5 Hz (ratio 1:1) 

Parameterization or configuration error 

Off No group error 
red Group error (communications error, etc.) 

SF 

red flashing 
0.5 Hz (ratio 1:1) 

Group error: logic error (sequence, etc.) 



 Diagnostics / service 
 8.2 Diagnostics with LEDs 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 509 

8.2.3 LED response for various element functions 

8.2.3.1 Monitoring Universal 
The table below lists all the messages and corresponding LED responses to the "Monitoring 
Universal" function element.   

 
LED response   Message Meaning 

SF-LED on central 
unit 

Input LEDs on central unit or 
expansion module 

Startup test required This message is set in a parameterized 
startup test on each restart and each 
time the substitute value is changed to a 
real value until the connected sensor is 
actuated at least once. After the sensor 
has been operated correctly this 
message is automatically reset. 

- The IN LEDs of the sensor are 
flashing green. 

Sequence condition 
not fulfilled 

The sequence condition was not fulfilled 
in accordance with the parameter 
assignment. This message is 
automatically reset if the value "0" is 
detected for all function inputs monitored.

flashes red The IN LEDs of the sensor are 
flashing green. 

Discrepancy 
condition violated 

is set if: 
• After the discrepancy time has 

elapsed, the signal states at the 
inputs monitored are different 

• The signal states of the inputs 
monitored had not all previously been 
reset simultaneously to the value "0" 
when they are set to "1" 

flashes red The IN LEDs of the sensor are 
flashing green. 

Safety sensor 
triggered 

The safety sensor has been actuated. 
This message is automatically reset if the 
value "1" is present for all function inputs 
monitored (set as part of configuring). 

- The IN LEDs of the sensor are off. 
The IN2-LED is green on input type 
NCNO. 

Cross-circuit at  
input x 

A cross-circuit was detected at input x. red The IN LEDs of the sensor are 
flashing green. 



Diagnostics / service  
8.2 Diagnostics with LEDs 

 Modular Safety System 3RK3 

510 System Manual, 06/2012, 9262530-02 Rev 004 

LED response   Message Meaning 

SF-LED on central 
unit 

Input LEDs on central unit or 
expansion module 

Start signal duration 
invalid 

Only with start type "Monitored start": 
The start signal time monitoring element 
detected a violation. 

- - 

Start condition not 
fulfilled 

is set if: 
• A sensor test was not executed in the 

case of an active startup test function 
• A discrepancy condition violation is 

present 
• The value "1" is not present 

simultaneously at all available 
(parameterized) function inputs 
(IN1, ...) 

• A signal sequence violation is present
• A cross-circuit is present in the case 

of cross-circuit monitoring 

- - 

8.2.3.2 EMERGENCY STOP 
The table below lists all the messages and corresponding LED responses to the 
"EMERGENCY STOP" function element.   

 
LED response Message Meaning 

SF-LED on central unit Input LEDs on central unit 
or expansion module 

Startup test required This message is set in a 
parameterized startup test on each 
restart and each time the substitute 
value is changed to a real value until 
the connected sensor is actuated at 
least once. 

- The IN LEDs of the sensor 
are flashing green. 

Discrepancy condition 
violated 

is set if: 
• After the discrepancy time has 

elapsed, the signal states at the 
inputs monitored are different 

• The signal states of the inputs 
monitored had not all previously 
been reset simultaneously to the 
value "0" when they are set to "1"

flashes red The IN LEDs of the sensor 
are flashing green. 

Safety sensor triggered The safety sensor has been 
actuated. This message is 
automatically reset if the value "1" is 
present for all function inputs 
monitored (set as part of 
configuring). 

- The IN LEDs of the sensor 
are off. 
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LED response Message Meaning 

SF-LED on central unit Input LEDs on central unit 
or expansion module 

Cross-circuit at input x A cross-circuit was detected at input 
x. 

red The IN LEDs of the sensor 
are flashing green. 

Start signal duration invalid Only with start type "Monitored 
start": 
The start signal time monitoring 
element detected a violation. 

- - 

Start condition not fulfilled is set if: 
• A sensor test was not executed 

in the case of an active startup 
test function 

• A discrepancy condition violation 
is present 

• The value "1" is not present 
simultaneously at all available 
(parameterized) function inputs 
(IN1, ...) 

• A cross-circuit is present in the 
case of cross-circuit monitoring 

- - 
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8.2.3.3 ESPE 
The table below lists all the messages and corresponding LED responses to the "ESPE" 
function element.   

 
LED response Message Meaning 

SF-LED on central 
unit 

Input LEDs on central unit 
or expansion module 

Startup test required This message is set in a 
parameterized startup test on each 
restart and each time the substitute 
value is changed to a real value until 
the connected sensor is actuated at 
least once. 

- The IN LEDs of the sensor 
are flashing green. 

Discrepancy condition violated is set if: 
• The signal states of the inputs 

monitored had not all previously 
been reset simultaneously to the 
value "0" when they are set to "1" 

flashes red The IN LEDs of the sensor 
are flashing green. 

Safety sensor triggered The safety sensor has been actuated. 
This message is automatically reset if 
the value "1" is present for all function 
inputs monitored (set as part of 
configuring). 

- The IN LEDs of the sensor 
are off. 

Cross-circuit at input x A cross-circuit was detected at input 
x. 

red The IN LEDs of the sensor 
are flashing green. 

Start signal duration invalid Only with start type "Monitored start": 
The start signal time monitoring 
element detected a violation. 

- - 

Start condition not fulfilled is set if: 
• A sensor test was not executed in 

the case of an active startup test 
function 

• A discrepancy condition violation 
is present 

• The value "1" is not present 
simultaneously at all available 
(parameterized) function inputs 
(IN1, ...) 

• A cross-circuit is present in the 
case of cross-circuit monitoring 

- - 
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8.2.3.4 Protective door 
The table below lists all the messages and corresponding LED responses to the "Protective 
Door" function element.   

 
LED response Message Meaning 

SF-LED on central 
unit 

Input LEDs on central unit or 
expansion module 

Startup test required This message is set in a 
parameterized startup test on each 
restart and each time the substitute 
value is changed to a real value until 
the connected sensor is actuated at 
least once. 

- The IN LEDs of the sensor are 
flashing green. 

Sequence condition not 
fulfilled 

The sequence condition was not 
fulfilled in accordance with the 
parameter assignment. 

flashes red Basic: The IN LEDs of the sensor 
are flashing green. 
Advanced/ASIsafe: The sensor that 
triggered the sequence violation is 
flashing.  

Discrepancy condition 
violated 

is set if: 
• After the discrepancy time has 

elapsed, the signal states at the 
inputs monitored are different 

• The signal states of the inputs 
monitored had not all previously 
been reset simultaneously to the 
value "0" when they are set to "1"

flashes red The IN LEDs of the sensor are 
flashing green. 

Safety sensor triggered The safety sensor has been 
actuated. This message is 
automatically reset if the value "1" is 
present for all function inputs 
monitored (set as part of 
configuring). 

- The IN LEDs of the sensor are off. 
The IN2-LED is green on input type 
NCNO. 

Cross-circuit at input x A cross-circuit was detected at input 
x. 

Red The IN LEDs of the sensor are 
flashing green. 

Start signal duration 
invalid 

Only with start type "Monitored 
start": 
The start signal time monitoring 
element detected a violation. 

- - 
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LED response Message Meaning 

SF-LED on central 
unit 

Input LEDs on central unit or 
expansion module 

Start condition not 
fulfilled 

is set if: 
• A sensor test was not executed 

in the case of an active startup 
test function 

• A discrepancy condition violation 
is present 

• The value "1" is not present 
simultaneously at all available 
(parameterized) function inputs 
(IN1, ...) 

• A signal sequence violation is 
present 

• A cross-circuit is present in the 
case of cross-circuit monitoring 

- - 
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8.2.3.5 Protective door with lock 
The table below lists all the messages and corresponding LED responses to the "Protective 
Door with Lock" function element.   

 
LED response Message Meaning 

SF-LED on 
central unit 

Input LEDs on central unit or 
expansion module 

Startup test required This message is set in a parameterized 
startup test on each restart and each 
time the substitute value is changed to a 
real value until the connected sensor is 
actuated at least once. 

- The IN LEDs of the sensor 
are flashing green. 

Sequence condition not 
fulfilled 

The sequence condition was not fulfilled 
in accordance with the parameter 
assignment. 

flashes red The sensor that triggered the 
sequence violation is 
flashing.  

Discrepancy condition 
violated 

is set if: 
• After the discrepancy time has 

elapsed, the signal states at the 
inputs monitored are different 

• The signal states of the inputs 
monitored had not all previously been 
reset simultaneously to the value "0" 
when they are set to "1" 

flashes red The IN LEDs of the sensor 
are flashing green. 

Safety sensor triggered The safety sensor has been actuated. 
This message is automatically reset if the 
value "1" is present for all function inputs 
monitored (set as part of configuring). 

- The IN LEDs of the sensor 
are off. 
The IN2-LED is green on 
input type NCNO. 

Protective door closed The protective door is closed. - The IN LEDs of the sensor 
are green. 
The IN2-LED is off on input 
type NCNO. 

Lock engaged The lock is engaged. - - 
Lock released The lock is released - - 
Cross-circuit at input x A cross-circuit was detected at input x. red The IN LEDs of the sensor 

are flashing green. 
Start signal duration invalid Only with start type "Monitored start": 

The start signal time monitoring element 
detected a violation. 

- - 
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LED response Message Meaning 

SF-LED on 
central unit 

Input LEDs on central unit or 
expansion module 

Start condition not fulfilled is set if: 
• A sensor test was not executed in the 

case of an active startup test function 
• A discrepancy condition violation is 

present 
• The value "1" is not present 

simultaneously at all available 
(parameterized) function inputs 
(IN1, ...) 

• A signal sequence violation is present
• A cross-circuit is present in the case 

of cross-circuit monitoring 

- - 

Start override active The start override time is running. - - 
Feedback circuit signal and 
switching status do not match 

The feedback circuit signal does not 
match the interlock status  

red The corresponding IN LED of 
the input that is connected on 
the FEEDBACK_LOCK 
function input flashes green if 
in the logic there is no more 
than one negation between 
the element input and the 
input cell. 

Protective door opened when 
interlock was active 

The protective door opened when 
interlock was active. 

red  The corresponding IN LEDs 
of the sensor (protective door 
monitoring) are flashing 
green. 

Interlock not possible because 
the protective door is open 

Interlock not possible because the 
protective door is open. 

flashes red  The corresponding IN LEDs 
of the sensor (protective door 
monitoring) are flashing 
green. 
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8.2.3.6 Safety shutdown mat with NC principle 
The table below lists all the messages and corresponding LED responses to the "Safety 
shutdown mat with NC principle" function element.   

 
LED response Message Meaning 

SF-LED on central 
unit 

Input LEDs on central unit 
or expansion module 

Startup test required This message is set in a 
parameterized startup test on each 
restart and each time the substitute 
value is changed to a real value until 
the connected sensor is actuated at 
least once. 

- The IN LEDs of the sensor 
are flashing green. 

Discrepancy condition 
violated 

is set if: 
• The signal states of the inputs 

monitored had not all previously 
been reset simultaneously to the 
value "0" when they are set to 
"1" 

flashes red The IN LEDs of the sensor 
are flashing green. 

Safety sensor triggered The safety sensor has been 
actuated. This message is 
automatically reset if the value "1" is 
present for all function inputs 
monitored (set as part of 
configuring). 

- The IN LEDs of the sensor 
are off. 

Cross-circuit at input x A cross-circuit was detected at input 
x. 

red The IN LEDs of the sensor 
are flashing green. 

Start signal duration invalid Only with start type "Monitored 
start": 
The start signal time monitoring 
element detected a violation. 

- - 

Start condition not fulfilled is set if: 
• A sensor test was not executed 

in the case of an active startup 
test function 

• A discrepancy condition violation 
is present 

• The value "1" is not present 
simultaneously at all available 
(parameterized) function inputs 
(IN1, ...) 

• A cross-circuit is present in the 
case of cross-circuit monitoring 

- - 
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8.2.3.7 Safety shutdown mat with cross-circuit principle 
The table below lists all the messages and corresponding LED responses to the "Safety 
shutdown mat with cross-circuit principle" function element.   

 
LED response Message Meaning 

SF-LED on central unit Input LEDs on central 
unit or expansion 
module 

Startup test required This message is set in a 
parameterized startup test on each 
restart and each time the substitute 
value is changed to a real value until 
the connected sensor is actuated at 
least once. 

- The IN LEDs of the 
sensor are flashing 
green. 

Safety sensor triggered The safety sensor has been actuated. 
This message is automatically reset if 
the value "1" is present for all function 
inputs monitored (set as part of 
configuring). 

- The IN LEDs of the 
sensor are off. 

Wire break at input x A wire break was detected at input x. red The IN LEDs of the 
sensor are flashing 
green. 

Short circuit to P at input x A short-circuit to P was detected at 
input x. 

red The IN LEDs of the 
sensor are flashing 
green. 

Start signal duration invalid Only with start type "Monitored start": 
The start signal time monitoring 
element detected a violation. 

- - 

Start condition not fulfilled is set if: 
• A sensor test was not executed in 

the case of an active startup test 
function 

• The value "1" is not present 
simultaneously at all available 
(parameterized) function inputs 
(IN1, ...) 

• A cross-circuit is present 

- - 
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8.2.3.8 Two-hand operation 
The table below lists all the messages and corresponding LED responses to the "two-hand 
operation" function element.   

 
LED response Message Meaning 

SF-LED on central unit Input LEDs on central unit 
or expansion module 

Discrepancy condition 
violated 

is set if: 
• After the discrepancy time has 

elapsed, the signal states at the 
inputs monitored are different 
within one or between to two 
pushbuttons. 

• The signal states of the inputs 
monitored had not all previously 
been reset simultaneously to the 
value "0" when they are set to "1"

flashes red The IN LEDs of the sensor 
are flashing green. 

Cross-circuit at input x A cross-circuit was detected at input 
x. 

red The IN LEDs of the sensor 
are flashing green. 

Start condition not 
fulfilled 

is set if: 
• If both pushbuttons were not 

pressed "synchronously," that is, 
they were pressed with a time 
offset greater than 0.5 s 

• A discrepancy condition violation 
is present 

• The value "1" is not present 
simultaneously at IN1 ... 2 / 4 

• A cross-circuit is present 

- - 

Pushbutton stuck  
(not in the case of 3RK3 
Basic) 

The pushbutton is stuck. flashes red The IN LEDs of the sensor 
are flashing green. 

Do not release both 
pushbuttons 
simultaneously 
(not in the case of 3RK3 
Basic) 

The two pushbuttons were not 
released simultaneously. 

flashes red The IN LEDs of the sensor 
are flashing green. 
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8.2.3.9 Enabling button 
The table below lists all the messages and corresponding LED responses to the "enabling 
button" function element.  

 
LED response Message Meaning 

SF-LED on central unit Input LEDs on central unit 
or expansion module 

Discrepancy condition 
violated 

is set if: 
• The signal states of the inputs 

monitored had not all previously 
been reset simultaneously to the 
value "0" when they are set to "1" 

flashes red The IN LEDs of the sensor 
are flashing green. 

Enabling button OFF The enabling button has the status 
OFF. 

- - 

Enabling button ON The enabling button has the status 
ON. 

- - 

Cross-circuit at input x A cross-circuit was detected at input x. red The IN LEDs of the sensor 
are flashing green. 

Start condition not 
fulfilled 

is set if: 
• A discrepancy condition violation is 

present 
• The value "1" is not present 

simultaneously at all available 
(parameterized) function inputs 
(IN1, ...) 

• A cross-circuit is present 

- - 

Pushbutton stuck  
(not in the case of 3RK3 
Basic) 

The pushbutton is stuck. flashes red The IN LEDs of the sensor 
are flashing green. 
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8.2.3.10 Mode selector switch 
The table below lists all the messages and corresponding LED responses to the "Mode 
Selector Switch" function element.   

 
LED response Message Meaning 

SF-LED on central unit Input LEDs on central 
unit or expansion 
module 

Switchover time exceeded The "1 out of 2...5 selection 
monitoring" has detected the value 
"0" at all inputs after the contact 
switchover time has elapsed. 

- - 

Invalid operating mode selection The "1 out of 2...5 selection 
monitoring" has detected after the 
contact switchover time has elapsed:
The value "1" is present at more than 
one input. 

red The IN LEDs of the 
sensor are flashing 
green. 
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8.2.3.11 Muting functions 
The table below lists all the messages and corresponding LED responses to the "Muting" 
function element.   

 
LED response Message Meaning 

SF-LED on central unit Input LEDs on central unit 
or expansion module 

Muting operation 
active 

Muting mode is activated. - - 

Muting operation not 
active 

Muting mode is not activated. - - 

Muting restart 
possible 

Muting mode was not terminated 
correctly, i.e. at least one muting sensor 
is still being triggered. 

flashes red The corresponding IN-LED 
of the muting display lamp 
flashes green if only 
single-channel elements 
(negation) have been 
placed between the input 
cell and the element input 
in the logic. 

Restart signal 
duration invalid  

The "Muting restart possible" message is 
set and, the first time the RESTART 
button is pressed, the expected 
operating sequence does not follow. 

flashes red The corresponding IN-LED 
of the muting display lamp 
flashes green if only 
single-channel elements 
(negation) have been 
placed between the input 
cell and the element input 
in the logic. 

Protective field not 
free 

The value "0" is present at the "FREE" 
function input. 

- - 

System not running The value "1" is present at the "STOP" 
function input. 

- - 

Start muting 
condition not met 

Not all conditions for operational starting 
of muting using muting sensors are met. 

- - 

Max. muting time 
exceeded 

Muting operation terminated because 
"max. muting time" expired. 

flashes red - 

Discrepancy 
condition sensor pair 
x not fulfilled 

A discrepancy violation was detected in 
the signals of muting sensor pair x. 

flashes red The corresponding IN 
LEDs of the sensors are 
flashing green. 

Sequence condition 
not fulfilled 

The sequence condition was not 
observed. 

flashes red The LED(s) on whose 
input the error was 
detected are flashing 
green. 

Muting display lamp 
defective 

The muting display lamp - monitoring 
function has detected an error. 

red The corresponding IN-LED 
of the muting display lamp 
flashes green if only 
single-channel elements 
(negation) have been 
placed between the input 
cell and the element input 
in the logic. 
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8.2.3.12 Output functions 
The table below lists all the messages and corresponding LED responses to the "standard 
output" and "F output" function elements.   

 
LED response Message Meaning 

SF-LED on central unit Input LEDs on central unit or 
expansion module 

Output x active Function output 1 is 
switched on. 

- - 

Feedback circuit signal 
and switching status do 
not match 

The signal at the feedback 
circuit input does not match 
the switching status of the 
function outputs. 
The output function 
immediately deactivates all 
its outputs in case of 
inconsistencies. 

red The corresponding IN LED of 
the sensor flashes green if 
there is no more than one 
negation between the element 
input and the input cell in the 
logic. 

Start condition not fulfilled is set if: 
• there is a feedback 

circuit error when 
feedback circuit 
monitoring is activated. 

• the value "0" is pending 
at the function input 
(IN). 

- - 

Start signal duration 
invalid 

Only with start type 
"Monitored start": 
The start signal time 
monitoring element 
detected a violation. 

- - 
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8.2.3.13 Messages for AS-i 1...4F-DO 
The table below lists all the messages and corresponding LED responses to the "AS-i1..4F-
DO" function element.   

 
LED response Message Meaning 

SF-LED on central unit Input LEDs on central unit 
or expansion module 

Output x active Function output x is switched on. - - 
Feedback circuit signal x 
and switching status do not 
match 

The signal at feedback circuit input 
x and the switching status of the 
corresponding function output x do 
not match.  
In case of inconsistencies, the 
output function immediately 
switches off all its outputs.  

red The corresponding IN LED 
of the sensor flashes green 
if there is no more than one 
negation between the 
element input and the input 
cell in the logic. 

Invalid output selection The value "1" was detected on 
more than one input IN1 ... 4 by the 
"1 out of 4 - selection monitoring." 

flashing red The corresponding IN 
LEDs of the sensors are 
flashing green. 

Start condition not fulfilled is set if: 
• there is a feedback circuit error 

when feedback circuit 
monitoring is active. 

• the logic error "Invalid output 
selection" is pending. 

• The value "1" is not present 
simultaneously at all available 
(parameterized) function inputs 
(IN1, ...). 

- - 

Auxiliary control signal x 
sent 

The auxiliary control signal x was 
transmitted completely by the code 
sequence that is currently active. 

- - 

Start signal duration invalid Only with start type "Monitored 
start": 
The start signal time monitoring 
element detected a violation. 

- - 
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8.3 Diagnostics with MSS ES 
This diagnostics can be used to read the status of each system function element. 
Diagnostics with MSS ES is divided into "Diagnostics configuration" and "Diagnostics logic".   

The diagnostics configuration provides users with an overview of the module status and the 
device messages.  

Diagnostics logic allows users to monitor system components. It also permits forcing. 

Depending on the existing license variant of MSS ES, the diagnostics can be accessed by 
means of PROFIBUS and the device interface (see Chapter "What's new? (Page 15)"). 

 

 Note 

A description of the diagnostics of older software versions of MSS ES is given in the online 
help. 
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8.3.1 Diagnostics configuration 

8.3.1.1 Module status 

Requirements 
The "Target system" > "Diagnostics configuration" > "Module status" menu command can 
only be selected if the main system or the subsystem (MSS 3RK3 Advanced, MSS 3RK3 
ASIsafe basic, MSS 3RK3 ASIsafe extended) is activated in the navigation window and if an 
online connection is established between MSS ES and the safety relay. 

Module status    
When you choose "Target system" > "Diagnostics configuration" > "Module status", the 
status of the modules is shown in an additional column in the configuration table. 

A red square indicates either a faulty module or a module that does not actually exist. 
 

 Note 

In the main system, all modules after the first defective module can no longer be addressed.
 

 Note 
Diagnostics display 

The status of the diagnostics display is not displayed. 
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8.3.1.2 Dialog "Device messages" > "Overview" tab 
The configuration supports the following messages:   

General 
 
Status Symbol Meaning 
Group error red At least one error is present. 
Bus error red Communication to the fieldbus master is disturbed. 
Group warning yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present (e.g. "Safety sensor triggered"). 

Problem / Message - Possible remedial measures 
In this window, problems / messages and possible remedial measures for these are shown 
in two columns. 
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Examples: 
 
Problem / Message Possible remedial measures 
Initialization error   • Switch off and switch on again the voltage supply of the device. 

• The next time a device error is indicated, the device must be replaced. 

Group error • The safety relay has detected at least one application-specific error. 
• More detailed messages will give the precise cause of the error. 

Error in configuration   • Check the actual device configuration against the configured target 
configuration. 

• Acknowledge after remedying the error. 

AS-i code sequence error   • An incorrect AS-i code sequence was received from at least one safety-related 
AS-i slave. 

• Check the system for EMC interference and start up the system again. 
• If code sequence errors occur again, replace the AS-i slave in question. 

Disconnect   • Restore the connection again. 
• Check whether another program is using and therefore blocking the interface. 

Logic error   • The monitored sensor outputs an invalid signal sequence. 
• Operate the monitored sensor in such a way that the start condition is fulfilled. 

Legends 
The meaning of the symbols used in the Problem / Message - Possible remedial measures 
section and the urgency level of the colors used is explained in the legends.  
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8.3.1.3 "Device messages" dialog box > "Status" tab 
The configuration supports the following messages:   

General 
 
Status Symbol Meaning 
Group error  red At least one error is present. 
Bus error red Communication to the fieldbus master is disturbed. 
Group warning  yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present (e.g. "Safety sensor triggered"). 

Group error 
 
Status Symbol Meaning 
Device error  red • Faulty input or output 

• Defective module 

Configuring error   red An error occurred during the configuration phase. 
Error in configuration   red TARGET slot configuration not equal ACTUAL slot configuration. 
Safety protocol error   red • Communication with a safety-relevant communications partner is 

disrupted; for example, communications disrupted due to effects of 
EMC. 

• Code sequence error (MSS 3RK3 Advanced, MSS 3RK3 ASIsafe basic 
and MSS 3RK3 ASIsafe extended) 

Group error from user program red At least one error is present. 
Wiring error   red Faulty wiring of a sensor connection or in the sensor itself. 
Logic error   red Protection fault: Processing sequence on the sensor not coherent. 
For an element number Issues the number of the lowest element on which the group error is 

pending. 

Bus error   
 
Status Symbol Meaning 
SC bus error red Communication via the device bus interface is interrupted. 
AS-i bus error red The message is displayed for up to 30 s during startup if no AS-i bus is 

detected. 
DP bus error red Communication via the fieldbus interface PROFIBUS DP is interrupted. 
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Group warning 
 
Status Symbol Meaning 
Group warning from user 
program 

yellow At least one warning is present. 

For an element number Issues the number of the lowest element on which the group warning is 
pending. 

Group prewarning 
 
Status Symbol Meaning 
Group prewarning from user 
program 

yellow At least one prewarning is present. 

For an element number Issues the number of the lowest element on which the group prewarning is 
pending. 

Error acknowledgment   
 
Status Symbol Meaning 
Reset implemented green All error sources were eliminated and could be acknowledged. 
Reset not possible yellow At least one error cannot be acknowledged since the error cause still 

exists. 

Operating status   
 
Status Symbol Meaning 
Configuring mode  green The safety relay is in configuring mode. 
Test mode green The safety relay is in test mode. 
Safety mode green The safety relay is in safety mode. 
User program is active green The safety relay is actively processing the safety circuit. 
User program stopped. yellow The safety relay is processing the safety circuit. 
Operating mode change rejected yellow No valid password has been entered for switching to test mode. 

There is a configuring or device error that is preventing operating mode 
change. 
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Access path   
 
Status Symbol Meaning 
Access path closed green No access path is open. 
Access path to fieldbus control is 
open 

green The access path over the fieldbus interface for a control is open. 

Access path fieldbus ES tool is 
open 

green The access path over the fieldbus interface for an ES tool is open. 

Access path to device interface 
is open 

green The access path over the device interface is open 

Disconnect yellow The monitoring time has been exceeded During monitoring time, the safety 
relay has not received any data set from the communication partner with 
write access to the safety relay. 

Handshake error red An error was detected during connection monitoring in test mode. 

Password protection   
 
Status Symbol Meaning 
Device access authorization 
exists 

green Device access authorization exists. 

Password protection for device 
access is inactive 

yellow There is no protection against access from a higher-level controller or other 
users. 

Incorrect password entry yellow A password was received that does not match any device access password 
stored in the safety relay. 

Device self-test   
 
Status Symbol Meaning 
Self-test active blue Device self-test running. 
Self-test ok green The device self-test was finished without an error. 
Self-test error red The device self-test has detected an error 

Legends 
The meaning of the symbols used in the Problem / Message - Possible remedial measures 
section and the urgency level of the colors used is explained in the legends.  
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8.3.1.4 Dialog "Device messages" > "Engineering" tab 
The configuration supports the following messages:   

General 
 
Status Symbol Meaning 
Group error  red At least one error is present. 
Bus error red Communication to the fieldbus master is disturbed. 
Group warning  yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present (e.g. "Safety sensor triggered"). 

 

 
Status Symbol Meaning 
Configuring error  red An error occurred during the configuration phase. 

Engineering   
 
Status Symbol Meaning 
Configuration missing yellow No valid configuration is stored in the safety relay. 
Configuration not released yellow A valid configuration is stored but not released yet in the safety relay. 
Release canceled yellow An already released configuration was canceled by means of the 

configuration release command. 
Release canceled due to 
incorrect configuration release 
CRC 

red The configuration release CRC in the release data has a value other than 
"0" and deviates from the value calculated by the safety relay. 

Release denied due to incorrect 
configuration CRC 

red The user tried to release a configuration whose configuration CRC does not 
match the configuration CRC to be released. 

Configuration released green A valid and released configuration is stored in the safety relay. 
Release denied, already 
released 

yellow The user is trying to release an already released configuration by means of 
the configuration release command. 

Factory settings restored green The factory settings were successfully restored. 
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Element error   
 
Status Symbol Meaning 
Invalid parameter value red A parameter value is not within the permissible value range. 
Interconnection rule violated red At least 1 interconnection rule is violated. 
Data structure incorrect red While receiving new configuring data, an inconsistency was detected by the 

safety relay in the structure and content of at least one data structure. 
For an element number Specifies the number of the lowest element whose parameters were not 

accepted by the device.  

Device resources   
 
Status Symbol Meaning 
Max. number of elements 
exceeded 

red More elements than the maximum number of elements were transferred to 
the safety relay. 

Max. size of memory exceeded red More element parameters were transferred to the device than can be stored 
in the safety relay memory . 

Program cycle time exceeded red The program cycle time set by the user is exceeded, MSS 3RK3 changes to 
configuring mode. 

Legends 
The meaning of the symbols used in the Problem / Message - Possible remedial measures 
section and the urgency level of the colors used is explained in the legends.  

8.3.1.5 "Device messages" dialog box > "Configuration" tab 
The configuration supports the following messages:   

General 
 
Status Symbol Meaning 
Group error  red At least one error is present. 
Bus error red Communication to the fieldbus master is disturbed. 
Group warning  yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present (e.g. "Safety sensor triggered"). 

 

 
Status Symbol Meaning 
Error in configuration red A problem has occurred in the memory module. 
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Device configuration   
 
Status Symbol Meaning 
TARGET configuration equal 
ACTUAL configuration 

green The specified TARGET configuration of the safety relay corresponds to 
the current function and module configuration. 

TARGET configuration not equal 
ACTUAL configuration 

red The specified TARGET configuration of the safety relay does not 
correspond to the current function and module configuration. 

TARGET slot configuration not 
equal ACTUAL slot configuration

red The specified TARGET slot configuration of the safety relay does not 
correspond to the ACTUAL slot configuration. 

Target subslot configuration not 
equal to actual subslot 
configuration 

red The specified target subslot configuration (AS-i configuration) of the 
safety relay does not match the actual subslot configuration. 

Memory module   
 
Status Symbol Meaning 
Memory module not plugged in red No memory module is plugged in the safety relay. 
Memory module defective red Memory module is defective. 
Programming successful green Programming of the memory module was successful. 
Programming error red Programming of the memory module was not successful. 
Memory module too small red More configuration data were transferred to the safety relay than can be 

stored in the memory module. 
Memory module deleted green The memory module was deleted by command beforehand. 

Legends 
The meaning of the symbols used in the Problem / Message - Possible remedial measures 
section and the urgency level of the colors used is explained in the legends.  

8.3.1.6 Dialog "Device messages" > "PROFIBUS DP" tab 
The "PROFIBUS DP" tab is only available when there is a configured DP interface module.    

The configuration supports the following messages: 

General 
 
Status Symbol Meaning 
Group error  red At least one error is present. 
Bus error red Communication to the fieldbus master is disturbed. 
Group warning  yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present (e.g. "Safety sensor triggered"). 
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DP status   
 
Status Symbol Meaning 
CPU/Master STOP yellow • CPU STOP: The user program in the PLC is not processed any more. 

• Master STOP: A disturbed communication with the fieldbus master was 
detected. 

DP bus error red Communication via PROFIBUS DP has been interrupted. 
DP parameter assignment error red During parameter assignment in existing communication connection a 

parameter assignment error occurred. 
DP configuration error red The actual configuration of an existing communication connection does not 

match the target configuration. This resulted in an error. 
DP process data exchange 
stopped 

yellow Process data exchange with the DP master has stopped, for example, 
because the controller is in the "STOP" state (= CPU STOP) or because the 
user program in the MSS 3RK3 is not running. 

DP communication ok green The communication connection to the fieldbus master is set up.  
Configuration and parameter assignment of the safety relay have been 
executed successfully. 

Legends 
The meaning of the symbols used in the Problem / Message - Possible remedial measures 
section and the urgency level of the colors used is explained in the legends.  

8.3.1.7 Dialog "Device messages" > "Device bus interface" tab 
The configuration supports the following SC status messages (SC = system interface):    

General 
 
Status Symbol Meaning 
Group error  red At least one error is present. 
Bus error red There is at least one communication fault of a bus system. 
Group warning  yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present (e.g. "Safety sensor triggered"). 
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SC status 
 
Status Symbol Meaning 
SC communication ok green The internal communication link is set up. 
SC bus error red Communication via the device bus interface is interrupted. 
SC parameter assignment error red An error occurred during parameter assignment in existing communication 

connection. 
SC configuration error red The actual configuration of an existing communication connection does not 

match the target configuration. This resulted in an error. 
SC process data exchange 
stopped 

yellow No more process data is exchanged. 

Legends 
The meaning of the symbols used in the Problem / Message - Possible remedial measures 
section and the urgency level of the colors used is explained in the legends.  

8.3.1.8 "Device messages" dialog box > "AS-Interface" tab 

Requirements 
The "AS-Interface" tab appears only if AS-Interface is configured for MSS 3RK3 Advanced, 
MSS 3RK3 ASIsafe basic or MSS 3RK3 ASIsafe extended.    

The configuration supports the following messages: 

General 
 
Status Symbol Meaning 
Group error  red At least one error is present. 
Bus error red Communication to the fieldbus master is disturbed. 
Group warning  yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present (e.g. "Safety sensor triggered"). 
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AS-i interface   
 
Status Symbol Meaning 
AS-i communication ok green • The communications link to the AS-i slaves exists. 

• The AS-i slaves have been successfully configured and parameterized. 

AS-i configuration error red The actual configuration of an existing communication connection does not 
match the target configuration. This resulted in an error. Communication via 
the AS-i fieldbus interface is interrupted. 

For AS-i address States the lowest of the affected addresses. 
AS-i parameterization error red A simulated AS-i slave was not included in the data traffic by the AS-i 

master. 
For AS-i address States the lowest of the affected addresses. 
AS-i bus error red The message is displayed for up to 30 s during startup if no AS-i bus is 

detected. 

AS-i slave function   
 
Status Symbol Meaning 
AS-i slave function active green The AS-i slave function is active, i.e. non-safety-related AS-i slaves are 

simulated by the safety relay. 

AS-i monitor function   
 
Status Symbol Meaning 
AS-i monitor function active green The AS-i monitor function is active, i.e. non-safety-related AS-i slaves are 

monitored. 
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ASIsafe   
 
Status Symbol Meaning 
Safety protocol error red Fault in safety-related communication, for example, resulting from ASIsafe 

code sequence error due to effects of EMC. 
ASIsafe 7x4-bit code sequence 
monitor active 

green At least one 7x4-bit code sequence monitor is monitoring data on the AS-i 
bus. 

ASIsafe 7x4-bit code sequence 
error 

red During data transmission, an error in the 7x4-bit code sequence was 
detected in at least one AS-i address. 

For AS-i address States the lowest of the affected addresses. 
ASIsafe 8x4-bit code sequence 
monitor active 

green At least one 8x4-bit code sequence monitor is active. 

ASIsafe 8x4-bit code sequence 
error 

red During data transmission, an error in the 8x4-bit code sequence was 
detected in at least one AS-i address. 

ASIsafe code table teaching 
active 

blue Monitoring of ASIsafe code sequences that have not yet been taught is 
active. 

Code tables missing red The code table is missing for at least one of the configured safety-related 
input slaves. 

Multiple code tables red At least two safety-related AS-i slaves with the same code table have been 
detected. 

New codes tables yellow The code table of at least one configured safety-related input slave has not 
yet been transferred. 

Code tables known green A valid code table has been taught and applied for all configured safety-
related AS-i input slaves detected on the AS-i bus. 

For AS-i address States the lowest of the affected addresses. 
ASIsafe 7x4-bit code sequence 
generator active 

green At least one 7x4-bit code sequence generator is involved in the AS-i 
communication, i.e. it is transmitting a certain 7x4-bit code sequence for a 
particular parameterized AS-i address. 

ASIsafe 8x4-bit code sequence 
generator active 

green At least one 8x4-bit code sequence generator is involved in the AS-i 
communication, i.e. it is transmitting a certain 8x4-bit code sequence for a 
particular parameterized AS-i address. 

Legends 
The meaning of the symbols used in the Problem / Message - Possible remedial measures 
section and the urgency level of the colors used is explained in the legends.  
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8.3.2 Diagnostics logic 

8.3.2.1 Monitoring 
The "Target system" > "Diagnostics logic" > "Monitor" menu command shows the status of 
the inputs / outputs, of the function elements, and of the connections between the functions.     

The status of the connections is determined based on the result of logic operation (RLO) of 
the respective function output. 

Requirements 
● The safety relay is opened online. 

● The logic diagram with the safety circuit is active. 

● The MSS 3RK3 is in safety mode or test mode 

General element status   
 
Symbol Color Meaning 

 
gray Function element is deactivated 

 
green At least one function output is active 

 
green flashing Function element is ready and is waiting for a start signal. 

 
yellow flashing Function element waiting for startup test 

 
blue  Timer is active 

 
red  Wiring error  

Note 
For input cells this means that the input substitute value is 
active.   

 
flashing red Logic error, e.g. status of the feedback contact, does not 

match the setpoint value 
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Status of the function inputs/function outputs    
 
Symbol Color Meaning 

 
green Function input active 

 
blue Function input inactive 

 
green Function output active 

 
blue Function output inactive 

8.3.2.2 Messages for Monitoring Universal 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 
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"Messages" tab 
The view of the "Messages" tab is divided into the sections "General," "Sensor," and "Start." 

General 
 
Status Symbol Meaning 
Logic error  red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error  red At least one wiring error is present (e.g. cross-circuit). 
Group warning  yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

 

 
Status Symbol Meaning 
Start condition not fulfilled yellow is set if: 

• A sensor test was not executed in the case of an active startup test 
function 

• A discrepancy condition violation is present 
• The value "1" is not present simultaneously at all available 

(parameterized) function inputs (IN1, ...) 
• A signal sequence violation is present 
• A cross-circuit is present in the case of cross-circuit monitoring 

Sensor 
 
Status Symbol Meaning 
Safety sensor triggered yellow The safety sensor has been actuated. This message is automatically 

reset if the value "1" is pending at all IN1 / 2 function inputs 
monitored. 

Startup test required yellow This message is set in a parameterized startup test on each restart 
and each time the substitute value is changed to a real value until the 
user has actuated the connected sensor at least once. 

Sequence condition not fulfilled red The sequence condition was not fulfilled in accordance with the 
parameter assignment. 

Discrepancy condition violated red is set if: 
• After the discrepancy time has elapsed, the signal states at the 

inputs monitored are different 
• The signal states of the inputs monitored had not all previously 

been reset simultaneously to the value "0" when they are set to 
"1" 

Cross-circuit at input x red A cross-circuit was detected at input x.  
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Start 
 
Status Symbol Meaning 
Start signal duration invalid yellow Only with start type "Monitored start": 

The start signal time monitoring element detected a violation. 

8.3.2.3 EMERGENCY STOP messages 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is divided into the sections "General," "Sensor," and "Start." 
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General 
 
Status Symbol Meaning 
Logic error red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error red At least one wiring error is present (e.g. cross-circuit). 
Group warning yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

 

 
Status Symbol Meaning 
Start condition not fulfilled yellow is set if: 

• A sensor test was not executed in the case of an active startup test 
function 

• A discrepancy condition violation is present 
• A cross-circuit is present in the case of cross-circuit monitoring 
• The value "1" is not present simultaneously at all available 

(parameterized) function inputs (IN1, ...) 

Sensor 
 
Status Symbol Meaning 
Safety sensor triggered yellow The safety sensor has been actuated. This message is automatically 

reset if the value "1" is pending at all IN1 / IN2 function inputs 
monitored. 

Startup test required yellow This message is set in a parameterized startup test on each restart and 
each time the substitute value is changed to a real value until the 
connected sensor is actuated at least once. 

Discrepancy condition violated red is set if: 
• After the discrepancy time has elapsed, the signal states at the 

inputs monitored are different 
• The signal states of the inputs monitored had not all previously been 

reset simultaneously to the value "0" when they are set to "1" 

Cross-circuit at input x red A cross-circuit was detected at input x.  

Start 
 
Status Symbol Meaning 
Start signal duration invalid yellow Only with start type "Monitored start": 

The start signal time monitoring element detected a violation. 
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8.3.2.4 Messages for ESPE 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is divided into the sections "General," "Sensor," and "Start." 

General 
 
Status Symbol Meaning 
Logic error red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error red At least one wiring error is present (e.g. cross-circuit). 
Group warning yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

 

 
Status Symbol Meaning 
Start condition not fulfilled yellow is set if: 

• A sensor test was not executed in the case of an active startup test 
function 

• A discrepancy condition violation is present 
• A cross-circuit is present in the case of cross-circuit monitoring 
• The value "1" is not present simultaneously at all available 

(parameterized) function inputs (IN1, ...) 
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Sensor 
 
Status Symbol Meaning 
Safety sensor triggered yellow The safety sensor has been actuated. This message is automatically 

reset if the value "1" is pending at all IN1 / IN2 function inputs 
monitored. 

Discrepancy condition violated red is set if: 
• The signal states of the inputs monitored had not all previously been 

reset simultaneously to the value "0" when they are set to "1" 

Startup test required yellow This message is set in a parameterized startup test on each restart and 
each time the substitute value is changed to a real value until the 
connected sensor is actuated at least once. 

Cross-circuit at input x red A cross-circuit was detected at input x.  

Start 
 
Status Symbol Meaning 
Start signal duration invalid yellow Only with start type "Monitored start": 

The start signal time monitoring element detected a violation. 

8.3.2.5 Messages for safety shutdown mat (NC principle) 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is divided into the sections "General," "Sensor," and "Start." 
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General 
 
Status Symbol Meaning 
Logic error  red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error  red At least one wiring error is present (e.g. cross-circuit). 
Group warning  yellow At least one warning is present. 
Group prewarning  yellow At least one prewarning is present. 

 

 
Status Symbol Meaning 
Start condition not fulfilled yellow is set if: 

• A sensor test was not executed in the case of an active startup test 
function 

• A discrepancy condition violation is present 
• A cross-circuit is present in the case of cross-circuit monitoring 
• The value "1" is not present simultaneously at all available 

(parameterized) function inputs (IN1, ...) 

Sensor 
 
Status Symbol Meaning 
Safety sensor triggered yellow The safety sensor has been actuated. This message is automatically 

reset if the value "1" is pending at all IN1 / IN2 function inputs 
monitored. 

Startup test required yellow This message is set in a parameterized startup test on each restart and 
each time the substitute value is changed to a real value until the 
connected sensor is actuated at least once. 

Discrepancy condition violated red is set if: 
• The signal states of the inputs monitored had not all previously 

been reset simultaneously to the value "0" when they are set to "1" 

Cross-circuit at input x red A cross-circuit was detected at input x.  

Start 
 
Status Symbol Meaning 
Start signal duration invalid yellow Only with start type "Monitored start": 

The start signal time monitoring element detected a violation. 
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8.3.2.6 Messages for safety shutdown mat (cross-circuit principle) 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is divided into the sections "General," "Sensor," and "Start." 

General 
 
Status Symbol Meaning 
Logic error red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error red At least one wiring error is present (e.g. cross-circuit). 
Group warning yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

 

 
Status Symbol Meaning 
Start condition not fulfilled yellow is set if: 

• A sensor test was not executed in the case of an active startup test 
function 

• A cross-circuit is present 
• The value "1" is not present simultaneously at all available 

(parameterized) function inputs (IN1, ...) 
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Sensor 
 
Status Symbol Meaning 
Safety sensor triggered yellow The safety sensor has been actuated. This message is automatically 

reset if the value "1" is pending at all IN1 / IN2 function inputs 
monitored. 

Startup test required yellow This message is set in a parameterized startup test on each restart and 
each time the substitute value is changed to a real value until the 
connected sensor is actuated at least once. 

Wire break at input x red Value "0" detected at input x. 
Short circuit to P at input x red A short-circuit to P was detected at input x. 

Start 
 
Status Symbol Meaning 
Start signal duration invalid yellow Only with start type "Monitored start": 

The start signal time monitoring element detected a violation. 

8.3.2.7 Messages for protective door 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is divided into the sections "General," "Sensor," and "Start." 
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General 
 
Status Symbol Meaning 
Logic error red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error red At least one wiring error is present (e.g. cross-circuit). 
Group warning yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

 

 
Status Symbol Meaning 
Start condition not fulfilled yellow is set if: 

• A sensor test was not executed in the case of an active startup 
test function 

• A discrepancy condition violation is present 
• The value "1" is not present simultaneously at all available 

(parameterized) function inputs (IN1, ...) 
• A signal sequence violation is present 
• A cross-circuit is present in the case of cross-circuit monitoring 

Sensor 
 
Status Symbol Meaning 
Safety sensor triggered yellow The safety sensor has been actuated. This message is automatically reset 

if the value "1" is pending at all IN1 / IN2 function inputs monitored. 
Startup test required yellow This message is set in a parameterized startup test on each restart and 

each time the substitute value is changed to a real value until the 
connected sensor is actuated at least once. 

Sequence condition not fulfilled red The sequence condition was not fulfilled in accordance with the parameter 
assignment. 

Discrepancy condition violated red is set if: 
• After the discrepancy time has elapsed, the signal states at the inputs 

monitored are different 
• The signal states of all inputs to be monitored had not all previously 

been reset simultaneously to the value "0" when they are set to "1." 

Cross-circuit at input x red A cross-circuit was detected at input x.  

Start 
 
Status Symbol Meaning 
Start signal duration invalid yellow Only with start type "Monitored start": 

The start signal time monitoring element detected a violation. 
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8.3.2.8 Messages for protective door with lock 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is divided into the sections "General," "Sensor / Protective 
Door," "Lock," and "Start." 

General 
 
Status Symbol Meaning 
Logic error red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error red At least one wiring error is present (e.g. cross-circuit). 
Group warning yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

 

 
Status Symbol Meaning 
Start condition not fulfilled yellow is set if: 

• A sensor test was not executed in the case of an active startup test 
function 

• A discrepancy condition violation is present 
• The value "1" is not present simultaneously at all available 

(parameterized) function inputs (IN1, ...) 
• A signal sequence violation is present 
• A cross-circuit is present in the case of cross-circuit monitoring 
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Sensor 
 
Status Symbol Meaning 
Safety sensor triggered yellow The safety sensor has been actuated. This message is automatically 

reset if the value "1" is pending at all IN1 / IN2 function inputs 
monitored. 

Protective door closed green The protective door is closed. 
Startup test required yellow This message is set in a parameterized startup test on each restart and 

each time the substitute value is changed to a real value until the 
connected sensor is actuated at least once. 

Sequence condition not fulfilled red The sequence condition was not fulfilled in accordance with the 
parameter assignment. 

Discrepancy condition violated red is set if: 
• After the discrepancy time has elapsed, the signal states at the 

inputs monitored are different 
• The signal states of the inputs monitored had not all previously 

been reset simultaneously to the value "0" when they are set to "1" 

Cross-circuit at input x red A cross-circuit was detected at input x.  

Lock 
 
Status Symbol Meaning 
Lock engaged green The lock is engaged. 
Lock released green The lock is released. 
Feedback circuit signal and 
switching status do not match 

red The feedback circuit signal does not match the interlock status.  

Protective door opened when 
lock was active 

red The protective door opened when lock was active. 

Locking not possible because the 
protective door is open 

red Locking not possible because the protective door is open. 

Start override active blue The start override time is running. 

Start 
 
Status Symbol Meaning 
Start signal duration invalid yellow Only with start type "Monitored start": 

The start signal time monitoring element detected a violation. 
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8.3.2.9 Messages for enabling button 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is divided into the sections "General" and "Sensor." 

General 
 
Status Symbol Meaning 
Logic error red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error red At least one wiring error is present (e.g. cross-circuit). 
Group warning yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

 

 
Status Symbol Meaning 
Start condition not fulfilled yellow is set if: 

• A discrepancy condition violation is present 
• A cross-circuit is present 
• The value "1" is not present simultaneously at all available 

(parameterized) function inputs (IN1, ...) 
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Sensor 
 
Status Symbol Meaning 
Enabling button OFF green The enabling button has the status OFF. 
Enabling button ON green The enabling button has the status ON. 
Bushbutton stuck  red The pushbutton is stuck. 
Discrepancy condition violated red is set if: 

• The signal states of the inputs monitored had not all previously been 
reset simultaneously to the value "0" when they are set to "1" 

Cross-circuit at input x red A cross-circuit was detected at input x.  

8.3.2.10 Messages for two-hand operation 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is divided into the sections "General" and "Sensor." 
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General 
 
Status Symbol Meaning 
Logic error red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error red At least one wiring error is present (e.g. cross-circuit). 
Group warning yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

 

 
Status Symbol Meaning 
Start condition not fulfilled yellow is set if: 

• A discrepancy condition violation is present 
• A cross-circuit is present 
• If both pushbuttons were not pressed "synchronously", that is, they were 

pressed with a time offset greater than 0.5 s 
• The value "1" is not present simultaneously at IN1 / 3, IN2 / 4 
• The two pushbuttons were not released simultaneously 
• A stuck button error is present 

Sensor 
 
Status Symbol Meaning 
Bushbutton stuck  red The pushbutton is stuck. 
Do not release both pushbuttons red The two pushbuttons were not released simultaneously. 
Discrepancy condition violated red is set if: 

• After the discrepancy time has elapsed, the signal states at the 
inputs monitored are different within one or both pushbuttons 

• The signal states of the inputs monitored had not all previously been 
reset simultaneously to the value "0" when they are set to "1" 

Cross-circuit at input x red A cross-circuit was detected at input x.  
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8.3.2.11 Messages for mode selector switch 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is contains the sections "General" and "Mode selector 
switch." 

General 
 
Status Symbol Meaning 
Logic error  red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error  red At least one wiring error is present (e.g. cross-circuit). 
Group warning  yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

Mode selector switch 
 
Status Symbol Meaning 
Switchover time exceeded yellow The "1 out of 2 ... 5 selection monitoring" detected the value "0" at all 

inputs after the contact switchover time had elapsed. 
Invalid operating mode selection red The "1 out of 2 ... 5 selection monitoring" detected after the contact 

switchover time had elapsed: 
The value "1" is present at more than one input. 
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8.3.2.12 Messages for the muting functions 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is divided into the sections "General", "Muting sensors", and 
"Restart." 

General 
 
Status Symbol Meaning 
Logic error red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error red At least one wiring error is present (e.g. faulty muting display lamp). 
Group warning yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

 

 
Status Symbol Meaning 
Start muting condition not met yellow Not all conditions for operational starting of muting using muting sensors 

are met. 
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Muting sensors 
 
Status Symbol Meaning 
Muting operation active green Muting mode is activated. 
Muting operation not active green Muting mode is not activated. 
Protective field not free yellow The value "0" is present at the "FREE" function input. 
System not running yellow The value "1" is present at the "STOP" function input. 
Sequence condition not fulfilled red The sequence condition was not observed. 
Discrepancy condition sensor pair x 
not fulfilled 

red A discrepancy violation was detected in the signals of muting 
sensor pair x. 

Max. muting time exceeded red Muting operation terminated because "max. muting time" expired. 
Muting display lamp defective red The muting display lamp - monitoring function has detected an 

error. 

Restart 
 
Status Symbol Meaning 
Muting restart possible green Muting mode was not terminated correctly, i.e. at least one muting 

sensor is still being triggered. 
Restart signal duration invalid  yellow The "Muting restart possible" message is set and, the first time the 

RESTART button is pressed, the expected operating sequence 
does not follow. 

8.3.2.13 Messages for counter functions 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is contains the sections "General" and "Counter function." 
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General 
 
Status Symbol Meaning 
Logic error red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error red At least one wiring error is present (e.g. cross-circuit). 
Group warning yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

Counter function 
 
Status Symbol Meaning 
Counter limit value exceeded yellow The parameterized counter limit value was exceeded. 
Counter limit value undershot green The parameterized counter limit value was undershot. 
Last count pulse was up green Last count pulse was up 
Last count pulse was down green Last count pulse was down. 

8.3.2.14 Messages for timer functions 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is contains the sections "General" and "Timer function." 
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General 
 
Status Symbol Meaning 
Logic error  red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error red At least one wiring error is present (e.g. cross-circuit). 
Group warning yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

Time function 
 
Status Symbol Meaning 
OFF delay active  blue The parameterized time t1 runs "with OFF delay". 
ON delay active blue The parameterized time t1 runs "with ON delay". 
Passing make pulse contact active blue The parameterized time t1 runs "with ON delay." 
Clock-pulse generator active green The parameterized times t1 and t2 run "with clocking". 

8.3.2.15 Messages for start functions 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is contains the sections "General" and "Start." 
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General 
 
Status Symbol Meaning 
Logic error red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error red At least one wiring error is present (e.g. cross-circuit). 
Group warning yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

 

 
Status Symbol Meaning 
Start condition not fulfilled yellow The value "0" is present at the "Start condition input (IN)". 

Start 
 
Status Symbol Meaning 
Start signal duration invalid yellow Only with start type "Monitored start": 

The start signal time monitoring element detected a violation. 

8.3.2.16 Messages for output functions 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is divided into the sections "General," "Output," "Feedback 
circuit," and "Start." 
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General 
 
Status Symbol Meaning 
Logic error red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error red At least one wiring error is present (e.g. cross-circuit). 
Group warning yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

 

 
Status Symbol Meaning 
Start condition not fulfilled yellow is set if: 

• there is a feedback circuit error when feedback circuit monitoring is 
activated. 

• the value "0" is pending at the function input (IN). 

Output 
 
Status Symbol Meaning 
Output x active green Function output x is switched on. 

Feedback circuit 
 
Status Symbol Meaning 
Feedback circuit signal and switching 
status do not match 

red The message at the feedback circuit input does not match the switching 
status of the function outputs. 
The output function immediately deactivates all its outputs in case of 
inconsistencies. 

Start 
 
Status Symbol Meaning 
Start signal duration invalid yellow Only with start type "Monitored start": 

The start signal time monitoring element detected a violation. 
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8.3.2.17 Messages for AS-i 1..4F-DO 
The "Element Messages" dialog box contains two tabs named "Overview" and "Messages" 
and provides information, remedial measures, and messages about pending problems and 
errors.   

"Overview" tab 
The view of the "Overview" tab is divided into the following sections:  

 
Section Content and meaning 
General The color indicates the type of error. 
Problem / Message 
Possible remedial measures 

Defines remedial measures for the displayed problem. 

Legend Explains the meaning of the symbols used in the Problem / Message - Possible 
remedial measures section. 

"Messages" tab 
The view of the "Messages" tab is divided into the sections "General," "Output," "Start," and 
"Feedback circuit." 

General 
 
Status Symbol Meaning 
Logic error red At least one logic error is present (e.g. discrepancy error / sequence error). 
Wiring error red At least one wiring error is present (e.g. feedback circuit error). 
Group warning yellow At least one warning is present. 
Group prewarning yellow At least one prewarning is present. 

 

 
Status Symbol Meaning 
Start condition not fulfilled yellow is set if: 

• there is a feedback circuit error when feedback circuit monitoring is 
active 

• the logic error "Invalid output selection" is present 
• the value "1" is present at more than one of the existing (parameterized) 

function inputs 
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Output 
 
Status Symbol Meaning 
Output x active green Function output x is switched on. 
Auxiliary control signal x sent green The auxiliary control signal x was transmitted completely by the code 

sequence that is currently active. 
Invalid output selection red The value "1" was detected on more than one input IN1 ... 4 by the "1 

out of 4 - selection monitoring." 

Start 
 
Status Symbol Meaning 
Start signal duration invalid yellow Only with start type "Monitored start": 

The start signal time monitoring element detected a violation. 

Feedback circuit 
 
Status Symbol Meaning 
Feedback circuit signal x and 
switching status do not match 

red The signal at feedback circuit input x and the switching status of function 
output x do not match.  
In case of inconsistencies, the output function immediately switches off 
all its outputs.  
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8.4 Diagnostics using PROFIBUS 

8.4.1 Using data sets 
Diagnostics of the MSS 3RK3 using PROFIBUS is an important part of the Diagnostics 
concept (Page 490) of MSS 3RK3. 

 

 Note 
Diagnostics block   

An MSS-specific diagnostics block is available for diagnostics using PROFIBUS. You will 
find more information on the Internet under FAQs 
(http://support.automation.siemens.com/WW/view/de/40631654). 

 

This section contains information about the data sets of the 3RK3 central unit and the DP 
interface and how to handle those data sets.    

Target groups 
This section is aimed at the following target groups: 

● Configuration engineers 

● PLC programmers 

Required knowledge 
You need to have a sound knowledge of writing/reading data sets using PROFIBUS. 

Data sets: overview 
 
Module Data 

set no. 
Description Read/write 

Central unit 
DP interface   

0 / 1 System diagnostics Read 

Central unit 92 Device diagnostics (faults, warnings, 
messages) 

Read 

Reading data sets 
Accessing data sets via slot: 

● Access to data set from DP interface via Slot_0 

● Access to data set from the central unit via Slot_1 

http://support.automation.siemens.com/WW/view/de/40631654�
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Reading data sets with STEP 7   
You can access the data sets from the user program. 

Reading data sets: 

● S7-DPV1 master: by calling SFB 52 "RDREC" or SFC 59 "RD_REC 

● S7 master: by calling SFC 59 

Additional information 
You will find more information about the SFCs and SFBs  

● Reference manual "System Software for S7-300/400, System and Standard Functions" 

● In the STEP7 online help 

Byte arrangements 
When data longer than one byte is stored, the bytes are arranged as follows ("big endian"): 

 
Figure 8-2 Byte arrangement 
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8.4.2 Structure of the diagnostics frame 

Diagnostics concept via PROFIBUS    
 

 
Figure 8-3 Diagnostics pyramid 

 
Byte Length Diagnostics block 

0 ... 5 6 bytes Standard diagnostics 
DPV0 standard 

6 ... 11 6 bytes ID-related diagnosis 
12 ... 23 12 bytes Status messages 

Device-related diagnostics 
24...x 
(max. 41) 

0 ... 18 bytes Channel-related diagnostics 
(max. 6 channels of 3 bytes each) Error numbers 
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Channel-related diagnostics 
Channel-related diagnostics contains the error number from DS92. Up to six errors can be 
transferred simultaneously. The MSS 3RK3 uses the following error numbers: 

 

 Note 
Difference between the 3RK3 central units 

The error numbers of the 3RK3 central units are not all identical. 
 

 

 
DP error numbers   

Error 
no. 

Description Explanation Remedy 

7 Upper limit exceeded Memory module too small Reduce configuring 
8 Lower limit undershot • Max. number of elements exceeded 

• Max. size of memory exceeded 
• Program cycle time exceeded 

Adapt configuring 

9 Error • Device error 
• Self-test error 

Replace device 

16 Parameterization error Configuring error: 
• Release denied due to incorrect 

configuration CRC 
• Release canceled due to incorrect 

configuration release CRC 
• Invalid parameter value 
• Interconnection rule violated 

(not in the case of MSS 3RK3 Basic) 
• Data structure incorrect  

(not in the case of MSS 3RK3 Basic) 

• Correct configuring 
• Update engineering software 

19 Communication error Bus error: 
• Error on PROFIBUS 
• Error on AS-i bus  

(MSS 3RK3 Basic only) 
• Multiple ASIsafe code tables  

(not for MSS 3RK3 Basic) 
• ASIsafe 8x4-bit code sequence errors  

(not for MSS 3RK3 Basic) 
• ASIsafe 7x4-bit code sequence errors  

(not for MSS 3RK3 Basic) 
• Error on the system interface 
• Handshake error (MSS 3RK3 Basic) 

• Check bus systems 
• Check device configuration 
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DP error numbers   
Error 
no. 

Description Explanation Remedy 

23 Actuator warning Group warning (MSS 3RK3 Basic) or group 
prewarning (MSS 3RK3 Advanced, MSS 3RK3 
ASIsafe) from the user program 

Eliminate cause of warning and 
acknowledge 

24 Actuator disconnection Group error: 
• Error in configuration 
• Configuring error 
• Protocol error on a safety-related bus 

(not for MSS 3RK3 Basic) 
• Handshake error 
• Group error from user program 
• Wiring error 
• Logic error 
• Release denied due to incorrect 

configuration CRC 
• Release canceled due to incorrect 

configuration release CRC 
• Max. number of elements exceeded 
• Max. size of memory exceeded 
• Program cycle time exceeded 
• TARGET≠ACTUAL configuration 
• TARGET≠ACTUAL slot expanded 

configuration 
• Invalid parameter value 
• Interconnection rule violated 

(not in the case of MSS 3RK3 Basic) 
• Data structure incorrect  

(not in the case of MSS 3RK3 Basic) 
• Memory module not plugged in 
• Memory module defective 
• Programming error 
• Memory module too small 
• Self-test error (device error) 
• Multiple ASIsafe code tables  

(not for MSS 3RK3 Basic) 
• ASIsafe 8x4-bit code sequence errors  

(not for MSS 3RK3 Basic) 
• ASIsafe 7x4-bit code sequence errors  

(not for MSS 3RK3 Basic) 
• System interface configuration error 

Eliminate cause of error and 
acknowledge 

25 Safety-related shutdown Logic error (user program) Eliminate cause of message 
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DP error numbers   
Error 
no. 

Description Explanation Remedy 

26 External error • Wiring error (user program) 
• Memory module not plugged in 

• Eliminate cause of message 
• Insert the memory module 

27 Unclear error Unclear errors include errors that have no 
equivalent in the other error numbers. 
• Error in configuration 
• Safety protocol error  

(not in the case of MSS 3RK3 Basic) 
• Handshake error 
• TARGET≠ACTUAL configuration 
• TARGET≠ACTUAL slot expanded 

configuration 
• Memory module defective 
• Programming error 
• System interface configuration error 

Eliminate cause of error 
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8.4.3 Data set 0 

8.4.3.1 General data set 0 
This DS is available for both the 3RK3 central unit and the DP interface. DS0 in the 3RK3 
central unit can be queried through DP slot number 1 on the PROFIBUS slot model, and 
DS0 in the DP interface can be queried through DP slot number 0.   

8.4.3.2 Data set 0 in 3RK3 central unit 
The content of DS0 for the 3RK3 central unit is described below:   

 
Byte Meaning Note 
00 Module fault SF on 3RK3 central unit 
01 Internal error Device error on 3RK3 central unit 
02 External error Logic or wiring error 
03 ... 05 Reserved=0 
06 Module not parameterized No configuration saved in device 
07 Incorrect parameters in device Incorrect configuration saved in device 
10 ... 13 Type class 0000 CPU 
14 Channel information available DS1 exists 
15 User information available Always 1 for MSS 3RK3 because 

diagnostics information is available via 
DS92 

16 Diagnostic interrupt from substitute Not set by MS 3RK3. 
17 Reserved=0 
20 No user module / user module 

incorrect 
Configuration error in MSS 3RK3 TARGET 
/ ACTUAL 

21 Communication fault Bus error or safety protocol error 
22 [0]: RUN mode 

[1]: STOP mode 
RUN: MSS 3RK3 in safety/test mode  
STOP: MSS 3RK3 in configuring mode 

23 Time monitoring Cycle time violation of MSS 3RK3 
24 ... 26 Reserved=0 
30 Rack failure System interface failed 
31 Reserved=0 
32 Memory module error Error in external memory module 
33 ... 37 Reserved=0 



 Diagnostics / service 
 8.4 Diagnostics using PROFIBUS 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 571 

8.4.3.3 Data set 0 in DP interface 
The content of DS0 for DP interface is described below:   

 
Coding Meaning Note 
00  Module fault SF on expansion module 
01 Internal error e.g. error mode, int. EEP 
02 ... 07 Reserved=0 
10... 13 Type class 0011 DP slave 
14 Reserved=0 
15 User information available Always 1 for MSS 3RK3 because no 

diagnostics information is available via 
DS92 

16 ... 20 Reserved=0 
21  Communication fault DeviceConnect failed 
22 [0]: RUN mode 

[1]: STOP mode 
RUN: Process data exchange with master 

23 ... 27 Reserved=0 
30  Rack failure DeviceConnect failed 
31 ... 37 Reserved=0 
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8.4.4 Data set 1 

8.4.4.1 Data set 1 in the 3RK3 central unit 
The content of DS1 for the 3RK3 central unit is described below:   

 
Byte Meaning 
Diagnostics data part 1 
00 ... 37 Same as DS0 
Diagnostics data part 2 
40 ... 47 7DH channel type 
50 ... 57 20H number of diagnostics bits per channel 
60 ... 67 01H number of channels (1 channel) 
70 [1] (channel 0) module faulty (error present) 

[0] module OK 
71 ... 80 Reserved=0 
81 Short-circuit 
82 Undervoltage 
83 Overvoltage 
84 Overload 
85 Overtemperature 
86 Line break 
87 Upper limit exceeded (memory module too small) 
90 Lower limit exceeded (no. of elements / memory exceeded) 
91 Error (device error present) 
92 ... 97 Reserved=0 
100 Parameterization error 
101 No encoder or load voltage  
102 Fuse faulty 
103 Reserved=0 
104 Ground error 
105 Reference channel error 
106 Process alarm lost 
107 Actuator alarm (e.g. group warning) 
110 Actuator shutdown (e.g. group error) 
111 Safety-related shutdown (e.g. logic error) 
112 External fault (e.g. memory module not connected) 
113 Unclear error (e.g. configuration error) 
114 Reserved=0 
115 Wiring error 
116 Logic error 
117 Configuring / test mode active 
120 ... 157 Reserved=0 
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8.4.4.2 Data set 1 in DP interface 
The content of DS1 for DP interface contains the same information as DS0 because certain 
CPUs first request DS1 for diagnostic purposes. If DS1 is rejected by DP interface, the CPU 
does not request any further diagnoses. Diagnostics bits that are not within the scope of DS0 
always remain set to 0.   

 
Byte Meaning 
Diagnostics data part 1 
00 ... 37 Same as DS0 
40 ... 47 7DH channel type 
50 ... 57 20H number of diagnostics bits per channel 
60 ... 67 01H number of channels (1 channel) 
70 [1] (channel 0) module faulty (error present) 

[0] module OK 
71 ... 112 Reserved=0 
112 Unclear error (e.g. configuration error) 
114 ... 157 Reserved=0 
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8.4.5 Data set 92 
All device-specific messages and information about the individual device function states are 
collected centrally and stored in the message memory of the 3RK3 central unit. The 
message memory can be read via DS92. The current device status is stored as of byte 12.   

The content of DS92 is described below: 

 
DS92 (device messages) 

3RK3 Basic 3RK3 Advanced 
3RK3 ASIsafe 

Byte Meaning Note 

Error 
category 

DP error 
number 

Error 
category 

DP error 
number 

Header 
0 … 11 Reserved = 0 
Device status 
120 Device error (GF/DEVICE) Device defective GF F9 GF F9 
121 Group error (SF) at least 1 group error pending. SF F24 SF F24 
122 Bus error (BF) at least 1 bus error pending. BF F19 BF F19 
123 Group warning (SW) at least 1 warning pending. SW F23 SW F23 
124 Group prewarning (SVW) at least 1 group prewarning 

pending. 
- SVW F23 

125 ... 130 Reserved = 0 
131 Configuration error (KF) Memory module not detected; 

change to configuring mode. 
SF F24, F27 SF F24, F27 

132 Configuring error (PF) The configuring contains at least 
1 error. 

SF F24, F16 SF F24, F16 

133 Safety protocol error (SPF) Protocol error at a safety-related 
bus, e.g., ASIsafe 

- - SF F24, F27 

134 Wiring error (VF) A wiring error is present. SF F24, F26 SF F24, F26 
135 Logic error (LF) A logic error is pending (e.g., 

discrepancy or sequence 
violation). 

SF F24, F25 SF F24, F25 

136 ... 137 Reserved = 0 
140 Configuring mode active Device is in configuring mode. ✓ ✓ 
141 Test mode active Device is in test mode. ✓ ✓ 
142 Safety mode active Device is in safety mode. ✓ ✓ 
143 User program is active Device is in test or safety mode. 

The safety program is executed. 
✓ ✓ 

144 User program stopped. The safety program is executed. ✓ SVW - 
145 ... 146 Reserved = 0 
147 Operating mode change 

rejected 
The operating status could not be 
changed. 

✓ ✓ 

150 Access path closed An access path in the device is 
not open. 

✓ ✓ 

151 Access path to fieldbus 
control is open 

Access path via the fieldbus 
interface is open. 

✓ ✓ 
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DS92 (device messages) 
3RK3 Basic 3RK3 Advanced 

3RK3 ASIsafe 
Byte Meaning Note 

Error 
category 

DP error 
number 

Error 
category 

DP error 
number 

152 Reserved = 0 
153 Access path fieldbus ES 

tool is open 
Access path through the ES tool 
is open. 

✓ ✓ 

154 Reserved = 0 
155 Access path to device 

interface is open 
Access path through the device 
interface is open. 

✓ ✓ 

156 ... 157 Reserved = 0 
160 Disconnect  Access monitoring has detected 

a communication break. 
SW - SW - 

161 Handshake error Connection monitoring has 
detected an error.  

SF F24, F19 SF F24, F27 

162 ... 167 Reserved = 0 
170 Device access authorization 

exists 
An access path with a valid 
password has been opened. 

✓ ✓ 

171 ... 173 Reserved = 0 
174 Password protection for 

device access is inactive 
Password protection for device 
access is inactive. 

✓ ✓ 

175 ... 176 Reserved = 0 
177 Incorrect password entry The wrong password was 

entered 
✓ ✓ 

180 Group error from user 
program 

At least 1 configured function 
element has a wiring or logic 
error. 

SF F24 SF F24 

181 Group warning from user 
program 

At least 1 configured function 
element has a group warning. 

SW F23 - 

182 Group prewarning from 
user program 

At least 1 configured function 
element has a group warning. 

- SVW - 

183 ... 197 Reserved = 0 
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DS92 (device messages) 
3RK3 Basic 3RK3 Advanced 

3RK3 ASIsafe 
Byte Meaning Note 

Error 
category 

DP error 
number 

Error 
category 

DP error 
number 

Configuration status: 
200 ... 207 Reserved = 0 
210 Configuration missing  The system does not contain a 

valid configuration. 
SW - SW - 

211 Configuration not released The configuration has not been 
released or the release has been 
canceled. 

✓ ✓ 

212 Configuration released The configuration has been 
released. 

✓ ✓ 

213 Reserved = 0 
214 Release denied due to 

incorrect configuration CRC 
Incorrect configuring CRC, or 
other incorrect entries, e.g., no 
time stamp, name or description 
of company  

SF F24, F16 SF, PF F24, F16

215 Release denied, already 
released 

The configuration cannot be 
released because it has already 
been released. 

✓ ✓ 

216 Release canceled The release of a configuration 
has been canceled. 

✓ ✓ 

217 Release canceled due to 
incorrect configuration 
release CRC 

The configuration release has 
been canceled because the 
configuration contains errors. 

SF F24, F16 SF, PF F24, F16

220 Max. number of elements 
exceeded 

The max. no. of system elements 
has been exceeded. 

SF F24, F8 SF, PF F24, F8 

221 Max. size of memory 
exceeded 

The maximum size of the system 
memory has been exceeded. 

SF F24, F8 SF, PF F24, F8 

222 Program cycle time 
exceeded 

The set cycle time has been 
exceeded. 

SF F24, F8 SF, PF F24, F8 

223 Reserved = 0 
224 TARGET = ACTUAL 

configuration 
The expanded system 
configuration matches the target 
configuration 

✓ ✓ 

225 TARGET≠ACTUAL 
configuration 

The expanded system 
configuration does not match the 
target configuration (e.g., 
modules swapped) 

SF F24, F27 SF, PF F24, F27 

226 TARGET≠ACTUAL slot 
expanded configuration 

The expanded system 
configuration does not match the 
target configuration (e.g., 
different number of modules) 

SF F24, F27 SF, PF F24, F27 

227 TARGET≠ACTUAL subslot 
expanded configuration 

The expanded configuration of 
the AS-i system does not match 
the configuration (e.g., different 
number of AS-i slaves) 

- ✓ 
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DS92 (device messages) 
3RK3 Basic 3RK3 Advanced 

3RK3 ASIsafe 
Byte Meaning Note 

Error 
category 

DP error 
number 

Error 
category 

DP error 
number 

230 Reserved = 0 
231 Invalid parameter value A parameter in the configuration 

contains an invalid value. 
SF F24, F16 SF, PF F24, F16 

232 Reserved = 0 
233 Interconnection rule 

violated 
At least 1 interconnection rule is 
violated. 

- SF, PF F24, F16 

234 Data structure incorrect Data has errors, e.g., data 
structure header or element data 
block header or element CRC 
non-matching.  

- SF, PF F24, F16 

235 Factory settings restored The device contains the factory 
settings. 

✓ ✓ 

236 ... 237 Reserved = 0 
24 ... 25 Reserved = 0 
260 Memory module not 

plugged in 
A memory module has not been 
plugged in. 

SF F24, F26 SF, KF F24, F26 

261 Memory module defective The memory module is defective. SF F24, F27 SF, KF F24, F27 
262 Reserved = 0 
263 Memory module 

programming successful 
The configuration data was 
successfully saved in the memory 
module. 

✓ ✓ 

264 Programming error The configuration data could not 
be saved in the memory module. 

SF F24, F27 SF, KF F24, F27 

265 Memory module too small The volume of configuration data 
is too large for the memory 
module. 

SF F24, F7 SF, KF F24, F7 

266 Reserved = 0 
267 Memory module deleted The configuring data has been 

deleted. 
✓ ✓ 

270 Reset implemented Reset implemented. ✓ ✓ 
271 Reset was not possible Reset was not possible ✓ ✓ 
272 ... 293 Reserved = 0 
294 Self-test active The system is executing a self-

test.  
✓ ✓ 

295 Self-test OK The self-test was successful. ✓ ✓ 
296 Self-test error (device error) A self-test error occurred. GF F24, F9 GF, SF F24, F9 
297 ... 33 Reserved = 0 
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DS92 (device messages) 
3RK3 Basic 3RK3 Advanced 

3RK3 ASIsafe 
Byte Meaning Note 

Error 
category 

DP error 
number 

Error 
category 

DP error 
number 

34 ... 35 Incorrect element number Element number of first element 
to be found for the parameter in 
the configuring not accepted by 
the device: 
• [0]: no incorrect element 

exists 
• [1..32767]: (unsigned int) 

element no. 

- ✓ 

DP fieldbus interface:  
360 CPU/master STOP The DP master is in STOP state. ✓ ✓ 
361 DP bus error PROFIBUS error, connection 

interrupted 
BF F19 BF F19 

362 DP parameterization error Erroneous or incorrect 
parameterization frame 

✓ BF - 

363 DP configuration error Erroneous or incorrect 
configuration frame 

✓ BF - 

364 DP process data exchange 
stopped 

Process data exchange with DP 
master stopped. 

✓ ✓ 

365 DP communication OK DP communication OK ✓ ✓ 
366 ... 377 Reserved = 0 
AS-i fieldbus interface 
380 AS-i bus error AS-i data exchange interrupted, 

substitute values in process 
image 

- BF F19 

381 AS-i parameterization error Simulated slave is not 
incorporated in the 
communication of the AS-i 
master 

- BF F19 

382 AS-i configuration error In addition, the AS-i address of 
the affected AS-i slave with the 
lowest address is entered in byte 
39. For example, set for TARGET 
≠ ACTUAL subslot expanded 
configuration 

- BF - 

383 ... 384 Reserved = 0 
385 AS-i communication OK AS-i communication is OK - ✓ 
386 ... 387 Reserved = 0 
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DS92 (device messages) 
3RK3 Basic 3RK3 Advanced 

3RK3 ASIsafe 
Byte Meaning Note 

Error 
category 

DP error 
number 

Error 
category 

DP error 
number 

39 Incorrect AS-i address AS-i address of AS-i slave 
identified as faulty by the device  
• [0x00]: no AS-i address exists 
• Bit 0... 4: address 

1 ... 31[1 ... 31] 
• Bit 5: A address [0] B address 

[1] 
• Bit 6: Standard slave [0] A/B 

slave [1] 
• Bit 7: reserved [0] 

- BF - 

40 ... 43  
440 AS-i slave function active at least one AS-i slave is being 

simulated 
- ✓ 

441 ... 447 Reserved = 0 
45 Reserved = 0 
460 AS-i monitor function active at least one AS-i slave is being 

monitored 
- ✓ 

461 ... 47 Reserved = 0 
ASIsafe: 
480 ASIsafe 8x4-bit code 

sequence monitor active 
at least one safety-related AS-i 
slave is being monitored 

- ✓ 

481 ASIsafe 7x4-bit code 
sequence generator active 

at least one safety-related AS-i 
output is being monitored 

- ✓ 

482 ASIsafe 8x4-bit code 
sequence generator active 

at least one safety-related AS-i 
sensor is being simulated 

- ✓ 

483 ASIsafe 7x4-bit code 
sequence monitor active 

at least one safety-related AS-i 
output is being simulated 

- ✓ 

484 ... 487 Reserved = 0 
490 ASIsafe code tables 

missing 
ASIsafe code tables missing. In 
addition, the (lowest) AS-i 
address is entered in byte 50 

- ✓ 

491 Multiple ASIsafe code 
tables 

More than one ASIsafe code 
table exists. In addition, the 
(lowest) AS-i address is entered 
in byte 50. 

- SPF F24, F19 

492 ASIsafe code tables new A new correct code sequence 
was received for at least one AS-i 
F slave. In addition, the (lowest) 
AS-i address is entered in byte 
50. 

- ✓ 
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DS92 (device messages) 
3RK3 Basic 3RK3 Advanced 

3RK3 ASIsafe 
Byte Meaning Note 

Error 
category 

DP error 
number 

Error 
category 

DP error 
number 

493 ASIsafe code tables known Code tables have been taught 
and stored in the memory 
module. 

- ✓ 

494 ASIsafe 8x4-bit code 
sequence error 

Error occurred while evaluating 
input slaves. In addition, the AS-i 
address is entered in byte 50. 

- SF, SPF F24, F19 

495 ASIsafe code table 
teaching active 

ASIsafe code table teaching 
active 

- ✓ 

496 ... 497 Reserved = 0 
50 AS-i address with 8x4-bit 

code sequence problem 
Lowest AS-i address in which an 
8x4-bit code sequence problem 
occurred. Code sequence 
problems are: 
Priority 1: Multiple ASIsafe code 
tables byte: 491 
Priority 2: ASIsafe 8x4-bit code 
sequence error byte: 494 
Priority 3: ASIsafe code tables 
missing byte: 490 
Priority 4: ASIsafe code tables 
new byte: 492 

- ✓ 

510 ASIsafe 7x4-bit code 
sequence error 

Error in 7x4-bit code sequences 
(MSS 3RK3 as safety-related AS-
i output). In addition, the AS-i 
address is entered in byte 52. 

- SF, SPF F24, F19 

511 ... 517 Reserved = 0 
52 AS-i address with 7x4-bit 

code sequence problem 
A problem has occurred on a 
safety-related AS-i output 

- ✓ 

53 ... 57 Reserved = 0 
Device bus interface: (SC = System Interface) 
580 SC bus error Communication error SF, BF F24, F19 SF, BF F24, F19 
581 SC parameterization error Error occurred during the transfer 

of parameters to expansion 
module. 

✓ BF - 

582 SC configuration error An expansion module cannot be 
addressed, or an unaddressed 
expansion module is installed. 

SF F24, F27 SF, BF F24, F27 

583 SC process data exchange 
stopped 

Expansion modules are not 
involved in cyclic data exchange 
(e.g., system in configuring 
mode) 

✓ ✓ 

584 SC communication OK Expansion modules in cyclic data 
exchange 

✓ ✓ 

585 ...  89 Reserved = 0 
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DS92 (device messages) 
3RK3 Basic 3RK3 Advanced 

3RK3 ASIsafe 
Byte Meaning Note 

Error 
category 

DP error 
number 

Error 
category 

DP error 
number 

Diagnosed elements 
90 ... 91 Element number for group 

error from user program  
Element number of the first 
detected element of the 
processing sequence for which a 
group error is pending:  
• [0]: for now error 
• [1 ... 32.767]: element no. 

- ✓ 

92 ... 93 Reserved = 0 
94 ... 95 Element number for group 

prewarning from user 
program  

Element number of the first 
detected element of the 
processing sequence for which a 
group error is present:  
• [0]: for now error 
• [1 ... 32.767]: element no. 

- ✓ 

96 ... 199 Reserved = 0 

✓: Supported 
-: Not supported 
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8.5 Diagnosis using AS-Interface (CTT2 protocol) 

8.5.1 Diagnostics concept using the CTT2 protocol 
For the 3RK3 central units with AS-interface, the diagnostics concept of the MSS 3RK3 
Basic is supplemented to include diagnostics of elements via AS-Interface using the CTT2 
protocol. For this purpose, the MSS 3RK3 simulates a CTT2 slave, which is interconnected 
in the logic. The diagnostics concept using the CTT2 protocol is shown in the following 
graphic: The device messages result in an entry in the cyclic data, the message data. The 
acyclic data can then be read out using a command. In these acyclic data, all elements are 
entered with their pending messages.    

 
Figure 8-4 Diagnostics concept of MSS 3RK3 with AS-i interface using CTT2 
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8.5.2 Diagnostics using the CTT2 protocol 
Diagnostics over an AS-i CTT2 channel provides access to the elements that have an error 
or whose safety sensor has been triggered. Device diagnostics using AS-i is possible with a 
simulated AS-i slave of type CTT2. This is able to process AS-i frames of type "Combined 
Transaction Type 2."   

Because both the cyclic and the acyclic "CTT2 data" are transmitted over the same CTT2 
channel, the cyclic CTT2 data transmission from the AS-i master is interrupted for 
transmission of the acyclic CTT2 data and resumed by the AS-i master automatically after 
acyclic data transmission has been completed.   

Cyclic CTT2 data transmission   
The cyclic CTT2 data transmission provides 8 bytes of input data and 8 bytes of output data 
per AS-i standard slave, which are cyclically exchanged over the CTT2 channel between the 
AS-i master and the AS-i slaves. Message data are sent by the AS-i slave to the AS-i master 
and control data are sent by the AS-i master to the AS-i slave. 

For the simulated CTT2 slave of the MSS 3RK3, the message data consist of 2 bytes of 
diagnostics data and 6 bytes of freely interconnectable signals that can be interconnected in 
the logic via terminals. The diagnostic data signal the status and the operating state of the 
MSS 3RK3 to a higher-level control. 

The MSS 3RK3 can be acknowledged with RESET via the control data. 

The transmission duration of the cyclic data transmission depends on the number of 
AS-i slaves and can be up to 1.31 s. 

Acyclic CTT2 data transmission   
The cyclic CTT2 data transmission can be interrupted by the acyclic data transmission to 
permit a precise diagnosis of the individual elements. In this way, function elements with 
errors and function elements with prewarnings can be read out. 

The acyclic CTT2 data transmission consists of up to 200 bytes of input and output data.  

The transmission duration of the acyclic data transmission depends on the number of 
AS-i slaves and can be up to 16 s. 
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8.5.3 Cyclic data 

Message data:    
For diagnostics purposes, the device provides message data through a simulated AS-i slave 
with a CTT2 channel via the cyclic CTT2 data transmission channel. These message data 
are a subset of data set 92. The following messages can be diagnosed: 

 
Process data block "device diagnostics" Byte 

Description DS92 

Note 

00 Device error 120: device error 
01 Group error 121: group error  
02 Bus error 122: bus error  
03 Group warning  123: group warning 
04 Group prewarning  124: group prewarning 
05 TARGET≠ACTUAL  ORing of: 

225: TARGET≠ACTUAL 
configuration 
226: TARGET≠ACTUAL slot 
expanded configuration 
227: TARGET≠ACTUAL subslot 
expanded configuration 

06 Group error code 
tables/sequences 

ORing of: 
490: code tables missing 
491: multiple code tables 
494: 8x4bit code sequence error 
510: 7x4bit code sequence error  

07 Reserved = 0 [0]: fix 
10 Configuring mode active 140: configuring mode active 
11 Test mode active 141: test mode active 
12 Safety mode active 142: safety mode active 
13 User program is active 143: user program is active 
14 ... 17 Reserved = 0  [0]: fix 

Device diagnostics messages 
Bit=[0]: Message not set 
Bit=[1]: Message set 

20 ...  77 SLOT3_ASI#xx-S2.0 
SLOT3_ASI#xx-S7.7 

- Signal from simulated CTT2 slave of 
MSS 3RK3 to AS-i master 

xx: AS-i address 
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 Note 
Substitute values on failure of a slave 

Depending on the AS-i master used, on failure of the AS-i bus or CTT2 slave different 
substitute values are generated by the master and transferred to the controller (0x7FFF or 
0x0000). This must be considered in the programming of the controller because otherwise 
messages will be interpreted that are not present. The same applies to the freely 
interconnectable protocol data (SLOT3_ASI#xx-Sy.z). 

If the corresponding master is used, the input data are checked word by word for the value 
0x7FFF. If the value 0x7FFF is received, the value 0x0000 must be used in the program. 

The corresponding substitute value response can be taken from the documentation of the 
master.  

The data in the MSS are not affected by this. The substitute value 0x00 is always generated 
in this case. 

 

 

Control data:   
Through a simulated AS-i slave with a CTT2 channel, an AS-i master or a controller 
connected to it can write data to the safety relay. The following data can be written to the 
safety relay through the cyclic CTT2 data transmission channel: 

 
Process data block "control data device" Byte 

Description Description 

Note 

00 Reset [->]: On pos. edge 0 -> 1, the command 
is executed once. 
[0,1]:constant value: does not cause 
command processing 

01 ... 17 Reserved=0 [0]: fix 

Device commands 

20 ... 77 SLOT3_ASI#xx-Q2.0 
SLOT3_ASI#xx-Q7.7 

- Master call (CTT2 protocol) from AS-i 
master to simulated non-safety-related 
AS-i slave (CTT2) of the MSS 3RK3 

xx: AS-i address 
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8.5.4 Acyclic data transmission with function block 
The process of transferring CTT2 data from the CPU to AS-i master is dependent on the 
master. The section that follows describes the process using the example of the DP/AS-i 
Link Advanced. If you are working with SIEMENS AS-i masters and SIMATIC S7 controllers, 
FC ASI_3422 offers a user-friendly command interface.   

 

 Note 

This FC ASi_3422 is not supported by all SIEMENS AS-i masters. You will find additional 
information in the documentation of the FC ASi_3422. 

If you are not using the FC ASi_3422, refer to the documentation of the master used and the 
following chapter on CTT2.. 

 

Block FC ASi_3422    
Calling block FC ASI_3422 enables you to both transfer commands and accept response 
data. For this purpose, FC ASi_3422 administers the calls Write_data_set and 
Read_data_set autonomously. 

When the command interface is called using command 44H, a byte string can be used to 
send a CTT2 request to the AS-i master. The master forwards the string bytes to the AS-i 
slave address specified in the transmit buffer. The AS-i master determines the number of 
string bytes to be sent to the AS-i slave (number depends on the data set to be transferred) 
on the basis of byte 2 of the transmit buffer (number of string bytes). 

The addressed AS-i slave responds to the CTT2 request with a CTT2 response. The AS-i 
master communicates this response as a byte string in the receive buffer. The structure of 
the CTT2 request or CTT2 response (code, index, etc.) begins with string byte 1 in each 
case and is not dependent on the master.  

The extended process image with the addressed AS-i slave is not transferred while string 
transfers to the AS-i are taking place.  

Depending on the type of protocol, the process of transmitting a data set to a slave may take 
up to 19 s:  

● Read DS3: up to 17 s 

● Write DS3: up to 2 s 

 

Reference 
You will find more details in the manual for the DP/AS-Interface Link Advanced (order 
number: C79000-G8900-C209-03) in the Internet 
(http://support.automation.siemens.com/WW/view/en/22710305). 

http://support.automation.siemens.com/WW/view/en/22710305�
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8.5.5 CTT2 data exchange 
Using CTT2 code 29 (1DH), data sets can be read out from the AS-i through the CTT2 
channel while carrying useful data. The read request must be acknowledged positively 
(= CTT2 code 5DH) or negatively (= CTT2 code 9DH) by the AS-i slave within a certain time. 
Transmission of the data set requested by the AS-i slave with the specified length is 
evaluated as a positive acknowledgment.   

Diagnostics with CTT2 codes   
The "Write/Read a data set" command is provided in the transmit buffer. The first three bytes 
(command header) contain the command code, slave address, and number of CTT2 bytes. 
The CTT2 data set follows this. The CTT2 data set starts with the CTT2 command code, the 
data set number, and the data set length, followed by the data set bytes DS byte 0 to DS 
byte 13. 

The DP command interface for the AS-i master accepts the data set bytes and forwards 
them to the addressed slave. These data are transmitted using the CTT2 protocol. 
MSS 3RK3 processes the CTT2 data set and prepares the requested data and answers 
using the CTT2 protocol. The AS-i master accepts the response and forwards it to the 
receive buffer of the CPU via the DP command interface. The response is decoded in the 
receive buffer of the CPU and the program is executed accordingly.  

The following responses are possible: 

● 5DH: Transmission without error (see Chapter "Element messages (Page 596)") 

● 9DH: Transmission with error, (CTT2 code that is not supported, see Chapter "Error codes 
"CTT2 error code" (Page 592)") 

● 5AH: Transmission with error (CTT2 error data set error, see Chapter "Error codes "CTT2 
error code" (Page 592)") 

1. Example of transmission without error 
The first example below demonstrates the writing of a data set using data set DS3 
"Command interface: Element accesses," with error-free transmission. 

2. Example of transmission with error because of incorrect DS number 
The second example below demonstrates the writing of a data set using data set DS3 
"Command interface: element accesses" when there is a transmission error due to incorrect 
data set number (DS 4). 
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3. Example of transmission with error because of incorrect CTT2 code 
The third example below demonstrates the writing of a data set using data set DS3 
"Command interface: element accesses" when an unknown CTT2 code (1EH) has been 
rejected: 

 
① F-PLC 
② AS-i master 
③ MSS 3RK3 with AS-i interface 

 Write DS2 

 Read DS2 

Figure 8-5 Example of transmission without error 
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① F-PLC 
② AS-i master 
③ MSS 3RK3 with AS-i interface 

 Write DS2 

 Read DS2 

Figure 8-6 Example of transmission with error because of incorrect DS number 
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① F-PLC 
② AS-i master 
③ MSS 3RK3 with AS-i interface 

 Write DS2 

 Read DS2 

Figure 8-7 Example of transmission with error because of incorrect CTT2 code 
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8.5.6 Structure of the transfer protocol 

CTT2 codes and feedback messages (request/response) 
The CTT2 slave supports the following CTT2 codes and feedback messages for transferring 
data sets:   

 
Code Meaning according to AS-i spec. 

V3.0 
Followed by 

144dec (90H) Read response not OK Standard error code 
29dec (1DH) Exchange request index, read length, write length, write data 
93dec (5DH) Exchange request OK read data 
157dec (9DH) Exchange request not OK Standard error code, data set error code 

 

 
index: Data set number; for MSS 3RK3 always 3 
read length: expected returned data; C8H 
write length: length of the data to be written 0EH 
write data: data to be transmitted, see Chapter "Diagnostics using the CTT2 protocol 

(Page 594)" 

This CTT2 data structure is defined in the AS-i specification V3.0 and therefore has the 
same structure for all AS-i masters. The various manufacturers of AS-i masters use different 
mechanisms for transferring this CTT2 data to the master, however (command interface or 
comparable methods). Please refer to the user documentation for the AS-i master for 
detailed information on this.  

The complete transmission protocol consists of the master-specific component of the 
protocol and the non-master-specific CTT2 data.  
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Acyclic CTT2 data transmission (code 29dec (1DH)) 
The acyclic CTT2 data transmission makes precise diagnostics of the individual elements 
possible. If an event is signaled through the cyclic diagnostics data, the cyclic CTT2 data 
transmission can be interrupted. The AS-i Master can read all messages of the elements 
with errors or a prewarning. The command is entered in DS3 to distinguish which error type 
is pending. You will find additional information in Chapter " Reading / writing data set 3 
(Page 594)." 

 
CTT2 code Data set Command Byte 

Elements with errors: Read 
messages 

52H exchange 29dec DS3 - command interface 
"element accesses" 

Elements with prewarnings: Read 
messages 

72H 

8.5.7 Error codes "CTT2 error code" 
If a data set is transferred with an error or rejected by the MSS 3RK3, the negative 
acknowledgment is accompanied by an "error code" explaining the reason for the negative 
acknowledgment.    

 
Figure 8-8 Error code 

Standard error code (CTT2 transmission error) 
 
CTT2 error Meaning 
0 No error, pay attention to the data set error code 
2 Impermissible length 
3 Request not implemented 
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MSS 3RK3 data set error code 
 

DS error Error message Possible causes Remedial measures 
0000H No error, pay attention to the standard error code 
80B0H Unknown data set 

number 
• DS no. not supported by 

device 
• None, since the device does not 

recognize this data set no. 

80B1H Incorrect data set 
length when writing 

• DS length ≠ specified DS 
length 

• Change DS length to match 
specified length and send DS 
again 

80B4H Incorrect data set 
length when reading 

• DS length ≠ specified DS 
length 

• Request DS with the correct 
length 

80B6H Device has rejected 
data transfer 

• Due to incorrect mode 
• Data set is read-only 
• Parameter change not 

permissible in current 
device/system operating 
mode 

Check whether  
• The correct mode is set on the 

device for the data sent 
• A data set that can only be read 

is to be written 
• A parameter has been changed 

even though it may only be 
changed in a particular operating 
mode 

80B7H Invalid value range • Value is not in the valid 
range 

• Correct the value and transmit 
again. 

80B8H Invalid parameter • Incorrect/invalid parameter 
values were received 

• Read out diagnosis DS 92 and 
ascertain the incorrect parameter 
using the "number of the 
parameter with error." 

• Change the parameter value to a 
valid one and resend. 
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8.5.8 Diagnostics using the CTT2 protocol 

8.5.8.1 Reading / writing data set 3 

Writing data set 03   
The following table shows the structure of Writing data set 03: 

 
Byte Value Explanation 
0 ... 3 21H / 00H / 00H / 00H Data set header 
4 ... 5 0AH / 00H Data structure length 
6 ... 7 00H / 00H Start position 
8 ... 9 00H / 00H Data structure CRC 
10 Command • 51H: The messages of the elements with errors are read 

• 71H: The messages of the elements with prewarnings are read 

11 ... 12 Fix 00H All elements that have a message are read. 
13 Reserved = 0 

Reading data set 03 
The following table shows the structure of Reading data set 03: 

 
Byte Value Explanation 
0 ... 3 00H / 00H / 00H / 00H Data set header 
4 ... 5 Variable Data structure length 
6 ... 7 00H / 00H Start position 
8 ... 9 CRC Data structure CRC 
10 ... 11 Number of the elements with 

a message 
Number of elements with an error or a prewarning, depending on what was 
requested. 

12 - x 1. Element data block 
x+1 to x+y 2. Element data block 

Net (useful) data: The structure of the element data blocks is written in 
Chapter "Structure of the element data blocks (Page 595)."  
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8.5.8.2 Structure of the element data blocks 
The following table shows the structure of the element data block:    

 
Byte Value Explanation 
Data block header 
0 ... 1 Element data block length The length of the element data block, including the data block header 
2 ... 3 Element number The element number is assigned by the MSS ES according to the 

configuration sequence. 
4 ... 5 Function element This object contains a number that uniquely identifies the function element, 

see Table below. 
Useful data 
6 Data 1 
7 to 5+x-1 Data 2 to x-1 
5+x Data x 

Net (useful) data: All pending messages about the element are entered here. 

 

 
Number Function element 
Decimal Hexadecimal  
4001 0FA1H Monitoring Universal 
4010 0FAAH EMERGENCY STOP 
4020 0FB4H ESPE 
4030 0FBEH Protective door 
4031 0FBFH Protective door with lock 
4040 0FC8H Safety shutdown mat with NC principle  
4041 0FC9H Safety shutdown mat with cross-circuit principle 
4050 0FD2H Two-hand operation 
4060 0FDCH Enabling button 
4070 0FE6H Mode selector switch 
12540 30FCH Counter functions 
12550 3106H Timer functions 
12560 3110H Start functions 
13002 32CAH Muting functions 
16501 4075H Switching output 
17002 426AH AS-i 1...4F-DO 
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8.5.8.3 Element messages 

Messages for Monitoring Universal 
The following table shows the messages with the associated byte arrangement in the 
element data block of the "Monitoring Universal" function element.   

 
Byte 
position 

Message Meaning Element status Cyclic data 

60 Startup test required This message is set in a parameterized 
startup test on each restart and each 
time the substitute value is changed to a 
real value until the connected sensor is 
actuated at least once. After the sensor 
has been operated correctly this 
message is automatically reset. 

SVW SVW 

61 Sequence condition 
not fulfilled 

The sequence condition was not fulfilled 
in accordance with the parameter 
assignment. This message is 
automatically reset if a correct sequence 
/ the value "0" is detected at all function 
inputs monitored. 

Logic error SF 

62 Discrepancy 
condition violated 

is set if: 
• After the discrepancy time has 

elapsed, the signal states at the 
inputs monitored are different 

• The signal states of the inputs 
monitored had not all previously been 
reset simultaneously to the value "0" 
when they are set to "1" 

Logic error SF 

63 Safety sensor 
triggered 

The safety sensor has been actuated. 
This message is automatically reset if the 
value "1" is pending at all function inputs 
IN1 ... 4 monitored. 

SVW SVW 

64 ... 67 Reserved=0 
70 Cross-circuit at input 

1 
A cross-circuit was detected at input 1. Wiring error SF 

71 ... 73 Reserved=0 
74 Cross-circuit at input 

2 
A cross-circuit was detected at input 2. Wiring error SF 

75 ... 77 Reserved=0 
80 Start signal duration 

invalid 
Only with start type "Monitored start": 
The start signal time monitoring element 
detected a violation. 

-- - 
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Byte 
position 

Message Meaning Element status Cyclic data 

81 Start condition not 
fulfilled 

is set if: 
• A sensor test was not executed in the 

case of an active startup test function 
• A discrepancy condition violation is 

present 
• The value "1" is not present 

simultaneously at all available 
(parameterized) function inputs 
(IN1, ...) 

• A signal sequence violation is present 
• A cross-circuit is present in the case 

of cross-circuit monitoring 

- - 

82 ... 87 Reserved=0 
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EMERGENCY STOP messages 
The following table shows the messages with the associated byte arrangement in the 
element data block of the "EMERGENCY STOP" function element.   

 
Byte 
position 

Message Meaning Element status Cyclic data 

00 Startup test required This message is set in a parameterized startup 
test on each restart and each time the 
substitute value is changed to a real value until 
the connected sensor is actuated at least 
once. 

SVW SVW 

01 Reserved=0 
02 Discrepancy condition 

violated 
is set if: 
• After the discrepancy time has elapsed, the 

signal states at the inputs monitored are 
different 

• The signal states of the inputs monitored 
had not all previously been reset 
simultaneously to the value "0" when they 
are set to "1" 

Logic error SF 

03 Safety sensor triggered The safety sensor has been actuated. SVW SVW 
04 ... 07 Reserved=0 
10 Cross-circuit at input 1 A cross-circuit was detected at input 1. Wiring error SF 
11 ... 13 Reserved=0 
14 Cross-circuit at input 2 A cross-circuit was detected at input 2. Wiring error SF 
15 ... 17 Reserved=0 
20 Start signal duration 

invalid 
Only with start type "Monitored start": 
The start signal time monitoring element 
detected a violation. 

- - 

21 Start condition not 
fulfilled 

is set if: 
• A sensor test was not executed in the case 

of an active startup test function 
• A discrepancy condition violation is present
• The value "1" is not present simultaneously 

at all available (parameterized) function 
inputs (IN1, ...) 

• A cross-circuit is present in the case of 
cross-circuit monitoring 

- - 

22 ... 27 Reserved=0 
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Messages for ESPE 
The following table shows the messages with the associated byte arrangement in the 
element data block of the "ESPE" function element.   

 
Byte 
position 

  Message Meaning Element status Cyclic data 

 60 Startup test required This message is set in a parameterized 
startup test on each restart and each time 
the substitute value is changed to a real 
value until the connected sensor is actuated 
at least once. 

SVW SVW 

61 Reserved = 0 
62 Discrepancy condition 

violated 
is set if: 
• The signal states of the inputs monitored 

had not all previously been reset 
simultaneously to the value "0" when they 
are set to "1" 

Logic error SF 

63 Safety sensor triggered The safety sensor has been actuated. SVW SVW 
64 ... 67 Reserved=0 
70 Cross-circuit at input 1 A cross-circuit was detected at input 1. Wiring error SF 
71 ... 73 Reserved=0 
74 Cross-circuit at input 2 A cross-circuit was detected at input 2. Wiring error SF 
75 ... 77 Reserved=0 
80 Start signal duration 

invalid 
Only with start type "Monitored start": 
The start signal time monitoring element 
detected a violation. 

- - 

81 Start condition not fulfilled is set if: 
• A sensor test was not executed in the 

case of an active startup test function 
• A discrepancy condition violation is 

present 
• The value "1" is not present 

simultaneously at all available 
(parameterized) function inputs (IN1, ...) 

• A cross-circuit is present in the case of 
cross-circuit monitoring 

- - 

82 ... 87 Reserved=0 
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Messages for protective door 
The following table shows the messages with the associated byte arrangement in the 
element data block of the "protective door" function element.   

 
Byte 
position 

  Message Meaning Element status Cyclic data 

60 Startup test required This message is set in a 
parameterized startup test on 
each restart and each time the 
substitute value is changed to a 
real value until the connected 
sensor is actuated at least once. 

SVW SVW 

61 Sequence condition not 
fulfilled 

The sequence condition was not 
fulfilled in accordance with the 
parameter assignment. 

Logic error SF 

62 Discrepancy condition 
violated 

is set if: 
• After the discrepancy time 

has elapsed, the signal 
states at the inputs 
monitored are different 

• The signal states of the 
inputs monitored had not all 
previously been reset 
simultaneously to the value 
"0" when they are set to "1" 

Logic error SF 

63 Safety sensor triggered The safety sensor has been 
actuated. 

SVW SVW 

64 ... 67 Reserved=0 
70 Cross-circuit at input 1 A cross-circuit was detected at 

input 1. 
Wiring error SF 

71 ... 73 Reserved=0 
74 Cross-circuit at input 2 A cross-circuit was detected at 

input 2. 
Wiring error SF 

75 ... 77 Reserved=0 
80 Start signal duration 

invalid 
Only with start type "Monitored 
start": 
The start signal time monitoring 
element detected a violation. 

- - 
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Byte 
position 

  Message Meaning Element status Cyclic data 

81 Start condition not 
fulfilled 

is set if: 
• A sensor test was not 

executed in the case of an 
active startup test function 

• A discrepancy condition 
violation is present 

• The value "1" is not present 
simultaneously at all 
available (parameterized) 
function inputs (IN1, ...) 

• A signal sequence violation 
is present 

• A cross-circuit is present in 
the case of cross-circuit 
monitoring 

- - 

82 ... 87 Reserved=0 
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Message for protective door with lock 
The following table shows the messages with the associated byte arrangement in the 
element data block of the "protective door with lock" function element.   

 
Byte 
position 

  Message Meaning Element status Cyclic data 

60 Startup test required This message is set in a 
parameterized startup test on each 
restart and each time the substitute 
value is changed to a real value until 
the connected sensor is actuated at 
least once. 

SVW SVW 

61 Sequence condition not 
fulfilled 

The sequence condition was not 
fulfilled in accordance with the 
parameter assignment. 

Logic error SF 

62 Discrepancy condition 
violated 

is set if: 
• After the discrepancy time has 

elapsed, the signal states at the 
inputs monitored are different 

• The signal states of the inputs 
monitored had not all previously 
been reset simultaneously to the 
value "0" when they are set to "1"

Logic error SF 

63 Safety sensor triggered The safety sensor has been 
actuated. 

SVW SVW 

64 Protective door closed The protective door is closed. - - 
65 Reserved=0 
66 Lock engaged The lock is engaged. - - 
67 Lock released The lock is released. - - 
70 Cross-circuit at input 1 A cross-circuit was detected at input 

1. 
Wiring error SF 

71 ... 73 Reserved=0 
74 Cross-circuit at input 2 A cross-circuit was detected at input 

2. 
Wiring error SF 

75 ... 77 Reserved=0 
80 Start signal duration invalid Only with start type "Monitored 

start": 
The start signal time monitoring 
element detected a violation. 

- - 
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Byte 
position 

  Message Meaning Element status Cyclic data 

81 Start condition not fulfilled is set if: 
• A sensor test was not executed 

in the case of an active startup 
test function 

• A discrepancy condition violation 
is present 

• The value "1" is not present 
simultaneously at all available 
(parameterized) function inputs 
(IN1, ...) 

• A signal sequence violation is 
present 

• A cross-circuit is present in the 
case of cross-circuit monitoring 

- - 

82 Start override active The start override time is running. - - 
83 ... 93 Reserved=0 
94 Feedback circuit signal 

and switching status do not 
match 

The feedback circuit signal does not 
match the interlock status  

Wiring error SF 

95 Protective door opened 
when lock was active 

The protective door opened when 
lock was active. 

Wiring error SF 

96 Locking not possible 
because the protective 
door is open 

Locking not possible because the 
protective door is open. 

Logic error SF 

97 Reserved=0 
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Messages for safety shutdown mat (NC principle) 
The following table shows the messages with the associated byte arrangement in the 
element data block of the "safety shutdown mat with NC principle" function element.   

 
Byte 
position 

  Message Meaning Element status Cyclic data 

60 Startup test required This message is set in a 
parameterized startup test on 
each restart and each time the 
substitute value is changed to a 
real value until the connected 
sensor is actuated at least once. 

SVW SVW 

61 Reserved = 0 
62 Discrepancy condition 

violated 
is set if: 
• The signal states of the 

inputs monitored had not all 
previously been reset 
simultaneously to the value 
"0" when they are set to "1" 

Logic error SF 

63 Safety sensor triggered The safety sensor has been 
actuated. 

SVW SVW 

64 ... 67 Reserved=0 
70 Cross-circuit at input 1 A cross-circuit was detected at 

input 1. 
Wiring error SF 

71 ... 73 Reserved=0 
74 Cross-circuit at input 2 A cross-circuit was detected at 

input 2. 
Wiring error SF 

75 ... 77 Reserved=0 
80 Start signal duration invalid Only with start type "Monitored 

start": 
The start signal time monitoring 
element detected a violation. 

- - 

81 Start condition not fulfilled is set if: 
• A sensor test was not 

executed in the case of an 
active startup test function 

• A discrepancy condition 
violation is present 

• The value "1" is not present 
simultaneously at all 
available (parameterized) 
function inputs (IN1, ...) 

• A cross-circuit is present in 
the case of cross-circuit 
monitoring 

- - 

82 ... 87 Reserved=0 
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Messages for safety shutdown mat (cross-circuit principle) 
The following table shows the messages with the associated byte arrangement in the 
element data block of the "safety shutdown mat with cross-circuit principle" function element.   

 
Byte 
position 

  Message Meaning Element status Cyclic data 

60 Startup test required This message is set in a 
parameterized startup test on each 
restart and each time the 
substitute value is changed to a 
real value until the connected 
sensor is actuated at least once. 

SVW SVW 

61 ... 62 Reserved=0 
63 Safety sensor triggered The safety sensor has been 

actuated. 
SVW SVW 

64 ... 67 Reserved=0 
70 Wire break at input 1 A cross-circuit was detected at 

input 1. 
Wiring error SF 

71 Short circuit to P at input 1 A short-circuit to P was detected at 
input 1. 

Wiring error SF 

72 ... 73 Reserved=0 
74 Wire break at input 2 A cross-circuit was detected at 

input 2. 
Wiring error SF 

75 Short circuit to P at input 2 A short-circuit to P was detected at 
input 2. 

Wiring error SF 

76 ... 77 Reserved=0 
80 Start signal duration invalid Only with start type "Monitored 

start": 
The start signal time monitoring 
element detected a violation. 

- - 

81 Start condition not fulfilled is set if: 
• A sensor test was not 

executed in the case of an 
active startup test function 

• The value "1" is not present 
simultaneously at all available 
(parameterized) function inputs 
(IN1, ...) 

• A cross-circuit is present 

- - 

82 ... 87 Reserved=0 
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Messages for two-hand operation 
The following table shows the messages with the associated byte arrangement in the 
element data block of the "two-hand operation" function element.   

 
Byte 
position 

  Message Meaning Element status Cyclic data 

60 ... 61 Reserved=0 
62 Discrepancy 

condition violated 
is set if: 
• After the discrepancy time 

has elapsed, the signal 
states at the inputs 
monitored are different within 
one or between to two 
pushbuttons. 

• The signal states of the 
inputs monitored had not all 
previously been reset 
simultaneously to the value 
"0" when they are set to "1" 

Logic error SF 

63 Bushbutton stuck  The pushbutton is stuck. Logic error SF 
64 Do not release both 

pushbuttons 
The two pushbuttons were not 
released simultaneously. 

Logic error SF 

65 ... 67 Reserved=0 
70 Cross-circuit at input 

1 
A cross-circuit was detected at 
input 1. 

Wiring error SF 

71 ... 73 Reserved=0 
74 Cross-circuit at input 

2 
A cross-circuit was detected at 
input 2. 

Wiring error SF 

75 ... 80 Reserved=0 
81 Start condition not 

fulfilled 
is set if: 
• If both pushbuttons were not 

pressed "synchronously," 
that is, they were pressed 
with a time offset greater 
than 0.5 s 

• A discrepancy condition 
violation is present 

• The value "1" is not present 
simultaneously at IN1 ... 2 / 4

• A cross-circuit is present 

- - 

82 ... 87 Reserved=0 
90 Cross-circuit at input 

3 
A cross-circuit was detected at 
input 3. 

Wiring error SF 

91 ... 93 Reserved=0 
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Byte 
position 

  Message Meaning Element status Cyclic data 

94 Cross-circuit at input 
4 

A cross-circuit was detected at 
input 4. 

Wiring error SF 

95 ... 97 Reserved=0 
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Messages for enabling button 
The following table shows the messages with the associated byte arrangement in the 
element data block of the "enabling button" function element.   

 
Byte 
position 

  Message Meaning Element status Cyclic data 

60 ... 61 Reserved=0 
62 Discrepancy 

condition violated 
is set if: 
The signal states of the inputs 
monitored had not all previously 
been reset simultaneously to the 
value "0" when they are set to "1" 

Logic error SF 

63 Bushbutton stuck  One pushbutton on the operating 
console is stuck. 

Logic error SF 

64 Enabling button OFF The enabling button has the status 
OFF. 

- - 

65 Enabling button ON The enabling button has the status 
ON. 

- - 

66 ... 67 Reserved=0 
70 Cross-circuit at input 

1 
A cross-circuit was detected at 
input 1. 

Wiring error SF 

71 ... 73 Reserved=0 
74 Cross-circuit at input 

2 
A cross-circuit was detected at 
input 2. 

Wiring error SF 

75 ... 80 Reserved=0 
81 Start condition not 

fulfilled 
is set if: 
• A discrepancy condition 

violation is present 
• The value "1" is not present 

simultaneously at all available 
(parameterized) function inputs 
(IN1, ...) 

• A cross-circuit is present 

- - 

82 ... 87 Reserved=0 
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Messages for mode selector switch 
The following table shows the messages with the associated byte arrangement in the 
element data block of the "mode selector switch" function element.   

 
Byte 
position 

  Message Meaning Element status Cyclic data 

60 Reserved=0 
61 Switchover time exceeded The "1 out of 2...5 selection 

monitoring" has detected the 
value "0" at all inputs after the 
contact switchover time has 
elapsed. 

- - 

62 Invalid operating mode 
selection 

The "1 out of 2...5 selection 
monitoring" has detected after 
the contact switchover time has 
elapsed: 
The value "1" is present at more 
than one input. 

Wiring error SF 

63 ...  87 Reserved=0 
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Messages for the muting functions 
The following table shows the messages with the associated byte arrangement in the 
element data block of the "muting" function element.   

 
Byte position   Message Meaning Element status Cyclic data 
60 Muting operation active Muting mode is activated. - - 
61 Muting operation not active Muting mode is not activated. - - 
62 Muting restart possible Muting mode was not terminated 

correctly, i.e. at least one muting 
sensor is still being triggered. 

- - 

63 Restart signal duration 
invalid  

The "Muting restart possible" message 
is set and, the first time the RESTART 
button is pressed, the expected 
operating sequence does not follow. 

- - 

64 Protective field not free The value "0" is present at the "FREE" 
function input. 

- - 

65 System not running The value "1" is present at the "STOP" 
function input. 

- - 

66 Start muting condition not 
met 

Not all conditions for operational 
starting of muting using muting 
sensors are met. 

- - 

67 Max. muting time 
exceeded 

Muting operation terminated because 
"max. muting time" expired. 

Logic error SF 

70 Discrepancy condition 
sensor pair 1 violated 

A discrepancy violation was detected 
in the signals of muting sensor pair 1. 

Logic error SF 

71 Discrepancy condition 
sensor pair 2 violated 

A discrepancy violation was detected 
in the signals of muting sensor pair 2. 

Logic error SF 

72 Sequence condition not 
fulfilled 

The sequence condition was not 
observed. 

Logic error SF 

73 Reserved=0 
74 Muting display lamp 

defective 
The muting display lamp - monitoring 
function has detected an error. 

Wiring error SF 

75 ... 77 Reserved=0 
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Messages for output functions 
The following table shows the messages with the associated byte arrangement in the 
element data block of the "switching output" function element.   

 
Byte 
position 

  Message Meaning Element status Cyclic data 

60 Output 1 active Function output 1 is 
switched on. 

- - 

61 ... 62 Reserved=0 
63 Output 2 active Function output 2 is 

switched on. 
- - 

64 ... 65 Reserved=0 
66 Feedback circuit signal 

and switching status do 
not match 

The message at the 
feedback circuit input 
does not match the 
switching status of the 
function outputs. 
The output function 
immediately deactivates 
all its outputs in case of 
inconsistencies. 

Wiring error SF 

67 ... 72 Reserved=0 
73 Start condition not 

fulfilled 
is set if: 
• there is a feedback 

circuit error when 
feedback circuit 
monitoring is 
activated. 

• the value "0" is 
pending at the 
function input (IN). 

- - 

74 ... 76 Reserved=0 
77 Start signal duration 

invalid 
Only with start type 
"Monitored start": 
The start signal time 
monitoring element 
detected a violation. 

- - 
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Messages for AS-i 1..4F-DO 
The following table shows the messages with the associated byte arrangement in the 
element data block of the "AS-i 1...4F-DO" function element.   

 
Byte position   Message Meaning Element status Cyclic data 
60 Output 1 active Function output 1 is 

switched on. 
- - 

61 Output 2 active Function output 2 is 
switched on. 

- - 

62 Output 3 active Function output 3 is 
switched on. 

- - 

63 Output 4 active Function output 4 is 
switched on. 

- - 

64 Feedback circuit signal 1 
and switching status do 
not match 

The signal at feedback 
circuit input 1 and the 
switching status of 
function output 1 do not 
match.  
In case of inconsistencies, 
the output function 
immediately switches off 
all its outputs.  

Wiring error SF 

65 Feedback circuit signal 2 
and switching status do 
not match 

The signal at feedback 
circuit input 2 and the 
switching status of 
function output 2 do not 
match.  
In case of inconsistencies, 
the output function 
immediately switches off 
all its outputs.  

Wiring error SF 

66 Feedback circuit signal 3 
and switching status do 
not match 

The signal at feedback 
circuit input 3 and the 
switching status of 
function output 3 do not 
match.  
In case of inconsistencies, 
the output function 
immediately switches off 
all its outputs.  

Wiring error SF 

67 Feedback circuit signal 4 
and switching status do 
not match 

The signal at feedback 
circuit input 4 and the 
switching status of 
function output 4 do not 
match.  
In case of inconsistencies, 
the output function 
immediately switches off 
all its outputs.  

Wiring error SF 
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Byte position   Message Meaning Element status Cyclic data 
70 Invalid output selection The value "1" was 

detected on more than 
one input IN1 ... 4 by the 
"1 out of 4 - selection 
monitoring." 

Logic error SF 

71 ... 72 Reserved=0 
73 Start condition not fulfilled is set if: 

• there is a feedback 
circuit error when 
feedback circuit 
monitoring is active. 

• the logic error "Invalid 
output selection" is 
pending. 

• The value "1" is not 
present simultaneously 
at all available 
(parameterized) 
function inputs (IN1, 
...). 

- - 

74 Auxiliary control signal 1 
transmitted* 

Auxiliary control signal 1 
was transmitted with value 
"1." 

- - 

75 Auxiliary control signal 2 
transmitted* 

Auxiliary control signal 2 
was transmitted with value 
"2." 

- - 

76 Reserved=0 
77 Start signal duration 

invalid 
Only with start type 
"Monitored start": 
The start signal time 
monitoring element 
detected a violation. 

- - 

* The message is active if the auxiliary signal has been transmitted and a "1" is present at the corresponding auxiliary signal 
input of the element. 
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8.5.8.4 Element status 
The following table explains each element status with the associated byte position element 
data block:  

 
Byte 
position 

  Message Meaning / Remedy DS 92 

60 At least one function 
output active 

At least one function output is active. - 

61 Function element ready 
and waiting for a start 
signal 

The function element is ready and is waiting for a start signal. - 

62 Timer is active Is set if at least one of the timers identified with the clock icon is 
running.  
The input delay time is an exception to this because this timer 
is always active. 

- 

63 Function element 
waiting for startup test 

A startup test is required for the corresponding function 
element. Read the element messages. 

- 

64 Logic error At least one logic error is pending, e.g.: 
• Discrepancy error 
• Sequence error 
Read the element messages. 

Logic error 

65 Wiring error At least one wiring error is pending, e.g.: 
• Cross-circuit fault 
Read the element messages. 

Wiring error 

66 ... 67 Reserved=0 
70 (Element) group error There is at least one error message among the element 

messages. Read the element messages. 
SF from user 
program 

71 (Element) group 
warning 

There is at least one warning message among the element 
messages. Read the element messages. 

SW from user 
program 

72 (Element) group 
prewarning 

There is at least one prewarning message among the element 
messages. Read the element messages. 

SVW from user 
program 

73 ... 74 Reserved=0 
75 Substitute input value 

active 
At least one input terminal has failed, e.g. because of:  
• Module / terminal is missing / defective 
• Module / terminal is incorrectly configured 
• Code sequence error 
• Missing code table 
If an element has multiple input terminals, work continues with 
the substitute value for the failed terminal only. The real value 
is used for all the other input terminals.  
Read the element messages. 

- 

76 ... 77 reserved 
80 to x7 reserved 
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8.6 Diagnostics with diagnostics display 

8.6.1 Diagnostics display 

 
Figure 8-9 Diagnostics display of the MSS 3RK3 

A diagnostics display is available for the MSS 3RK3 that is able to display the current 
messages, diagnostics data, and status information of the monitored system. It also contains 
all status LEDs present on the basic unit and makes the system interface easily accessible 
outside of the control cabinet.    

 

 Note 
MSS 3RK3 Advanced/ MSS 3RK3 ASIsafe basic/ MSS 3RK3 ASIsafe extended 

These three 3RK3 central units are supported by the diagnostics display with product version 
E03 and firmware version V1.1.x and higher. 

MSS 3RK3 Basic is supported by the diagnostics display with product version E01 and 
higher. 
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 Note 
Access from MSS ES via PROFIBUS and diagnostics display 

If the access from MSS ES to the MSS 3RK3 is by means of PROFIBUS, the diagnostics 
display must have, at a minimum, product version 3 (E03) or firmware version1) V1.1.x, as 
well as the MSS ES 2008 SP3. 

If an access path is established by the MSS ES over an extended period or the device is 
switched to test mode, the display is disabled and outputs a corresponding message. The 
display restarts automatically once this status ends. 

 

1) The firmware version can be read at the startup of the display or at the bottom left when 
the display is disabled. In addition, it is shown by selecting menu command "Display settings 
/ Identification". (see also Chapter "Display settings (Page 633)") 

 

The pending messages/errors can be read and acknowledged with the keys, current status 
information is shown on the display. The display can also be set for different ambient 
conditions. 

All of the following is available: 

● 4 keys for navigating the display menu, 2 keys are softkeys with different functions (e.g., 
test/reset) 

● 1 graphical display 

● 3 LEDs (DEVICE, BF, SF) 

The diagnostic display can be connected directly to the central unit/interface module through 
the rear system interface. It is powered from the 3RK3 central unit. Via the system interface 
on the front (with a cover cap for IP54), a PC or programming device can be connected to 
MSS ES with a PC cable. 

 
 

CAUTION  
The diagnostics display must only be removed or connected when the system is de-
energized! 

 

 

"Park position" for cover 
The cover can be "parked" on the front of the diagnostics display under the system interface. 
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8.6.2 Displays 
On the display, you can read current operating and diagnostics data as well as status 
information of the MSS 3RK3 in plaintext.   

SIRIUS 3RK3
DEVICE

BF

SF

XXXX

 
Display on the diagnostic display 

Display ① 
Messages and status information of the MSS 3RK3 can be displayed in plaintext here. Short 
values (e.g.: plant identifiers) are displayed directly under the heading, long texts (e.g. the 
comment) are shown in a submenu. It can be seen on the (OK) key that a submenu can be 
launched. 

Scrollbar ② 
As shown in the graphic, this bar shows whether there are any more menu items or 
messages. These items can be selected and displayed using the arrow keys. 

If no other entries are present, the inside of the bar is black. 

Function of the softkeys ③ 
Displays the current function of the two softkeys. 

Possible displays: 

 
Key left (meaning) Key right (meaning) 
⇑ (moves you one menu level higher)  OK (selects / confirms) 
 Reset (acknowledges error) 
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8.6.3 Operator controls and displays 

SIRIUS 3RK3
DEVICE

BF

SF

 
Figure 8-10 Display and operating elements on the diagnostics display 

   

Two arrow keys ①  
They serve to navigate the menu or change the display settings, e.g. to change the contrast 
setting or to scroll through displayed content. 

Two softkeys ② 
They can have different functions depending on the menu displayed (e.g. open menu, exit 
menu, reset). The current assigned functions are displayed on the bottom left or right of the 
display. 

LED displays ③ 
 
LED Meaning 
DEVICE Status 
BF Bus error 
SF Group error 

Reference 
You will find additional information in Chapter " Displays on diagnostic display (Page 508)." 
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8.6.4 Menus 
You can navigate the menu with the arrow keys and softkeys. Any menu option may have 
additional sub-menus. The menu structure and display are in part directly dependant on the 
device parameterization (e. g. selected control function) and hardware configuration (e.g. 
type and number of expansion modules used).   

 

 Pressing of the softkeys 

 Pressing of the arrow keys 

Figure 8-11 First level of the menu of the diagnostics display 
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Status display ① 
The "status display" is the standard display of the diagnostics display. It displays the 
equipment identifier, the operating status and the status of the configuration. 

You can navigate to the individual menus via the right softkey (OK). With the left softkey 
(reset), pending errors can be acknowledged directly. 

If messages are pending, they are displayed directly, that is, the diagnostics menu switches 
directly to the message menu and to the message with the highest priority. This function can 
be deactivated via the display settings. If multiple messages are pending, they are displayed 
as a list that is visible on the scrollbar on the right side of the display. You can scroll to the 
individual messages with the arrow keys. 

Messages ② 
The "Messages" menu provides an overview of all current pending error messages and 
warnings for the entire system. 

You will find detailed information in Chapter "Messages (Page 621)" 

Status ③ 
The "Status" menu displays all relevant status information and messages for the configured 
function elements. Pending messages can be acknowledged after they are dealt with. 

You will find detailed information in Chapter "Status (Page 626)" 

System configuration ④ 
The "System configuration" menu provides all relevant information for configuration and for 
the individual modules. 

You will find detailed information in Chapter "System configuration (Page 630)" 

Display settings ⑤ 
All settings affecting the diagnostics display can be made via the "Display settings" menu. In 
addition to selecting the language and adjusting contrast and brightness, it is also possible to 
reset to the default settings.   

You will find detailed information in Chapter "Display settings (Page 633)" 

About MSS ⑥ 
The "About MSS" menu option provides more information on MSS 3RK3. 



 Diagnostics / service 
 8.6 Diagnostics with diagnostics display 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 621 

8.6.4.1 Messages 
The "Messages" menu option provides an overview of all current pending error messages 
and warnings for the entire system.   

 

 Pressing of the softkeys 

 Pressing of the arrow keys 

Figure 8-12 Second level of the menu of the diagnostics display - "Messages" menu option 
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Message categories 
The following message categories may be displayed, according to the cause of error: 

● Device errors ② 

● Group errors ③ 

● Bus errors ④ 

● Group warning ⑤ 

● Group prewarning ⑥ 

If multiple errors from different categories are pending, you can switch between the individual 
error categories with the arrow keys. 

Errors and error causes 
You can access the pending error messages by pressing the right key (OK). 

With some errors, a distinction is made between different causes, e.g., in the case of group 
errors. In this case, the cause can be displayed as a plaintext message with the right key 
(OK): 

If multiple errors/error causes from different categories are pending, you can switch between 
the individual messages categories with the arrow keys. 

With the left key, the display moves up one menu level. 

Acknowledging errors   
For individual errors, you can switch directly to the applicable function element in the status 
menu by marking the error message with the arrow keys and by pressing the right key (OK). 

You can switch to the status display for the affected function element when the following 
messages occur: 

● Group prewarning from user program 

● Group warning from user program 

● Wiring error 

● Logic error 

● Group error from user program 

In the "Status" menu, you can acknowledge the error after having dealt with it with the right 
key (reset). 

Device errors ②  
Possible causes for device errors/self-test errors are: 

● Faulty input or output 

● Defective module 
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Group errors ③  
The following group errors can be diagnosed: 

 
Message Meaning(s) 
Configuration error1) • Memory module not plugged in 

• SC configuration error (Basic) 
• Memory module defective (Advanced/ASIsafe) 
• Memory module too small (Advanced/ASIsafe) 

Configuration error1) An error occurred during the configuration phase: 
• Release denied due to incorrect configuration CRC 
• Release canceled due to incorrect configuration release CRC 
• Max. number of elements exceeded 
• Max. size of memory exceeded 
• Program cycle time exceeded 
• TARGET≠ACTUAL configuration 
• TARGET≠ACTUAL slot expanded configuration 
• Invalid parameter value 
• Interconnection rule violated 
• Data structure incorrect 
You will find more information in Chapter "Diagnostics with MSS ES 
(Page 525)" 

Safety protocol error • Multiple ASIsafe code tables 
• ASIsafe 8x4-bit code sequence error 
• ASIsafe 7x4-bit code sequence error 

Wiring error2) Faulty wiring of a sensor connection or in the sensor itself. 
Logic error2) Protection fault: Processing sequence on the sensor not coherent. 
Handshake error An error was detected during connection monitoring in test mode. 
Group error from user 
program2) 

At least one error from the user program is present. 

SC bus error Communication via the device bus interface is interrupted. 
SC configuration error 
(Advanced/ASIsafe) 

The actual configuration of an existing communication connection does 
not match the target configuration. This resulted in an error. 

Memory module defective 
(Basic) 

Memory module is defective. 

Memory module too small 
(Basic) 

More configuration data were transferred to the safety relay than can be 
stored in the memory module. 

1) Different error causes are possible. The cause is displayed by pressing the right key (OK).  
2) Pressing the right key (OK) switches the diagnostics display directly to the relevant function 

element in the status menu. 
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Bus errors ④  
The following bus errors can be diagnosed: 

 
Message Meaning 
DP bus error Communication via the fieldbus interface PROFIBUS DP is 

interrupted. 
DP parameterization error An error occurred during parameterization for an existing 

communication connection. 
DP configuration error The actual configuration of an existing communication connection 

does not match the target configuration. This resulted in an error. 
ASi bus error Communication via the AS-i interface is interrupted. 
ASi parameterization error An error occurred during parameterization for an existing 

communication connection. 
ASi configuration error The actual configuration of an existing communication connection 

does not match the target configuration. This resulted in an error. 
SC bus error Communication via the device bus interface is interrupted. 
SC parameterization error An error occurred during parameter assignment for an existing 

communication connection. 
SC configuration error The actual configuration of an existing communication connection 

does not match the target configuration. This resulted in an error. 

Group warning ⑤  
The following group warnings can be diagnosed: 

 
Message Meaning 
Disconnect The monitoring time has been exceeded During monitoring time, the 

safety relay has not received any data set from the communication 
partner with write access to the safety relay. 

Group warning from user 
program1) 

At least one warning from the user program is present. 

Configuration missing No valid configuration is stored in the safety relay. 

1) Pressing the right key (OK) switches the diagnostics display directly to the element in the status 
menu. 



 Diagnostics / service 
 8.6 Diagnostics with diagnostics display 

Modular Safety System 3RK3 

System Manual, 06/2012, 9262530-02 Rev 004 625 

Group prewarning ⑥  
The following group prewarnings can be diagnosed: 

 
Message Meaning 
User program stopped. The safety relay is not processing the safety circuit. 
Group prewarning from user 
program 1) 

At least 1 configured function element has a group prewarning. 

1) Pressing the right key (OK) switches the diagnostics display directly to the element in the status 
menu. 
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8.6.4.2 Status 

Selection of the individual functions 
The status display makes a distinction between input elements ②, output elements ③, and 
other elements ④.   

 

 Pressing of the softkeys 

 Pressing of the arrow keys 

Figure 8-13 Second level of the menu of the diagnostics display - "Status" menu option 

In the respective submenu, either  

● all function elements, 

● function elements with an error, or 

● function elements without an error 

can be displayed as a list. 

To differentiate between like function elements, the function elements are each displayed 
with their name, number, and element type in MSS ES. The name remains in the first line 
when navigating the submenu. 
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Status information and error acknowledgment  
You can select the marked function element with the right key (OK) to display status 
information and any pending messages. 

If several error messages are pending, you can scroll up and down to the individual 
information via the arrow keys. The error can be acknowledged with the right key (reset) 
after the cause of the error has been remedied. 

 

 Note 

In the process, some of the information directly depends on the parameterized function 
element of the individual inputs and outputs, as well as the hardware configuration of MSS 
3RK3, and may vary. 

 

Possible status information   
The following status information can be diagnosed: 

● Substitute input value active 

● At least one function output active 

● Waiting for start signal 

● Timer is active 

● Waiting for startup test 

● Logic error 

● Wiring error 

● Hardware fault 

● Group error 

● Group warning 

● Group prewarning 
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Possible element messages   
The following element messages can be diagnosed: 

● Pushbutton stuck 

● Do not release both pushbuttons 

● Safety sensor triggered 

● Protective door closed 

● Lock engaged 

● Lock released 

● Start override active 

● Protective door opened when interlock was active 

● Interlock not possible because the protective door is open 

● Muting operation active 

● Muting operation not active 

● Muting restart possible 

● Restart signal duration invalid 

● Protective field not free 

● System not running 

● Start muting condition not met 

● Max. muting time exceeded 

● Discrepancy condition sensor pair n violated 

● Muting indicator light defective 

● Output n active 

● Invalid output selection 

● Auxiliary control signal n active 

● Reset active 

● Startup test required 

● Sequence condition not fulfilled 

● Discrepancy condition violated 

● Cross-circuit at input n/output n 

● Start signal duration invalid 

● Start condition not fulfilled 

● Wire break at input n 

● Synchronous operation time exceeded 

● Enabling button OFF/ON 

● Switchover time exceeded 
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● Invalid operating mode selection 

● Incoming/outgoing alarm 

● Counter limit value exceeded/undershot 

● Last count pulse was up/down 

● OFF delay active 

● ON delay active 

● Passing make pulse contact active 

● Clock-pulse generator active 

● Standby time is ON 

● Control mode selection invalid 

● Output n active 

● Output n overloaded 

● Output n defective 

● Feedback circuit signal n and switching status do not match 

Reference 
You will find additional information about the meaning of the messages in Chapter 
"Diagnostics with MSS ES (Page 525)" 
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8.6.4.3 System configuration 

Structure of the menu    

 

 Pressing of the softkeys 

 Pressing of the arrow keys 

Figure 8-14 Second level of the menu of the diagnostics display - "System configuration" menu 
option 

Information on the following topics is provided in the "System configuration" menu: 

● Marking ② 

● Project ③ 

● Slot 2 (DP interface if present) ④ 

● Slot 3 (central unit) ⑤ 

● Slot 4 ... n (max. 12) ⑥ 

You can select the marked menu with the right key (OK), thereby displaying information. 

With the left key, the display moves back one menu level. 
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Marking 
The following plant information is available: 

● Plant identifier 

● Location identifier 

● Installation date 

● Description 

● Author 

● Comment 

Project 
The following project information is available: 

● Project name 

● Name of configuration engineer 

● Company name 

● Config CRC 

● Time stamp 

● Configuration released 

● Cycle time 

● Number of slot modules 

● Number of elements 

Slot 2 (DP interface) 
The following information on the DP interface is available: 

● Equipment identifier (BMK)  

● Order No. (MLFB) 

● DP address 

● Short designation 

● HW revision level 

● FW revision level 

● Time stamp 
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Slot 3 (central unit) 
The following project information about the 3RK3 central unit is available: 

● Equipment identifier (BMK) 

● Order No. (MLFB) 

● Short designation 

● HW revision level 

● FW revision level 

● Time stamp 

Slot 4 ... y 
The following information on the expansion modules is available: 

● Equipment identifier (BMK) 

● Order No. (MLFB) 

● FW revision level 
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8.6.4.4 Display settings 
All settings affecting the diagnostics display can be made via the display settings.  

 

 Pressing of the softkeys 

 Pressing of the arrow keys 

Figure 8-15 Second level of the menu of the diagnostics display - "Display settings" menu option 
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In this menu, you will also find information on the diagnostics display itself. The display 
settings can be reset to the default setting in the "Factory settings" menu option.   

You can access the individual submenus by pressing the right key (OK): 

● Identification ② 

● Languages ③ 

● Contrast ④ 

● Lighting ⑤ 

● Return to the status display ⑥ 

● Invert display ⑦ 

● Messages ⑧ 

● Factory settings ⑨ 

With the left key, the display moves back one menu level. 

Identification ② 
The following information for identifying the diagnostics display is to be found here: 

● MLFB (order number) 

● Hardware version (HW revision level) 

● Firmware version (FW revision level) 

Languages ③ 
The following languages can be selected: 

● English (default setting) 

● German 

● French 

● Spanish 

● Italian 

● Portuguese 

The desired language can be marked with the arrow keys. The right key (OK) selects the 
marked language.  
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Contrast ④ 
You can set the desired contrast of the display with the arrow keys and with the right key 
(OK).  

● Setting range: 10% ... 90% (default setting: 50%) 

● Increment: 5% 

Lighting ⑤ 
This menu option specifies how long the backlit display will remain on after the last keystroke 
and enables permanent activation or deactivation of the backlit display. 

The following settings are possible: 

● Off 

● 3 s 

● 10 s (default setting) 

● 1 min 

● 5 min 

● On 

The desired setting can be marked with the arrow keys. The right key (OK) selects the 
marked setting. 

Return to the status display ⑥ 
This menu option specifies whether and at what time to switch back to the status display 
from the current menu. 

The following settings are possible: 

● Manual 

● 3 s 

● 10 s 

● 1 min 

● 5 min 

The desired setting can be marked with the arrow keys. The right key (OK) selects the 
marked setting. 

Invert display ⑦ 
This setting makes it possible to specify whether the display should be displayed normally or 
inverted. The readability of the display can be improved in the event of difficult lighting 
conditions. 

The desired setting can be marked with the arrow keys. The right key (OK) selects the 
marked setting. 
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Messages ⑧ 
This setting makes it possible to specify whether to automatically switch to the "Messages" 
menu if messages are pending and to display the messages (default setting) or whether the 
status display should remain.  

The desired setting can be marked with the arrow keys. The right key (OK) selects the 
marked setting. 

Factory settings ⑨ 
The factory setting makes it possible to reset the display settings to the default settings. 

The desired setting can be marked with the arrow keys. The right key (OK) selects the 
marked setting. A prompt for confirmation then follows that also has to be confirmed with the 
right key (OK). 
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8.7 Restoring factory settings 
To restore the factory settings of the safety relay, proceed as follows:    

 
Step Action 

① Switch the 24 V DC power supply off. 

② Hold down the "RESET" key. 

③ Switch the 24 V DC power supply on again. 

④ Release the "RESET" key only when the DEVICE LED flickers yellow. 

⑤ Keep holding down the "RESET" key if the DEVICE LED flickers red. 

⑥ Release the "RESET" key when the DEVICE LED flickers yellow. 

⑦ Keep holding down the "RESET" key if the DEVICE LED flickers red. 

⑧ When the DEVICE LED goes out, release the "RESET" key within 10 s. 
The DEVICE LED starts to flash yellow. 

⑨ Once the factory settings have been restored, the 3RK3 central unit automatically restarts 
and switches to configuring mode. 

 

 
Figure 8-16 Factory settings 
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Result 
When the factory settings are restored, all the LEDs on the inputs and outputs light up. 

The procedure for restoring the factory settings has the following effects: 

● All configuring information in the internal memory of the 3RK3 central unit is deleted. 

● If the external memory module is plugged in, all the existing data is deleted. 

● For 3RK3 central units with AS-i interface, the saved code sequence table is also deleted. 

 

 Note 

Alternately, the factory settings can be restored by means of MSS ES; see also Chapter 
"Commands... (Page 204)." 

 

 Note 

Since communication is interrupted when the factory settings are being restored, you must 
reboot the DP interface (power OFF/ON) once the factory settings have been restored or 
switch the entire system off and then on again. 

 

 Note 
Factory settings for DP interface  

The factory settings for the DP interface can also be restored; see also Chapter "Menu mode 
with user control (Page 444)." 

 

 Note 
Factory settings of the diagnostics display 

The factory settings for the diagnostics display can also be restored; see also Chapter 
"Display settings (Page 633)." 
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8.8 Module replacement 
 

WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 

Before starting work, therefore, disconnect the system and devices from the power supply. 
 

 Note 

When replacing a module, you do not need to re-wire it. The terminal blocks can be 
disconnected from the defective module and then connected to the new module. 

 

Replacing the central unit    
 

WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 
Conduct a functional test of the system 

To ensure the safety of the system, any changes to it or any replacement of defective 
components must be followed by a thorough and successfully completed function test of 
the system. 

 

NOTICE  
Data loss 

Connect or disconnect the external memory module only when the power is switched off! 
 

1. Disconnect the defective 3RK3 central unit. 
See also Chapter "Disconnecting (Page 136)." 

2. Remove the defective 3RK3 central unit. 
See also Chapter "Removing the central unit, expansion module, or interface module 
(Page 114)." 

3. Remove the memory module with the device configuration. 

4. Install the new 3RK3 central unit. 
See also Chapter "Mounting the central unit, expansion module, or interface module on a 
DIN rail (Page 111)" or Chapter "Mounting the central unit, expansion module, or 
interface module on a level surface (Page 112)." 
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5. Connect the module. 
See also Chapter "Plugging in terminal blocks (Page 139)." 

6. Insert the memory module with the existing configuration data. 
See also Chapter "Connecting the memory module (Page 140)." 

NOTICE  
 

Do not connect a memory module with released configuration to a 3RK3 central unit of 
another type. 

The released configuration on the memory module depends on the 3RK3 central unit. 
For example, the configuration released on an MSS 3RK3 Basic cannot be interpreted 
by an MSS 3RK3 Advanced, or vice versa. The same applies to all other 3RK3 central 
units. When the memory module is plugged into a 3RK3 central unit of another type, the 
configuration release is canceled.  

The configuration may have to be adapted and released again. 

After the supply voltage has been applied, the new 3RK3 central unit checks whether the 
expanded hardware configuration matches the device configuration. 

If there are no deviations, the system re-enters safety mode. 
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Replacing expansion modules/DP interface    
 

WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 
Conduct a functional test of the system 

To ensure the safety of the system, any changes to it or any replacement of defective 
components must be followed by a thorough and successfully completed function test of 
the system. 

 

NOTICE  
Only replace a defective module with a module of an identical type. 

 

1. Disconnect the defective module. 
See also Chapter "Disconnecting (Page 136)." 

2. Remove the defective module. 
See also Chapter "Removing the central unit, expansion module, or interface module 
(Page 114)." 

3. Install the new module. 
See also Chapter "Mounting the central unit, expansion module, or interface module on a 
DIN rail (Page 111)" or "Mounting the central unit, expansion module, or interface module 
on a level surface (Page 112)." 

4. Connect the module. 
See also Chapter "Plugging in terminal blocks (Page 139)." 

After the supply voltage has been applied, the 3RK3 central unit checks whether the 
expanded hardware configuration matches the device configuration. 

If there are no deviations, the system re-enters safety mode. 
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8.9 Creation, modification, and release of the configuration without the 
actual system 

A configuration can created, modified, and released without the actual system. Transfer of 
the configuration into the memory module and release of the configuration do not have to be 
performed on the actual system. All that is required is a 3RK3 central unit of the same type 
and a link to the PC / PG with MSS ES. 

Creation, modification, and release of the configuration without the actual system   
With the following steps, you can modify the configuration remotely away from the system: 

● Open the current configuration with "Load to switching device" or by opening the 
configuring file or creating a new configuration. 

● Modification of the configuration 

● Save 

– Confirm cancellation of the configuration release 

– Consistency is checked 

● "Target system" > "Load to switching device" 

– Choose an access path and confirm 

– Confirm cancellation of the configuration release 

– Confirm the message "Loading successfully completed" 

● "Target system" > "Go offline" (may not be necessary, depends on settings in MSS ES) 

● "Target system" > "Prepare configuration test" 

– Choose an access path and confirm 

– Save and print out the PDF file 

● "Target system" > "Go offline" 

● "Target system" > "Approve configuration" 

– Choose an access path and confirm 

– Confirm release 

– Enter the name and name of the company of the person releasing and confirm 

– Confirm configuring released message 

– Save and print the release information 

● Switch off the 3RK3 central unit 

● Remove the memory module 
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Apply the configuration to the actual system 
The following steps must be performed on the system: 

● Switch off the MSS 3RK3 on the system 

● Replace / insert the memory module 

● Switching on 

– The MSS 3RK3 performs a target/actual comparison of the hardware configuration. 

– The MSS 3RK3 checks whether there is a released project on the memory module. 

– If this is the case, the MSS 3RK3 will load the project into its main memory and switch 
to safety mode. 

● A function test must be conducted. 

WARNING  
 

Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 
Commissioning of the system only after a full functional test   

The system must not be commissioned until a full functional test of the configuration has 
been successfully completed. 

● Normal operation of the system is now possible. 
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8.10 Failure of AS-i components 

8.10.1 Acknowledgement behavior 

Responses in the event of an error 
On failure of a component on the AS-i bus, calculation in the logical processing is always 
performed with the substitute value "0."    

 

WARNING  
Hazardous Voltage. 
Can Cause Death, Serious Injury, or Property Damage. 
Recovery of an AS-i slave after failure 

As soon as the failed AS-i slave returns to the AS-i bus, its real value is immediately 
processed in the logic and the corresponding partial path of the logic is active again. To 
prevent this, you must activate the "Startup test" parameter for the relevant function 
elements in MSS ES, or secure the system by other suitable means. 

 

For the monitoring functions (e.g. EMERGENCY STOP), a startup test is required on 
recovery of the safety-related slaves if any have been parameterized in the function element.   

On failure of an AS-i component, the AS-i-LED flashes red and a warning is generated.  

If errors are pending on the AS-i bus (e.g. code sequence errors), the AS-i-LED lights up red. 
The error must be acknowledged once it has been rectified. 
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8.10.2 Failure of an AS-i slave 
The AS-i master cyclically scans all AS-i addresses to ascertain whether new slaves have 
been added. These scans are detected and evaluated by the AS-i monitor functionality. In 
this way, the MSS 3RK3 can determine what slaves are on the bus and can independently 
detect the absence of an AS-i slave on the bus or the absence of the monitored AS-i subnet.   

Substitute value on missing slave/erroneous code sequence 
If the MSS 3RK3 detects that a configured AS-i slave is missing, or that a safety-related 
AS-i slave is transmitting an erroneous code sequence, the logic processing at the relevant 
terminals continues with the substitute value "0" for the terminals affected.   

It is possible to ascertain which slaves are missing or defective by reading out the actual 
status of the AS-i slaves by online diagnostics in MSS ES. 

 

 Note 

If the missing or defective AS-i slave is a device that is not contained in the configuration of 
the MSS 3RK3, there is no response. 

 

Recovery of an AS-i slave 
When the removed safety-related AS-i slave (identical code sequence) is reinserted or when 
a non-safety-related slave is plugged in with the corresponding slave profile, work is 
resumed with the received process value. 

For the monitoring elements (e.g., EMERGENCY STOP), a startup test is required on 
recovery of the safety-related slaves if any have been parameterized in the function element.   
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8.10.3 Failure of the AS-i bus 

Entering safety mode even without the AS-i bus 
When the system enters safety or test mode, if it is detected that the AS-i bus is not running 
or is missing completely, the system enters safety mode nevertheless. This can take up to 
30 s. In this case, the process values of all configured AS-i slaves are assigned the 
substitute value "0." 

Failure of the total AS-i bus   
In protection or test mode, the device evaluates the bus failure as a TARGET ≠ ACTUAL 
error, but remains in safety mode. Calculation continues with the substitute value "0" for all 
AS-i slaves.  

 

 Note 
Simulated AS-i slaves 

On bus failure, the substitute value 0 is assumed for all slaves at the input of the logic in 
safety or test mode. 

Where values from output terminals of simulated slaves are used again as an input in the 
logic, the input value is not derived using the monitor function but the value of the output 
terminal is used. In this case, no substitute value is assumed. 

 

 

Recovery / switch-on of the AS-i bus while safety mode is running 
If the AS-i bus is switched on in safety or test mode or recovers after a failure, the substitute 
values of the AS-i slaves are shut down and the received process image is transferred. 

Because this procedure can be performed without informing the user and can therefore 
result in safety-critical conditions, "restart" of the AS-i bus is controlled so that a startup test 
(if configured) is performed in the input elements of the logic not only on entering safety 
mode but also on the transition from the substitute value to the real value.   

You will find additional information in Chapter " Failure of an AS-i slave (Page 645)." 
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8.11 Replacement of AS-i components 

8.11.1 Replacement of an AS-i slave during running operation 
An AS-i slave is considered faulty or defective if it is no longer addressed by the AS-i master. 
MSS 3RK3 detects this configuration error and uses the substitute value "0" in the 
interconnection logic.   

Replacement of a non-safety-related slave   
 

WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 
Conduct a functional test of the system 

To ensure the safety of the system, any changes to it or any replacement of defective 
components must be followed by a thorough and successfully completed function test of 
the system. 

 

If a non-safety-related slave of the same type is plugged in at the corresponding address and 
if MSS 3RK3 detects that this slave matches the data in the configuration of the target 
expanded configuration, the configuration error will automatically be reset. The sensor value 
is input to the logic processing again instead of the substitute value. 

Replacing a safety-related AS-i slave 
 

WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 
Conduct a functional test of the system 

To ensure the safety of the system, any changes to it or any replacement of defective 
components must be followed by a thorough and successfully completed function test of 
the system. 
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Addressing the new slave   

If the newly inserted, safety-related AS-i slave already has the correct address, it is enough 
to close the contacts on the safety-related AS-i slave in order for the MSS 3RK3 to be able to 
receive the new code sequence. 

If the new safety-related AS-i slave has to be included on the bus by the AS-i master, it is 
first necessary to wait for the autoadressing phase of the AS-i master. During the 
autoaddressing phase, the new AS-i slave is addressed through address "0." This is not 
monitored by the MSS 3RK3. The system does not detect the new AS-i slave until it is 
provided with a correct address. 

Teaching the new code sequences   

If a safety-related AS-i slave is replaced, the MSS 3RK3 detects that the code sequence 
transmitted by the AS-i slave is not contained in the code sequence table. This initially 
results in the substitute value "0" being used in the interconnection logic for this slave. 

 

 Note 
Important requirement 

Before the code sequences are taught, both contacts of the safety-related AS-i input slaves 
must be closed to enable the code sequences to be taught. 

If the contacts are not closed, calculation in the logic diagram continues with the substitute 
value "0." The current status of the AS-i slave is displayed in the "Learn ASIsafe code tables" 
dialog box. 

 

If MSS 3RK3 has ascertained after a monitoring period has elapsed that the new code 
sequence is unique, the TEACH-LEDs will indicate that the new code sequence can be used 
instead of the originally used code sequence. The new code sequence is applied and saved 
if you press the RESET button for 3 s or use the "Apply learned AS-i code tables" command. 

You will find additional information in Chapter " Teaching the code sequences (Page 482)." 
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LED display during teaching of code sequences 
 
LED Display Explanation 

green Device in safety mode DEVICE 
flickering green Device in test mode 

AS-i flashing red Other code sequence on the AS-i bus 
TEACH yellow flashing Teaching of code sequences active: The code 

sequences are being taught. 
SF off No group error 

LED display if the code tables can be applied 
 
LED Display Explanation 

green Device in safety mode DEVICE 
flickering green Device in test mode 

AS-i flashing red Other code sequence on the AS-i bus 
TEACH yellow Code sequences can be applied 
SF off No group error 
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8.11.2 Replacing an AS-i slave in different subnetworks 
 

WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 
Conduct a functional test of the system 

To ensure the safety of the system, any changes to it or any replacement of defective 
components must be followed by a thorough and successfully completed function test of 
the system. 

 

To ensure that the code sequences are unique, the code sequences of all safety-related AS-i 
slaves on every device must be saved with monitor functionality. If a safety-related AS-
i slave of another subnet is replaced, the code sequence will change. This is detected by 
each AS-i monitor on the AS-i bus and it is treated just like an AS-i slave of the same subnet. 
When it lights up yellow, the TEACH-LED on the MSS 3RK3 indicates that a new code 
sequence has been detected that can be applied.   

Applying the new code sequence   
The new code sequence can be applied and saved by pressing the reset button for 3 s or by 
pressing the "Adopt code tables" button in the "Target system" > "ASIsafe code tables" 
dialog box in MSS ES. The code sequence of MSS 3RK3 is applied and saved in this way. 

You will find additional information in Chapter " Teaching the code sequences (Page 482)." 

LED display on replacement of an AS-i slave in different subnets in safety mode 
 
LED Display Explanation 
DEVICE green Device in safety mode 
AS-i off  Another code sequence in another subnet is not 

evaluated as an error 
TEACH yellow Code sequences can be applied 
SF off No group error 
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8.11.3 Replacement of multiple AS-i slaves during running operation 
 

WARNING  
Hazardous voltage 
Can Cause Death, Serious Injury, or Property Damage. 
Conduct a functional test of the system 

To ensure the safety of the system, any changes to it or any replacement of defective 
components must be followed by a thorough and successfully completed function test of 
the system. 

 

When multiple defective AS-i slaves are replaced, the defective AS-i slaves can be replaced 
by any new slaves if they are of the same type and have already been assigned the same 
address.   

If the new AS-i slaves have not yet been addressed, each must be addressed in succession 
through an AS-i master with the autoadressing function to apply them to the system.   

In the case of safety-related AS-i input slaves, the sensor must be operated once to teach 
the new code sequence. Non-safety-related slaves are interpreted according to the 
configuration. 

Automatic teaching of code sequences in the background   
The transmitted code sequences are learned in the background by the system. The TEACH-
LED light up yellow when all code sequences have been taught. The code sequences of all 
taught slaves can be saved in the code sequence table by pressing the reset button for 3 s 
or by pressing the "Adopt code tables" button in the "Target system" > "ASIsafe code tables" 
dialog box in MSS ES. 

You will find additional information in Chapter " Teaching the code sequences (Page 482)." 
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8.11.4 Additional AS-i slave in running operation 

Additional non-safety-related AS-i slave   
An additional non-safety-related slave on the AS-i bus is ignored. 

Additional safety-related AS-i slave 
 

WARNING  
Additional safety-related AS-i slave on AS-i bus 

For safety reasons, the code sequences of all safety-related slaves must be known to every 
monitor on the AS-i bus. If an additional safety-related AS-i slave is added to the AS-i bus, 
the code sequence of this slave must be taught on every MSS 3RK3 or safety monitor 
located on the AS-i bus, irrespective of whether or not this new safety-related AS-i slave is 
monitored by the respective MSS 3RK3 or safety monitor. 

 

Consider the following when adding a further safety-related slave: 

● If a new safety-related AS-i slave is connected to the AS-i bus and its contacts are 
closed, the MSS 3RK3 detects a new code sequence, the AS-i BF-LED flashes red, and 
the TEACH-LED lights up yellow. The code sequence table can be transferred into the 
memory of the MSS 3RK3 in three different ways:  

– Pressing the RESET buttons for 3 s 

– Pressing the "Apply code tables" button in the "Target system" > "ASIsafe code 
tables" dialog box in MSS ES 

– Controlling a device command function element with the "Adopt code tables" 
command 

The TEACH-LED goes off after the code sequences have been successfully stored.  

● As long as the contacts of the safety-related input slave are not closed, it will be ignored 
by the MSS 3RK3. 

● As soon as teaching in the background has detected that the code sequence that 
provides a newly inserted safety-related AS-i slave is identical to an existing slave, the 
substitute value "0" will be used for both slaves.  

You will find additional information in Chapter "Teaching the code sequences (Page 482)." 
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8.11.5 Replacement of MSS 3RK3 with AS-i interface 
Replacement of all 3RK3 central units is identical. Because the code sequences are stored 
on the memory module, the code sequences do not have to be taught as new.    

Reference 
You will find a description of how to replace the 3RK3 central units in Chapter "Module 
replacement (Page 639)." 
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Technical data 9
9.1 General technical data 

Table 9- 1    

Device data  
Shock resistance (half-sine pulse) 15 g/11 ms 
Shock-hazard protection to DIN EN 60529 IP20 
Pollution degree 2 
Permitted mounting position  Vertical securing surface (+10°/ -10°) 
Minimum clearances for heat dissipation by convection from the devices: 25 mm 

from the ventilation openings (top and bottom) 
Ambient conditions  
Ambient temperature during operation -20 ... +60℃1) 
Ambient temperature during storage -40 ... +85℃2) 
Installation altitude max. 2000 m above sea level 
Pressure 70 ... 106 kPa; < 90 kPa with restrictions 
Relative humidity 10% .... 95% 
Safety data  
SIL claim limit SIL CL in accordance with EN 61508 3 
Performance Level PL in accordance with EN ISO 13849-1 e 
Safety category in accordance with EN ISO 13849-1 4 
Requirement class to EN 574 III C 
Proof-Test Interval T1 20 years 
Setting accuracy of times ± 0.6% 
Environmental data  
EMC 
EMC emitted interference 

according to IEC 60947-5-1 
Severity level A (industry) 

Vibrations in accordance with EN 60068-2-6 
• Frequency 
• Amplitude 

  
5 ... 500 Hz 
0.75 mm 

1) Diagnostics display: 0 ... 60 ℃ 
2) Diagnostics display: -20 ... 70 ℃ 
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9.2 3RK3 Basic central unit 

Technical data of the 3RK3 Basic   
 
Device data  
Number of sensor inputs (1-channel), fail-safe 8  
Number of test outputs 2 
Number of outputs 1 redundant relay output 

1 redundant semiconductor output 
Height 
• Screw terminals 
• Spring-loaded terminals 

  
111 mm 
113 mm 

Width 45 mm 
Depth 124 mm 
Weight 300 g 
Typical number of function elements to be 
processed1) 

250 

Electrical data  
Supply voltage/ 
rated control supply voltage Us 

Device power supply via power supply unit in accordance with 
IEC 60 536 protection class III (SELV or PELV)  
24 V DC  

Operating range 0.85 to 1.15 x Us 
Rated insulation voltage Ui 300 V 
Rated impulse voltage Uimp 2.5 kV2) 
Total power consumption 185 mA + 1.5 A semiconductor output 
Rated power at Us 4.5 W 
Utilization category in accordance with EN 60947-5-1
(relay outputs) 
• AC-15 at 230 V 
• DC-13 at 24 V 
(semiconductor outputs) 
• DC-13 at 24 V 

  
  
2 A 
1 A 
  
1.5 A; short-circuit-proof up to 10 A 

Resetting time3) of the safety-related outputs tRT  
420 ms 

Mechanical durability4) 10 x 106 switching cycles (relay) 
Max. switching frequency z at rated operational 
current 

1000 1/h 

Conventional thermal current Ith 
(relay/semiconductor) 

2/1.5 A 
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Max. protection of relay contacts with fuses NH type 
3NA, DIAZED type 5SB, NEOZED type 5SE  
• Operating class gL/gG 
• Operating class quick response 

  
 
  
4 A 
6 A 

Safety data according to EN ISO 13849-1 
Probability of a dangerous failure per hour (PFHD) 5.14 x 10-9 1/h 
Probability of a dangerous failure on demand (PFD) 1.28 x 10-5 
Characteristic values for cables  
Max. permissible cable resistance 100 Ω 
Max. permissible cable length from device to sensor 
(for CU 1.5 mm2 and 150 nF/km) 

1000 m 
(i.e., max. total cable length of 2000 m) 

Max. permissible cable capacitance 330 nF 
Dark period of solid-state outputs < 1 ms 

1)  The number of function elements that can be processed by one MSS 3RK3 depends on the type of function elements. 
2) Protective separation, reinforced insulation 4 kV between input circuit and output contact current paths. 
3) Time from instant an output is switched off to the instant the output reaches a state that permits it to be switched on 

again. 
4) The mechanical durability may be reduced, depending on the contact load. 
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9.3 3RK3 Advanced central unit 

Technical data of the 3RK3 Advanced   
 
Device data  
Number of sensor inputs (1-channel), fail-safe 8  
Number of test outputs 2 
Number of outputs 1 redundant relay output 

1 redundant semiconductor output 
Height 
• Screw terminals 
• Spring-loaded terminals 

  
111 mm 
113 mm 

Width 45 mm 
Depth 124 mm 
Weight 300 g 
Typical number of function elements to be 
processed1) 

250 

Electrical data  
Supply voltage/ 
rated control supply voltage Us 

Device power supply via power supply unit in accordance with 
IEC 60 536 protection class III (SELV or PELV)  
24 V DC  

Operating range 0.85 to 1.15 x Us 
Rated insulation voltage Ui 300 V 
Rated impulse voltage Uimp 2.5 kV2) 
Total power consumption 185 mA + 1.5 A semiconductor output 
Rated power at Us 4.5 W 
Utilization category in accordance with EN 
60947-5-1 
(relay outputs) 
• AC-15 at 230 V 
• DC-13 at 24 V 
(semiconductor outputs) 
• DC-13 at 24 V 

  
  
2 A 
1 A 
  
1.5 A; short-circuit-proof up to 10 A 

Resetting time3) of the safety-related outputs tRT  
420 ms 

Mechanical durability4) 10 x 106 switching cycles (relay) 
Max. switching frequency z at rated operational 
current 

1000 1/h 

Conventional thermal current Ith 
(relay/semiconductor) 

2/1.5 A 
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Max. protection of relay contacts with fuses 
NH type 3NA, DIAZED type 5SB, NEOZED type 
5SE  
• Operating class gL/gG 
• Operating class quick response 

  
 
  
4 A 
6 A 

Safety data according to EN ISO 13849-1 
Probability of a dangerous failure per hour (PFHD)   

2.8 x 10-9 1/h (without use of AS-i) 
3.8 x 10-9 1/h (with use of AS-i) 

Probability of a dangerous failure on demand 
(PFD) 

  
1.7 x 10-4 

Characteristic values for cables  
Max. permissible cable resistance 100 Ω 
Max. permissible cable length from device to 
sensor 
(for CU 1.5 mm2 and 150 nF/km) 

1000 m 
(i.e., max. total cable length of 2000 m) 

Max. permissible cable capacitance 330 nF 
Dark period of solid-state outputs < 1 ms 
AS-Interface data  
AS-i voltage 18.5 V DC ... 31.6 V DC 
AS-i power consumption < 45 mA 
AS-i bus load like A/B slave 
AS-i slave profiles (simulated slaves) • S-7 F.F (4I/4O): standard slave (max. 4) 

• S-7 A.E (4I/3O): AB slave (max. 4) 
• S-6 B.D: safety-related output slave for controlling a safety-related 

AS-i output (maximum of 12) 
• S-0 B.F: safety-related input slave for AS-i link (maximum of 12) 
• S-7 5.5: (standard CTT2 + 2I/2O) CTT2 slave for transmission of 

diagnostics information (maximum of 1) 

Number of devices per AS-Interface line In the maximum configuration of the AS-Interface network in which 31 
standard addresses are used, you can install up to four additional 
safety monitors without addresses. 
If fewer than 31 standard addresses are used, a further monitor can 
be installed for each unused standard address. If you install additional 
nodes without an address (e.g., ground fault monitoring modules), this 
reduces the number of safety monitors that can be installed 
accordingly. When repeaters are used, this definition applies to each 
segment. 

1)  The number of function elements that can be processed by one MSS 3RK3 depends on the type of function elements. 
2) Protective separation, reinforced insulation 4 kV between input circuit and output contact current paths. 
3) Time from instant an output is switched off to the instant the output reaches a state that permits it to be switched on 

again.  
4) The mechanical durability may be reduced, depending on the contact load. 
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9.4 3RK3 ASIsafe basic central unit 

Technical data of the 3RK3 ASIsafe basic   
 
Device data  
Number of sensor inputs (1-channel), fail-safe 2 
Number of digital standard inputs 6 
Number of test outputs 2 
Number of outputs 1 redundant relay output 

1 redundant semiconductor output 
Height 
• Screw terminals 
• Spring-loaded terminals 

  
111 mm 
113 mm 

Width 45 mm 
Depth 124 mm 
Weight 300 g 
Typical number of function elements to be 
processed1) 

250 

Electrical data  
Supply voltage/ 
rated control supply voltage Us 

Device power supply via power supply unit in accordance with 
IEC 60 536 protection class III (SELV or PELV)  
24 V DC  

Operating range 0.85 to 1.15 x Us 
Rated insulation voltage Ui 300 V 
Rated impulse voltage Uimp 2.5 kV2) 
Total power consumption 185 mA + 1.5 A semiconductor output 
Rated power at Us 4.5 W 
Utilization category in accordance with EN 60947-5-1
(relay outputs) 
• AC-15 at 230 V 
• DC-13 at 24 V 
(semiconductor outputs) 
• DC-13 at 24 V 

  
  
2 A 
1 A 
  
1.5 A; short-circuit-proof up to 10 A 

Resetting time3) of the safety-related outputs tRT  
420 ms 

Mechanical durability4) 10 x 106 switching cycles (relay) 
Max. switching frequency z at rated operational 
current 

1000 1/h 

Conventional thermal current Ith 
(relay/semiconductor) 

2/1.5 A 
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Max. protection of relay contacts with fuses NH type 
3NA, DIAZED type 5SB, NEOZED type 5SE  
• Operating class gL/gG 
• Operating class quick response 

  
 
  
4 A 
6 A 

Safety data according to EN ISO 13849-1 
Probability of a dangerous failure per hour (PFHD)  

2.8 x 10-9 1/h (without use of AS-i) 
3.8 x 10-9 1/h (with use of AS-i) 

Probability of a dangerous failure on demand (PFD)   
1.7 x 10-4 

Characteristic values for cables  
Max. permissible cable resistance 100 Ω 
Max. permissible cable length from device to sensor 
(for CU 1.5 mm2 and 150 nF/km) 

1000 m 
(i.e., max. total cable length of 2000 m) 

Max. permissible cable capacitance 330 nF 
Dark period of solid-state outputs < 1 ms 
AS-Interface data  
AS-i voltage 18.5 V DC ... 31.6 V DC 
AS-i power consumption < 45 mA 
AS-i bus load like A/B slave 
AS-i slave profiles (simulated slaves) • S-7 F.F (4I/4O): standard slave (max. 4) 

• S-7 A.E (4I/3O): AB slave (max. 4) 
• S-6 B.D: safety-related output slave for controlling a safety-

related AS-i output (maximum of 8) 
• S-0 B.F: Safety-related input slave for AS-i link (maximum of 8) 
• S-7 5.5: (standard CTT2 + 2I/2O) CTT2 slave for transmission 

of diagnostics information (maximum of 1) 

Number of devices per AS-Interface line In the maximum configuration of the AS-Interface network in which 
31 standard addresses are used, you can install up to four 
additional safety monitors without addresses. 
If fewer than 31 standard addresses are used, a further monitor 
can be installed for each unused standard address. If you install 
additional nodes without an address (e.g., ground fault monitoring 
modules), this reduces the number of safety monitors that can be 
installed accordingly. When repeaters are used, this definition 
applies to each segment. 

1)  The number of function elements that can be processed by one MSS 3RK3 depends on the type of function elements. 
2) Protective separation, reinforced insulation 4 kV between input circuit and output contact current paths. 
3) Time from instant an output is switched off to the instant the output reaches a state that permits it to be switched on 

again.  
4) The mechanical durability may be reduced, depending on the contact load. 
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9.5 3RK3 ASIsafe extended central unit 

Technical data of the 3RK3 ASIsafe extended   
 
Device data  
Number of sensor inputs (1-channel), fail-safe 4 
Number of digital standard inputs 4 
Number of test outputs 2 
Number of outputs 1 redundant relay output 

1 redundant semiconductor output 
Height 
• Screw terminals 
• Spring-loaded terminals 

  
111 mm 
113 mm 

Width 45 mm 
Depth 124 mm 
Weight 300 g 
Typical number of function elements to be 
processed1) 

250 

Electrical data  
Supply voltage/ 
rated control supply voltage Us 

Device power supply via power supply unit in accordance with 
IEC 60 536 protection class III (SELV or PELV)  
24 V DC  

Operating range 0.85 to 1.15 x Us 
Rated insulation voltage Ui 300 V 
Rated impulse voltage Uimp 2.5 kV2) 
Total power consumption 185 mA + 1.5 A semiconductor output 
Rated power at Us 4.5 W 
Utilization category in accordance with EN 60947-5-1
(relay outputs) 
• AC-15 at 230 V 
• DC-13 at 24 V 
(semiconductor outputs) 
• DC-13 at 24 V 

  
  
2 A 
1 A 
  
1.5 A; short-circuit-proof up to 10 A 

Resetting time3) of the safety-related outputs tRT  
420 ms 

Mechanical durability4) 10 x 106 switching cycles (relay) 
Max. switching frequency z at rated operational 
current 

1000 1/h 

Conventional thermal current Ith 
(relay/semiconductor) 

2/1.5 A 
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Max. protection of relay contacts with fuses NH type 
3NA, DIAZED type 5SB, NEOZED type 5SE  
• Operating class gL/gG 
• Operating class quick response 

  
 
  
4 A 
6 A 

Safety data according to EN ISO 13849-1 
Probability of a dangerous failure per hour (PFHD)   

2.8 x 10-9 1/h (without use of AS-i) 
3.8 x 10-9 1/h (with use of AS-i) 

Probability of a dangerous failure on demand (PFD)   
1.7 x 10-4 

Characteristic values for cables  
Max. permissible cable resistance 100 Ω 
Max. permissible cable length from device to sensor 
(for CU 1.5 mm2 and 150 nF/km) 

1000 m 
(i.e., max. total cable length of 2000 m) 

Max. permissible cable capacitance 330 nF 
Dark period of solid-state outputs < 1 ms 
AS-Interface data  
AS-i voltage 18.5 V DC ... 31.6 V DC 
AS-i power consumption < 45 mA 
AS-i bus load like A/B slave 
AS-i slave profiles (simulated slaves) • S-7 F.F (4I/4O): standard slave (max. 4) 

• S-7 A.E (4I/3O): AB slave (max. 4) 
• S-6 B.D: safety-related output slave for controlling a safety-

related AS-i output (maximum of 10) 
• S-0 B.F: Safety-related input slave for AS-i link (maximum of 

10) 
• S-7 5.5: (standard CTT2 + 2I/2O) CTT2 slave for transmission 

of diagnostics information (maximum of 1) 

Number of devices per AS-Interface line In the maximum configuration of the AS-Interface network in which 
31 standard addresses are used, you can install up to four 
additional safety monitors without addresses. 
If fewer than 31 standard addresses are used, a further monitor 
can be installed for each unused standard address. If you install 
additional nodes without an address (e.g., ground fault monitoring 
modules), this reduces the number of safety monitors that can be 
installed accordingly. When repeaters are used, this definition 
applies to each segment. 

1)  The number of function elements that can be processed by one MSS 3RK3 depends on the type of function elements. 
2) Protective separation, reinforced insulation 4 kV between input circuit and output contact current paths. 
3) Time from instant an output is switched off to the instant the output reaches a state that permits it to be switched on 

again.  
4) The mechanical durability may be reduced, depending on the contact load. 
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9.6 EM 4/8F-DI 

Technical data of the expansion module 4/8F-DI   
 
Device data  
Number of sensor inputs (1-channel), fail-safe 8 
Number of test outputs 2 
Height 
• Screw terminals 
• Spring-loaded terminals 

  
102 mm 
105 mm 

Width 22.5 mm 
Depth 124 mm 
Weight 160 g 
Electrical data  
Supply voltage/ 
rated control supply voltage Us  

24 V DC 

Operating range 0.85 to 1.15 x Us 
Rated insulation voltage Ui 50 V 
Rated impulse voltage Uimp 500 V 
Total power consumption 60 mA 
Rated power at Us 1.5 W 
Safety data according to EN ISO 13849-1 
Probability of a dangerous failure per hour (PFHd) 1.89 x 10-9 1/h 
Probability of a dangerous failure on demand (PFD) 4.29 x 10-6 
Characteristic values for cables  
Max. permissible cable resistance 100 Ω 
Max. permissible cable length from device to sensor 
(for CU 1.5 mm2 and 150 nF/km)  

1000 m 

Max. permissible cable capacitance 330 nF 
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9.7 EM 2/4F-DI 1/2F-RO 

Technical data of the expansion module 2/4F-DI 1/2F-RO   
 
Device data  
Number of sensor inputs (1-channel), fail-safe 4  
Number of test outputs 2 
Number of outputs 2 
Height 
• Screw terminals 
• Spring-loaded terminals 

  
102 mm 
105 mm 

Width 22.5 mm 
Depth 124 mm 
Weight 160 g 
Electrical data  
Supply voltage/ 
rated control supply voltage Us 

24 V DC 

Operating range 0.85 to 1.15 x Us 
Rated insulation voltage Ui 300 V 
Rated impulse withstand voltage Uimp 2.5 kV1) 
Total power consumption 85 mA 
Rated power at Us 2.0 W 
Utilization category in accordance with EN 60947-5-1 
(relay outputs) 
• 15 V AC at 230 V AC 
• 13 V DC at 24 V DC 

  
  
2 A 
1 A 

Resetting time2) of the safety-related outputs tRT  
420 ms 

Mechanical durability 10 x 106 switching cycles 
Max. switching frequency z at rated operational current 1000 1/h 
Conventional thermal current Ith 2 A 
Output contacts protected with fuses NH type 3NA, 
DIAZED type 5SB, NEOZED type 5SE 
• Operating class gL/gG 
• Operating class quick response 

  
  
4 A 
6 A 

Safety data according to EN ISO 13849-1 
Probability of a dangerous failure per hour (PFHd) 3.79 x 10-9 1/h 
Probability of a dangerous failure on demand (PFD) 5.85 x 10-6 
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Characteristic values for cables  
Max. permissible cable resistance  100 Ω 
Max. permissible cable length from device to sensor 
(for CU 1.5 mm2 and 150 nF/km) 

1000 m 

Max. permissible cable capacitance 330 nF 

1) Protective separation, reinforced insulation 4 kV between input circuit and output contact current paths. 
2) Time from instant an output is switched off to the instant the output reaches a state that permits it to be switched on 

again. 
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9.8 EM 2/4F-DI 2F-DO 

Technical data of the expansion module 2/4F-DI 2F-DO   
 
Device data  
Number of sensor inputs (1-channel), fail-safe 4  
Number of test outputs 2 
Number of outputs 2 redundant semiconductor outputs 
Height 
• Screw terminals 
• Spring-loaded terminals 

  
102 mm 
105 mm 

Width 22.5 mm 
Depth 124 mm 
Weight 160 g 
Electrical data  
Supply voltage/ 
rated control supply voltage Us 

24 V DC 

Operating range 0.85 to 1.15 x Us 
Rated insulation voltage Ui 50 V 
Rated impulse withstand voltage Uimp 500 V 
Total power consumption 85 mA + 1.2 A per semiconductor output 
Rated power at Us 2.0 W 
Utilization category in accordance with EN 60947-5-1 
(semiconductor outputs) 
• 13 V DC at 24 V DC 

  
  
1.2 A; short-circuit-proof up to 10 A 

Resetting time1) of the safety-related outputs tRT  
420 ms 

Max. switching frequency z at rated operational current 1000 1/h 
Conventional thermal current Ith 1.2 A 
Safety data according to EN ISO 13849-1 
Probability of a dangerous failure per hour (PFHd) 2.70 x 10-9 1/h 
Probability of a dangerous failure on demand (PFD) 8.34 x 10-6 
Characteristic values for cables  
Max. permissible cable resistance 100 Ω 
Max. permissible cable length from device to sensor 
(for CU 1.5 mm2 and 150 nF/km) 

1000 m 

Max. permissible cable capacitance 330 nF 
Dark period of solid-state outputs: < 1 ms 

1) Time from instant an output is switched off to the instant the output reaches a state that permits it to be switched on 
again. 
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9.9 EM 4F-DO 

Technical data of the expansion module 4F-DO   
 
Device data  
Number of outputs 4 redundant semiconductor outputs 
Height 
• Screw terminals 
• Spring-loaded terminals 

  
102 mm 
105 mm 

Width 22.5 mm 
Depth 124 mm 
Weight 135 g 
Electrical data  
Supply voltage/ 
rated control supply voltage Us 

24 V DC 

Operating range 0.85 to 1.15 x Us 
Rated insulation voltage Ui 50 V 
Rated impulse withstand voltage Uimp 500 V 
Total power consumption 100 mA + 2 A per semiconductor output 
Rated power at Us 4.8 W 
Utilization category in accordance with EN 60947-5-1 
(semiconductor outputs) 
• 13 V DC at 24 V DC 

  
  
2 A; short-circuit-proof up to 10 A 

Resetting time1) of the safety-related outputs tRT  
420 ms 

Max. switching frequency z at rated operational 
current 

1000 1/h 

Conventional thermal current Ith 2 A 
Safety data according to EN ISO 13849-1 
Probability of a dangerous failure per hour (PFHd) 3.18 x 10-9 1/h 
Probability of a dangerous failure on demand (PFD) 2.20 x 10-5 
Dark period of solid-state outputs: < 1 ms 

1) Time from instant an output is switched off to the instant the output reaches a state that permits it to be switched on 
again. 
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9.10 EM 4/8F-RO 

Technical data of the expansion module 4/8F-RO   
 
Device data  
Number of outputs 8 
Height 
• Screw terminals 
• Spring-loaded terminals 

  
102 mm 
105 mm 

Width 45 mm 
Depth 124 mm 
Weight 400 g 
Electrical data  
Supply voltage/ 
rated control supply voltage Us 

24 V DC 

Operating range 0.85 to 1.15 x Us 
Rated insulation voltage Ui 300 V 
Rated impulse withstand voltage Uimp 2.5 kV1) 
Total power consumption 140 mA 
Rated power at Us 3.0 W 
Utilization category in accordance with EN 60947-5-1 
(relay outputs) 
• 15 V AC at 230 V AC 
• 13 V DC at 24 V DC 

  
  
2 A 
1 A 

Resetting time2) of the safety-related outputs tRT  
420 ms 

Mechanical durability 10 x 106 switching cycles 
Max. switching frequency z at rated operational current 360 1/h 
Conventional thermal current Ith 3 A 
Output contacts protected with fuses NH type 3NA, 
DIAZED type 5SB, NEOZED type 5SE 
• Operating class gL/gG 
• Operating class quick response 

  
  
4 A 
6 A 

Safety data according to EN ISO 13849-1 
Probability of a dangerous failure per hour (PFHd) 7.15 x 10-9 1/h 
Probability of a dangerous failure on demand (PFD) 4.36 x 10-5 

1) Protective separation, reinforced insulation 4 kV between input circuit and output contact current paths. 
2) Time from instant an output is switched off to the instant the output reaches a state that permits it to be switched on 

again. 
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9.11 EM 8DI 

Technical data of the expansion module 8DI   
 
Device data  
Number of standard inputs 8 
Height 
• Screw terminals 
• Spring-loaded terminals 

  
102 mm 
105 mm 

Width 22.5 mm 
Depth 124 mm 
Weight 125 g 
Electrical data  
Supply voltage/ 
rated control supply voltage Us  

24 V DC 

Operating range 0.85 to 1.15 x Us 
Rated insulation voltage Ui 50 V 
Rated impulse voltage Uimp 500 V 
Total power consumption 78 mA 
Rated power at Us 1.9 W 
Characteristic values for cables  
Max. permissible cable resistance 100 Ω 
Max. permissible cable length from device to sensor 
(for CU 1.5 mm2 and 150 nF/km)  

1000 m 

Max. permissible cable capacitance 330 nF 
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9.12 EM 8DO 

Technical data of the expansion module 8DO   
 
Device data  
No. of outputs 8 
Height 
• Screw terminals 
• Spring-loaded terminals 

  
102 mm 
105 mm 

Width 22.5 mm 
Depth 124 mm 
Weight 160 g 
Electrical specifications  
Supply voltage / 
rated control supply voltage Us 

24 V DC 

Work area 0.85 to 1.15 x Us 
Rated insulation voltage Ui 50 V 
Rated impulse withstand voltage Uimp 500 V 
Total power consumption 60 mA + 0.5  A per semiconductor output 
Rated power at Us 1.5 W 
Utilization category to EN 60947-4-1 
(semiconductor outputs) 
• DC 13 at 24 V 

  
  
0.5 A; short-circuit-proof up to 10 A 

Max. switching frequency z at rated operational current 1000 1/h 
Conventional thermal current Ith 0.5 A 
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9.13 DP interface module 

Technical data of the DP interface module    
 
Device data  
Height 
• Screw terminals 
• Spring-loaded terminals 

  
111 mm 
113 mm 

Width 45 mm 
Depth 124 mm 
Weight approx. 270 g 
Electrical specifications  
Power supply / rated control supply voltage Us 
(to IEC 61131-2) 

24 V DC 

Work area 0.85 to 1.15 x Us 
Rated insulation voltage Ui 50 V 
Rated impulse voltage Uimp 500 V 
Total power consumption 100 mA 
Rated power at Us 2.4 W 

9.14 Diagnostics display 

Technical data of the diagnostics display   
 
Device data  
Height 60 mm 
Width 96 mm 
Depth 44 mm 
Weight 91 g 
Electrical specifications  
Supply voltage / 
rated control supply voltage US 

via a connection cable from the 3RK3 central unit 
Us = 24 V DC 

Work area 0.85 to 1.15 x Us 
Rated insulation voltage Ui 50 V 
Rated impulse voltage Uimp 500 V 
Total power consumption 24 mA 
Rated power at US 0.6 W 
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9.15 Memory module 

Technical data of the memory module   
 
Device data  
Electronic supply From the 3RK3 central unit 
EEPROM  
Data storage > 40 years 
Deletion/write cycles  100 000 
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Dimension drawings A
A.1 Dimension drawings 

   

 
Figure A-1 Dimension drawing: Enclosure 45 mm with screw terminals 
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Figure A-2 Dimension drawing: Enclosure 45 mm with spring-loaded terminals 
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Figure A-3 Drilling plan: Enclosure 45 mm   
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Figure A-4 Dimension drawing: Enclosure 22.5 mm with screw terminals 

 
Figure A-5 Dimension drawing: Enclosure 22.5 mm with spring-loaded terminals 
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Figure A-6 Drilling plan: Enclosure 22.5 mm 
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Figure A-7 Dimension drawing: Diagnostics display 
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Figure A-8 Cut-out for diagnostics display 
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Evaluation/Feedback B
B.1 Correction sheet 

Correction sheet 
Have you noticed any errors while reading this manual? If so, please use this form to tell us 
about them. We welcome comments and suggestions for improvement.  

Fax response 

 
 From (please complete): 
To 
SIEMENS AG 
I IA CE MK&ST 3 
 
92220 Amberg / Germany 

Name 
  
Company/Department 
  
Address 
  

_________________________________________________________________________________ 

Fax: +49 (0)9621-80-3337 

   

Manual title: 

  

Table B- 1 Errors, comments, and suggestions for improvements 
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Certificates C
C.1 Certificates 

    

You will find all valid conformity and approval certificates for the MSS 3RK3 on the Internet 
(http://support.automation.siemens.com/WW/view/de/26412499/134200). 

http://support.automation.siemens.com/WW/view/de/26412499/134200�
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Index 

  

2 
2007 print function footer, 168 

3 
3RK3 Advanced central unit, 63 
3RK3 ASIsafe basic central unit, 70 
3RK3 ASIsafe extended central unit, 75 
3RK3 Basic central unit, 58 

7 
7 x 4-bit code sequence, 467, 471 
7 x 4-bit code sequences, 454, 482 

8 
8 x 4-bit code sequences, 454, 482 

A 
Access path, 531 
Accessories, 36 
Acknowledging errors 

Diagnostics display, 622 
Acyclic CTT2 data, 583, 586 
Add diagram, 177 
Additional AS-i slave, 652 
Addressing 

AS-i slave, 648 
AS-i slaves, 241, 651 
PROFIBUS DP, 163, 441, 445 
Simulated AS-i slaves, 243 

AND, 337 
Applications, 29 
Apply code tables, 485 
Approve configuration..., 199 
AS-i 1..4F-DO, 392, 467 

Messages, 562 
AS-i 2F-DI, 312, 476 
AS-i code sequence error, 528 
AS-i interface, 537 
AS-i monitor function, 537 

AS-i output, 392, 482 
AS-i signals in the logic diagram, 481 
AS-i slave function, 537 
AS-i slaves, 242 
AS-i subsystem, 242 
AS-Interface, 32, 63, 70, 75, 241, 242, 453, 457, 536 

Connecting, 135 
Minimum expanded configuration, 473 

ASIsafe, 454, 473, 538 
Automation License Manager, 152, 154 

Installation, 153 
AUX1/AUX2, 468 
Auxiliary control signals, 468 

B 
Basic Settings..., 216 
Baud rate, 239 
Block FC ASi_3422, 586 
BMK, 219, 236, 631 
Bus error, 529 

C 
Cable cross-section, 126 
Cancel configuration release, 201 
Catalog window, 214 
Cell function 

Input cell, 276 
Output cell, 277 

Central units, 34, 57, 230, 240 
Certification, 683 
Change grid settings, 253 
Check consistency, 180, 237 
Circular update (line view), 194 
Clocking, 380 
Close, 165 
Code sequences, 197, 648, 650, 651, 652, 653 

AS-i input slaves, 482 
AS-i outputs, 482 

Commands, 205 
Commissioning, 43, 426, 643 
Compare with file, 186, 437 
Compare with switching device, 436 
Compare with switching device..., 186 
Comparison function, 436 
Comparison of configurations, 437 
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Configuration, 49, 235 
AS-i slaves, 460 
Main system, 424 
Subsystem, 424 

Configuration CRC, 233, 429, 433 
Configuration release, 55, 198, 199, 201, 432 
Configuring, 642 

Safety logic, 460 
Configuring error, 493, 529 
Configuring in MSS ES, 423 
Configuring mode, 201, 422 
Connecting, 46, 125, 265 

AS-Interface, 135 
Cable cross-section, 126 
Diagnostics display, 132 
Ground, 141 
Inputs, 117, 123 
PROFIBUS DP, 134 
Relay outputs, 119 
Solid-state outputs, 121, 123 
System interfaces, 131 
Terminal blocks, 127 

Connection cables, 129 
Consistency check 

Messages, 234, 245, 269 
Control data 

CTT2, 585 
Control function 

Device command, 336 
Copy, 173 
Correction sheet, 681 
Counter function 

Counter (0 -> 1 / 1 -> 0), 348 
Counter (0 -> 1), 344 
Counter (1 -> 0), 346 
Messages, 557 

Create macro, 179 
Cross references, 222, 438 
Cross-circuit detection, 125, 266, 274 
CTT2, 582, 583, 595 

Commands and feedback, 591 
Error code, 592 

CTT2 code, 587 
CTT2 protocol, 243 
CTT2 slave, 243 
Cut, 173 
Cyclic CTT2 data, 583, 584 

D 
Data set 0, 570 

Central unit, 570 

DP interface, 571 
Data set 03, 594 
Data set 1 

Central unit, 572 
DP interface, 573 

Data set 92, 574 
Data sets, 442, 564 
Data transfer on the AS-i bus, 458 
Declaration of conformity, 683 
Delay time, 271, 416 
Delete, 174, 250 
Delete highlighting, 213, 259 
Deleting code sequences, 485 
Determine online, 237 

AS-Interface, 242 
Device command, 336 
Device configuration, 534 
Device diagnostics, 191 
Device error, 491 
Device messages, 206, 490 

AS-Interface, 536 
Configuration, 533 
Device bus interface, 535 
Engineering, 532 
Overview, 527 
PROFIBUS DP, 534 
Status, 529 

Device resources, 533 
Device self-test, 531 
Device status, 332 
Device-specific data (line view), 193 
Diagnostics 

Red SF LED on expansion module, 497 
Diagnostics block, 564 
Diagnostics configuration, 206, 526 
Diagnostics display, 35, 106, 238, 615, 617, 618, 619, 
626, 630 

Connecting, 132 
Messages, 621 
Settings, 634 

Diagnostics frame, 566 
Diagnostics logic, 207, 539 
Diagnostics options, 489 
Diagnostics using PROFIBUS, 239, 450, 564, 566 
Diagnostics using the CTT2 protocol, 582, 583 
Diagnostics with CTT2 codes, 587 
Diagnostics with diagnostics display, 615 
Diagnostics with LED, 494 

3RK3 Advanced central unit, 499 
3RK3 ASIsafe basic central unit, 501 
3RK3 ASIsafe extended central unit, 502 
3RK3 Basic central unit, 498 
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Diagnostics display, 508 
DP interface, 508 
Expansion module 2/4F-DI 1/2F-RO, 505 
Expansion module 2/4F-DI 2F-DO, 506 
Expansion module 4/8F-DI, 504 
Expansion module 4/8F-RO, 507 
Expansion module 4F-DO, 506 
Expansion module 8DI, 507 
Expansion module 8DO, 507 

Diagnostics with LEDs 
AS-i1..4F-DO, 524 
EMERGENCY STOP, 510 
ESPE, 512 
Mode selector switch, 521 
Monitoring Universal, 509 
Muting, 522 
Protective door, 513 
Protective door with lock, 515 
Safety shutdown mat with cross-circuit 
principle, 518 
Safety shutdown mat with NC principle, 517 
Standard output/F output, 523 
Two-hand operation, 519 

Diagnostics with MSS ES, 525 
Dimensions, 675 
Disassembly, 114 
Disconnect, 528 
Disconnecting, 136 
Discrepancy monitoring, 273, 318 
Discrepancy time, 273 
Display settings, 211, 220, 260, 620 
Displaying all the switching devices in the PROFIBUS 
segment, 190 
Documentation, 55, 232, 246, 429, 433 
DP address, 441, 446, 449 
DP error numbers, 567 
DP interface, 35, 102, 238, 442, 443, 450, 451, 564, 
672 

Factory settings, 448 
Menu navigation, 444 
Settings, 444 

DP status, 535 
Drilling plan, 677 

E 
Edit terminal identifier..., 179 
Element comment, 219, 220 
Element data block, 595 
Element error, 533 
Element messages, 207, 490, 539, 628 
Element name, 219 

Element numbers in macros, 220 
Element reset, 208 
Element status, 334, 490, 539, 614 
EMERGENCY STOP, 282 

Messages, 542, 598 
Enabling button, 305 

Interconnecting, 266 
Messages, 552, 608 

Engineering, 532 
Engineering system (ES), 144 
Error acknowledgment, 530 
Error category, 491 
Error in configuration, 528, 529 
Error management, 490, 491 
Error messages, 262 
ESPE, 285 

Messages, 544, 599 
Example 

MSS Basic, 43 
Exit, 171 
Expansion module 

2/4F-DI 1/2F-RO, 84 
2/4F-DI 2F-DO, 87 
4/8F-DI, 81 
4/8F-RO, 93 
4F-DO, 90 
8 DO, 99 
8DI, 96 

Expansion modules, 35, 80, 241 
Export macro..., 226, 265 
Export..., 164 

F 
F output, 389, 467 
Factory settings, 205, 637 
Failure of the AS-i bus, 644, 646 
Failure of the AS-i slave, 645 
Fault signaling output (FAULT), 275 
Flip-flop 

FF-SR, 343 
Floating license, 153 
Forcing, 36, 208, 431, 435 
Function block, 586 
Function elements, 247 

Connections, 248 
Function test, 54 
Functional ground, 127 
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G 
Go Offline, 189 
Go to, 437 
Go to..., 175 
Grid settings, 211, 261 
Grounding, 141 
GSD file, 449 

H 
Handshake error, 493 
Header, 167 
Help file, 228 
Help topics, 229 
Highlight signal flow, 212, 258 
HMI module, 238 
HW Config, 449 

I 
Identification, 230, 232, 233 
Identification (line view), 193 
Import macro..., 226, 265 
Import..., 161 
Inductive interference protection, 23 
Info, 229 
Initialization error, 528 
Input cell, 276 
Input delay, 271, 398, 415 
Input terminals, 265 
Inputs 

Connecting, 117, 123 
Insert comment, 175, 255 
Installation, 45 

Automation License Manager, 153 
Diagnostics display, 113 
MSS ES, 154 
On a level surface, 112 
onto DIN rail, 111 

Interconnecting, 46, 125, 265 
Monitoring function, 266 

Interface module, 238 
Interface modules, 35, 102 
Interfaces, 425, 453 
Interrupt connection, 176, 256 

L 
Language, 216 
Learn ASIsafe code tables..., 195 

License key, 152, 153, 154 
License Manager, 152 
Licenses MSS ES, 146, 147 
Line topology (line view), 190 
Line view, 190 
Load to PC..., 188 
Load to switching device..., 187, 427 
Local device interface, 162 
Logic diagram, 246, 424 
Logic error, 492, 528, 529 
Logic function 

AND, 337 
NAND, 340 
NEGATION, 342 
NOR, 341 
OR, 338 
XOR, 339 

Logic prewarning, 493 
Logic warning, 493 

M 
Macrofunction, 263 
Main system, 30 
Maintaining the footer, 2007 print function, 168 
Manual start, 272, 386 
Marking, 232 
Meander (line view), 190 
Memory module, 37, 140, 426, 534, 673 

Delete, 205 
Menu commands, 147 
Message data 

CTT2, 584 
Messages 

Consistency check, 234, 245, 269 
Logic diagram, 262 

Minimize / restore online dialogs, 215 
Minimum actuating duration, 417 
Mode selector switch, 310 

Interconnecting, 266 
Messages, 555, 609 

Modification of the configuration, 642 
Modular Safety System ES settings, 218, 219, 220 
Module replacement, 639 
Module status, 206, 526 
Monitored start, 272, 385 
Monitoring, 204, 207, 539 
Monitoring AS-i slaves 

Non-safety-related AS-i slaves, 474 
Safety-related, 476 

Monitoring function 
AS-i 2F-DI, 312 
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EMERGENCY STOP, 282 
Enabling button, 305 
ESPE, 285 
Mode selector switch, 310 
Protective door, 294 
Protective door with lock, 298 
Safety shutdown mat (cross-circuit principle), 291 
Safety shutdown mat (NC principle), 288 
Two-hand operation, 307 
Universal, 278 

Monitoring of simulated AS-i slaves, 473 
Monitoring simulated AS-i slaves, 473 
Monitoring Universal, 278 

Messages, 540, 596 
Most recently used files, 171 
Move diagram, 212 
Move mode, 253 
MSS 3RK3 diagnostics concept, 490 
MSS ES, 36, 144 

Installation, 154 
SP3, 143 
Starting the program, 155 
User interface, 156 

Muting, 314, 317, 322 
Discrepancy monitoring, 318 
Messages, 556, 610 
Sequence monitoring, 319 
Time limit, 319 

Muting (2-sensor-parallel), 323 
Muting (4-sensor-parallel), 329 
Muting (4-sensor-sequential), 326 

N 
NAND, 340 
Navigation window, 213 
NEGATION, 342 
New..., 160 
Newsletters, 27 
NOR, 341 

O 
Object properties, 180 
Open online..., 162 
Open..., 161 
Operating status, 530 
OR, 338 
Order numbers, 17 
Output cell, 277 
Output function 

AS-i 1..4F-DO, 392 
F output, 389 
Standard output, 387 

Output functions 
Messages, 560 

Output terminals, 265 
Output window, 214 
Overall response time, 271 
Overall view, 210, 254 

P 
Page Setup..., 165, 166, 167, 168, 169 
Parameter assignment, 50 
Parameterization error, 493 
Passing make contact, 360 
Passing make contact (trigger), 365 
Password, 418 

Default password, 430 
forgot, 182 
Reset, 183 

Password for device access..., 184 
Password for project access..., 181 
Password for test mode..., 185 
Password protection, 531 
Paste, 173 
Power supply, 46, 125 
Prepare configuration test..., 198 
Print, 55, 166, 167, 169, 200, 227, 429, 433, 434, 437 

DIN A3, 165 
Print Preview..., 170 
Print..., 170 
PROFIBUS DP, 102 

Connecting,  
Line view,  

Program cycle time, 240, 270, 398, 415 
Project, 233 
Properties 

AS-i slaves, 244 
Central unit, 240 
Expansion module, 241 
HMI modules, 238 
Interface modules, 238 

Protective conductor, 127 
Protective door, 294 

Messages, 548, 600 
Protective door with lock, 298 

Messages, 550, 602 
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R 
Realign graphic, 176, 251, 252 
Redraw partial connection, 177, 258 
Reference points, 257 
References, 18 
Relay outputs 

Connecting, 119 
Release information, 227, 433 
Release information..., 227 
Remove diagram, 178 
Removing 

Diagnostics display, 116 
Replacing 

AS-i slave, 647, 650 
AS-i slaves (more than one), 651 
Central units, 639, 653 
DP interface, 641 
Expansion modules, 641 

Report printout, 55, 198, 200, 429, 433 
Representation of AS-i outputs, 471 
Representing an AS-i output, 471 
Reset, 205 
Response time, 271, 397, 398, 415 

Examples, 407, 410 
Response time of the logic, 398 
Response time of the system, 403 
Restart, 205 
Restore, 172 
Restoring the factory settings, 637 
Rules 

Interconnecting / wiring / connecting, 125, 265 

S 
Safety guidelines, 432 
Safety information, 21 
Safety mode, 55, 203, 423, 434 
Safety monitor, 473 
Safety of the installation, 19 
Safety protocol error, 529 
Safety regulations, 265 
Safety shutdown mat (cross-circuit principle), 291 

Messages, 547, 605 
Safety shutdown mat (NC principle), 288 

Messages, 545, 604 
Safety shutdown mat cross-circuit principle 

Interconnecting, 266 
Save, 164 
Save as..., 164 
Save memory space, 219 
SC (system interface), 535 

Screen grid, 221, 261 
Screw-type connection, 128 
Select all, 174, 250 
Setting options for line view, 194 
Setting the access point (line view), 194 
Setting the circular update interval (line view), 194 
Setting/resetting of AS-i outputs, 467 
SF LED on the expansion module lights up red, 497 
Show hardware configuration, 237 
Simulated AS-i slaves 

Safety-related, 465 
Simulated slaves, 69, 241, 243, 424, 461 

Non-safety-related, 462 
Simulating a CTT2 slave, 462 
Simulating AS-i slaves, 461 

Non-safety-related, 462 
Safety-related, 465 

SIRIUS ES, 144, 160 
Slave status, 196 
Slot, 235, 237 
Slot number, 192 
Software, 36 
Software versions, 57, 151 
Solid-state outputs 

Connecting, 121, 123 
Spring-loaded connection, 128 
Standard output, 387 
Standards, 21 

DIN EN ISO 7200, 168 
EN 61496-1-A.7, 314 
EN 61508, 29 
EN ISO 13849-1, 29 

Start 
Manual, 272 
monitored, 272 

Start conditions, 272 
Start functions 

Manual start, 386 
Messages, 559 
Monitored start, 385 

Start wizard, 155, 217 
Startup test, 272, 644, 645, 646 
Status bar, 159 
Status function 

Device status, 332 
Element status, 334 

Status information, 627 
Status of function inputs, 540 
Status of function outputs, 540 
STEP 7, 449, 565 
Substitute value, 451, 483, 487, 539, 644, 645, 647, 
652 
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Switching output 
Messages, 611 

Symbol list, 223, 439 
System components, 29, 34 
System configuration, 30, 630 

with AS-Interface, 32 
System error, 492 
System interfaces, 129 

T 
Teaching code sequences, 483, 486 

Error, 486 
Teaching the code sequences, 483, 486 

Error, 487 
Technical data 

Central unit, 656, 658, 660, 662 
Diagnostics display, 672 
DP interface module, 672 
EM 2/4F-DI 1/2F-RO, 665 
EM 2/4F-DI 2F-DO, 667 
EM 4/8F-DI, 664 
EM 4/8F-RO, 669 
EM 4F- DO, 668 
EM 8DI, 670 
EM 8DO, 671 
Memory module, 673 
MSS, 655 

terminal blocks, 139 
Terminal identifier, 219, 220, 225, 236, 440 
Terminal list, 225, 440, 481 
Test mode, 54, 202, 422, 430 
Test output, 125 
Timer functions, 398 

Clocking, 380 
Messages, 558 
Passing make contact, 360 
Passing make contact (trigger), 365 
With OFF delay, 370 
With OFF delay (trigger), 375 
With ON delay, 350 
With ON delay (trigger), 355 

Toolbar, 158 
Two-hand operation, 307 

Messages, 553, 606 

U 
Undo, 172 
Undo the fixed assignment of the interface, 189 

W 
Wiring, 46, 125, 265 
Wiring error, 492, 529 
With OFF delay, 370 
With OFF delay (trigger), 375 
With ON delay, 350 
With ON delay (trigger), 355 

X 
XOR, 339 

Z 
Zoom dialog, 210, 254 
Zoom in, 209, 254 
Zoom out, 209, 254 
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